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Administrator's Guide

Important

This content may not be the latest Genesys Engage cloud content. To find the latest

content, go to Genesys Engage cloud for Administrators.
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Workforce Optimization Analytics
Workforce Management Historical Reporting
Recording Real-Time Reporting

GVP Reporting

What is the role of an Administrator?

Administrators play several parts.

Architect

The Genesys Engage cloud Administrator is the architect and overseer of the Genesys Engage
platform (the physical and non-physical resources that you use to run your contact center, including
people, skills, and data). The platform is managed from the Configuration Database.

Agent Setup

Administrators create agents, configure accounts, and assign skills to agents. Administrators set up
switches, voicemail, and interaction routing, and manage call recording. Administrators set up
outbound calling campaigns.

Monitoring

Administrators also monitor the performance of the contact center using real-
time and historical reporting and Workforce Management.

Solution notes

Are you looking for some quick answers or notes about these solutions? Here are answers to a few. If
you have other questions, please send us an email at Techpubs.webadmin@genesys.com.

Please note that Genesys does not provide customers with the ability to reach 911 or

Genesys Engage cloud Administrator's Guide 13
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other emergency services. Customers shall inform any individuals who may be
present where the Genesys Engage cloud Services are used, or who use the Genesys
Engage cloud Services, of the non-availability of 911 or other emergency dialing.

What are the PC requirements?

« RAM: 4 GB RAM (800 MB available for the Screen Recording Service, 400 MB available for WWE)
¢ Processor: Dual-core, 2GHz CPU

* Hard drive: 5 GB of available space (in total) for the Screen Recording Service installation and working
space
Note: Genesys Interaction Recording disk space requirements vary greatly based on the retention
period of media assets on the desktop prior to download to the API. As a general guideline in
assessing hard disk space, estimate the retention period of media assets and combine that
configuration with sizing of files based on % of screen recording.

¢ Supported Operating Systems: Windows 7, 8, and 10, 32-bit or 64-bit
e Citrix version: Citrix Receiver 3.3
¢ Supported browsers:
* Chrome 75+
* Firefox 68+
* Microsoft Internet Explorer 11 (exception: Callback is not supported in IE)

* Microsoft Edge (Callback is supported in Microsoft EdgeHTML version 16.0 and up and on Chromium-
based Edge)
Note: With Microsoft Edge, Genesys recommends to add all sites involved in smart-failover and
Identity Provider in trusted sites. For example: gwa-uswl.genesyscloud.com; api-
uswl.genesyscloud.com.

There are no drivers, applets or any other downloads that need to be made to the PC, with the

exception of the Genesys SIP Endpoint and Screen Recording Client for users who are processing
interactions (calls, emails).

What are the bandwidth requirements?

Traffic Bandwidth Transport Via When
. 100 kbps G.711, (40
Voice (SIP/RTP) Kbps G.729) MPLS Per call
LDAP Negligible MPLS Per use logon
Web Service Tvoicallv low MPLS or Internet Varies based on the
yp y (HTTPS) application
Desktop/CTI 16 kbps ?f—lF‘)II'_rSPg; Internet Per call

Genesys Engage cloud Administrator's Guide 14
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Traffic Bandwidth Transport Via When
. MPLS or Internet
Screen Recording 350 kbps two screens Per recorded call/screen
(HTTPS)
Call playback 50 kbps Internet (HTTPS) User initiated
. MPLS or Internet User initiated or can be
Report download Varies (HTTPS) scheduled (SFTP)

Where can | find an overview of Genesys Engage cloud services?

The Genesys Engage cloud User Guide provides information on how Genesys Engage cloud can work
for, and support, your enterprise.

What hard and soft phones does Genesys Engage cloud support?

¢ Genesys: 420HD
e AudioCodes: 420HD, 430HD, 440HD

* Polycom: SPIP_321, SPIP_331, SPIP_335, SPIP_450, SPIP_550, SPIP_560, SPIP_650, SPIP_670, VVX_300,
VVX_310, VVX_400, VVX_410, VVX_500, VVX_600, VVX_1500

* Yealink: SIP-T19P, SIP-T20P, SIP-T21P, SIP-T22P, SIP-T26P, SIP-T28P

Will | be able to test changes | make to my environment?

Genesys knows that contact centers require tricky routing of interactions. As such, you will have a
chance to test changes you might make to aspects of your environment. Check out the details here.

About Genesys Engage cloud

Genesys Engage cloud architecture leverages the world-class SIP-based GVP/
Media Services products at the core of Genesys Engage while providing the full
Genesys Engage suite of services in the cloud. This offer is customizable to meet
the needs of enterprise customers, whether they need a large number of seats,
heavy-duty premise system integration, or bespoke routing and reporting. Built
on market-leading universal queuing and routing features, the full Genesys
Engage suite will add the ability to support blended agents of any type, including
blending inbound with outbound, voice with e-Services, or any other
combination.

Genesys Engage cloud Administrator's Guide 15
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Top tasks for Genesys Engage cloud

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Whether you're new to Genesys or would just like to know how to carry out one of our most-
requested tasks, we hope this page has the information you need.

Can't find it? Ask us.

Get started

New to Genesys? Need a refresh? Learn the basics about using your all-in-one Genesys contact
center platform.

¢ Getting started as an Administrator

People & Permissions

Manage the people in your organization.

* Set up a new agent
e Set up your teams and permissions
* Create and manage skills

¢ Manage users (Persons)

Business & Operations

Manage resources and settings for your business and operations.

* Make changes to a routing application (Designer content requires login)
¢ Manage your resources

* Make changes to Business Attribute values

Genesys Engage cloud Administrator's Guide
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Single Sign-0On

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Most Genesys Engage cloud applications allow a logged-in user to navigate across those applications
without prompting for credentials again. It can also be configured to use SAML 2.0 for integrations
with third-party identity providers such as Okta or Google. There are many advantages to enabling
single sing-on (SSO) in Genesys Engage cloud—for example:

¢ Users need to remember only one password.

e User credentials are managed by a third-party identity provider.

¢ Users must have multi-factor authentication by a third-party identity provider for additional security.

e Users only need to log in once to gain access to Genesys Engage cloud applications that have SSO
enabled and non-Genesys applications that use the same identity provider.

SSO support by application

View which Genesys Engage cloud applications support SSO.

Applications Single Sign On Support Notes
Agent Desktop Yes
Agent Setup Yes
Callback Yes
Cloud Data Download Service Yes
CX Contact Yes
Designer Yes
Developer Console Yes

Supported in version 9.0.013.0+.
Genesys CX Insights Yes Contact your Genesys
representative to enable.

Genesys Softphone Yes

Supported in Agent Desktop

Screen Recording Yes version 9, but not with custom

Genesys Engage cloud Administrator's Guide 17
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Applications Single Sign On Support Notes
desktops.
Real-Time Reporting (Pulse) Yes \S,gfs'?g;tgd 1) (R FITIE (pelHig
Gplus Adapter Salesforce Yes

Recording, Quality Management

and Speech Analytics Future Roadmap

Not supported for supervisor

Workforce Management Yes accounts for administrative
activities.

Agent Scripting Administration No

Interactive Insights No

Outbound No

Platform Administration (GAX)

Includes plug-ins like eServices Manager No
and IVR Administration

WebRTC Yes

SSO Configuration - Genesys Engage cloud

To enable Single Sign-On for your environments, see the configuration help in Agent Setup.

SSO can be configured for different groups and you can have multiple identity
providers, as long as there is only one per region.

If you're planning to enable SSO, consider the following conventions for creating users:

e The domain declared in the identity provider metadata should be part of the user name stored within
Genesys, to create the most seamless experience. (Example: john@mycompany.com) Otherwise, users
would need to enter a Tenant or enter the domain before their username. (Example: mycompany\john)

e The username provisioned within Genesys Engage cloud should match the username in the external
identity provider.

SSO Configuration - Identity Provider

Genesys Engage cloud must be defined as an application within the identity provider to support the
SSO integration.

Genesys Engage cloud Administrator's Guide 18
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Genesys Engage cloud supports the SAML 2.0 protocol as a standard interface to identity providers,
and has successfully validated with popular IdPs, including Okta and Ping. Other identity providers
can be supported provided they comply with SAML 2.0 and you validate the integration before using
in production.

How does SSO work for users?

S GENESYS

Workspace

okta

Remember me )
Sign In

[] Remember me

MNeed help signing in?

= Genesys * Workspace Carole Spencer ~
Type name of number  Q E
My Workspace
My Channels My Campaigns Dashboard My Statistics Information
Media Status Forward
® voice © Ready (00:26) No Active Forward
O chat © Ready (00:26)
© email © Ready (00:26)
e ™ e ™™ TT—028) e e i

Let's look at the login process for Agent Desktop with SSO enabled and Okta configured as the third-
party identity provider. Note: The login flow is the same for all supported identity providers.

Genesys Engage cloud Administrator's Guide 19
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First, click the Agent Desktop icon in Genesys Portal and enter your username. You must log in to the
application even though you're already logged in to your workstation.

Click Next. Genesys redirects you to Okta where you're prompted to enter your username and
password. Once you log in with Okta, you're redirected back to Agent Desktop and automatically
logged in. Alternatively, if you are already logged in with Okta when you click Next, Genesys skips
the Okta login and automatically logs you in to Agent Desktop.

Now that you're authenticated with the identity provider, you can choose any SSO-enabled
application from Genesys Portal and you'll be automatically logged in without entering your
credentials.

If you happen to close all browser tabs without logging out of the applications, you will remain logged
in for five minutes. If a second window or browser is opened after five minutes, to either the same
application or any other SSO-enabled application, you will once again be prompted for your
credentials.

Genesys Engage cloud Administrator's Guide 20
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Cloud basics for administrators

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Welcome to Genesys Engage cloud. This Genesys offering enables you to get started today with an
all-in-one Genesys contact-center platform.

Access your applications

Genesys Portal is your access point to all Genesys Engage cloud applications.

Genesys Engage cloud Administrator's Guide
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User Administration Support Custom

Agent Desktop Platform Administration Agent Setup Designer Real-Time Reporting

Welcome to your Genesys Portal

®
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—- .
v 9 0 1 0
@ - -
Historical Reporting Interaction Recording Workforce Management Performance DNA Workforce Administration

Reporting Administration Genesys Care Mobile Services Administration iWD Manager

All of your Genesys applications can be found on the All Apps screen. These applications are also
divided into three categories, which you can select by clicking the corresponding category links at the
top right of the Portal.

To customize categories for your contact center, contact Genesys Customer Care.
The out-of-the-box categories are:

User - User applications can be used by contact-center agents and supervisors, such as Agent
Desktop, Workforce Management, and Reporting.

Administration - Administration applications can be used by contact-center administrators and
supervisors to configure users and applications based on their roles.

Support - Support applications are used by authorized contact-center administrators to submit
requests with Genesys Customer Care, and to view the status and schedule of service for Genesys
applications.

Documentation and eLearning are accessed via the Help (9) menu, located in the top-right
corner of Genesys Portal.

Genesys Engage cloud Administrator's Guide 22
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Application

Agent Desktop

Agent Scripting Administration

Cloud iWD

Designer

Genesys Customer Care

IVR Administration

Outbound

Platform Administration

Recording

Reporting

Application Description

Agent Desktop provides agents and knowledge
workers with non-intrusive access to the
information, processes, and applications they need
to perform their jobs more efficiently.

Agent Scripting Administration is a scripting tool
that is used to prompt agents throughout the call-
handling process with customers.

Cloud intelligent Workload Distribution (iWD) allows
you to dynamically prioritize the distribution of
workitems from external source systems to the
employee best suited to handle them.

Genesys Designer helps you to design assisted
service or Routing applications, as well as self-
service or Interactive Voice Response (IVR)
applications.

Genesys Customer Care is a portal for Genesys
customers to locate resources, tools and
information that will aid in resolving your issues,
including the ability to create and track tickets
based on Salesforce.

IVR Administration assists your business with
providing cost-effective customer interactions 24/7
for voice, video, and web-based interactions.

Outbound Contact is an automated system for
creating, modifying, running, and reporting on
outbound campaigns for proactive customer
contact. Outbound Contact Server (OCS) provides
automated dialing and call-progress detection, so
that an agent is required only when a customer is
connected. OCS also intelligently uses customer
data to ensure that campaigns are contacting the
right customers, not just a large number of
customers.

Platform Administration helps you to manage your
user accounts and configure settings to maintain
your contact center. It also provides a dashboard
and widgets to see contact-center activities in real-
time.

Recording provides recording control via a host of
integrations across the suite. The recorded
segments are linked to the contact's account
history, and include information about date and
time, duration, and the parties involved for each
segment.

Reporting assists contact-center managers in:

e Assessing the day-to-day operations of their
contact center resources for the routing and
handling of interactions.

* Better tuning resources to increase utilization

Genesys Engage cloud Administrator's Guide
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Application Application Description

and efficiency.

¢ Benchmarking key performance indicators of
quality and service.

* ldentifying corrective actions to help reduce
costs and increase service

Reporting Administration is used to provision new

Reporting Administration users for Reporting.

Workforce Management (WFM) provides tools to
enable contact-center managers to better manage
their workforce. WFM enables managers to create
accurate staffing plans that take into account
projected contact volumes and average handle
times, as well as the various skills and skill levels of
the agent population. Contact center managers can
achieve these goals, by using WFM's advanced
forecasting, scheduling, and real-time adherence
capabilities.

Workforce Management

Role Access

Access to Genesys Portal applications is provided based on the following user roles:

Application/Role Agent Supervisor CC Manager Administrator
Agent Desktop

Agent Scripting
Administration

Agent Setup
Callback
Cloud iWD
Designer

Genesys Customer
Care

IVR Administration
Outbound

Platform
Administration

Recording
Reporting

Reporting
Administration

Training
Workforce

Genesys Engage cloud Administrator's Guide 24
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Application/Role

Management

Important

Account Types

Agent

Supervisor

CC Manager Administrator

+ - Read and write access.

++ - Limited read and write access.

+++ - This role is not defined within Agent Setup.

* - Separate Agent accounts must be created for Supervisors, Managers, and
Administrators. See How to create an Agent account for Supervisors, Managers, and
Administrators with dual role in Platform Administration.

** - Supervisors and Managers have read-only access to callbacks and callback configuration.
*kk - Supervisors and Managers only have access to modify Designer parameters.
k% - Agents only have the ability to change their own password in Platform Administration.

Fhikk . Agents work on a different Ul from Supervisors, Managers, and Administrators.

The following types of accounts are provisioned in Genesys Engage cloud:

Account Type

Agent Scripting
Administration
Account

Customer Care
Account

IVR Administration
Account

Outbound Account

Platform Account

Reporting Account

Important

Provisioned By

Genesys

Genesys

Customer
Administrator
Genesys

Customer
Administrator

Customer
Administrator

Provisioning Tool
Agent Scripting

Genesys
Salesforce

IVR Administration

Genesys Engage

Platform
Administration

Reporting
Administration

LDAP enabled* Note

No

No

One per IVR
Administration
region

Yes

No

Yes

No

e Certain types of accounts - as specified in the table - can be configured to use
authentication through customer LDAP-compatible directory service.

Genesys Engage cloud Administrator's Guide

25



Cloud basics for administrators

e Itis recommended that all accounts for a particular user be created with the same user
name and password. The table above outlines the different authentication and
authorization systems where separate user accounts need to be created.

* The recommended naming convention for user accounts is the following: <login_name/
first last name>@<customer_company>, for example: john.bull@acme.com. It is
important to include <customer_company> in the user name as unique name domain
identifier.

* For supervisor/administrator users who need access to the Agent Desktop or Agent
Workforce Management interface, the suggested naming convention is the following:
<login_name/first_last name>@<customer_company>.agent

Password Rules

User accounts are required to meet the following password rules:

e Password Length - Must include a minimum of 8 characters.

* Password Complexity - Must include lowercase, uppercase and a number.

* Password Lockout - After 5 failed login attempts, the user account is locked for 30 minutes.
* Password Changes - Must be changed every 90 days.

* Password Re-use - Cannot re-use any of their last 5 passwords.
Managing User Passwords

A user may be configured to set a new password the first they log in, or after a system administrator
has reset their password. In this case, the Change Password dialog box appears.

To change the password, the user must complete the following steps:

1. Enter a new password in the New Password field.
2. Enter the same password in the Confirm Password field.

3. Click Ok.
Changing a Password

If configured, a user can change their password at any time, using the following procedure:

1. Log in to the user account in Platform Administration. The user’s first name appears in the top header
bar of the window.

2. Select the first name.
3. Click Change Password.

4. In the Change Password dialog box, enter the current password, enter a new password and confirm
the new password.
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5. Click Save.

Using Accounts in Applications

The table below lists correlation between account types and Genesys Engage cloud applications.

Application/Account Account Notes on Provisioning
Agent Desktop Platform Account
Account should be enabled by

Agent Scripting Administration Agent Scripting Account Genesys for use in this interface
Cloud iWD Platform Account

Designer Platform Account

Genesys Customer Care Customer Care Account

IVR Administration IVR Administration Account

Platform Administration Platform Account

Recording Platform Account

Reporting Reporting Account

Reporting Administration Reporting Account

Training No account needed

Account should be assigned to
Workforce Management Platform Account security group in WFM by
customer administrator

Call control in Agent Desktop

In Genesys Engage cloud, agents control calls using the Agent Desktop web interface. Agent Desktop
supports call control in the majority of call scenarios.

Hold/retrieve, conference, call transfer, call termination are fully supported for all types of agent
phones.

Engaging another agent, as well as transferring a call to an agent, agent group, or queue should rely
on Favorites in the desktop communicator. Only a few use cases require an agent to call an external
party by means of dialing a phone number.

In the scenario where an agent needs to interact with an IVR via a telephone keypad, the agent can
use Agent Desktop to send dual-tone multi-frequency (DTMF) signals to the IVR.

The Call Answer (Call Accept) desktop feature is disabled in environments where telephony
infrastructure between Genesys and the agent's phone, or the phone itself, does not support the
functionality.

This feature is not supported if:

1. There is a PSTN between Genesys and the phone.
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2. The phone is behind an Avaya switch.

In these environments, agents need to answer calls manually or auto-answer needs to be setup on
their phones.

Begin provisioning your contact center

Click here to begin provisioning your contact center.
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Provisioning your Contact Center

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

The Genesys Engage cloud platform enables you to create basic virtual contact-center infrastructure
and begin using it within minutes. Upon completion of the steps below, you will be able to call your
virtual contact center, accept and control calls in Desktop as an agent, monitor results of the calls in
Real-Time and Historical Reporting as a supervisor, and also play back recordings of the calls in the
Recording interface.

Provision your Contact-Center Resources

Before you start provisioning your contact-center resources, Genesys will supply you with a test IVR
application and a test public phone number that can be called to reach the application. The
application will have an initial greeting and a simple IVR menu with options resulting in the routing of
calls to available agents with specific Skills associated with specific Virtual Queues. The Skills and the
Virtual Queues may be pre-created for you by Genesys, but you can also create your own, as
described below, and ask Genesys to update the IVR application logic.

Create a Skill in Platform Administration

In the top menu, select Configuration to access the Configuration Manager page. While hovering
over the Accounts area, select Skills.

1. Navigate to Skills > Company Folder.
2. Click New (+).

3. Enter a Skill name in the Name field.

4. Click Save.

Create a Virtual Queue in Platform Administration

In the top menu, select Configuration to access the Configuration Manager page. While hovering
over the Switching area, select DNs.

1. Navigate to Switches > Target Switch > DNs > Company Folder > Virtual Queues.
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Click New (+).

Enter a Virtual Queue name in the Number field.
Select Virtual Queue in the Type field.

Repeat the Virtual Queue name in the Alias field.

Click Save.

Provision your Contact-Center Agents

The next step is to provision a contact-center agent and the associated resources in Platform
Administration.

Creating an agent consists of the following actions:

. Create an agent account.
. Create an agent’s Place and associate it with an extension.

1
2
3.
4

Associate an agent with Skills.

. Create an agent’s Login.

Create an Agent Account

In the top menu, select Configuration to access the Configuration Manager page. While hovering
over the Accounts area, select Persons.

1.
2.
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Click New (+).

Enter the agent’s user name in the User Name field - normally this is the agent’s email address or
<login_name>@<company_domain>.

Make sure that the Agent checkbox is checked.
Enter the agent’s first and last names in the corresponding fields.
Optionally, enter the agent’s email address in the E-mail Address field.

Enter the agent’s corporate ID in the Employee ID field. The Employee ID may be the user name or
another unique corporate ID.

Enter the agent’s password and confirm it.

Click Apply.
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Create an Agent’s Place and Associate it with an Extension

Steps 6 through 15 are not required for Chat and/or E-mail only customers.

In the same Persons window from the previous step, perform the following actions:

[
= O

12.
13.
14.
15.
16.
17.
18.

© ® N o U A W N

Click the Browse button located in the Default Place field.

Click the Show Hierarchy link.

Navigate to the folder in which you would like to create the Place.

Click New (+).

Enter the Agent’'s user name attribute value in the Name field.

Click on the DNs tab while still remaining on this Place screen.

Click Add.

Click the Show Hierarchy link.

Navigate to Switches > Target Switch > DNs > Company Folder > Extensions.

Click New (+).

. Enter the Agent’s phone number attribute value in the Number field. The phone number in the simplest

case can be a public phone number at which an agent can be reached (starting with “+” and the
country code) or it can be an extension in the corporate switching system.

Select Extension in the Type field.

Enter the Agent’s user name in the Alias field.
Click Save.

Select the newly created DN extension in the list.
Click Save.

Select the newly created Place from the list.

Click Apply.

Associate an Agent with Skills

In the same Persons window from the previous steps, perform the following actions:

1. Click the Skills tab on the left navigation pane.
2. Click Add.

3.
4

Click the Browse button in the Skill field.

. Navigate to your company folder.
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Select a skill from the list.
Assign the appropriate skill level.
Click OK.

© N o u

Click Apply.

Create an Agent’s Login

Agent Login is not required for Chat and/or E-mail only customers.

In the same Persons window from the previous steps, perform the following actions:

1. Click the Agent Logins tab on the left navigation pane.

2. Click Add.

3. Click the Browse button in the Agent Login field.

4. Navigate to Switches > Target Switch > Agent Logins > Company Folder.
5. Click New (+).

6. Enter the Agent’s phone number attribute value in the Code field.

7. Click Save.

8. Select the newly created Agent Login from the list.

9. Click OK.

10. Click Apply or Save.

Provisioning Agent Groups and Non-Agent Accounts

While it is not strictly required for basic contact-center provisioning, you may also provision additional
types of resources as described below.

Create a Virtual Agent Group in Platform Administration

Virtual Agent Groups allow you to group agents dynamically based on their skills assignment. You can
conveniently select and use them in Historical and Real-Time Reporting.

In the top menu, select Configuration to access the Configuration Manager page. While hovering
over the Accounts area, select Agent Groups.

1. Click New.
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5.

Enter the Agent Group name in the Name field.
Click the Options tab on the left navigation pane.
Click Add.
In the pop-up dialog box, enter the following:

a. Section: Virtual

b. Key: Script

c. Value: SkillExists(“skill name”)

d. Click OK.

Click Save.

Create Administrator/Manager/Supervisor Accounts

Your Administrators, Managers, and Supervisors may need more than one account in the system,
depending on their role or needs. Please refer to the reference tables in the Role Access section.

The topics below describe how to add different types of accounts.

Create a Platform Account

Log in to the Platform Administration interface.

In the top menu, select Configuration to access the Configuration Manager page. While hovering
over the Accounts area, select Persons.

1.
2.

10.
11.
12.
13.

14.
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Click New (+).

Enter a user name in the User Name field - normally this is the user's email address or
<login_name>@<company_domain>.

Make sure that the Agent checkbox is NOT checked.

Enter the user’s first and last names in the corresponding fields.
Enter the user’'s email address in the E-mail Address field.
Enter the user’s corporate ID in the Employee ID field.

Enter a password and confirm it.

Click Apply.

Click on the Member Of tab on the left navigation pane.

Click Add.

Click the Show Hierarchy link.

Navigate to your company folder.

s

Select an appropriate Access Group. Normally, it will be “<company> Administrators”, “<company>
Supervisors” or “<company> Managers”.

Click Save.
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Create an IVR Administration Account

Log in to the IVR Administration interface (in each geographical region where your contact center
is provisioned).

Repeat all of the steps described in the previous topic (Create a Platform Account).

Create a Reporting Account

Use either Mozilla FireFox or Microsoft Internet Explorer to create a Reporting account.

Log in to the Reporting Administration interface. Leave the System and Authentication fields with
the default values, and enter your Reporting user name and password.

Navigate to Group Hierarchy > Interactive Insights Report Users > <company> Users.

Click the Create New User icon in the toolbar.

Enter the user name (same as in Platform Account) in the Account Name field.

Enter the user's first and last names in the corresponding fields.

Enter a password in the Password field (it cannot equal the user name).

IS

Click Save and Close.

Create an Agent Account for Administrator/Manager/Supervisor in Platform
Administration

If your Administrator, Manager, or Supervisor also needs access to agent interfaces (such as Agent
Desktop or the agent part of Workforce Management), you will need to create a separate agent
account.

Separate Agent accounts need to be created for an Administrator, Manager, or Supervisor who plays
a dual role.

1. Follow the steps described in How to Create an Agent in Platform Administration, but make the following
modifications:

a. Wherever a person’s email is used for a field value (User Name, Employee ID, Place Name, DN
Alias), add the .agent suffix to it, such as john.smith@company.com.agent.

If your Administrator, Manager, or Supervisor needs to monitor Agents, follow these steps:
1. Click the Options tab on the left navigation pane.

2. Click Add.

3. In the dialog box, enter the following:
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a. Section: htcc

b. Key: roles

c. Value: Supervisor,Agent
d. Click Save.

5. Click Add.

6. In the dialog box, enter the following:
a. Section: interaction-workspace
b. Key: privilege.teamlead.can-use

c. Value: true

4. Click Save.

Allowing users to customize Pulse dashboards

Add the Person object Select these boxes

Configuration

Home > Persons > Persons > DEVOPS > TeamA >\Adam.Apple@company.com Properties

General

Permissions
Member Of
Name L 3 Tenant 3
Ranks
‘.h Adam.Apple@company.com Environment
Options
& Supervisors-TeamA Environment T U v

Permissions

‘P RPS Users
If your users are working with Pulse for real-time reports, they might want to save any changes they
make to their dashboards. You can enable this by granting them the proper permissions.

On the Configuration Manager page, under Accounts, go to Persons and find the User that you
want to edit. On the Permissions tab, Add the Person object for this user. Once the Person object
appears in the Permissions list, add both Read and Update permissions for this user.

Don't forget to Save the permission before closing the window.

Do this for each user you want to enable.
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Begin Using your Contact Center

Having provisioned your contact center, click here to begin using your virtual contact center.
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Using your contact center

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Once you have configured the necessary contact-center resources, you can start using applications to

make or control calls, and view the results of your calls in reports.

Using Agent Desktop to Accept, Control, and Make Calls

1. Log in to Agent Desktop with an agent account that you created while Provisioning your Contact
Center. Make sure the agent has been assigned the Skills to be targeted by your IVR application. Also,
make sure the agent is in possession of a phone set (corporate SIP Phone or PSTN phone, or even a
personal cell phone) and that phone number associated with this set is configured as this agent’s

extension.
2. Make this agent ready in Agent Desktop for Voice (this is a default state).

3. Call the number associated with the test application (provided by Genesys), and navigate to the IVR
Menu option intended to initiate routing to a skill target possessed by your agent.

4. Your agent phone will ring.
5. Accept the call on your phone set.
a. Click Accept in the pop-up window if you are using a SIP Phone.
b. Answer the call through your device if you are using a PSTN phone or a personal cell phone.
3. Use the navigation buttons to put the call on hold, retrieve the call, transfer the call to another phone
number, or simply terminate the call.
4. You can also initiate an outbound call by entering the phone number in the phone input field.

5. Once the call is complete, the call statistics are updated on the Dashboard.
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Use Real-Time Reporting to View Intra-Day Statistics and Reports

Real-Time Reporting can be viewed in Platform Administration by navigating to Pulse in the
top menu.

Each user is presented with an individual dashboard based on a default dashboard provisioned by

Genesys Administrator. At any moment it is possible to reset the individual dashboard to the default

view.

Within a dashboard, users are able to add new Widgets.

Add a new Widget

Click New (+) within the dashboard.

Choose a Widget Template in the new pop-up window and click Next.

Choose a target configuration object to monitor (Agent, Group, Queue) and click Next.
Choose a list of statistics to view and click Next.

Customize the display options.

Click Finish.

o Uk w N H

All saved widgets are saved in the individual dashboards.

To obtain more details about Real-Time Reporting, refer to the Pulse documentation page.

Use Historical Reporting to view Contact-Center Analytics

To access Historical Reporting, log in to Reporting from Genesys Portal with an Administrator,
Manager, or Supervisor account.

Click Document List in the top menu.

Navigate to Public Folders > Interactive Insights > 8.1.1.

Select the desired Reports Group (such as Agents or Queues).

Select the reports you want to view.

When the Report opens, click Refresh All to invoke the Report Parameters.

Select one of the pre-defined date ranges (such as Today).

Apply any additional filter criteria.

Click Run Query.

© ® N o U A~ W N

Review the results in either the Summary or Main pages (navigation is available in the left pane).
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For more information about Historical Reporting, refer to the Historical Reporting documentation
page.

Or you can read the documentation available in the application by following these steps:

1. Click Document List from the top menu.

2. Navigate to Public Folders > Interactive Insights > 8.1.1 > Documentation.

3. View the Universe Guide or the User’s Guide.
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How to Set Up Your Teams

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

You can organize the personnel in your contact center into groups, called Teams, to better reflect
your organizational structure and to meet your particular needs. You then set up Access Groups
within the Teams to control data access and role privileges within your organization.

[+] Why use Access Groups to control what information users can
access?

If you only have a few users in your contact center, you might want to give
each of those users specific permissions and role privileges to access data
and other call center resources (called objects) that they need to work with.
This protects data and resources from possible misuse (malicious or
otherwise) by users who do not need access. However, as your contact
center grows and you hire more users, keeping track of who has what
permissions can become an administrative nightmare.

Instead, Genesys recommends that you use Access Groups. Access Groups
are virtual groups of users that have the same access permissions and role
privileges. But the permissions and privileges are assigned to the Access
Group, not to the users themselves. Users can belong to more than one
Access Group, so if you need to add or change the permissions and
privileges assigned to a user, you only have to add or move the User to or
between appropriate Access Groups. Instead of keeping track of who has
what permissions, you only need to know the Access Groups of which the
user is a member.

The minimum Access Groups that Genesys recommends in a Team are a Managers Access Group and
a Supervisors Access Group. By default, these groups should have full access to agent-related objects
(Places, Agent Logins, and DN Extensions), and Read access to most other objects, including users.
You can customize other permissions and privileges of each of these Access Groups as required. For
example, you may want to enable only one or both of these Groups to view Real Time Reporting
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information.

The Basics

From the Access Groups and Users pages in Platform Administration you are going to:

1. Create two Access Groups, one for Managers and one for Supervisors.

2. Create the new Team.

3. Add Managers and Supervisors to the Team, and to the Access Groups as appropriate.
4

. Set up permissions to the Team folder for each Access Group.

Create Access Groups for Managers and Supervisors

Configuration

Home = Access Groups = Access Groups > DEVOR

[ select ( O New) : More

MName

5P DEVOPS Admipd

Configuration

Home = Access Groups = Access Groups = DEVOPS = = ulse gents Configuration

peneral Name * Home > Access Groups » Access Groups > DEVOPS > New Properties
i Managers-TeamA
Options | . General
Name *
Tenant : :
Options Supervisors-TeamaA
Environment

Tenant
Environment

From the list of Access Groups in Configuration Manager, navigate to the folder where you are going
to create the Managers Access Group and click New. Then do the same to create the Supervisors
Access Group.
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Create the Team

Configuration

Home = Persons = Persons = DEVOPS

[ select © New : More

Refresh Table

New Folder

Configuration

Home = Persons = Persons > DEVOPS = Mew Properties

General Name *
Options TeamA
Folder Type *
Person
Tenant

Environm

From the list of Persons in Configuration Manager, navigate to the folder in which you want to create

the Team and use the More menu to create a new folder. This folder represents the Team, and will

contain Team members, both individual users and groups of users.
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Add Managers and Supervisors to the Team

Configuration

Home = Persons = Persons = DEVOPS
[ select © MNew [J Delete (: More @, Show Quick Filter ]
A Please Confirm
Refresh Table “ .
tName % LastN Cheoose a location to move the item(s)
to.
|
Folder ——m———
=
| | ( Teamd (Person Folder) )
Disable ~——
Enable p—
| MNew Folder
I TeamA
2 ibe Argon@company.com Abe
2 idam Apple@company.c... Adam = ilse gents Configuration
3dmin@21-53 Home = Persons = Persons = DEVOPS = TeamA

[ select € New * More Q,

Name = First Name
2 ibe Argon@company com Abe
2 idam Apple@company.c. .. Adam

Before you start this step, make sure that you have created user objects that
represent your Managers and Supervisors. See Provisioning your Contact Center for
more information.
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In the Persons list of the folder that contains the Managers and/or Supervisors that you want to add
to this Team, use the More menu to move the selected Manager to the Team folder that you just
created. If the Managers and Supervisors are currently in different folders, simply repeat this action in
each folder. Within a given folder, you can select and move the Managers and/or Supervisors
individually, or select them all and then move them to the Team.

... and to the Access Groups

S GAX Pulse Agents  Configuration
Home = Access Groups = Access Groups = DEVOPS = & Clone T Delete Il Move Tg
General
Persons Add
Members
Name . First Name 2 Last Name E A... é\
Options
Mo items Person
Permissions
Select Person
Dependencies

,’\/\

Configuration

Name . First Name 2 Last Name

2 Abe Argon@company.com Abe Argon
Home = Access Groups = Access Groups > DEVOPS clune

2 Adam Apple@company.d . Adam Apple

General

Persons
Members
Name . First Name
Options .
2 Abe Argon@company.com Abe c“Ck kﬁl"ﬁ
Permissions

... to add him or her to

this Access Group

Dependencies

From the Members tab in the properties of the Managers Access Group, click Add and navigate to
the Team folder, and select the Managers to be added to the Group. A reverse entry will be made
automatically to add the Manager Access Group to the Members Of tab of each Manager. Do these
steps again to add Supervisors to the Supervisors Access Group.
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Set permissions for Members of the Access Group

Home > Persons > Persons = DEVOPS

[1 selecf # Edit New [ Delete i More

& GAX Pulse gents  Configuration

Name

Home > Persons = Persons = DEVOPS > TeamA Properties

I Agents

. I General
GU_Persons Permissions Add Access Group

Options
I 0CS_Agents P

Name B Tenant E Create Read

Permissions

I Team_Exam|

@ I Teamd

2 admin@21-55 Home > Persons » Persons > DEVOPS = TeamA Properties

,’\M\ -

rd

rd

L DEVOPS Administrators

Permissions Add 4

Options
Name E Tenant & Create Read Update
Permissions
£ DEVOPS Administrators Environment v v v
2 Managers-TeamA Environment o v &
Added P RPs Users Environment G
P Supervisors-TeamA Environment L L4 t

For your Team, you want the Managers and Supervisors Access Groups to be able to make changes to
the Team, and you allow this on the Permissions tab of the Team folder. If the Managers and
Supervisors Access Groups are not listed on this tab, click Add Access Group to add them. Then set
the required permissions.
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How To Work with Skills

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

You can assign skills to your agents so that different interactions get routed to the right person for
the right kinds of tasks. For example, you can set up skills for a particular language - so that calls
requiring an English agent are routed to an agent assigned with that skill. You can assign skills based
on different business processes or special knowledge that your agents may have, whatever makes
sense for your company.

How Genesys skill-based routing improves customer experience and contact
center flow

When a customer contacts your organization, they want to connect with the person who is best able
to help them. Genesys skills-based routing will greatly improve the efficiency and quality of your
contact center.

Genesys skills-based routing will connect the customer to the agent who can best help them

By assigning skills to your agents, an administrator can ensure that customers will reach those
agents who have the knowledge and experience related to their issue. Agents can have multiple
skills, and the routing system can find the best available agent for the task.

How it works

Administrators assign skills to their agents, along with a level (or ranking) for each skill. The customer
provides information related to their call (for example, by using keypad menu selections, submitting
an online form, or describing their issue in a chat window). The routing strategy then searches for an
available agent who is the best match for the skills required and connects them to the customer.

The benefits of using skills-based routing

e For customers, this vastly improves their customer service experience. They will connect with someone
who can best help them with their issue.

e For agents, they get to utilize their skills and qualifications in a way that best serves the customers.
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e For administrators, they can leverage agent skills to improve reporting statistics and manage agents
according to the needs of the organization.

The Basics

Let's say you want to create a new skill based on Spanish language ability. The typical flow for setting
that up will go like this:

1. Create the skill.
2. Assign the skill to the right agents.
3. Apply the skill to your routing strategy.

Create a new skill

(@

GAX Configurati

Home > Skills > Skills

[ select Q {'\Ijew
Platform Ad New
& GAX Configuration
Access Groups - Home > Skills > Skills > New Properties
Agent Groups
Persons General
Name *
Roles
myﬁ Options ‘ Spanish|
mnant
Environment

From Genesys Portal, click the Platform Administration tile and go to Skills.

e Click New + and give the skill a name.

* In this example, we have created a new skill called Spanish.
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Assign the skill to an Agent

Bt | S ok e 8, S e File

#geri fiare B g e I Sepervisan b sk 1

AP ALY LML VLS QETLEMER (100 SEVED 1Y 9 N ,

# Edit Agent *

Uger Information Skills (312) Agent Groups (0/14)

User Name * Lgent_D5 Q q,

First Name Agent Siolll Naime H Rating H Doy Naime

Last Mams oS

External il
Emai
Password

Grganizaion * Agerts GSYS_English VG

SEVE_Guest_vG
Defaslt Mumber 16474985671 GEYE_Guest VG
o Spanish ]

Go to the Agents tab and highlight the agent you want to assign a skill to.

e Click 4 to edit the agent's settings.

e Select the desired skill from the Skills list. In this example, we've selected the Spanish skill.

Add a numeric rating to indicate how proficient the agent is with that particular skill (this helps the
routing strategy determine which agent should receive the call). We've given our agent a rating of 8 to
indicate that they are relatively strong in Spanish.

* You can continue to apply more skills to the agent. When you are done, save your changes.

Use the skill in your routing strateqgy

You can now design your routing strategies to make use of these defined skills.
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Using the Genesys Designer palette, you can combine various blocks to create a routing strategy.
Some blocks that relate to agent skills routing are:

¢ Route Call
¢ Menu

To show how it works, we will edit an existing routing application to direct certain calls to our Spanish-
speaking agent.

Agent routing blocks are only used in the Assisted Service phase of the application
structure.

From the Genesys Portal page, log on to Designer and select the application to modify.

To add a routing block, simply drag and drop the Route Call block from the Palette to the Assisted
Service block under the Application Flow.

This opens the Properties section for the Route Call block, where you can select skills and other
routing properties.

Add the Spanish skill by selecting it from the list. You can then add other skills, or
select any of the other options for routing calls.
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How to set up your agents

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Before your contact-center agents can begin interacting with customers, you must set up their
account.

The Basics
From the Agents screen in Platform Administration you are going to:

1. Create the Agent account.
2. Assign one or more Skills to the Agent.

3. Assign the new Agent to an Agent Group.
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Create an Agent Account

Agents (27)

+ Add Agent

@ add ) @ show i

User Information
Agent Name

Agent 02 (Agg First Name Joe

External ID JoeAgent123
Email

Password

Organization * Persons

Default Number 5146844251

Agent 01 (Agd User Name * Joe Agent@company.com

ent 03 (Agef LastName Agent
Employee ID * Joe Agent@company.com

Skills (3/12)

Q

Skill Nam

v Billing
v English
i French

Select Add and enter the agent's personal information. Mandatory fields are indicated by a red star

(*).

To help you fill in these fields, remember:

* User Name is normally the agent’s email address or login_name@company_domain.

« Employee ID is a unique corporate ID.

e Password might be required (even though it is not indicated as mandatory) depending on the

corporate password policy and rules.

* Default Number is the agent's telephone number, either a regular directory number or an
international number (preceded by + and the country code).
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Assign Skills to Agents

+ Add Agent

User Information Skills (3/2) Agent Gro
User Name * Joe Agent@company.com Q, Quick Filter or Create Skill Q, quick
First Name Joe skill Name = Rating 4
Last Name Agent v Billing g m
Employee ID * Joe Agent@company.com [+ English 10
External ID JoeAgent123 L4 French
Ema|l [} GSY E_E'-- 5N
Password TTITT T o GSYS_Guest v

- (] _Ho ]
Organization * Persons M

|} G _Russian L [}

Default Mumber | 5146844251

Select the Skills that the Agent possesses, and then assign a Rating, or proficiency level, for each
assigned skill. Inactive skills are grayed out and unavailable.

A Rating is a numerical representation of the proficiency of the Agent in a skill. Values are 1 to 10,
with 10 being the most proficient.
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Assign Agents to Agent Groups

+ Add Agent x

User Information Skills (3/12) ( Agent Groups E‘I)I 1)
User Name * Joe Agent@company.com Q, Quick Filter or Create Skill Q, QuickFilter
First Name Joe skill Name E Rating B Group Name 4
Last Name Agent [ Billing 9 N Billing_VG =
Employee 1D * Joe Agent@company.com ¥ English 10 GSYS_English_VG
Extemal ID JoeAgent123 @ French 5 GSYS_Guest_VG
Email ()] GSYS_English GSYS_Host_VG
Password ()] GSYS_Guest [+ 0OCS_Agents

L (] GSYS_Host (] RS_chat_AG
Organization * Persons e

J GSYS_Russian — J RS_email_AG

Default Number | 5146844251

Select the Agent Groups to which this Agent belongs.
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Platform Administration

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Welcome to the Platform Administration Help. This document introduces you to the GUI of Platform
Administration and describes concepts and procedures relevant to using Platform Administration in
your contact center.

About Platform Administration
Platform Administration introduces the next-generation user interface for Genesys that reduces both

the overall operating costs and the time to deployment, by providing user-friendly interfaces that
perform complex operations while at the same time preventing user error.

Configuration Manager

Within Platform Administration, Configuration Manager enables you to create and manage system-
level configuration objects.

The Configuration Manager page is a central location for viewing and managing the configuration
objects used by your system.

Configuration objects, also known as Configuration Database objects, contain the data that Genesys
applications and solutions require to operate in a particular environment. These objects are all
contained in the Configuration Database.

Configuration Manager lists these objects by type. For example, configuration objects related to users
and their accounts are listed under the Accounts heading.

Hover over a configuration object type to view a list of the related configuration objects on your
system.

[+] Naming Conventions

Because most objects in the Configuration Database mirror physical objects
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in your contact center (for example, switches, agents, and installed
applications), this document uses an initial capital letter for Configuration
Database objects. For example, the word switch appears in lowercase when
it refers to a physical switch in your contact center, but it is capitalized
when it refers to the configuration object that mirrors your physical switch.
Similarly, the word application appears in lowercase when it refers to a
physical installation in your contact center, but it is capitalized when it
refers to the configuration object that mirrors the installed program.

Common Object Properties

All objects have the following configuration properties and elements:

« Name—Names uniquely identify objects within a certain range. Therefore, the name, which can be up
to 255 characters, is a required parameter for most types of objects. The exceptions are:

* DNs and Agent Logins—Their unique numbers and codes identify them within a Switch.

The way you name objects in your environment is important. Consistent and sensible naming conventions make your
configuration environment easier to understand and faster to browse, leading to a more maintainable and usable configuration.

Although Platform Administration supports the full character set in object names, the use of certain characters
can cause problems in the behavior of other Genesys applications. Therefore, avoid spaces, dashes, periods,
or special characters in object names. Consider using underscores where you might normally use spaces or
dashes.

The names you set for some types of objects must match the names of the entities that those objects represent elsewhere in an
environment. For example, the names of Hosts must match the names given to the computers they represent in the data network
environment.

¢ State Enabled—If checked, indicates that the entity represented by an object is in regular operating
condition and can be used without any restrictions. If not checked, indicates that the entity represented
by an object is being used in a non-production environment. Customer interactions cannot be directed
to this target, even if operating information indicates that this object is available.

Disabling a folder or an object that is a parent to other objects also disables all objects within the folder or all child objects of that
parent object.

For example:

» Disabling an Agent Group folder disables all Agent Groups configured within this folder.

However, if you disable a group of objects (for example, an Agent Group), the individual members of
this group (in this example, Agents) remain enabled.
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Accounts

Important

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

The Accounts section of Configuration Manager enables you to configure the following objects:

* Access Groups
* Agent Groups
e Agent Skills

* Roles

e Users (Persons)
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Access Groups

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Access Groups are groups of Users who need to have the same set of permissions for Configuration
Database objects.

In many cases, users fall into a small number of categories with similar access needs. A team of
agents all performing the same tasks often has identical access needs. Two or three people
responsible for maintaining a specific site of the contact center may also have identical access needs.
You can greatly simplify access control by adding individuals to Access Groups and then setting
permissions for those groups.

e The default user account is not related to Access Groups and, therefore, does not
appear as a member of any Access Group.

Overview

Display Options
The Access Groups list shows the Access Groups that are in your environment.

Access Groups that are disabled will appear grayed out in the list.

To select or de-select multiple objects at once, click Select.

Click the name of an Access Group to view additional information about the object.
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Procedures

Possible Procedures from this Panel

To create a new Access Group object, click New. To view or edit details of an existing object, click on
the name of the object, or click the check box beside an object and click the Edit.

To delete one or more objects, click the check box beside the object(s) in the list and click Delete.
You can also delete individual objects by clicking on the object and then clicking Delete.

When you delete an Access Group, only the Access Group object itself is removed
from the Configuration Database. Its member objects—Access Group and User
objects—are not deleted.

Otherwise, select the check box beside one or more objects and click More to perform the following
tasks:

¢ Clone—Copy an Access Group.

¢ Move To—Move an Access Group to another folder.

¢ Enable or disable Access Groups

¢ Create a folder.

Click on the name of an Access Group to view additional information about the object.

Creating Access Group Objects

To create an Access Group, perform the following actions:

1. In the header, click Configuration.
2. Under the Accounts heading, click Access Groups.
3. Click New.

4. Enter the following information. For some fields, you can either enter the name of a value or click
Browse to select a value from a list:

* Name—The name of the Access Group. You must specify a unique value for this property.
* Tenant—N/A

» State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

u

. Click Apply to save the access group. The Members tab appears.
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6. In the Members tab, click Add to add a User. In the pop-up window, you can create a new User object
by clicking New.

7. Perform one of the following actions after you have added a User to the Access Group:
* Click Save to accept the changes and return to the object list.
* Click Apply to accept the changes and remain in the tab.

* Click Cancel to discard the changes.
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Agent Groups

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

An Agent Group is a logical grouping of Agents. Agent Groups are typically set up to provide
particular sets of contact-center services.

Overview

Display Options

The Agent Groups list shows the Agent Groups that are in your environment.

Agent Groups that are disabled appear grayed out in the list.

To select or de-select multiple objects at once, click Select.

Procedures

Possible Procedures from this Panel

To create a new Agent Group object, click New. To view or edit details of an existing object, click on
the name of the object, or click the check box beside an object and click Edit.

To delete one or more objects, click the check box beside the object(s) in the list and click Delete.
You can also delete individual objects by clicking on the object and then clicking Delete.
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When you delete an Agent Group, only the Agent Group object itself is removed from
the Configuration Database. Its member Agent objects are not deleted.

Otherwise, select the check box beside one or more objects and click More to perform the following
tasks:

e Clone—Copy an Agent Group.

* Move To—Move an Agent Group to another folder.

e Enable or disable Agent Groups

¢ Create a folder.

Click on the name of an Agent Group to view additional information about the object.

Creating Agent Group Objects

To create an Agent Group object, perform the following actions:

5.

6.

1. In the header, click Configuration.

2. Under the Accounts heading, click Agent Groups.
3.
4

Click New.

. Enter the following information. For some fields, you can either enter the name of a value or click

Browse to select a value from a list:

* Name—The name of the Agent Group. You must specify a unique value for this property. You cannot
change this value as long as this Agent Group contains at least one User.

* Capacity Table—N/A
* Quota Table—N/A

* Cost Contract—N/A
e Site—N/A

» Script—Enter a valid expression on the Script tab to define the group as a Virtual Agent Group. The
expression must be in Virtual Group Script Language (VGSL) and must define at least one skill (with
optionally, a skill level) in the following format:

Skill("SkillName")>SkillLevel
Example
Skill("Spanish")>5

e Tenant—N/A

» State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

In the Supervisors tab, click Add to add a User. In the pop-up window, you can create a new User by
clicking New.

In the Agents tab, click Add to add a User. In the pop-up window, you can create a new User by
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clicking New.

7. Perform one of the following actions:
* Click Save to accept the changes and return to the object list.
e Click Apply to accept the changes and remain in the tab.

* Click Cancel to discard the changes.

Virtual Agent Groups

Virtual Agent Groups

A Virtual Agent Group is similar to an Agent Group except that a Virtual Agent Group has no
permanent members. Instead, an Agent becomes a member of a Virtual Agent Group if that Agent
meets the criteria specified by the script. Agent membership in a Virtual Agent Group can change
dynamically based on changes in the Virtual Agent Group criteria or changes in the object properties
of the Agent.

When you click a Virtual Agent Group in Platform Administration, you see its current member Agents.

Although you can create and configure them using Platform Administration, Virtual
Agent Groups are used primarily by Reporting applications.

Warning

If Platform Administration finds Virtual Agent Groups (converted from an earlier
installation) that contain illegal script expressions or include permanent members,
Platform Administration will display an error message. To preserve correct
functionality of the Virtual Agent Groups, you must address the problem manually by
either correcting the error or converting the Virtual Agent Group to a non-virtual Agent
Group by removing the expression from the configuration option script.
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Agent Skills

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Skills are qualities or abilities that Agents possess and that affect the placement of each Agentin a
contact center hierarchy. Common Skills include abilities in different languages, particular categories
of product knowledge, or ability in particular types of sales.

Related Topics

¢ How to Work With Skills
¢ Route Call Block

¢ Menu Block

Overview

Display Options

The Skills list shows the Skills that are in your environment.

Skills that are disabled will appear grayed out in the list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order.

To select or de-select multiple objects at once, click Select.
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Procedures

Possible Procedures from this Panel

To create a new Skill object, click New. To view or edit details of an existing object, click on the name
of the object, or click the check box beside an object and click Edit.

Otherwise, click More to perform the following tasks:

Clone—Copy a Skill.
Move To—Move a Skill to another folder.
Enable or disable Skills.

Create a folder.

Click on the name of a Skill to view additional information about the object.

Creating Skill Objects

To create a Skill object, perform the following actions:

1. In the header, click Configuration.

2. Under the Accounts heading, select Skills. The Skills list displays.
3.
4

. Enter the following information. For some fields, you can either enter the name of a value or click

Click New.

Browse to select a value from a list:

* Name—The name of this Skill. You must specify a value for this property, and that value must be
unique within the Configuration Database.

¢ Tenant—N/A

» State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

Click Save.
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Roles

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Roles define what you can do in a given application. In Platform Administration, roles and their
privileges are controlled by the use of Role objects, which are assigned to Users (including Agents)
and Access Groups. Roles are application-specific, and must be defined for each application that
supports them.

Overview

Display Options

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order.

To select or de-select multiple objects at once, click Select.
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Persons (Users)

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Persons (or users) are the contact-center personnel, including agents, who need access to Genesys
applications. Agents are users who handle customer interactions directly. Non-agent users include
managers and supervisors.

User management starts in the Persons window, a central location for creating, provisioning, and
managing user accounts. Select Persons in the Accounts tile of the Configuration Manager toolbar
to open it.

[+] What if | want to manage just agents, not other users?

You can create agents in either the Persons window (as described here) or in
the Agents window. The result is the same—an agent of type Person is
created and stored in the Configuration Database, and you can manage that
agent in the Persons window or Agents window.

If at any time you want to work only with agents, you can select Agents in
the Configuration Manager menu bar. This shows you a list of only the
agents in your contact center, filtering out all non-agent users and giving
you a shorter list to work with.

Creating an agent in the Persons window might take a little more time,
because you must specify all agent properties. In the Agents window, some
properties, such as DNs and Agent Logins, are created and assigned
automatically.

In addition, the Persons window does not offer you additional time- and
effort-saving features that are not available in the Agents window:

* You can create and modify multiple agents at once (see Create or modify
more than one agent at a time).
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* You can manage the Skills for selected agents at the same time (see Assign
skills to more than one agent at a time.

So unless want to (or have to) define all agent properties yourself and on an
agent-by-agent basis, you should consider creating and modifying the agent
accounts from the Agents window of Configuration Manager.

What do you want to do?

¢ View users

* Create users

¢ Modify users

* Remove users

* Enable or disable users

¢ Create a new users folder

¢ Move a user between folders
* Reset a user's password

¢ Set or change a user's password

How do | view users?

The Persons window lists the users, both agents and non-agents, in your environment. You can
quickly distinguish between agents and non-agents by looking at the icon to the left of the object
name, as follows:

2 Agent

2 Non-agent

See How do | view resources for the different ways to use the Persons window
to see the agents in your call center.
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How do | create a new user?

If you are creating a new agent, the method of creating one and setting it up to
handle customer interactions, as described in this topic, requires that you assign all of
the properties yourself. If you prefer to use a simpler method, in which some
properties, such as DNs and Agent Logins, are created and assigned automatically,
consider creating the agent account from the Agents window of Configuration
Manager.

You can create a new user from scratch.

Creating a new user by cloning is not supported.

Creating a new user from scratch

To create a new user from scratch:

1. In the Persons window, navigate to the folder in which you want to create the user, and click New..

2. On the General tab, enter the required information. For some fields, you can either enter the name of a
value or click Browse to select a value from a list. [+] Show field descriptions

The following fields apply to all users, agents and non-agents:

User Name—Enter the email address of the user.

Agent—This checkbox indicates in this new user is an agent. It is selected by default, so if your new
user is not an agent, clear the box.

First Name—The first name of the user.
Last Name—The last name of the user.
E-mail Address—The e-mail address of the user.

Employee ID—A code of up to 64 characters that identifies this user within the contact-center staff.
You must specify a value for this property and that value must be unique.

Password—A password no longer than 64 characters that this user must use to log in to the
environment. You cannot view the existing password. When creating a new user, this field is always
enabled. When editing an existing user, this field is enabled only if Reset Password is not
selected.
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Passwords can be subject to format rules.

e Confirm Password—The same password entered in the Password field, for confirmation purposes.
When creating a new user, this field is always enabled. When editing an existing user, this field is
enabled only if Force Password Reset on Next Login is not selected.

* Force Password Reset on Next Login—A check box that, if selected, will prompt the User to
enter a new password upon the next login.

» External ID—This setting applies only if your environment is using external authentication, either
LDAP or RADIUS. This may be the user name in the external authentication system. For LDAP, it
might be a whole, or partial, LDAP URL corresponding to RFC 2255.

¢ Tenant—N/A

» State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

If the new user is an agent (Is Agent is selected), the following fields also appear:

* Default Place—The Place assigned to this agent, by default. This optional parameter applies to a
limited number of configurations, in particular those where a real-time association between a place
and an agent cannot be established through a telephony login procedure.

» Capacity Rule—N/A
* Cost Contract—N/A
* Site—N/A
3. (Optional) In the Member Of tab, click Add to add the new user to an Access Group as follows:

a. In the Select Access Group window, either navigate to the folder in which the Access Group exists,
or enter the name of the Access Group in the Search box.

b. Click on the Access Group to which you want the new user to be a member.

c. Click Save.

4. In the Ranks tab, click Add to add a Rank. Enter the following information in the New window:

* Application Type—The type of Application to which a user needs access. Consult the manuals for a
GUI application to see if this application is using Ranks to enable or block certain functions. If a
manual does not contain any references to Ranks, this application does not use Ranks, and you do
not need to specify the Person's Ranks with respect to this application.

* Application rank—The Rank with respect to Applications of the specified type.
5. If the new user is an agent, click Apply to display the following tabs.

* In the Skills tab, click the Add button to add a Skill. Enter the following information in the New
window:

¢ Skill—The Skill assigned to this agent.

e Level—The relative measure of the agent's proficiency in this Skill.

* In the Agent Logins tab, click the Add button to add an Agent Login. Enter the following information
in the New window:

Genesys Engage cloud Administrator's Guide 69



Platform Administration Accounts

¢ Agent Login—The Agent Login code assigned to this agent. You cannot assign an Agent Login
to more than one agent.

* Wrap-up Time—N/A
6. Click Save.

How do | modify a user?

Tip
If you are modifying only multiple agents, you might consider saving time and effort

by importing the changes. See the Can | create or modify more than one agent at a
time? section.

To modify the properties for a user:

1. Either click on the user's name, or select a user in the Persons window and click Edit.

2. Click Edit and make the necessary changes.

Tip
You can also convert an existing agent to a non-agent or an existing non-agent to an

agent by clearing or selecting, respectively, the Agent checkbox in the user's
properties.

How do | remove (delete) a user?

To remove (delete) an agent, refer to Common Resource Operations.

When you remove a user:

* Any objects assigned to that user are not deleted from the Database.
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* All active browser sessions associated with this user are closed. When the user next tries
to access the system, he or she will be redirected to the login page.

How do | disable or enable a user?

To enable or disable an agent, refer to Common Resource Operations.

* Disabled user are not removed from your contact center; they are only removed from

operations. If you want to remove the agent from your contact center completely, you
must delete the agent.

* When a user is disabled, all sessions to which the user is logged in are closed. If the

disabled user tries to do any action in one of those sessions, he or she is redirected to
the login page.

How do | create a new folder for users?

To create a folder:

1. In the Persons window, navigate to the folder in which you want to create the folder, and select New
Folder from the More menu.

2. Enter a name for the folder, and click Save.

How do | move a user between folders?

To move a user between folders:

1.
2.

In the Persons window, select the user to be moved.

In the drop-down list in the Confirmation window, select the folder to which the Person is to be moved.
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How do | reset a user's password?

If a user has lost or forgotten their password, or their password has been jeopardized in some way,
you can force them to change their password when they next log in. Use the following steps:
1. In the Persons window, select the user whose password is to be reset.

2. On the General tab, select Force Password Reset on Next Login.

3. Click Save.

Force Password Reset is disabled if the password has already been flagged to be
reset by the user. It is enabled only when the user logs in and clears the flag by

resetting the password.

How do | set or change a user's password?

If your password policy is to not allow a user to change his or her own password, use these steps to
set or change the password for a user:

1. In the Persons window, select the user whose password is to be set or changed.

2. On the General tab, type a new password in the Password field and then type the same password
(case-sensitive) in the Confirm Password field to confirm it. Your organization might have some rules
governing what makes up a valid password, so make sure that the password you enter meets these

rules.
3. Click Save.
Back to top
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Customizing your Agent Desktop

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

As an administrator, you can customize what a given agent sees when they login to their Agent
Desktop. You also have flexibility in deciding who gets to see what — for example, you can apply a
given customization to a single agent at a time (set this on the Person) or to a whole group of
agents at once (set this on the Agent Group).

You have three options for customizing what your agents see when they open their Agent Desktop:

* Web content

e CallerID

¢ Corporate favorites
You also have the option to configure inactivity timeouts for your agents:

e Security
Since these customizations are unique to you and your business, they are not available out of the
box. To get started on any of these customizations, you need to contact Genesys first. We will do the

initial set up for you — create the phone numbers, URLs, or caller IDs that you tell us you need for
your business.

If any of the custom configurations need to be set up once for all Agents, contact
Genesys.

Once things are set up in the system, you decide who can access the customization — by setting
options in Person or Agent Group objects in Platform Administrator (see Configuration Notes
below).

Let’s take a closer look at the options available to you.
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Setting up custom web content
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You can integrate external web sites into Agent Desktop, displayed in dedicated tabs.

These tabs give your agents quick access to any web sites that you decide they need, without their
having to leave Agent Desktop. For example, your company's knowledge base or corporate search

page.

You can set up these web sites to appear in either the Main View or the Interaction View.

Setup

First, contact Genesys to get codes set up for each URL that you want to add to the Agent Desktop.

¢ Main View — You can set the Main View so that multiple tabs appear for different URLs. After you get
your codes from Genesys enter them as a comma-separated list in workspace.web-content.
For example,
YourSearch, YourKnowledgeBase, YourHelp

¢ Interaction View — For Interaction View, you can only set up a single web site to appear when the
interaction opens. When you get your code from Genesys, enter it in interaction.web-content.
For example,
YourSearch
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[+] See sample configuration

New x

Section *

interaction-workspace

Setting up Caller ID selection

My Workspace

Please select your Caller [dentification

Sales i f

Key =
interaction. web-content -
<
Value
YourSearch, YourkKnowledgeBase <‘

Continue

Cancel

Gptfon nAME

values as set up by Genesys

To get the initial setup for this customization added to your system, submit a service

request to Genesys.

When the Caller ID feature is enabled, a "Please select your Caller Identification" popup box will

appear to your agents when making a call.
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Agents can then select the appropriate caller ID from your predefined list to display to the person
receiving the call.

Setup

To setup the Caller ID list, contact Genesys. You will receive a code that maps to the list that you want
displayed in the Caller ID popup.

Once you get this code, enter it in the intercommunication.voice.make-call-caller-id-business-
attribute option.

For example,
YourList

The change will show up for the next time your agent logs in or starts a new session.

[+] See sample configuration

New x

Section *

interaction-workspace

Key =
intercommunication. voice.m ake-cau'u'-cau'u'er-<; 0 Ptf o nAapag
Value
Vourlist < code sent to You by Genesys
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Setting up corporate favorites

Configuration

General
Options

Home > Agent Groups > Agent Groups > DEVOPS > OCS_Agents > OCS_Agents Properties

Supervisors
Key
Agents

¥ interaction-workspace
Origination DNs

Options
¥ Test_Corporate
Permissions
category
Dependencies

teamcommunicator.corporate-favorites

P>

Value

Section name

Test_Corporate

AgentGroup

Assigned Keys

<
and Values

0OCS_Agents

AgentGroup

A corporate favorite is an internal target or contact that people in your company need to call

frequently, or who you want your agents to find quickly.

In your agents' Team Communicator, corporate favorites are marked by a locked gold star ().

[+] See a screenshot.

Genesys Engage cloud Administrator's Guide

77



Platform Administration Accounts

indicates a corporate favorite

[fype name or number

+ 5 = N

Avril Mai

Carole Spencer
& Unavailable

Dave Williams
& Unavailable

{risti Sippola
& Unavailable

Ravi Pache

You can designate corporate favorites as context-sensitive, determined by a user role, or by the
contact you are currently interacting with.

Setup
Basically, you need to create new options for a Person or an Agent Group objects to:
* Define corporate favorites
e Display corporate favorites for select Person(s) or Agent Group(s) in Agent Desktop Team Communicator

Define corporate favorites

To do this, in Platform Administrator, open the properties for the Agent or Agent Group you want to
modify and go to Options. Add a new entry and enter the details as follows:

e For the Section, enter any name of your choosing.

¢ For the Key, enter one of the options available for the section type (see Corporate Favorite Options by
Type, below). For example, you could enter category, id, type, or display-name.

You can only enter one key at a time, so you will need to repeat this process for each option. Make sure to use
the same Section name so that the keys are grouped together.
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e For the Value, enter an option that applies to the key. For example, an id key would have a value of the
Agent's user ID. A type key would have a value such as AgentGroup, Agent, Skill, or RoutingPoint. If you
are entering more than one value, separate them with semi-colons.

Display corporate favorites for select Person(s) or Agent Group(s) in Agent Desktop Team
Communicator

After you have defined the section and applicable key/value pairs, create a new section to display the
Corporate Favorites in Agent Desktop Team Communicator:

e For the Section, enter interaction-workspace.
¢ For the Key, enter teamcommunicator.corporate-favorites.

¢ For the Value, enter the name of the section(s) you want the favorites to apply to. If you are entering
more than one value, separate them with semi-colons.

[+] See sample configuration

Here is how you could do it for an Agent Group:

A) Create a section called Test _Corporate (make sure to use the same
section name for all key/value pairs you will apply to this section):

¢ Key = type and Value = AgentGroup.
Repeat this for the other mandatory keys:

e Forid, Key = id and Value = 0CS_Agents (as this is the name of the Agent
Group we are modifying in this example).
e For category, Key = category and Value = AgentGroup (as this is an Agent
Group category we are modifying — note there are no spaces).
B) Create a section called interaction-workspace:

e Key = teamcommunicator.corporate-favorites and Value =
Test Corporate.
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Edit X

Section *

interaction-workspace

Key *

teamcommunicator.corporate-favorites

Value

Test_Corporate

C) Agents belonging to the modified Agent Group will now see the corporate

favorites listed in their Team Communicator interface.

Corporate Favorite Options by Type

Expand each section to see the available key and value options for each Corporate Favorite type:

Agent

[+] Show options.

Key Mandatory (Y/N) Valid Values
type Y Agent
id Y <user name of agent>
<semicolon-separated
IR v list of categories>
. i <display name of
display-name N agent>

Example
Agent
userl23

CorporateCategoryl;FavoriteAgents

Jim Brown
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Agent Group
[+] Show options.
Key Mandatory (Y/N) Valid Values Example
type Y AgentGroup AgentGroup
. <name of Agent -
id Y Group> AgentGroupMeridian
<semicolon-separated i .
category Y list of categories> CorporateCategoryl;FavoriteAgents
. i <display name of Agent -
display-name N Group> Meridian
Skill
[+] Show options.
Key Mandatory (Y/N) Valid Values Example
type Y Skill Skill
id Y <name of skill> French
. French-speaking
<semicolon-separated :
category Y ) : Agents;Mandarin-
list of categories> speaking Agents
display-name N <display name of skill> French
Custom Contact
[+] Show options.
Key Mandatory (Y/N) Valid Values Example
type Y CustomContact CustomContact
<semicolon-separated
category Y list of categories> ExternalResources
firstname N <any string> First
lastname N <any string> External
phonenumber =a semicolon-separatediii 55573156 7800: +55512 3454321

Y (one or both)
emailaddress

display-name N

Interaction Queue

[+] Show options.

Key Mandatory (Y/N)
type Y

list of phone numbers>

<a semicolon-separated
list of email addresses>

<display name of
custom contact>

Valid Values

InteractionQueue

externall@mail.dom;external2@mail.d

Angie Davis

Example
InteractionQueue
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Key Mandatory (Y/N) Valid Values Example

<script name of 123

id Y interaction queue>

<semicolon-separated

category Y list of categories> CorporateCategory1l;FavoriteAgents
. ) <display name of .
display-name N interaction queue> Quality Assurance
Security

You can configure Agent Desktop to log out an agent from the application if the
agent has not used the keyboard or mouse for a period of time. Agent Desktop
saves the agent's work, ends the session, logs out the agent on all media
channels, and returns to the login page.

Setup

To set this up, configure the following options in the [interaction-workspace] section:

¢ security.inactivity-timeout
This option specifies how long (in minutes) an agent can be inactive (no mouse or keyboard
activity) before Agent Desktop ends their session. The default value for this option is 0, which
disables the inactivity timeout.

e security.inactivity-alert-dialog-before-timeout
This option specifies how much advanced warning (in seconds) Agent Desktop will give to an agent
who is about to have their session ended due to inactivity. The default setting is 30 seconds. (You
must set this option to a value that is less than the value of security.inactivity-timeout.)

The changes for both of these options take effect as soon as the session is started or restarted.

Warning

After the timeout occurs, the Agent Desktop login dialog should be blank; however, if
the agent has allowed the browser to remember his or her password, then the login
dialog will still be populated with the agent's credentials. For security, agents should
not allow web browsers to remember their login credentials.
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Configuration Notes

Add  ZX More

Configuration

A
v

Home > Persons = Persons = Customer22-65 =

General
Options Q

Member Of
Value

ap

Key
Ranks

¥ htce
skills

_’ -
ent Logins.

roles agent, supervisor

¥ interaction-workspace

Options
privilege_chat.can-use true

Permissions
privilege.email.can-use true

Dependencies

privilege voice can-use true
Accessible Objects
privilege.workbins.can-use true

¥ provisioning_flags

e For each option, you must set the section name to interaction-workspace.

* You can set these customizations individually, on the Person object for each agent, or globally for each
Agent group. Note that the group settings takes precedence over the individual setting.

* Whenever you add multiple values to an option, separate each value with a comma.

Update

To update an existing option, just click on it in Platform Administrator. The Edit window opens with all
existing values filled out, and you can edit as you need to. For example, to add more favorites to your
Corporate Favorites quick dial list.

Delete

To delete an existing option, you need to select the check box next to the option. This enables the
Delete button in the toolbar. Once the button is enabled, you can click to remove the option. Note
that there is no prompt — as soon as you click Delete, it's gone.

Finalize

When adding or changing an option, you always need to close out the change by taking one of these
actions:

¢ Click Save to accept the changes and return to the object list.

e Click Apply to accept the changes and remain in the Options tab.

¢ Click Cancel to discard the changes.

Genesys Engage cloud Administrator's Guide 83



Platform Administration Accounts

Important

Any changes made to your Agent or Agent Group configurations will only take effect
when a session of Agent Desktop if started or restarted.
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Routing/eServices

Important

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

The Routing/eServices section of Configuration Manager enables you to configure the following
objects:

e Business Attributes

e Business Attribute Values
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Business Attributes

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Business Attributes are objects that serve as containers of a particular type for Attribute Value
objects. Instances of this object are available enumerations (classifications), such as Media Type,
Service Type, and others.

Business Attribute names and values may be stored using UTF-8. This enables the
attributes and their values to be entered and displayed in any language, including
non-ASCIl languages such as Japanese. If required, two or more languages can be
combined for a single Business Attribute.

Overview

Business Attributes Overview

The Business Attributes list shows the Business Attributes that are in your environment.

Business Attributes that are disabled appear grayed out in the list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.

Genesys Engage cloud Administrator's Guide 86



Platform Administration Routing/eServices

Business Attribute Values

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

A Business Attribute Value is an object which represents a single value within the range of values for
a given Business Attribute object.

Overview

Business Attribute Values Overview

The Business Attribute Values list shows the Business Attribute Values that are in your
environment.

¢ The Business Attributes list displays when you select Business Attribute Values in
Configuration Manager. To access the Business Attribute Values list, you must first
select a Business Attribute object and then a Business Attribute Value folder.

e Business Attribute Values that are disabled appear grayed out in the list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.
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Scripts

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Scripts identify processing scenarios or treatments that can be applied to customer interactions. For
example, an Alarm Reaction Script specifies how to react when an Alarm Condition is triggered.
Capacity Rules scripts govern the number and kind of interactions each agent can process.

You can view script metadata (name, type, and whether the script is enabled) but you cannot view
the actual script or modify its metadata. If you believe you need a script modified, you must contact
Customer Care.

To view a list of your scripts, go to Configuration > Environment > Scripts.
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Switching

Important

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

The Switching section of Configuration Manager enables you to configure the following objects:

¢ Agent Logins
* DNs
* DN Groups

¢ Places
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Agent Logins

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Agent Logins are unique codes defined within a Switch and assigned to agents. They identify which
agent is working at which Place during a particular working session.

The configuration of Agent Logins in the Configuration Database must match exactly the
configuration of those Agent Logins in the switching system. Before adding or deleting a particular
Agent Login, make sure that the same change was made in the database of the switching system.

When you specify Agent Logins as objects in a Switch, they are not associated with any particular
agents. For information about how to assign Agent Logins to agents, refer to Creating Agents.

Overview

Agent Logins Overview

The Agent Logins list shows the Agent Logins that are in your environment.

e The Switches list displays when you select Agent Logins in Configuration Manager. To
access the Agent Logins list, you must first select a Switch object and then an Agent
Logins folder.

e Agent Logins that are disabled appear grayed out in the list.

To select or de-select multiple objects at once, click Select.
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Procedures

Possible Procedures from this Panel

To create a new Agent Login object, click New. To view or edit details of an existing object, click on
the name of the object, or click the check box beside an object and click Edit.

To delete one or more objects, click the check box beside the object(s) in the list and click Delete.
You can also delete individual objects by clicking on the object and then clicking Delete.

When you delete an Agent Login, the Agent Login is removed from the Configuration
Database and from any Agent to which it is assigned. This might affect the
configuration of a particular Agent in the contact center. Before deleting an Agent
Login, consider viewing the dependencies tab to identify the Agent to which this Login
is assigned. If you want to remove only the Agent Login from the Agent to which it is
assigned, but leave it still existing in the Configuration Database and available for
assignment to another Agent, open the User Account for the Agent, remove the Agent
Login from the Agent, and click Save.

Otherwise, select the check box beside one or more objects and click More to perform the following
tasks:

¢ Clone—Copy an Agent Login.

* Move To—Move an Agent Login to another folder.

* Enable or disable Agent Logins

¢ Create a folder.

Click on the name of an Agent Login to view additional information about the object.

Creating Agent Login Objects

To create an Agent Login object, perform the following actions:

In the header, click Configuration.

Under the Switching heading, click Agent Logins.

The Switches list displays.

Click the Switch object in which you wish to create an Agent Login.

Click the Agent Logins folder in which you wish to create an Agent Login.

Click New.

o vk~ w N e
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7. Enter the following information. For some fields, you can either enter the name of a value or click
Browse to select a value from a list:

Code—The Agent Login code. You must specify a value for this property, and that value must be
unique within the Switch. Once you set the value, you cannot change it.

Switch—The Switch to which this Agent Login belongs. This value is automatically set, based on the
Switch being viewed in the Agent Logins list.

Override—N/A
Switch-specific Type—N/A
Password—N/A

Confirm Password—N/A
Tenant—N/A

State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

8. Click Save.
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DNS

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

DNs are communication devices, uniquely identified by their directory numbers (DNs), where
customer voice interactions reside and are handled.

Because most types of DNs represent the actual devices of the telephone system, their specification
in the Configuration Database must always correspond to their Switch settings. Remember that
Platform Administration has no way of verifying this correspondence.

Related Topics

As a general rule, changes made to DN configurations in the Configuration Database must always
follow the changes made to DNs within the telephone system, and never the other way around.

Overview

Display Options

The DNs list shows the DNs that are in your environment.

¢ The Switches list displays when you select DNs in Configuration Manager. To access the
DNs list, you must first select a Switch object and then a DN folder.

* DNs that are disabled appear grayed out in the list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order. You can add or remove columns by clicking Select Columns.
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Click Group By to group objects by various criteria.

To select or de-select multiple objects at once, click Select.

Procedures

Possible Procedures from this Panel

To create a new DN object, click New. To view or edit details of an existing object, click on the name
of the object, or click the check box beside an object and click Edit.

To delete one or more objects, click the check box beside the object(s) in the list and click Delete.
You can also delete individual objects by clicking on the object and then clicking Delete.

When you delete a DN, it is removed from the Configuration Database and from any
DN Group of which it is a member. If you want to remove only the DN from a DN Group
of which it is a member, but leave it still existing in the Configuration Database and
available for assignment to another DN Group, you must remove it from the DNs tab
of the DN Group.

Otherwise, click More to perform the following tasks:

¢ Clone—Copy a DN.
¢ Move To—Move a DN to another folder.
e Enable or disable DNs.

¢ Create a folder.

Click on the name of a DN to view additional information about the object.

Creating DN Objects

To create a DN object, perform the following actions:

1. In the header, click Configuration.

2. Under the Switching heading, click DNs. The Switches list displays.
3. Click the Switch object in which you wish to create a DN.

4. Click the DN folder in which you wish to create a DN.
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5. Click New.

6. Enter the following information. For some fields, you can either enter the name of a value or click
Browse to select a value from a list:

Number—A directory number assigned to this DN within the Switch. You must specify a value for
this property, and that value must be unique within the Switch for all DN types. Once you set the
value, you cannot change it.

Type—The type of the DN. This value must be set to Extension.

Switch—The Switch to which this DN belongs. This value is automatically set, based on the Switch
being viewed in the DNs list.

Association—N/A

Register—N/A

Alias—N/A

Route Type—N/A

DN Group—The DN Group to which this DN belongs.
Override—N/A

Login ID—N/A

Switch-specific Type—N/A

Number of Trunks—N/A

Tenant—N/A

State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

7. Click Save.
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DN Groups

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

DN Groups are logical groupings of DNs. You can use DN Groups in network-level routing algorithms
and in some types of statistics.

Although a DN Group can contain DNs that belong to a number of different Switches, you can receive
correct statistical information about this DN Group only if the reporting applications connect to the
servers associated with those Switches.

Overview

Display Options

The DN Groups list shows the DN Groups that are in your environment.

DN Groups that are disabled appear grayed out in the list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.
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Places

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

A Place is a location that has one or more DNs operated by a single agent.

You configure Places and assign individual DNs to them in order to monitor performance and
availability, and to provide this information to call-processing applications.

Overview

Display Options
The Places list shows the Places that are in your environment.

Places that are disabled appear grayed out in the list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order.

To select or de-select multiple objects at once, click Select.

Procedures

Possible Procedures from this Panel

To create a new Place object, click New. To view or edit details of an existing object, click on the
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name of the object, or click the check-box beside an object and click Edit.

To delete one or more objects, click the check-box beside the object(s) in the list and click Delete.
You can also delete individual objects by clicking on the object and then clicking Delete.

* You should only reconfigure a Place object when there are no Agents logged into the
Place. Doing so can have an impact on both the status of the Place in Pulse reports and
call routing to the associated Agents.

e When you delete a Place, it is removed from the Configuration Database and from any
Place Group it belongs to. If you want to remove a Place, remove it from the Place
Group. This keeps it in the Configuration Database and allows it to be added to another
Place Group.

Otherwise, click More to perform the following tasks:

¢ Clone—Copy a Place.
¢ Move To—Move a Place to another folder.
e Enable or disable Places.

¢ Create a folder.

Click on the name of a Place to view additional information about the object.

Creating Place Objects
To create a Place object, perform the following actions:

1. In the header, click Configuration.

2. Under the Switching heading, click Places.
3. In the Places window, click New.
4

. Enter the following information. For some fields, you can either enter the name of a value or click
Browse to select a value from a list:

* Name—The name of this Place. You must specify a unique value for this property.
* Capacity Rule—N/A

* Cost Contract—N/A

* Site—N/A

* Tenant—N/A

» State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.
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5. In the DNs tab, click Add to add a DN. In the pop-up window, you can create a new object by clicking
New.

6. Perform one of the following actions after you have added a DN to the Place:
* Click Save to accept the changes and return to the object list.
* Click Apply to accept the changes and remain in the tab.

* Click Cancel to discard the changes.

7. Click Save.
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Agents

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Agents are Users who handle customer interactions directly. The Agents window lists all Agents in

your environment (or Tenant, if you are in a multi-tenant environment). You can only see those
objects for which you have access.

You can filter the contents of this list in several ways:

Click Show Quick Filter and type a search term in the Quick Filter field. The list updates dynamically
to show items that match the text in the Quick Filter field.

Click Show Column Filter to show search fields for each column header. Enter a search term in one of
these fields to quickly search the column for the search term.

Click the cube icon to open the Tenant Directory window. In this window, click the Tenant that you
want to select. Use the Quick Filter field to filter the Tenant list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order.

Creating an Agent

To create a new Agent, click Add.

[+] Show Procedure

Procedure: Creating an Agent

Purpose: To create an Agent in the Agents window.
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Steps

1. Click Add. The Add Agent window appears.

2. Enter the following information. For some fields, you can either enter the name of a value or click
Browse to select a value from a list:

¢ User Information

* User Name—The name that this User should use to log into the environment. You must
specify a value for this property, and that value must be unique within the Configuration
Database.

¢ First Name—The first name of this User.
e Last Name—The last name of this User.

* External ID—This setting applies only if your environment is using external
authentication, either LDAP or RADIUS. This may be the user name in the external
authentication system. For LDAP, it might be a whole, or partial, LDAP URL corresponding
to RFC 2255.

e Email—The e-mail address of this User.

« Employee ID—A code of up to 64-characters that identifies this User within the contact-
center staff. You must specify a unique value for this property.

* Password—A password no longer than 64-characters that this User must use to log in to
the environment. You cannot view the existing password.

Passwords can be subject to format rules.

* Organization—The folder in which the Person object for this User is stored.

* Default Number—The phone number of this User. This field is used to create the
associated DN, Place, and Agent Login objects for this User. Platform Administration uses
existing objects, if available.

e Skills
* You can add Skills to the Agent by:

e Creating a Skill—Type the name of the new Skill in the Quick Filter field and click +
to create the Skill.

e Selecting an existing Skill—In the Skills section, select existing Skills from a list to add
to the Agent. To select a Skill, click the check box beside the Skill and enter a
numerical value in the Rating field.
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Since Agent Groups might be defined automatically based on a Skill (Virtual Agent Groups), the
list of Agent Groups refreshes if you create a Skill.

* Agent Groups

* You can add the Agent to an Agent Group by clicking the check box beside an item in the
list.

3. Click Save.

When adding an Agent in Cloud mode, Platform Administration also makes
the following configuration changes:

* Create Agent Logins in each Switch, using information that was entered in the
Default Number field.

* Create the User object and associate Agent Logins to the User object. Wrap-
up Time for each Agent Login is set to 0.

Other Actions

Once you select an Agent, you can:

e Edit Agent Information—Select an Agent and click Edit to edit Agent information. If you edit the
Default Number field:
e |If this field is emptied, the Agent is disassociated from the current Place and its Agent Login objects
are emptied.

* If a new value is given, the agent is associated with a new Place, DN, and Agent Login that match
the value. New objects are created, if they do not already exist. Existing objects are emptied and
not deleted.

e Copy an Agent—Select an Agent and click Clone to make a copy of the Agent object.

¢ Change State—Select an Agent and click either Enable or Disable to change the state of an Agent.
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e Agents that are disabled appear grayed out in the list.

e When a User is either disabled or removed, Platform Administration invalidates all
sessions associated with this User. Upon the User's next action, he or she will be
redirected to the login page.

To delete one or more Agents, click the check box beside the Agent(s) in the list and click Delete

¢ When deleting an Agent, Platform Administration does not delete the DN, Place, or Agent
Login objects assigned to the Agent.
* You should only reconfigure a Place object when there are no Agents logged into the

Place. Doing so can have an impact on both the status of the Place in Pulse reports and
call routing to the associated Agents.
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Voicemall Management

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Voicemail management gives you control over Users and User Groups, DNs, Settings, Mailboxes,
Greetings, and Voicemail Profiles.

Administration

SIP Voicemall & Call Settings

™
-

T i lalallals
e o 't

Users
User Groups
DMs

1
L) L

aa]

N1

Settings
Mailboxes
Profiles

To Access Voicemail Management...

1. Start Genesys Portal and select login to Platform Administration.
2. Select SIP Voicemail and Call Settings from the Administration menu.

3. Choose a category to manage:
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* Users

e User Groups
* DNs

e Settings

* Mailboxes
* Greetings

¢ \oicemail Profiles

Managing Voicemail Users

Here, you can manage user roles, mailbox access, voicemail profile, time zone, DNs, voicemail
notification and web service notification preferences:

General tab

1. Select Users, then search for and select a specific user. You can enter the first letter to see a list.

» Specify Roles, Mailbox Access, Voicemail profile, and Time Zone from drop-down menus.

e Click the values in the Agent Logins, DNs, and Mailboxes tables to view details.
Feature Server Roles field:

¢ Select one:

e User (default) grants the user access to voicemail.

* Administrator grants the user the ability to log in as administrator and perform all the tasks
available in Agent Desktop.

e Group Mailbox Administrator grants the user the ability to log in as administrator and manage
group mailboxes. Only users who are Group Mailbox Administrators can change greetings and
passwords for group mailboxes.

User Mailbox Access drop-down menu:
e Select one:

* Phone + Web View + Web Playback enables the user to access voicemail over the phone and to
view and play voicemail.

* Phone + Web View enables the user to access voicemail over the phone and to view, but not play,
voicemail.

* Phone Only enables the user to access voicemail over the phone, without web access.

Voicemail Profile drop-down menu:
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e To activate voicemail access, select a profile other than Not Set.
Time Zone drop-down menu:

* Select a time zone for message playback.

Email Notifications tab

e Set Notifications On or Off in the drop-down menu.

* Specify a destination email in the Email To field. Use the standard address format: name@domain.

Web Service Notifications tab

¢ Set Notifications On or Off in the drop-down menu.

e Specify a destination phone in the Phone Number field. Use only digits.
Note: If your notification message does not include the user phone number, this field does not
appear.

Managing Voicemail User Groups

You create user groups and perform most provisioning in Genesys Administrator, not here.

Here, you can manage user-group voicemail profiles:

General tab
1. Select User Groups, then search for and select a specific user. You can enter the first letter to see a
list.

2. Specify a Voicemail profile from the corresponding drop-down menu.
Voicemail Profile: To activate voicemail access, select a profile other than Not Set. If the menu is
empty, you can create a voicemail profile or let the default calling profile apply to the user.

Email Notifications tab

¢ Set Notifications On or Off in the drop-down menu.

e Specify a destination email in the Email To field. Use the standard address format: name@domain.

Web Service Notifications tab

¢ Set Notifications On or Off in the drop-down menu.

* Specify a destination phone in the Phone Number field. Use only digits.
Note: If your notification message does not include the user phone number, this field does not
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appear.

Managing Voicemail DNs

To create DNs, see the topic DNs.
1. Select DNs, then search for and select a specific DN. You can enter the first number to see a list.

* You can optionally set a password for the DN. This password controls device authentication.

Managing Voicemail Settings

General tab

¢ Set Voicemail Enabled to Yes or No in the drop-down menu.

¢ Click the value for Voicemail Profile to edit it.

Email Notifications tab
The system uses notification defaults if the voicemail profile doesn't contain a value for a given field.
e Turn Notifications On or Off by selecting from this drop-down menu.

¢ Enter the email address to receive notifications in the Email to field.

Web Service Notifications tab

The system uses notification defaults if the voicemail profile doesn't contain a value for a given field.

¢ Turn Notifications On or Off by selecting from this drop-down menu.

e Enter the phone number to receive notifications in the Phone number field.

Managing Voicemail Mailboxes

* Select Mailboxes, then search for and select a specific mailbox. You can enter the first number to see a
list.

e Before you select a mailbox, you can enable or disable the Disclaimer. Click on that word to see the
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status and instructions.

You can configure these settings for the selected mailbox:

Setting

Status

Voicemail Deposit Enabled

Mailbox Password

Max Messages

Optout Phone

Time Zone

Language

Assigned

Values (default value in bold)

Active, Locked

Yes, No

System, user-selected

10,1ton

System (Not Set), any phone
number or routing point

System, time zone from menu

System (English(United
States)), language from menu

n/a

Description

When Locked, four
unsuccessfully times, locks you
out for 10 minutes. Select Active
to override.

Yes forwards unanswered calls to
voicemail under various
conditions, depending on the
options set.

No plays a "voicemail is disabled"
message to the caller.

Press Reset to reset the
password to the system (default)
value.

Select the second radio button
and type a value to set a new
maximum number of messages.

Select System to restore the system
(default) value.

When set, enables a caller to
transfer out of voicemail to the
specified destination at any time
during a call.

Select the second radio button and type a
value to set a new optout phone.

Select System to restore the value to the
number in parentheses, which is the
value set at the application or switch
level for the configuration option
voicemail-optout-destination.

Select a time zone from the
menu to set a new time zone for
all mailboxes that use the system
(default) time zone.

Select System to restore the system
value.

Select a language from the menu
to set a new language.

Select System to restore the system
value.

The Assigned table lists the
objects (directory numbers,
agents, users, user groups) to
which this mailbox has been
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Setting Values (default value in bold) Description

assigned. For some objects you
can click the object name to view

the object.
Unread/Read(Unread high-priority Press Delete All to delete all
Messages messages/Read high-priority normal and high-priority
messages) messages.

Managing Greetings

Users can manage greetings for their personal mailboxes.
Users who are Group Mailbox Administrators can change greetings and passwords for group
mailboxes, by accessing the group mailbox remotely, as described here.

To manage your greetings from a local or remote telephone, press 4 and use these commands:

e Press 1 to record an extended absence greeting.
e Press 2 to record a personal greeting.

e Press 5 to activate the standard greeting that inserts your recorded name into a standard message.
For example: You have reached the mailbox of play recorded name.

e Press 6 to activate your personal greeting. Not available or played unless this greeting exists.

* Press 7 to activate your extended absence greeting. Not available or played unless this greeting
exists.

After initiating each action, follow the audio prompts.

e Press * to exit the Greetings menu and return to main menu.

Managing Voicemail Profiles

About Voicemail Profiles

Voicemail profiles determine how long voicemails are kept for a user or user group before deletion.
Voicemail profiles use a Class of Service model to enable the quick assignment of voicemail
notifications and retention limits to user groups or specific collections of users.

You can create profiles that set retention limits of 1 to 10,000 days, or use No Limits to set
voicemails not to expire. You can effectively disable voicemail profiles by keeping the default
Retention Limit value of the System Profile, No Limits, and assigning no other profile to your users.

The System Profile applies only when none of the users or user groups assigned to a mailbox has an
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assigned profile.
e To create a new profile, select New. To edit an existing profile, select it from the list.
General tab

« Name is an editable field.

e Empty if you clicked New. Enter a name.

* Populated if you selected an existing profile. You can change its name if you want.
* Retention Limit specifies the limit for each profile, in number of days.
e Use the radio buttons to select No Limits or the editable field.

¢ Notifications are described in Notifications, below.

Notifications tab

e Set each of the first four values to Yes or No using its drop-down menu.

Email Notification Enabled Yes enables email (SMTP) notifications.

Email Notification Allow User Setup Yes allows users and user group administrators to turn
email notifications on or off for themselves, and to specify the recipient email address. (No allows

only administrators tocontrol user and user group settings.)
Web Service Notification Enabled Yes enables web (HTTP) notifications.

Web Service Notification Allow User Setup Yes allows users and user group administrators to

turn web notifications on or off for themselves, and to specify the recipient phone number. No
allows only administrators can control user and user group settings.

e All other Notifications settings are described in Notification Defaults.
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Agent Scripting Administration

Agent Scripting Administration (Echoscripting) is a scripting tool used to prompt agents through the
call-handling process with customers. It can be used for either inbound customer service or outbound
telemarketing calls. Agent Scripting is a powerful tool that supports branching to guide agents
through different paths of the script, depending on the customer’s answers to scripted questions.
Additionally, agents can capture information about customers and update the customer database,
process orders, or track ongoing customer service calls.

Agent Scripting (Echoscripting) User Guide
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Agent Setup

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Agent Setup is a cloud-based web application that allows you to manage your cloud-based contact
center and your agent accounts for products such as Agent Desktop and Gplus Adapters.

Link to video

Agent Setup now has a new and enhanced user interface, making it easier to create users, set up
agent groups, and to configure desktop options.

See an overview of the changes in this video.

Tip

Be sure to check out other Agent Setup videos below!

Documentation

Click any of the topics below for details.

Contact Center Configuration Agent Provisioning
Configuring desktop settings Adding agents
Managing desktop statistics Importing multiple agents
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Managing desktop options Exporting agents

W1 L

A ' R A=l il
Viatayimiy CRIVICAUpPLET UPLIUTTS

Managing Agent Groups

AJERIBR{EFVTIaos
Managing Templates

Below are some video tutorials on working with Agent Setup to configure and provision your contract
center.

Note:

¢ While the Agent Setup interface in these videos has changed slightly in each release, the steps are
basically the same for each release.

How to add a single agent How to update multiple agents

Link to video Link to video

How to import multiple agents

Link to video
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Getting started

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Before you start, review the following web browser requirements and access information to gain a full
understanding of the Agent Setup tool. The intended audience for this guide are administrators that
are responsible for creating and managing user accounts, configuring the call center settings, and
assigning global settings to agent groups.

Web browser requirements

You access the Agent Setup interface through one of the following supported web browsers:

e Microsoft Internet Explorer 11
¢ Google Chrome 54 or later
e Mozilla Firefox 45 or later

e Microsoft Edge

Agent Setup User Roles

When setting up user accounts, it's important to understand how the Agent Setup user and
administrator roles are distinguished and what Genesys product to use to add the accounts.
Essentially, two main roles exist:

* Agent Setup users: Users are assigned to the Administrator access group, which grants the user the
correct role to perform basic administration of users. To add Agent Setup users accounts to your
contact center, import the administrator accounts or use Platform Administration.

* Agent Setup administrators: These users are assigned to both the Administrator access group and
the Agent Setup Administrator access group. The Agent Setup Administrator access group is
associated with the correct role and permissions to perform administrative tasks in Agent Setup. To add
administrator accounts to your contact center, you can either import the administrator accounts or use
Platform Administration.
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() Note: In your access group folder, each of these access groups are prepended with your company
name. For example, Genesys Administrator.

How do | access the Agent Setup interface?

Access to Agent Setup requires a web browser. If you haven't already, read Before you set up an
agent.

You can access the Agent Setup interface by logging into your Genesys Portal and clicking the Agent
Setup icon.

Logging in

Welcome

Welcome

Remember me ‘ | ‘

rl“‘ u re : “

After you log into the Genesys Portal, the Agent Setup displays another login window and you must
log in again.

Type your username, click Next, type your password, and click Sign In.

C;J Note: You are not required to enter a Tenant name.
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Logging out

Mitchell Marner w

Search by MamefUsel  Hello, Mitchell!

le— anced

Skills

4 Skills

When you have completed your administration tasks, click the menu in the upper-right corner, and
select Log Out.
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Bulk Import

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

As you set up and maintain your call center, you may sometimes need to input a large amount of
data into the system. Using Agent Setup, you can import agent accounts and customer contact
records in bulk, making the process smoother and more reliable. When you have a large number of
objects to import, use the Bulk Import page under Data Tools in the Agent Setup application menu.

How do | import a file?

Link to video

Before you can import agent accounts or customer contact records in bulk, you must prepare a CSV
file that contains all the required data.

The values from the imported file overwrite corresponding values that are specified in the template.
For example, the value for the Skill parameter in the imported file takes precedence over the value
for the Skill parameter that is specified in the template.

When you are ready to import the Source File, select the file from your local device, then click
Import. You can validate the file to ensure that it is structured correctly.

About CSV files

The CSV file must be a text file in a comma-separated format. In the source file each line represents a
single user or agent.

When you import a CSV file, each parameter value is updated according to the following rules:

e If a value is present, the new value replaces the previous value.
e If an empty value is encountered, no change is made.
e |If the value includes /d , the attribute is deleted.

¢ If no corresponding record is found, an error message is logged and the update continues to process.
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How do I stop an import?

Bulk Import

Choose a csv file for import

5% o
Template Mo Template v m Validate

[¥ Validate Before Import

Choose File | users 2017-...1-17 PM.csv
D

Stop Import

Are you sure you wish to stop the import process?

Cancel

el

When you stop an import, a window asks you to confirm that you really want to stop the import. After

you click Stop, agent records that were imported before you clicked © are retained and the import
process does not proceed. By clicking Stop, you are not cancelling the entire import.

Importing agent accounts

By importing a large number of agent accounts at one time, you won't need to add the accounts one
at a time and you can apply a template to configure options, such as DN, place, person, and log in
options, to all accounts.

CSV file parameters

Property Type Mandatory? Action Description
The unique
. ADD, UPDATE,
Username String Yes DELETE username of the

agent or user.
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Property

First Name

Last Name

Email

Extension

Extension2

Extension3

Folder

Place Name

Place Name2

Place Name3

String

String

String

String

String

String

String

String

String

String

Type

Mandatory?

Yes

Yes

No

No

No

No

No

No

No

No

Action

ADD, * needed for
UPDATE if First
Name change

ADD, * needed for
UPDATE if Last
Name change

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

Description

The first name of
the agent or user.

The last name of
the agent or user.

The agent or
user's email
address.

The extension #1
of the agent. A
place is also
created if the
extension is
specified.

The extension #2
of the agent. A
place is also
created if the
extension is
specified.

The extension #3
of the agent. A
place is also
created if the
extension is
specified.

The folder path to
root folder
(Persons) where
new agent or user
is created. For
example,
Company/
Department/Team.

The place name
#1 of the agent.
The place name
"Extension" is
used if not
specified.

The place name
#2 of the agent.
The place name
"Extension2" is
used if not
specified.

The place name
#3 of the agent.
The place name
"Extension3" is
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Property Type Mandatory? Action Description

used if not
specified.

The name of the

Default Place String No Default Place.

The employee
Employee ID String Yes ADD identifier of the
agent.

Specifies that the
user will be
prompted to
change the
password on their
next log in.

Y specifies that the
agent account is
enabled.

N specifies that
the agent account
is disabled.

Y specifies that
Is Agent Boolean Yes ADD this user is an
agent.

Change Password Boolean No

Enabled Boolean No

Any external ID
External ID String No used to identify
the user.

Login ID String No The user's login ID.

Y specifies that
Is Supervisor Boolean No this user is a
supervisor.

Y specifies that
Is Admin Boolean No this user is an
administrator.

The number of
seconds an agent
remains in ACW

Wrap Up Time Numeric No after call is
disconnected. This
field applies only
to voice calls.

If specified,
populate the
following option to
the Annex of all

associated Agent
VoiceMail.MailBox String No log ins:

AgentLoginAnnex:TServer/
gvm_mailbox. Valid
values: numerical

(12345)
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Property Type
Recording .
Hierarchy S
SIP Phone Type String

Skill:<skill_name>  Numeric

Switch:<switch_nameBoolean

AgentG:<agent_grouBoaleer>

Annex String

Action String

CSV file example

No

No

No

No

No

No

No

Mandatory?

Action

Description

If specified,
populate the
following option to
the Agent's
Annex: [recording]
agent_hierarchy.

The type of SIP
phone the agent is
using as a
softphone.

The number that
identifies the
agent's skill level
for the specified
skill.

Y means that a DN
and Agent Login
are created for the
agent on the
specified switch.

Y means that the
agent is added to
the specified agent
group.

Any custom Annex
value. For
example, column
name
Annex:htcc/roles
with a value of
Agent.

ADD adds a new
agent.

UPDATE updates
an existing agent.
DELETE removes
an existing agent.

First Name,Last Name,Employee Id,Username,Is Agent,Is Supervisor,Is Admin,External
Id,Login ID,Extension,Skill:English,Switch: San Fran,Switch:
London,AgentG:Good,AccessG: Super,Annex,Action,Folder,Wrap Up Time,Enabled

Sarah,Lee, 223344 ,sarahl@acme.com,N,Y,Y,ADD,Acme/Branch/Team 1,60

John,Doyle, 223465, johnd@acme.com,Y,N,N,2233,1,Y,N,ADD,Acme/Branch/Team 2,0
Robert, Cook, 244456 ,bobc@acme.com,Y,Y,Y, johnd@acme.com,5,Y,Y,ADD,Acme/Branch/Team

3,60,Y
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Bulk imports do not include the Password field in the imported file. A default
password is associated to each user account in the imported file. The format of the
default password is: <username>@<company-name>.com-<Month>-<year>, where
<Month> is the three-digit abbreviation for the month. For example,
hjackson@demo.com-Feb-2017. The Reset Password option is automatically enabled
when adding or importing new users, so all users are prompted to reset their
password the next time that they log in.

Importing multiple contacts

By importing contact records with Bulk Import, you can avoid having agents add contacts manually.

After importing customer contact records, you must log into Agent Desktop and use
Contact Directory to view the imported records.

CSV file parameters

Property Type Mandatory? Action Description
ADD, * needed for The first name of
First Name String Yes UPDATE if First Ce e
Name change '
ADD, * needed for
Last Name String Yes UPDATE if Last -trk?ee (l:iitt:ftme of
Name change )
. The contact's
Phone Number String Yes phone number.
ADD adds a new
contact.
UPDATE updates
. . an existing
Action String Yes contact.
DELETE removes
an existing
contact.

Genesys Engage cloud Administrator's Guide

122



Agent Setup Contact Center Settings

Contact Center Settings

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

A key factor in a well-configured contact center is how well the global contact centers are configured.
This important task ensures your customers are routed to the correct agents and that the agents
have the correct tools available to them as they handle customer interactions.

Configuring your contact center settings

The settings can be configured in any order, however, for initial setup, we recommend that you
configure your contact center in the order displayed in the left navigation menu. The recommended
order is also described in the sections below.

Agent Setup  Contact Center Settings

Agent Deskiop Manage Skills
I Skills Skills are agent's knowledge of a particular subject that might be required in an interaction, such as language skills. They can also be used for routing purposes
Dispositions
Custom Agent States
Global Favorites
External URLs Q, Search ltem +Add meAdd Folder
Case Data
Toast Data O m  Customer22-30

Caller IDs
O m  Internal

Desktop Options
Channels OO0 m  Testing
Standard Response
Statistics

Global Login

OO  Accept_Conference

O  alexsh
Supervisor
Voice O  blablablablabla
Chat
Email O CallbackTestSkill
Recording
Contact O  L1_GENERAL

In

nf

On the various screens, you select the check boxes next to the options that you want
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to enable. Each check box has three states:

J The option is inactive. To activate the option, click the check box once. The option is
then set to the default setting as specified in the description in the tool tip.

. [ A check mark indicates that the option is enabled. You can click to disable the
option.

. No check mark indicates that the option is disabled. You can click to enable the
option.

Agent Desktop settings
Create desktop objects to customize the Agent Desktop for your agents. Objects include items that

are specific to your business needs, such as disposition codes, Caller IDs, global favorites, and more.
For more information, see Agent Desktop settings.

Desktop Options
Agent Setup includes a list of configuration options that you can customize for your contact center.
Use these settings to enable, disable, or configure values for the various interaction channels and

Agent Setup features that are available for your agents to use. For more information, see Desktop
Options.

Agent Groups

Agent Groups are logical groupings of agent accounts, grouped by skill sets. See Agent Groups.

Transactions
Sometimes it might be necessary to override the desktop settings defined in Agent Desktop settings.

Overrides allow you to manage business attributes that are applied at a transaction level, such as a
call or a chat. To create business attribute overrides, see Transactions.

Desktop Statistics

You will need to add, edit, import and export statistics for the My Reports and Contact Center sections
of Agent Desktop. To configure statistics, see Desktop Statistics.

Templates

Now that your contact center is configured, create templates that you can apply when you provision
your contact center with agents. Templates define sets of configuration options such as login, place,
DNs, and more, so that when you add agents, you don't need to build each agent account's settings
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individually. For more information, see Templates.

CRM Adapter settings

Configure options for the Gplus Adapter. For more information, see CRM Adapter settings.

Next steps

After you configure your contact center settings, you can easily manage user accounts, because all
the correct options will be available to you.
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Agent Desktop settings

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Configuring your Agent Desktop settings involves customizing the available options to meet the
specific needs of your contact center.

To access the Contact Center Settings tab, click Contact Center Settings on the application
menu across the top of Agent Setup. On the Contact Center Settings tab, you will see a navigation
menu on the left hand side. You can see only the objects that permissions enable you to view. If you
need to edit an object that you don't see on the interface, contact your administrator.

You can customize the following objects:

Skills

On the Skills page, you can add and delete skills, as well as organize the skills into folders.
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Manage Skills

Skills are agent’s knowledge of a particular subject that might be required in an interaction, such as language skills. They can also be used for routing
purposes.

=+ Add I Add Folder i Delete

v &8 PFS Banking
Account Manager
Back_Office
Billing
Customer_Care
Customer_Service

Mobile_Internet_Help

Skills are an agent's knowledge of a particular subject that might be required in an interaction, such
as language skills. They can also be used for routing purposes.

To add a skill:
1. Click Add.

2. Type a name in the Name field.

You can also organize skills into folders. If needed, select '4— Add Folder to create a new folder.

Dispositions

On the Dispositions page, you can create a list of Disposition options to be displayed when an agent
makes an outbound call or transfer. Dispositions are descriptions of the final outcome of a call. These
codes are used to flag calls for reporting purposes.

Creating a sharable Disposition business attribute

Dispositions can be used as sharable business attributes for agents, agent groups, and the global
contact center. To view an article about how to create sharable business attributes, see Sharing
Business Attributes in Agent Setup.
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Tip
* To view an example of Disposition options in Agent Desktop, see What do | do at the end
of a call? in Agent Desktop Help.

* In the table of configured Dispositions, in addition to selecting and adding Dispositions,
you can also filter items using the Quick Filter field and delete a Disposition.

Selecting a disposition

Manage Dispositions

Dis, cnptions of the final outcome of the call’

to flag calls for reporting purposes.

Folder: /DEVOPS/ Disposition_Sales v

__._.—-—-—""'"-.
+Add BB AddFolder  fj Delete select the folder

Sales: Follow-up required

select a disposition

and business attribute

1. Select a business attribute:
a. Select the folder you want to view from the Folder drop-down list box.
b. Click the second drop-down list box and select the business attribute for the Disposition.

You can consider a business attribute to be the container that holds a list of Dispositions that have a common theme.

3. Select a Disposition from the list.
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Adding a disposition

Manage Dispositions

Dispositions are the descriptions of the final outcome of the call. These codes are used to flag calls for reporting purposes.

Folder: /DEVOPS/ Disposition_Sales v

+ Add | Add Folder @ Delete

Sales: Follow-up required

Name Display name

=

Select the folder you want to view from the Folder drop-down list box.

N

. Click the second drop-down list box and select the business attribute into which you want to add the
Disposition.

. Click Add.

. Type the Name and Display Name for the new Disposition.

~ W

Tip
To add a new folder to the list, you can do one of the following:
e Click Add Folder; or

e To add a subfolder, click the Folder drop-down list box, select a folder, and then click
the Add folder icon.
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Custom agent states

available to take a call.

Folder: /DEVOPS/

After Call Work

= Name

JDEVOPS/aftercall

JSWrapUpCall

Display Name

After Call

Wrap Up Call

Manage Custom Agent States

after call

Wrap Up Call

Mot Ready
Q
= Mame
/Break

fMarchBreak

fMeal

Display MName

Break

March Break

Meal

s
v

After Call Work codes are used when an agent is in the wrap-up state after a call has ended. Not Aeady reason codes are used when an agent is not

Code

Break
March Break

Meal

On the Custom Agent States tab, you can add custom agent states that an agent can select for
After Call Work and Not Ready reasons.

You can organize custom agent states into folders. When you select the Folder option, a drop-down

list box is displayed where you can select a folder or click the add folder icon !I- to create a new

folder.

Once you have selected the folder, enter an appropriate Display Name (example: Lunch Break) and
a relevant Code that is unique.
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Global Favorites

Global Favorites

Global Favorites is a list of Agents, Agent Groups or external contacts that agents frequently dial. This list provides a click-to-call list of these numbers
on Agent Desktop.

global favorites for Agent Desktop
Favorites|List (26) Manage Favorites
q Agent - Chioose abject - m Delete
Select at least one category rd ached
Name s ]

sharable favorites

Escalations
q

Hame 3 Display Name - Type ] Categary ] Dietails: Aftached Data
French

?al}! ity Daly City Favarites fustem R e

Favorites
Insurance_Specialist

Fussian Russman Sk Quick
Danish Spanish Spanish Sh Quick

As a contact center administrator, you can create and maintain a list of Favorites, which are contacts
and internal targets that your agents can access quickly in the Team Communicator. To see how
agents use Global Favorites in Agent Desktop, see How do | set up my favorites? in the Agent Dektop
Help guide.

In addition to managing favorites from the Desktop Settings page, you can also manage favorites
on the Agent Groups page and the Add/Manage User window. No matter from what screen you
add a favorite, you can include the favorite in the list of shareable favorites to be reused in all places
where Global Favorites (or Personal Favorites for user accounts) are available for configuration in
Agent Setup.

To learn more about how to work with Global Favorites, including a scenario-based demonstration,
see Working with Global Favorites.

External URLS

You can integrate internal and external websites into your agent's main view. At the Agent Desktop
level, the external website is displayed in dedicated tabs. These tabs allow you to access the website
without leaving Agent Desktop.
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External URLs

Level Workspace v INTERNAL v

Label* Templates v URL* Templates v “

URLs List (1)

Q T Delete

Level [

<>

Label [ Mode g URL

test INTERNAL https://test-url Workspace

At the interaction level, there are two ways to display websites depending on the main interaction
type.

e For voice, the external website is displayed in the background when an interaction is selected. When the
interaction is unselected or closed, the external website is replaced with the previous panel displayed
in the background.

¢ For multimedia, the external website is displayed in a dedicated view in the case data.

To add a URL to the list, select Workspace or Interaction from the Level menu, type a label for the
URL, type or paste the URL in the URL field, and click Add.

Depending on the Level you choose - Workspace or Interaction - the following options populate in the
Templates menus for both Label and URL:

Workspace:

Agent.FullName
* Agent.UserName
¢ Agent.LastName
e Agent.FirstName

¢ Agent.Employeeld

Interaction:

¢ Agent.FullName

* Agent.UserName

¢ Agent.LastName

e Agent.FirstName

e Agent.Employeeld

e AttachedData.{{attached-data-key-name}}
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¢ Interaction.id

e AttachData.KVPName

An external web site URL can be defined using the $AttachedData.Y$ parameter to have flexible text
in the URL where Y represents an attached data name.

Warning

e If the $AttachedData.Y$ parameter is specified for the external website URL, and Y is
not part of the attached data associated with an interaction, the external website is not
displayed.

* If an agent manually adds the attached data to the interaction (or if it's added by any
other means), then the external website tab is displayed with the content of the
external website.

For example, the external website specified as follows:

Customer Location

label =
= https://www.bing.com/search?q=$AttachedData.CustomerLocation$

url

With this URL, if an interaction is received with a CustomerLocation attached data with the value of
Paris, then the external website will be displayed in a dedicated tab called Customer Location,
and the external web site will be https://www.bing.com/search?g=Paris

mode: Specifies the mode Agent Desktop uses to display the web application. The default value is INTERNAL.
The possible values are:

» INTERNAL: The web application is displayed in a dedicated tab in Agent Desktop. It can be viewed and
used when the agent clicks the tab to display it. This is the default behavior.

e EXTERNAL: The web application is displayed in a popup window.

* BACKGROUND: The web application is displayed in the background when the interaction is selected. When
the interaction is deselected or closed, the third-party website is replaced with the previous panel that
was displayed in the background. This mode is only applicable at the interaction level.

* HIDDEN:The web application is loaded but not displayed in Agent Desktop. You can use this mode to
integrate Agent Desktop with a non-web application.

Case Data

On the Case Data page, you can specify the information to be displayed to agents when a call, chat, or other interaction is transferred
to them.
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Creating a sharable Case Data business attribute

Case data can be used as sharable business attributes for agents, agent groups, and the global contact center. To view an article about
how to create sharable business attributes, see Sharing Business Attributes in Agent Setup.

Tip
¢ To view an example of Case Data in Agent Desktop, see Contact and interaction history in

Agent Desktop Help.

* In the table of configured Case Data, in addition to selecting and adding Case Data, you
can also filter items using the Quick Filter field and delete a Case Data.

Selecting Case Data

Manage Case Data

Case ation that'1s displayed about a callnpn

Folder: / CustomerCase

________...—"
+Add BB AddFolder De e select the folder
and business attribute
> 1 I Folder -
LastName: Last Name ¥ Mandatory Enum i

select Case Data

Firsthame: First Name Mandatory Read Only v

1. Select a business attribute:
a. Select the folder you want to view from the Folder drop-down list box.

b. Click the second drop-down list box and select the business attribute for the Disposition.

You can consider a business attribute to be the container that holds a list of Dispositions that have a common theme.

2. Select a Case Data from the list.
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Adding Case Data

Manage Case Data

Case data is the call information that is displayed about a call in progress.

Folder: / Case Data v Sort Case Data

=+ Add I® Add Folder @ Delete

MName Display name Mandatory Read Only A\

Select the folder you want to view from the Folder drop-down list box.

1. Click the second drop-down list box and select the business attribute into which you want to add the
Case Data.

Click Add.
Specify a name and display name.

Select Mandatory to specify that the case data is mandatory.

vk W

Enable the Read Only option if you do not want the agent to be able to update the data. Or, select a
data validation type, such as Boolean, String, Integer, or Enum which allows the agent to edit the
data. If the case data is mandatory, the Read Only option is disabled.

Tip
To add a new folder to the list, you can do one of the following:
* Click Add Folder; or

* To add a subfolder, click the Folder drop-down list box, select a folder, and then click
the Add folder icon.

To configure the order in which the case is displayed in the Ul, click Sort Case Data and follow the
instructions in the dialog box.

Toast Data

On the Toast Data page, you can specify the information to be displayed to the agent when they
receive a call, chat, or other interaction.
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Creating a sharable Toast business attribute

Toast Data can be used as sharable business attributes for agents, agents groups, and the global
contact center. To view an article about how to create sharable business attributes, see Sharing
Business Attributes in Agent Setup.

Tip
e To view an example of Toast Data in Agent Desktop, see Contact and interaction history

in Agent Desktop Help.

e In the table of configured Toast Data, in addition to selecting and adding Toast Data, you
can also filter items using the Quick Filter field and delete a Toast Data.

Selecting Toast Data

Manage Toast Data

Toast datai

L select the folder

and business attribute

Folder: / ToastData w

+ Add I Add Folder @ Delete

Toast:Toasté'—\se"EGt TOﬁSt Dﬂtﬂ

1. Select a business attribute:
a. Select the folder you want to view from the Folder drop-down list box.
b. Click the second drop-down list box and select the business attribute for the Disposition.
You can consider a business attribute to be the container that holds a list of Dispositions that have a common theme.

2. Select a Toast Data from the list.
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Adding Toast Data

Manage Toast Data

Toast data Is the call information that is displayed for a ringing call.

Folder: / ToastData v

+ Add | Add Folder @ Delete

Toast: Toast

Name Display name

Select the folder you want to view from the Folder drop-down list box.

1. Click the second drop-down list box and select the business attribute into which you want to add the
Toast Data.
2. Click Add.

3. Specify a name and display name.

Tip
To add a new folder to the list, you can do one of the following:
e Click Add Folder; or

e To add a subfolder, click the Folder drop-down list box, select a folder, and then click
the Add folder icon.

Caller ID

On the Caller ID page, you can create a list of Caller Identification (ID) options to be displayed when
an agent makes an outbound call or transfer. A Caller ID is typically the phone number that you want
displayed on the phone of the person who receives the call when the agent consults, conferences, or
transfers a call.

You can also specify a display name, such as your company name, to be included with the Caller ID.
For example, SalesForMore 1-555-555-5555. In this case, Agent Desktop shows SalesForMore on the
list of Caller IDs that an agent can select.
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Creating a sharable Caller ID business attribute

Caller IDs can be used as sharable business attributes for agents, agents groups, and the global
contact center. To view an article about how to create sharable business attributes, see Sharing
Business Attributes in Agent Setup.

Tip
e To view an example of Caller ID options in Agent Desktop, see How do | manually select

a Caller Identification? in Agent Desktop Help.

e In the table of configured Caller IDs, in addition to selecting and adding Caller IDs, you
can also filter items using the Quick Filter field and delete a Caller ID.

Selecting a Caller ID

Manage Caller IDs

A Call enumber that the caller can see.

Caller ID-Sales

|0 for the cgntact center or for a team.
é\sefzct the folder
___—-—-_-_-' o o
— and business attribute
+ Add ® Add Folder @ Delete

Folder: /DEVOPS/

oo 1 ssssesens 42 select a Caller 1D

1. Select a business attribute:
a. Select the folder you want to view from the Folder drop-down list box.
b. Click the second drop-down list box and select the business attribute for the Caller ID.
You can consider a business attribute to be the container that holds a list of Caller IDs that have a common theme.

2. Select a Caller ID from the list.
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Adding a new Caller ID

Manage Caller IDs

& Caller iDis a registered phone number that the caller can see. You can select a caller 1D for the contact center or for a team.

Folder: /DEVORS/ Caller ID-Sales w

+ Add B Add Folder @ Delete

Sales: 1-555-555-5555

Name Display name

1. Select the folder you want to view from the Folder drop-down list box.

2. Click the second drop-down list box and select the business attribute into which you want to add the
Caller ID.

3. Click Add.
4. Type the Name and Display Name for the new Caller ID.

Tip
To add a new folder to the list, you can do one of the following:

¢ Click Add Folder; or

e To add a subfolder, click the Folder drop-down list box, select a folder, and then click
the Add folder icon.

Next Steps

Now that you have configured your Agent Desktop settings, you can proceed to configure Desktop
Options for your contact center. See Desktop Options.
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Enable Single Sign-On

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Single Sign-On (SSO) identity authentication enables your users to securely access multiple Genesys
applications with a single credential.

After entering their username in the application login screen, users are taken to your company's
authentication provider where they will enter their username and password. After that, they will not
have to log in again until your authentication expires which is typically every eight hours. For a list of
Genesys Engage cloud applications supporting SSO, see Single Sign-On.

You can enable Single Sign-On for your environments in the SAML section of Agent Setup under
Single Sign-0On. Security Assertion Markup Language (SAML) is an open standard for exchanging

authentication and authorization data between parties, in particular, between an identity provider
(IdP) and a service provider (SP).

You do not need to enter any IdP-metadata in the "Region Name" field in order to
enable SAML.

SAML fields and actions

Region Name Base URL Status Actions
E : EEOS
= . EEAS

On the SAML Configuration screen, a table displays the following information:

* Region Name - the name of the region in which your contact center is located.

* Base URL - the base URL associated with the region. This field is editable - simple double click
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anywhere within the text box to edit it.
¢ Status - indicates the status of configuration:
* ON - the configuration is complete.
* OFF - there is no configuration.
* PENDING - configuration is in progress.
¢ Actions - you take any of the following actions for a particular region:
* Upload SAML metadata enables you to upload your metadata;

 Download SAML metadata enables you to download SP metadata for your use. This is available
after your IdP metadata has been uploaded;

* Clear SAML metadata enables you to clear previously uploaded metadata;

* Reload SAML configuration refreshes the configuration for a specific region.

Configure SAML

SAML Configuration

Configure Single Sign On for your applications. SAML allow users to securely access multiple applications with a single credential.

Enable SAML ©@

@)

Access Groups @ SAML Binding @
Administrators_0377c85¢-58f5-4230-bd3.. HTTP POST v
Genesys User Identifier @ SAML Name Identifier @
Username v NamelD
Region Name Base URL Status Actions

APS2 https://gws-aps2.genhtec.com ON
uswi https://gws-usw1.genhtcc.com oN

To configure SSO:
1. From the Access Groups list, select one or more access groups. These groups contain users who will
use SSO.
2. Optional: From the SAML Binding list, select the SAML Binding type (HTTP POST or HTTP Redirect).

3. The next 2 fields specify how to match the user defined in your IdP with its corresponding Genesys user
at the time of login. In the Genesys User Identifier field, select the field you wish to use as the user
identifier on the Genesys side - either the Username or the External ID.
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4. In the SAML Name Identifier field, enter the name of the attribute of your SAML assertion that
contains the user identifier. This attribute is matched with the Genesys Username (or External ID). If
you leave this field empty, the "NamelD" attribute is used by default.

5. Set the Base URL to the region(s).
6. Upload the idP metadata to the region(s).
7. Turn the Enable SAML to the On position.
8. Click Save.
When SAML configuration completes, the status changes from PENDING to ON and the Download

SAML metadata button is enabled. Note: for secondary regions, SAML configuration can take about
15 minutes.

Reconfigure SAML

Region Name Base URL Status ions
AL
S

If SAML is already enabled and you need to reconfigure it with new IdP metadata, do the following:

1. Upload the new IdP metadata (remember: for secondary regions, SAML configuration can take up to 15
minutes).

2. Next, you must click the Reload SAML configuration button.
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Email Mailboxes

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Genesys Email enables you to create and configure inbound and outbound mailboxes for your contact
center through Digital Management in the Contact Center Settings section.

Mailboxes

Email Mailboxes

This is list of mailboxes available for accepting inbound email (POP or IMAP) or sending outbound email (SMTP).

. . . . Select Mailbox for details
Mailbox Name Mailbox Host Mailbox Type  Client Type

O smtp-client esj-22-30@hmail. stg.genesys-cloud. hmail.stg.genesysclo SMTP Outbound

O pop-client es]-22-30 hmail.stg.genesysclo POP3 Inbound

The Email Mailboxes sub-section displays all configured mailboxes for your contact center. The
mailbox table will be empty if there are no mailboxes configured.

Select a mailbox in this view to see its details displayed on the right side of the view.

You can also filter this view by Inbound and Outbound mailboxes, as well as search for mailboxes.
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Add or edit a mailbox

Inbound Mailbox

Mailbox Mame + Manx size =

AJohnson 5

Server Info

Mailbox = Password *

andreas.johnson@lLeafscom e

Host:Port/Type =

MNone -

Cancel

To create a new mailbox, select either Inbound or Outbound from the Add Mailbox menu. A

mailbox is created in a disabled state.

Mailboxes are enabled when they are assigned to a Digital application in Designer. If the application

stream is disabled, so are the mailboxes assigned to it.

Once enabled, the selection box beside the mailbox turns red. The mailbox cannot be deleted until it

is disabled.

Note: Only one outbound mailbox is permitted at this time.

To edit a mailbox, select the mailbox you wish to edit and click the Edit # button at the top of the

page.

Add or delete Business Attributes

Email Mailboxes

This is list of mailboxes available for accepting inbound email (POP or IMAP) or sending outbound email (SMTP).

Add Mailbox i @ Show All
Mailpéx Name ¥ Mailbox Host Mailbox Type

4 smtp-client SMTP
pop-client POP3

Client Type

Outbound

Inbound

Select Mailbox for details
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Business Attributes can be added and deleted within Agent Setup through the From Address field in

the Outbound Mailbox window.

From the main Email Mailboxes window, select the outbound email mailbox name and click the Edit

# button.

From the drop-down list under From Address, select Add.... The Manage

Email Addresses window opens. Here you can add a new Business

Attribute, as

well as delete an existing Business Attribute. (click to expand the image)

Outbound Mailbox

Mailbox Name * From Address *

smtp-client Exist From Address...

Server Info

Mailbox *

Unigue login name that identifies owner of n

Manage Email Address

Allow customer to configure their Agent's potential From addresses displayed in WWE's drop-down list of outbound emails
Folder. /OneCloud/ ‘ Select Business Attribute , v

+ Add  BmAddFolder [ Delete

Host:Port/Type *
25/SMTP/none

Cancel

’_\

NA tarmmo Cannd

Manage Email Address

m\ Allow customer to configure their Agent's potential From addresses displayed in WWE's drop-down list of outbound emails
Folder. /OneCloud/ @ v

+ Add

I Add Folder

i Delete

¥ testtest o
Use the following table for advice on how to fill in the mailbox creation/edit modal fields:
Outbound mailbox create and edit form
Label Field type s Posslble Action Description
values values
Strings:
alphanumeric, A read-only Outbound
. no special T . mailbox names
Mailbox Name T, [ smtp-client N/A gie;dlgo:de are set as
more than 40 play smtp-client
characters
Strings: .. The email
From Address alphanumeric N/A N/A Create and Edit address
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Label

Mailbox

Password

Host/Port/Type

Field type

Strings:
alphanumeric

Strings:
alphanumeric

Drop-down list

Default
values

N/A

N/A

N/A

Inbound mailbox create and edit form

Label

Mailbox Name

Max size

Mailbox

Password

Host/Port/Type

Field type

Strings:
alphanumeric,
no special
characters, no
more than 40
characters

Numeric:

minimum =5,
maximum = 20

Strings:
alphanumeric

Strings:
alphanumeric

Drop-down list

Default
values

N/A

N/A

N/A

N/A

Possible
values

N/A

N/A

SMTP

Possible
values

N/A

Range between

5 and 20

N/A

N/A

POP3, IMAP

Action

Create and Edit

Create and Edit

Create and Edit

Action

Create only,
Edit field is
read-only

Create and Edit

Create and Edit

Create and Edit
Note: The user

must type in a
password.

Select only

Description

associated with
this account

The name used
to log in to the
corporate
email server

The password
associated with
this account

The name of
the corporate
SMTP server

Description

Any valid login
name
associated with
a POP/IMAP
account

The maximum
size (in MB) of
an incoming
message

The login name
associated with
the POP/IMAP
account

The password
associated with
this account

Parameters of
the corporate
email server
where the
account
resides
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Desktop Statistics

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

The Desktop Statistics section allows you to add, edit, import and export statistics to be displayed
under My Reports and Contact Center panes of the Agent Desktop dashboard or the Reports view
in Gplus Adapter. The Statistics tab includes three sub-tabs to help you manage your statistics:

¢ Agent Statistics

¢ Contact Center Statistics
» Statistic Definitions
Essentially, you add statistics to a global statistics list. Then from that list, you can select the

statistics that you want to apply. Statistics can be re-used, meaning that if you create a statistic for a
specific agent group, for example, you can then apply that favorite to another agent group.

Agent Statistics

On Agent Statistics tab, manage the statistics that are displayed under My Reports to the agent.
The My Reports page gives agents a view of the current state of their own activity.
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Add Statistics

Agent Statistics (12)

1 Delete
Warning Warning Error Error Worst Worst
Level Level Level Level Level Level Measurement
Display Name Statistic Low High Low High Low High Unit
Hold Duration HoldDuration 1 1 1 1 1 1
Average Handling AverageHandlingTim...
Time
Productivity Productivity
Wrap Duration WrapDuration

To access the Agent Statistics tab, click Contact Center Settings > Agent Statistics. The list on
the page includes all agent statistics that are already configured, either by you or another
administrator. For a new implementation, the list might be blank.

Agent Statistics (1) [ |

Warning Warning Error Error Worst Worst
Level Level Level Level Level Level Measurement
Display Name Statistic Low High Low High Low High Unit

ReadyDuration ReadyDur...

To add a shared statistic to the list, click Add Statistics to access a list of shared statistics. In the
window that opens, select an option from the list of statistics, and then click Add.
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Add Statistic

What will be displayed for the statistic in the Ul

Warning Level Low

The minimum value of the statistic before a warning is raised

Error Level Low

The minimum value of the statistic before a warning is raised

Worst Level Low

The minimum value of the statistic before a critical error is raised

Measurement Unit

An optional display value

Close

Productivity v

Name of the statistic in statistics.yaml

Warning Level High

The maximum value of the statistic before a warning is raised

Error Level High

The maximum value of the statistic before an error is raised

Worst Level High

The maximum value of the statistic before a critical error is raised

Number Duration

If you don't see the statistic you want, you can create a new statistic for the global list and then add

that statistic for the Agent Statistics list.

. Click Add Statistics.

. In the window that opens, click Add to create a new statistic.

1
2
3. In the Add Statistic window, configure the attributes.
4

. Click Add.

The statistic is now listed in the list on the Add Statistic window. This means that the statistic is
now available in the global list, but is not yet assigned.

5. To assign the new statistic to Agent Statistics list, select the statistic and click Add.
The window closes and the new statistic is assigned to the Agent Statistics list.

[+] Show a list of Agent Statistic attributes

You can set the following attributes for each statistic that you specify to be displayed to agents.

* Display Name: The name of the statistic to be displayed.

« Name of the statistic in the statistics.yaml file: This must correspond to the value of the name

attribute in the statistics.yaml file.

* Warning Level Low: The minimum value of the statistic before a warning is raised. No warnings above

this value.

* Warning Level High: The maximum value of the statistic before a warning is raised. No warnings

below this value.

¢ Error Level Low: The minimum value of the statistic before an error is raised. No errors above this

value.

e Error Level High: The maximum value of the statistic before an error is raised. No errors below this
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value.
* Worst Value Low: The minimum value of the statistic before a critical error is raised.
* Worst Value High: The maximum value of the statistic before a critical error is raised.
¢ Measurement Unit: an optional display value.
* Number: Indicates the statistic type is numeric.

* Duration: Indicates the statistic type is duration (in HH:MM:SS format).

Contact Center Statistics

On the Contact Center Statistics tab, manage the statistics that are displayed under Contact
Center. The Contact Center tab gives agents a view of the current state of activity for the call
center.

To access the Contact Center Statistics tab, click Contact Center > Contact Center Statistics.

Contact Center Stafj (4)

o] [ i >

—
| al—

Agent Groups

Contact Center Resource Current In Queue Total Queue Inbound TotalCalllnbound

GSYS_Internal_Agents (Agent Groups)

entGrp (Agent Groups)

To configure Contact Center Statistics, you must first add a resource. Resources can include agent
groups, queues, DN groups, and routing points. In the first drop-down list box, select the type of
resource you want to add, and then select the resource from the second drop-down list box. Click
Add Resource. This action adds a row for the resource to the Contact Center Statistics table.
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Contact Center Statistics n
Warning Error Worst -

Warning Level Error Level Worst Level Measurement

Display Name Statistic Level Low High Level Low High Level Low High Unit

Average Inbound Averageln... 123421 12512 1521513 5325632 13531 3215235 132525

Handing Time

Average Inbound Averageln... 10000000 10000000 10000000 10000000 10000000 10000000 LRRERRRER S

Per Hour

Then you can add statistics by clicking Add Statistics. The Add Statistics window opens, where
you can either select a preconfigured statistic or create a new one. For details on how to select or
add statistics, see Agent Statistics. This action adds a column to the Contact Center Statistics
table. Continue adding the statistics that you want to add to the table.

Contact Center Statistics (4)

Agent Groups v AgentGroup2 v Add Resource Add Statistics

10 Delete
Contact Center Resource Currentent In Queue Total Queue Inbound TotalCalllnbound DM EXISTS FOR IMPORT
VQ_57 (Virtual Queues) (/] (]
VQ_devops (Virtual Queues) (/) [~]
2200 (Routing Points) [} (]

When you are done, notice the black checkmarks in the Contact Center Statistics table. The black
checkmarks indicate which statistics apply to each resource. For example, the current number in
queue statistic does not apply to agent groups. Agent desktops shows only statistics with check
marks; other desktops show only statistics with hyphens (-).

Agents can only see Route Points on switches they are given permission to view. For
example: Your Contact Center Statistics are configured to monitor the following
routing points: RP1, RP2, and RP3. RP1 belongs to one switch while RP2 and RP3
belong to another switch. An agent who is only configured to log into the switch that
contains RP1 can only see RP1 in the Contact Center Statistics. RP2 and RP3 are not
visible to the agent because they belong to a switch that agent doesn’t have
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permission to access.

Statistic definitions

Using the Statistic Definitions tab, you can import, export, and edit statistic definitions. The
supported formats for the statistic definition files are: .CSV and .YAML.

About CSV files

The .CSV file must be a text file in a comma-separated format. In the source file each line represents
a single statistic.

About YAML files

Use a YAML file to import custom statistics from a valid .YAML file. The following example shows one
custom statistic from a sample .YAML file:

[+] Show an example

name: ReadyDuration

objectType: AGENT
notificationMode: PERIODICAL
notificationFrequency: 10
statisticDefinitionEx:
category: TotalAdjustedTime
intervalType: GrowingWindow
mainMask: WaitForNextCall
subject: DNStatus
dynamicTimeProfile: '8:00'
dynamicFilter: MediaType=voice
saveHistory: false
insensitivity: 1
location: /
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How do | import custom statistic definitions?

Manage contact center statistic definitions

Q =+ Add i Delete
Name = Type 7 Category Location &
Productivity Agent AverageMumberPerRelativeHour /
RejectedChats Agent TotalMumber /

To import a .CSV or .YAML file that contains your custom statistic definitions, click Import, select your
file, and then click Open. User Setup validates the file and indicates which, if any, values need to be
corrected. If you receive such a message, make the recommended corrections and then try again.

How do | export statistic definitions?

Export Statistics
M Custom Statistics

¥ Global Statistics

Cancel m Export YAML

You can export your statistic definitions to an external .CSV or .YAML file. You can select your custom

statistics, global statistics, or both. Then you can choose which file type to export. The exported file
downloads to your local computer.
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Agent Groups

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

An Agent Group is a logical grouping of agents. Agent Groups are typically set up to provide
particular sets of contact-center services.

Prerequisites

Before you can configure Agent Groups:

* You need to configure skills that will assign to the Agent Groups. If you haven't done so already, go to
the Skills tab and set up the skills you want to use.

e If you plan on creating Agent Groups by selecting specific agent accounts to the group, you first need to
add the agent accounts. If you want to set up Virtual Agent Groups, it is not necessary to add the agent
accounts first.

Configuring Agent Groups
You have two options for creating Agent Groups:

* Create an Agent Group and then manually add agents to the group. For example, if you want to create
an Agent Group for a group of new hires, you create the Agent Group, and then manually add each of
the new hire's agent accounts to the group.

e Create a Virtual Agent Group to automatically group agents, according to their skills. You create an
Agent Group object and define a script to identify the skills that you want the agents in the group to
share. For example, you can create a virtual Agent Group for all agents that can speak Russian.

Both types of Agent Groups are configurable on the Agent Groups page. Use the following
procedures to create and configure your Agent Groups:
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Creating an Agent Group

General Info

Agent Group Name
November2016 New Agents

Folder /Training Groups/

Type @® Agent Group  © \irtual Agent Group

In the New Agent Group window, type the name you want to assign to the Agent Group and click
Save. In our example, the new Agent Group is a group of new hires, so let's name the Agent Group
November2016 New Agents.

You can put the new Agent Group into a folder. This is useful for organizing your Agent Groups to
make them easy to locate in the future. For example, you can place our new group into the Training
Groups folder. When you select the Folder option, a drop-down list box is displayed where you can

select a folder or click the add folder bl— icon to create a new folder.

Adding agents to an Agent Group

% All Agents Agents

General Info

I o All Agents Agent Groups Agent
Dispositions
Custom Agent States =
Group Favorites
External URLs
Agent Statistics n Drag and drop agents here
Contact Center Statistics
Case Data
Toast Data (| FN_Ageni_2230_7000000 LN_Agent_2230_7000000 (22307... FN_Agent_2230_7000000 LN_Agent_2230_7000000 (22307000000)
Caller IDs
. (| FN_Agent_2230_7000001 LN_Agent_2230_7000001 (22307... FN_Agent_2230_7000001 LN_Agent_2230_7000001 (22307000001)
Desktop Options v
(| FN_Agent_2230_7000008 LN_Agent_2230_7000008 (22307... FN_Agent_2230_7000008 LN_Agent_2230_7000008 (22307000008)
e test agent 2 (222222) FN_Agent_2230_7000009 LN_Agent_2230_7000009 (22307000008)

When you create an Agent Group, you can go to the Agents tab and add agents to the group.

You can either drag the agent over to the Agent Groups Agent column, or you can click the box next
to the agent's name in the All Agents list and then click Add. This automatically drops the agent into
the Agent Groups Agent list.
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Tip

On your Agent Groups list, you might see Agent Groups that have an Add script link
in the script column. If you see this, it means that you or someone else created an
Agent Group and no agents have been assigned to it. In other words, it's an empty

group. You have the option to edit the group to manually add agents or click Add
script to create a virtual Agent Group.

Creating a virtual Agent Group

General Info

Agent Group Name

Folder /
Type © AgentGroup @ Virtual Agent Group
Script | |

Specify expression in Virtual Group Script Language (VGSL) defining at least one skill in the format: Skill("Skill Name")=SkillLevel

You can create a virtual Agent Group by specifying a script when you add an Agent Group.

As opposed to a regular Agent Group, you can't manually add agents to a virtual Agent Group. Agents
are automatically included in the group if the agent is assigned the skill that is specified in the script.

After you add the script, you will see a link in the Script column on the Agent Groups page. The
script identifies the common skills shared by all agents that belong to the group. You can edit the
script by double-clicking the script text and then updating the script in the dialog box that is
displayed.
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Configuring the desktop for an Agent Group

General Info
Agent Group
| seneratinto agent Group ame
Agents
Dispositions AgentGroup1

Custom Agent States
) Folder  /DEVOPS/
Group Favarites

Statistics Type ® Agent Group
Case Data

Toast Data

Caller IDs

Desktop Options EOE
Channels

Global Login

Supervisor

Voice

Chat

Email

Recording

Contact
Standard Response Library
Feedback

CRM Adapter
Provisioning Options
Interaction

Screen Pop
Salesforce

After you populate your Agent Group with agents, you can assign objects to the group. Under each of
the following tabs, make your selections:

* Dispositions: See Manage Dispositions.

* Custom Agent States: See Manage Agent States.

¢ Group Favorites: Group favorites are configured the same way as Global Favorites. See Global
Favorites.

e External URLs: See External URLs.

¢ Agent Statistics: See Statistics.

¢ Case Data: See Manage Case and Toast Data
¢ Toast Data: See Manage Case and Toast Data.
e Caller IDs: See Manage Caller ID.

* Desktop Options: Use the Desktop Options tabs to configure the desktop settings for the Agent
Group. For information, see Desktop Options.

e CRM Adapter: Use the CRM Adapter tabs to configure the Gplus Adapter settings for the Agent
Group. For information, see CRM Adapter options.
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Next Steps

After you have configured Agent Groups, you can proceed to configure:

e Business attribute overrides (Transactions)

¢ Templates
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Transactions

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Use the Transactions page to manage business attribute overrides that are applied at a
transactional level, such as a call or a chat. You can configure the following business attributes at the
transaction level:

¢ Dispositions

e Favorites

¢ Case Data

¢ Toast Data

Caller IDs

Select Transactions in the navigation menu to access the Transactions page. The Transactions
main view lists the transactions only by name. Click the link for the transaction to view the details.

Use the following procedures to create and configure transactions:

Adding a new transaction

Folder: / Transaction name “ Cancel

Name

UserPreference/default

Internal/Support

Internal/ORS

Click the New Transaction button, type a unique name in the Transaction name field, select a
folder to store the transaction configuration, and then click Add. If you do not select a folder, the
transaction is stored in the /default directory.

Genesys Engage cloud Administrator's Guide 159



Agent Setup Contact Center Settings

The name of the transaction is prefixed with the name of the folder. For example,
UserPreference/<TransactionName>. At this point, configuration is not complete. You need to add
business attributes to the transaction.

Tip
You can manage folders from this page. When you select the Folder option, a drop-
down list box is displayed where you can select a folder or click the add folder icon

.-I"- to create a new folder.

Adding business attributes to a transaction

Edit Transaction

Manage Disposiions

) . Dispositions are the descriptions of the final outcome of the call. These codes are used
I Dispositions

Case Data Folder: /DEVOPS/ Select Business Attribute ... w
Toast Data

Caller ID <+ Add e Add Folder @ Delete

Favorites

No ltems Found

To edit a transaction, click the link in the Name column. If the transaction has no configured business
attributes, as is the case when you add a new transaction, you are prompted to complete the
configuration. Follow the prompts to add Dispositions, Case Data, Toast Data, Caller ID and
Favorites business attributes. After you add the business attributes, you can define them.
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Managing dispositions

Manage Dispositions
Dispesitions are the descriptions of the final outcome of the call. These codes are used to flag calls for reporting purposes.

Folder: /DEVOPS/ Disposition_Sales -

=+ Add I Add Folder i Delete

Sales: Follow-up required

Mame Display name

Dispositions are the descriptions of the final outcome of the call. These codes are used to flag calls
for reporting purposes. To learn more about how to manage dispositions, see Managing dispositions.

Managing case data

Manage Case Data

Case data is the call information that is displayed about a call in progress.
Folder: [DEVOPS/ Support v Sort Case Data

+ Add g Add Folder il Delete

Mame Display name Mandatory Read Only W

On the Manage Case Data screen, you can specify the information to be displayed to the agent when
an interaction is transferred to them. To learn more about how to manage case data, see Managing
case data.
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Managing toast data

Manage Toast Data

Toast data is the call information that is displayed for a ringing call.

Folder: /DEVOPS/ Support v

+ Add I Add Folder M Delete

Mame Display name

On the Manage Case and Toast Data screen, you can specify the information to be displayed to the
agent when they receive a call, chat, or other interaction. To learn more about how to manage toast
data, see Managing toast data.

Managing caller IDs

Manage Caller IDs

A Caller 1D 15 a registered phone number that the caller can see. You can select a caller ID for the contact center or for a team.

Folder: /DEVOPS/ Caller ID-Sales v

+ Add B Add Folder i Delete

Sales: 1-555-555-5555

Mame Display name

You can allow agents to select from a predefined list of caller IDs. The selected caller ID is then
displayed to the person receiving the call when the agent consults, conferences, or transfers a call. To
learn more about how to manage caller IDs, see Managing caller IDs
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Managing favorites

Favorites

Favarites is a list of Agents, Agent Groups or external contacts that group members frequently dial. This list provides a click-to-call list of these

numiers on Agent Desktop.

Add Favorites

Favorites List (0)
Q

=]
2
i3]
T
=
T

Mo Contacts Found

On the Favorites screen, you can create a list of agents, agent groups or external contacts that
agent group members frequently dial. This list provides a click-to-call list of these numbers on Agent
Desktop. To learn more about how to manage favorites, see Global Favorites.

What should a configured transaction look like?

New Transaction

Name

UserPreference/default

Internal/Support

Manage Case Data

Case data is the call information that 1s displayed about a call in pr

\ Folder: ¢ Caselata

Interfgl/ORS + Add & Add Folder (]

Manage Dispositions

uspositions are the descriptions of the final outcome of the call.

/Publications

Folder: / Dispositio

+ Add 8 Add Folder 7]

LastName: Last name

Transaction complate: Transacton complete

Manage CalleffiDs

A Caller ID is a registered 2 nsmber that the caller can see
Needs follow up: Needs follow up . &g P "

Falder | CalleriD,

+ A = codoier - Firstlame: First name

v

ABC Customer Suppart: ABC Customer Suppart

Subject: Subject

ABLC Shipping: ABC Shipping
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In this example, the transaction includes the following business attributes:
Dispositions:

¢ Transaction complete

¢ Needs follow-up

Case Data

¢ First name
¢ Last name

e Subject
Caller IDs

e ABC Customer Support
e ABC Shipping

Use Case

In Agent Desktop, you have the ability to override desktop options by setting the value of a KVP to
the name of a transaction list object. The desktop option is interaction.override-option-key that
is configured in Channels and Options. In the inbound or outbound routing application, you set the
value of the identified key to the name of the transaction list object and the desktop options in the
transaction list object are used instead of the Agent Desktop application or agent group objects.

Next Steps

Now that you have configuration business attribute overrides, you can proceed to configure
templates. See Templates.
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Templates

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Templates allow you to create a set of configuration options that you can apply to agent accounts
when you add an agent. The following diagram shows the relationship between the templates and
the sequence in which the templates must be created:

© ® ©

i ' '
DN Place Person
f——
Switch = Name [ | Agent/Supervisor
Folder Folder Channels
Skills

Access Group

@ Folder

Annex
Logins \ )
Switch il
Colder single arrow represents 1:1
Ao triple arvow represents L:many

Access the Templates tabs on the Contact Center Settings page.

To add a template, select a template type, and then click Add. For each template you create, ensure
that you give the template a unique name.
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To configure a specific template, click on the Template Name and make your intended changes.

DN template

Add "dn” Template

Template Mame

Switch us-west-1

Faolder: /

Close

DN Templates specify the switch and folder where the DN needs to be created.

Login template

Add "agent-login" Template

Template Name

Agent Login Mame

Switch us-west-1

Folder: /

Close

Templates
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Agent Login Templates specify the switch, folder, and annex options.

In the Agent Login Name field, you can use a variable to specify the contents of the field, for
example, {{person.userName}}.

Person Templates

Add "person” Template

Template Name

Supervisor
Channels
¥ Voice
Place Template Select Place Template I
Login Templates Select Login Templates s +
s | oo
Folder: /

Person Templates define properties such as Channels, Skills, Access Groups, Annex options, folder,
and Supervisor role for newly created agents.

You also need to select a place template and one or more login templates. Then you can select the
channels, skills, annex, and access groups that you want to apply to this template. Before you save
the Person template, select the folder where the user is created.
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Place template

Add "place” Template

Template Name

Place Name Templates v
DN Templates Select DM Templates 7z =+
Folder: /

Place Templates must contain one or more DN Templates.

If your contact center has a requirement to specify unique place names for different business groups
or regions, type a place name variable. For example, the place name might be the same as the
agent's phone number or as the agent's user name. Place names can contain the following variables:

e {{person.userName}}

e {{person.emailAddress}}

* {{phone.number}}

¢ {{phone.description}}

e {{phone.index}}

You can also combine variables. For example: {{person.userName}}-{{phone.index}} creates
JohnAppleseed-1 and JohnAppleseed-2 if JohnAppleseed has two phone numbers.

Next Steps

Now that you have set up templates, you can proceed to provision your contact center with agents.
See Agent Accounts.
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Gplus Salesforce

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Configure options for the Gplus Adapter on the Contact Center Settings page.

The Gplus Salesforce options are organized into the following sections:

General options

Agent Desktop v
General
Desktop Options v
[¥ Click to Dial Preprocessing Rules Default -
Digital Management v
. . Salesforce Object Type Salesforce Object Type
Single Sign On v
Desktop Statistics v Salesforce Object Name Salesforce Object Name
Templates v Salesforce Object Key Salesforce Object Key

Gplus Salesforce
[ Keep Alive Sync

I General
Screen Pop
Activity Log Run Salesforce Apex on Interaction Events
Services Options v
P [ Apex Class Name Apex Class Name
Routing Manager v
[¥ Salesforce Message Channel Name for Service Client API GplusChanel_c

In the General section, configure the following options:

¢ Click to Dial Preprocessing Rules specifies the rules to apply to a phone number before making a
dialing request.
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+ Salesforce Object Type specifies the key that Adapter uses when saving the type of the focused
Salesforce object to attached data.

* Salesforce Object Name specifies the key that Adapter uses when saving the name of the focused
Salesforce object to attached data.

* Salesforce Object Key specifies the key that Adapter uses when saving the ID of the focused
Salesforce object to attached data.

Keep Alive Sync specifies whether to prevent Adapter from logging out of Salesforce when there is no
activity in Salesforce beyond the configured time period. If enabled, Adapter refreshes the Salesforce
session at short intervals and keeps the Adapter-Salesforce session alive.

* Run Salesforce Apex on Interaction Events specifies the interaction event which triggers
Salesforce Apex to run.

* Apex Class Name configures the name for a Salesforce custom apex class.

+ Salesforce Message Channel Name for Service Client API specifies the name of the message
channel in Salesforce for Service Client API.

Genesys Engage cloud Administrator's Guide 170



Agent Setup

Contact Center Settings

Screen Pop settings

Agent Desktop
Desktop Options
Digital Management
Single Sign On
Desktop Statistics
Templates

Gplus Salesforce

General
I Screen Pop
Activity Log

Services Options
Routing Manager

Recording Management

In the Screen Pop section, configure the following options:

Screen Pop

[ Screen Pop for Internal Calls

[ Use ANl in Screen Pop Search

[J Use DNIS in Screen Pop Search

[¥ Screen Pop on Ringing

[ Screen Pop Preprocessing Rule
RegEx to Match UserData

[ Object ID UserData key

[J Screen Pop on Chat Invite

[J Screen Pop on Email Invite

[ Screen Pop on Open Media Invite
[J Enable Screen Pop for Consult

[ Screen pop object type

[ Screen pop URL section name

[¥ Screen pop Object home section name
[ Screen pop List section name

[ Screen pop Search section name

[ Screen pop New record section name

[ Screen pop Flow section name

RegEx to Match UserData

id_transfer_object

¢ Screen Pop for Internal Calls specifies whether the adapter initiates a screen pop for internal calls.

Use ANI in Screen Pop Search specifies whether ANI is to be used in the screen pop search.

¢ Use DNIS in Screen Pop Search specifies whether DNIS is to be used in the screen pop search.

e Screen Pop on Ringing specifies whether the adapter initiates a screen pop when the call is ringing. If
not enabled, or set to False, the adapter initiates a screen pop when the call is established.
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¢ Screen Pop Preprocessing Rule specifies the preprocessing rule to apply to the ANI or DNIS before
showing the screen pop. When you enable this option, you can choose the default preprocessing rules
or add a rule. If you add a rule, you will need to define a Display Name for the rule and define the
RegEXx, Prefix, and Description.

 RegEx to Match UserData specifies a regular expression pattern used to match one or more
UserData keys. The values for these keys are used to build the search and screen pop expression. If this
option is not defined, the adapter uses the existing cti prefix logic.

* Object ID UserData key specifies the custom UserData key that the adapter should use for the object
ID of the focused page when performing a transfer.

¢ Screen Pop on Chat Invite specifies whether the adapter initiates a screen pop in Salesforce
immediately after displaying a chat invite notification. If the option is not set or is set to false, the
adapter initiates a screen pop only when an agent accepts the chat invite.

¢ Screen Pop on Email Invite specifies whether the adapter initiates a screen pop in Salesforce
immediately after displaying an email invite notification. If the option is not set or is set to false, the
adapter initiates a screen pop only when an agent accepts the email invite.

¢ Screen Pop on Open Media Invite specifies whether the adapter initiates a screen pop in Salesforce
immediately after displaying the open media invite notification. If the option is not set or is set to false,
the adapter initiates a screen pop only when an agent accepts the open media invite. This option
supports the items configured in the openmedia.workitem-channels.

* Enable Screen Pop for Consult specifies whether the adapter initiates a screen pop in Salesforce
when using voice consult. This option works with option Update Attached Data on Transfer

e Screen pop object type specifies the the type of object (for instance "URL" or "OBJECTHOME") to
screen pop in Salesforce.

» screen pop URL section name specifies the URL for the screen pop object type.

e Screen pop Object home section name specifies the object home (for instance, an account or
contact) for the screenpop object type.

e Screen pop List section name specifies a list view for the screenpop object type.

¢ Screen pop Search section name specifies the top results section of the search page for the
screenpop object type.

¢ Screen pop New record section name specifies the new record name (for instance, new account or
new contact name) for the screenpop object type.

* Screen pop Flow section name specifies the target Ul screen flow for the screenpop object type.
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Activity Log options

Agent Desktop

Skills

Dispositions

Custom Agent States
Global Favorites
External URLs

Case Data

Toast Data

Caller IDs

Desktop Options

Digital Management

Single Sign On

Desktop Statistics

Templates

Gplus Salesforce

General

Screen Pop

Activity Log

Services Options

Routing Manager

In the Activity Log section, configure the following options:

Activity Log
O Activity Log on Screen Pop

[¥ Salesforce Activity Log Status
[ Voice Activity Log

[ Chat Activity Log

[ Open Media Activity Log

[J Email Include in Activity Description
¥ Update Attached Data on Transfer

Templates Salesforce Inbound-Voice Subject
Templates Salesforce Outbound-Voice Subject
Templates Salesforce Transfer-Voice Subject
Templates Salesforce Chat Subject

Templates Salesforce Email Subject

[ chat Include Transcript in Description

Chat Transcript Custom Field Name

Completed

Inbound v

Templates Salesforce Inbound-Voice Subject
Templates Salesforce Outbound-Voice Subject
Templates Salesforce Transfer-Voice Subject
Templates Salesforce Chat Subject

Templates Salesforce Email Subject

Chat Transcript Custom Field Name

Activity Log on Screen Pop specifies whether Adapter creates the activity in Salesforce on screen

pop and modifies logged activity when interaction is marked done. Activity on screen pop is created for
inbound and internal calls. This option depends on Screen Pop for Internal Calls being selected and
the value of Voice Activity Log containing Inbound and Internal.

* Salesforce Activity Log Status specifies the custom task status to be applied when an activity log is
created by Adapter. Prerequisite: The status must exist in the Salesforce Task Status Picklist.

Voice Activity Log specifies the call types for the adapter to create in the activity history for
Salesforce.

Chat Activity Log specifies the chat types for the adapter to create in the activity history for
Salesforce.

Open Media Activity Log specifies the open media types for the adapter to create in the activity
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history for Salesforce. To disable the open media activity log creation, set the option to None.

¢ Email Include in Activity Description specifies to include the text version of the email body in the

activity description in Salesforce. The email body is saved for only inbound emails and outbound
replies.

* Update Attached Data on Transfer specifies whether to update the call data with the ID of the
Saleforce object the agent is viewing when performing a transfer or conference. When set to True, the
agent that receives the voice or chat interaction gets a screen pop for the most relevant object.

¢ Chat Include Transcript in Description specifies whether the adapter saves the chat transcript, as
part of the activity description in Salesforce.

¢ Chat Transcript Custom Field Name specifies the name of a custom activity field in Salesforce.

Custom templates

You can specify what the adapter saves for the subject field in the Salesforce activity by using custom
templates with the following options:

¢ Templates Salesforce Inbound-Voice Subject

* Templates Salesforce Outbound-Voice Subject

e Templates Salesforce Transfer-Voice Subject

¢ Templates Salesforce Chat Subject

* Templates Salesforce Email Subject

The value specified for each of these fields can be a combination of text and parameters to achieve
the desired result for each type of interaction.

For example, you might want the activity for all inbound voice calls to have details about the
customer's name and phone number. In this case, here's how you would configure the option:
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Templates Salesforce Inbound-Voice Subject = Customer: {interaction.contact}, Phone Number: {interaction.ani}
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If a call comes in from Willard Clinton at 123-456-7890, when the call ends the adapter creates the
related activity in Salesforce with following subject field: Customer: Willard Clinton, Phone
Number: 123-456-7890

Another common use case might be to include information from UserData for all inbound calls. This
could come from your own UserData keys or from UserData provided by Agent Desktop (see the table
above). For example, you want the activity history's subject to include information from your own
UserData key, PurposeOfCall, and the contact's name. Here's how you should configure the option:
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Templates Salesforce Inbound-Voice Subject = Call from {interaction.contact} about {userData.PurposeOfCall}
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In this scenario, if Willard Clinton calls into the contact center and chooses the Technical Support
option in the IVR, that information is saved in the PurposeOfCall UserData key. When the call ends,
the adapter creates the related activity in Salesforce with the following subject field: Call from
Willard Clinton about Technical Support

The adapter supports the following templating variables:

Variable Description
The number that originated the call. This variable
interaction.ani identifies the caller for inbound calls and is best
used in inbound templates.
interaction.callType The type of call (inbound/outbound).
interaction.caseld The unique ID of the related case.
interaction.contact The first and last name of contact.

The last call dialed (useful for call transfer). This
variable identifies the outbound location for

interaction.dnis outbound calls and is best used in outbound

templates.
interaction.endDate The date and time when interaction ended.
interaction.isConsultation This is true if the interaction is a consultation.
interaction.startDate The date and time when the interaction started.

This can be any UserData key available for the
interaction. You might also find some of the
following UserData keys useful (they're included by
default by Agent Desktop on transfers):

e userData.GCS_TransferringAgentName — The
name of the transferring agent.

userData.<key> e userData.GCS_TransferringDate — The date and
time of transfer.

» userData.GCS_TransferringEmployeeld — The ID
of the transferring employee.

* userData.GCS_TransferringReason — The reason
for the transfer. This is an empty string if no
reason exists.

A list of email addresses associated with the

contact.EmailAddresses contact.

A list of phone numbers associated with the

contact.PhoneNumbers contact.

Next Steps

After you have configured the Gplus Adapter options, you can proceed to set up your Agent Groups.
See Agent Groups.
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Routing Manager

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

The Routing Manager section on the Contact Center Settings allows you to view your Routing
Points and your Virtual Queues, as well as create DN Groups for both.

In the Routing Point and Virtual Queue sections, the Alias name for each line is editable; however
all other fields are read only.

You can also filter both lists by Number, Alias, or Switch.

Routing Point
Q 1-150f24 £ >
Number % Alias 4 Type Switch 4
/+14045094516 +14046094516.us-west-1 Routing Point us-west-1
/Customer22-30/Route Points/+140460945... Routing Point ap-southeast-2
/Customer22-30/Route Points/+140460945... Routing Point ap-southeast-2
/+14046094551 +14046094557 us-west-1 Routing Peoint us-west-1
fCustomer22-30/Route Points/+151264013... Routing Point ap-southeast-2
fCustomer22-30/Route Points/+151264013. Routing Point us-west-1
/16508925011 Routing Point us-west-1
/16508925012 Routing Point us-west-1
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DN Groups
DN Groups
Folder: /Customer22-30/ Select DN group type v m
Q f Delete
Name & Type £ Total DNs in Group %  Actions
/BrandNewRPGroup Routing Point 5 i)
/BrandNewVQGroup Virtual Queue 0 i)
/Customer22-30/CXContact_Queues Virtual Queue 0 ]
/Customer22-30/CXContact_RPs Routing Point 3 mia
/Customer22-30/newDNGroup Routing Point 7 m O
/Customer22-30/NewDNGroup1 Routing Point 3 i)
[HealthCheck_DNG Virtual Queue 1 i)
/Internal/GSYS_Internal_Queues Routing Point 6 ]

In the DN Groups section, you can group your Routing Points and Virtual Queues for display in Real-
time Reporting with Pulse and to simplify the on-boarding of new agent and business groups.

To create a new DN group, select an existing Folder or create a new one, enter the DN group name,
and select the group type before clicking Add.

Once you have created a new DN group, select it from the list and begin adding DNs (directory
numbers) to the group. You can add DNs by dragging and dropping, selecting one or more and
clicking Add, or by clicking on the arrow that pops up when you hover over an available DN. You can
remove a DN from a group by clicking the X that pops up when you hover over that DN.
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Desktop Options

Important

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

To configure desktop options, click Contact Center Settings > Desktop Options. In the Desktop
Options section, you can select the channels and other options that are available to all agents and
users in your contact center. Click the links below to view an image and option descriptions for each
section.

¢ Channel options

» Standard Response options

¢ Statistics options

¢ Global Login options

* Supervisor options

* Voice options

e Chat options

* Email options

¢ Outbound options

* Workitem options

* Facebook options

¢ Twitter options

e Recording options

* Contact options

¢ Interaction History Advanced Search options

e Standard Response Library options

* Genesys Softphone options

¢ Feedback options

¢ My Channels options

* Service Client options
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Next Steps

After you have configured your Desktop Options, configure options for the Gplus Adapter. See CRM
Adapter. You can also proceed to configure your Agent Groups. See Agent Groups.
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Channel options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Channels section under Desktop Options, select the channels you want to enable in your
contact center.

Channels

¥ Voice

[ Chat

¥ Email

¥ Workbins

C Outbound
Workitem

C Facebook

C Twitter

The choices that you make in the Channels section are not automatically applied to all agents and
users. Your selection provides a set of channels that you choose from when you add an agent. For
example, you can select Voice, Chat, Email, Workbins, Outbound, Workitem, Facebook, or
Twitter for the contact center. Then, when you add an agent or edit an agent, you can configure the
individual agent to only have access to certain channels.

You can also enable Genesys Altocloud for Chat channel users working with the new Agent
Desktop. When editing or creating a user in Agent Setup, you can select Altocloud under Desktop
Options in the Users section. This option is not available in the Contact Center Settings or Agent
Groups sections. For more information, see Altocloud Chat Interaction.
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Standard Response options

Important

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Standard Response section, you can specify custom field codes, such as agent nicknames,
roles, departments, and email signatures.

Standard Response

Standard Response Items

Enter Display Name Enter Value “

Standard Response Items test_record test_record_value i

You can format custom field codes to represent agent attributes using Agent.<CustomAgentAttr>, or
any custom attribute by dropping the agent modifier and using <CustomFieldCode>. Enter a Display
Name and the corresponding Value for each field code.
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Statistics options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Statistics section of the Contact Center Settings page, you can configure the following
options:

Statistics
4 Statistics - Default Statistics displayed Choose ameng the fellowing... -
[# statistics - Refresh Time 20
Statistics - Maximum guantity of Gadget Statistics displayed 10

- =N

* Default Statistics displayed specifies the statistics displayed in the Agent Desktop menu bar. The
statistic specified by this option is the name of a section containing the statistic definition or the
statistic object.

* Refresh Time defines the frequency of notification (in seconds) for statistics.

¢ Time for Statistics Reset specifies the time that you want agent and call center statistics to be reset
in Agent Desktop. Indicate the time using UTC time in 24-hour format. For example, PDT midnight is
7AM in UTC and should be specified as 7:00.

« Maximum quantity of Gadget Statistics displayed specifies the quantity of statistics displayed.
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Global Login options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Global Login section under Desktop Options on the Contact Center Settings page,
configure the following options:
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Agent Desktop v
Global Login

Desktop Options -

Channels Frompt Place
Standard Response
Statistics

I Global Login [ Store Recent Place
Supervisor
Voice
Chat
Email
Outbound [0 Mandatory Disposition
Workitem
Facebook
Twitter
Recording
Contact
Interaction History Advanced

O allow Voicemail

[ Agent States Global Status

[ Agent States by Channel

Search

Standard Response Library [0 Allow Pending State in My Channel
Genesys Softphone

Feedback

My Channels [ Team Communicator Search Filter

* Prompt Place requires the agent to specify a place when they log in.

* Store Recent Place specifies whether the most recently used Place is stored. This option is applicable
when Prompt Place option is set to true.

¢ Voicemail enables the Voicemail menu.

« Mandatory Disposition specifies whether it is mandatory for the agent to select a disposition before
marking an interaction as done.

Agent States Global Status defines the available agent states in the global Status menu.

Agent States by Channel defines the available agent state actions in the My Channels contextual
menu.

Allow Pending State in My Channel allows an agent to have a pending state in the My Channel tab.

« Team Communicator Search Filter specifies the list of filters that an agent can use to search for
contacts and internal targets in the Team Communicator. When you select this option, all filters are
enabled by default. To customize the filters, click the drop-down list box and deselect the filters that
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you don't want to include.

¢ Team Communicator Exclude from Groups - When you select this option, the agents from excluded
groups are not visible in Team Communicator, Favorites, and Statistics.

¢ Team Communicator Exclude Groups - Specifies the list of agent groups to be excluded from
searches and statistics. Virtual agent groups are not supported. This option is overridden by the Team
Communicator Restrict to Groups option.

¢ Team Communicator Include Groups - Specifies the list of agent groups that are returned for
searches and statistics. Overrides the Team Communicator Exclude Groups option. Virtual agent groups
are not supported.

¢ Team Communicator Restrict to Groups - When you select this option, only agents from restricted
groups are visible in Team Communicator, Favorites, and Statistics.

« Team Communicator Max Favorites specifies the maximum size of the favorites list displayed in the
Team Communicator.

* Transaction Override Attached Data Key allows you to override desktop options in Agent Desktop
by setting a key value to the name of a transaction list object. When you set the value of the identified
key to the name of the transaction list object, desktop options in the transaction list object are used
instead of the Agent Desktop application or agent group objects.

¢ Inactivity Timeout (min) specifies the number of minutes of agent inactivity (no mouse or keyboard
usage) that triggers application locking. If the agent has been inactive longer than the number of
minutes this option, the agent session is ended.

* Alert before timeout (sec) specifies the number of seconds that pass before the inactivity alert is
sent to the agent.

* Sidebar Region specifies the order of the Region to be displayed in the sidebar.
* Use Performance Tracker allows the use of the Performance Tracker.
¢ Use Dashboard allows the use of the Dashboard.

e Auto-focus on inbound interactions enables inbound interactions to automatically be in focus when
accepted.

¢ Channel to be auto-focused specifies whether the inbound interaction of a particular media type is
automatically in focus when accepted.

* Invalidate Auth SSO session on Workspace logout specifies whether the Single sign-on (SSO)
authentication session is invalidated when an agent logs out of the Workspace. When this option
selected, both Workspace and user authentication sessions get terminated when the agent exits the
Workspace and the agent is redirected to the authentication login page. When this option is cleared,
only the Workspace session is removed when the agent exits the Workspace and the agent is
redirected to the Workspace session ended page.

¢ Show Change Account Link specifies whether or not to display the Change Login Account link on the
login error page and the second step login page. This option is not used if the Invalidate Auth SSO
session on Workspace logout option is selected.
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Supervisor options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Supervisor section under Desktop Options, configure the following options:

supervisor

¥ Monitor
[# Agent Control

[¥i Agent Channels Vaice -

] Monitor Cumrent Vaice

[ coach Current Voice

[ Show Vaice Monitoring

[# Cross Site Voice Monitoring
] Monitor Chat

[ coach Chat

¢ Monitor enables supervisor and team lead monitoring on agent interactions.

e Agent Control allows the supervisor or team lead to access the My Agents view.
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¢ Agent Channels defines the channels to be displayed in the My Agents view.
* Refresh Agent Control enables the manual refresh of agent states.
* Agent Page Limit specifies the maximum number of rows displayed per page in the My Agents tab.

* Agent Page Refresh specifies the frequency, in seconds, to refresh the list of users. Auto-refresh is
turned off when this is set to '0' (zero).

* Monitor Current Voice allows the supervisor or team lead to monitor voice interactions.
¢ Coach Current Voice allows the supervisor or team lead to coach voice interactions.

* Show Voice Monitoring enables agents to be notified when the current call is being monitored by a
supervisor or team lead.

¢ Cross Site Voice Monitoring allows the supervisor or team lead to perform supervision of an agent
that is located at a different location.

* Monitor Chat allows the supervisor or team lead to monitor chat interactions.

¢ Coach Chat allows the supervisor or team lead to coach chat interactions.

* My Team Workbins enables supervisors to see the workbins of the agents in their Agent Group.
* Access to Interaction Management enables supervisors to see Interaction Management.

* Allow Moving Interactions to Queue enables supervisors to move interactions from displayed
workbins to available queues.

¢ Allow Moving Interactions to Workbin enables supervisors to move interactions from displayed
workbins to other workbins.
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Voice options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Voice section of the Contact Center Settings page, configure the following options:
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Contact Center Settings

Agent Desktop v
Voice
Desktop Options -
Channels [0 Voice Auto Answer

Standard Response
Statistics 1 Allow Reiect Call
. Allow Reject Ca
Global Login Allow el
Supervisor
I Voice & Voice Auto Answer On Active Call
Chat
Email
Outbound [+ DTMF Tone
Workitem
Facebook .
. [0 Voice Auto Ready
Twitter

Recording

Contact Auto Mot Ready Reason
Interaction History Advanced

Search

Standard Response Library [0 Show Post Call Duration
Genesys Softphone
Feedback

My Channels
Service Client

[ Show Hold Indication Timer

[+ Release Voice Calls while on hold
Digital Management v

¢ Voice Auto Answer specifies that voice interactions are automatically answered when an agent
receives the invitation.

* Voice Auto Answer On Active Call specifies that a voice interaction is not automatically answered if
the agent has another active call.

« DTMF Tone specifies to play a tone when the agent select a DTMF key.
* Voice Auto Ready places the agent in the Ready state as soon as they log in.

* Auto Not Ready Reason places the agent in Not Ready state as soon as they log in. When you select
this option, define the default Not Ready reason code.
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* Show Post Call Duration allows the post-call duration for a voice call to be shown in the interaction
bar's tool tip area.

* Show Hold Indication Timer allows the hold duration to be shown to the agent in the interaction bar.
* Release Voice Calls while on Hold enables agents to manually end voice calls that are on hold.

* Conference enables one-step voice conferencing.

* Two-Step Voice Conference enables two-step voice conferencing.

¢ Clear Conference on Release clears a conference call of all parties when the last agent leaves the
conference call.

e Cancel ACW on Done specifies that the voice channel is to be returned to the agent's former
availability status when the agent marks the voice interaction as Done while in After Call Work status.

* Cancel ACW on Change specifies that After Call Work status should be cancelled when an agent
switches from After Call Work to Ready or Not Ready during a call.

* Lookup Contact for Voice activates Agent Desktop for contact lookup when an interaction is
presented to an agent.

* Create Contact for Voice will create a contact if the initial contact lookup fails to find an existing
contact.

e Caller ID Anonymous specifies whether the anonymous Caller ID is enabled. This option applies to
only outbound calls.

e Caller ID for Consultations enables agents to use a Caller ID for consultations.

e Caller ID for Conferences enables agents to use a Caller ID for single-step conferences.

e Caller ID for Transfers enables agents to use a Caller ID for single-step transfers.

* Routing Point for Skill Based Transfers specifies the call number used by the Routing Point feature.

* Routing Based Actions defines the list of routing-based actions that an agent can perform. Options
include:

* Make Call

* One Step Conference
* Initiate Conference

* One step Transfer

¢ Initiate Transfer

* Routing Based Targets defines the list of contact types to which an agent can route calls through the
actions defined in the Routing Based Actions option. Options include Agent, Routing Point, Type
Destination, Outbound Record, and Contact. Note that Agent Groups and Skills targets are not listed
here, because they are configured through a routing strategy.

e Options to exclude a range of numbers from the Team Communicator. For each option, if you enable it,
you must type a regular expression (RegEx) to match against the following items:

* Entered phone number

* Selected agent or routing point

For example, to exclude extensions that are 7 digits and start with the numbers 7 or 8, type
~(7]18)\d{6}$

Genesys Engage cloud Administrator's Guide 193



Agent Setup Desktop Options

* Make Call Exclude Number specifies the format for a phone number to exclude from Team
Communicator when making a call.

* Single Step Conference Exclude Number specifies the format for a phone number to exclude
from Team Communicator on a single step conference.

* Single Step Transfer Exclude Number specifies the format for a phone number to exclude from
Team Communicator on a single-step transfer.

* Consultations Exclude Number specifies the format for a phone number to exclude from Team
Communicator on consultation.

These options are not applicable to global or personal favorites.

¢ Voice Ringtone Type specifies the voice ringtone type. Enable the option and then select the ringtone
type from the drop-down list box.

* Voice Ringtone Priority specifies the priority level of the voice ringtone within the channels. Enable
the option and then type the number for the priority level.

* Voice Ringtone Duration specifies how long the ringtone rings. Use the following values:
» -1 specifies to repeat the ringtone until the call is answered.
e 0 specifies to play the ringtone only one time.

* 1 or more specifies to play the ringtone for the specified duration (in milliseconds) and then repeat
until the call is answered.

e Can One Step Transfer enables instant conferencing of a voice call.
¢ Can Two Step Transfer enables two-step transfer of a voice call.

* Can Extend After Call Work enables the extension of After Call Work indefinitely, until the user's
status is changed manually.

¢ Can Use WebRTC enables WebRTC in Agent Desktop. Note: The Can Use Voice Channel option must
be enabled.

¢ Can change speaker volume allows an agent to change speaker volume. Note: The Can Use Voice
Channel option must be enabled.

* Can mute microphone allows an agent to mute and unmute the microphone. Note: The Can Use
Voice Channel option must be enabled.

¢ Can mute speaker allows an agent to mute and unmute the speaker. Note: The Can Use Voice
Channel option must be enabled.

¢ Can send DTMF specifies if DTMF is available for WebRTC calls. Note: The Can Use Voice Channel
option must be enabled.

* WebRTC Ringtone Type specifies the voice channel ringing sound -
« WebRTC Ringtone Priority is the priority of ringtone. The higher the integer, the higher the priority.
* WebRTC Ringtone Duration:

* -1 plays means to play and repeat until an explicit message stops it with an established event.

* 0 means to play the entire sound one time.

* An integer greater than 0 means a time in milliseconds to play and repeat the sound.
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Chat options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Chat section of the Contact Center Settings page, configure the following options:
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Chat

Chat Auto Answer
B4 chat Rejact

B Chat Nickname User Mame i

B Lookup Contact for Chat
B Create Contact for Chat
Click fram Chat to Voice
Click from Chat to eMai

Chat Interaction Ringtone Type

Chat Interaction Ringtone Priority 7
Chat Interaction Ringtone Duration -1
Chat Message Ringtone Type

Chat Message Sound Priority ¥
Chat Message Sound Duration a

B Can Two Step Transfer

B Can Two Step Conference

/w

¢ Chat Auto Answer specifies that chat interactions are automatically answered when an agent receives
the invitation.

¢ Chat Reject enables agents to reject incoming chats.
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¢ Chat Nickname specifies the nickname that is displayed on the chat window in interactions. Type one
the following syntax options:

* $Agent.UserName$ to display full username.

* $Agent.LastName$ to display only last name.
* $Agent.FirstName$ to display only first name.
* $Agent.FullName$ to display full name.

* $Agent.Employeeld$ to display employee ID.

¢ Lookup Contact for Chat activates Agent Desktop for contact lookup when an interaction is presented
to an agent.

* Create Contact for Chat will create a contact if the initial contact lookup fails to find an existing
contact.

¢ Click from Chat to Voice enables users to initiate a voice interaction by clicking a phone number in a
chat transcript.

¢ Click from Chat to eMail enables users to initiate an email by clicking an email address in a chat
transcript.

e Chat Interaction Ringtone Type specifies the chat ringtone type. Enable the option and then select
the ringtone type from the drop-down list box.

¢ Chat Interaction Ringtone Priority specifies the priority level of the chat ringtone within the
channels. Enable the option and then type the number for the priority level.

¢ Chat Interaction Ringtone Duration specifies how long the ringtone rings. Use the following values:
e -1 specifies to repeat the ringtone until the chat is answered.
* 0 specifies to play the ringtone only one time.

* 1 or more specifies to play the ringtone for the specified duration (in milliseconds) and then repeat
until the chat is answered.

 Chat Message Ringtone Type specifies the chat message ringtone type. Enable the option and then
select the ringtone type from the drop-down list box.

* Chat Message Sound Priority specifies the priority level of the chat message sound within the
channels. Enable the option and then type the number for the priority level.

« Chat Message Sound Duration specifies the length of the sound. Use the following values:
» -1 specifies to repeat the sound until the chat message is read.
* 0 specifies to play the sound only one time.

* 1 or more specifies to play the sound for the specified duration (in milliseconds) and then repeat
until the chat message is read.

e Can Two Step Transfer enables two-step transfer of a chat, beginning with a chat consultation.
 Can Two Step Conference enables two-step conference of a chat, beginning with a chat consultation.
¢ Can One Step Transfer enables instant chat transfer.

* Auto-disconnect automatically disconnects a chat session when the agent is the last remaining party.

¢ On-hold Queue specifies the Interaction Queue where a chat interaction is placed when an agent
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places it on hold. This option can be overridden by a routing strategy.

* Warning time specifies the time in seconds that a warning alarm alerts an agent of a customer
awaiting a chat response.

« Maximum time specifies the time in seconds

* Prompt for end displays a confirmation prompt to an agent when they select End. This option can be
overridden by a routing strategy.

¢ URL push max records specifies the maximum size of the pushed URL list.
¢ Timestamp specifies whether the timestamp is displayed in the Chat transcript area.
* Typing specifies whether a typing notification is sent to customers during a chat interaction.

¢ Typing timeout specifies the duration in seconds of when the typing notification is displayed after the
last keystroke.

* Decline allows an agent to decline incoming chat interactions.
¢ URL push allows an agent to push URLs to customers during chat sessions.

* Interaction Disposition allows an agent to set a disposition code for chat interactions.
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Email options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Email section under Desktop Options, configure the following options:
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Desktop Options

Email

1 Email Auto Answer
] Email Forward
LI Forward email inline

Forward prefix

M Lockup Contact for Emai

B Create Contact for Emai

Email Interaction Ringtone Type

Email Interaction Ringtone Priority

Email Interaction Ringtone Duration

] Enable CC Addresses
1 Enable Instructions
1 Enable Multiple to Addresses

Email Max Attachments Size

1 can Cne Step Transfer

-1

* Email Auto Answer specifies that email interactions are automatically answered when an agent

receives the invitation.

* Email Can Decline enables agents to decline an incoming email.

* Enable Email Send enables agents to send outgoing email.

Enable Email Save enables agents to save in-progress outgoing email.

Enable Add Attachment enables agents to add attachments to outgoing email.
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¢ Allow Email Deletion enables agents to delete an email.
 Enable Email Reply enables agents to reply to an email.
* Enable Email Reply All enables agents to reply all to an email.

 Email Address Regular Expression specifies the regular expression used to recognize an email
address of a target entered in Team Communicator.

 Email Forward enables agents to forward emails to another agent.

¢ Forward email inline enables agents to forward an email as part of the body of an email, instead of as
an attachment.

* Forward prefix specifies the prefix added to an email that includes an inline email. For example,
"Fwd:".

¢ Lookup Contact for Email activates Agent Desktop for contact lookup when an interaction is
presented to an agent.

¢ Create Contact for Email will create a contact if the initial contact lookup fails to find an existing
contact.

* Email Interaction Ringtone Type specifies the email ringtone type. Enable the option and then select
the ringtone type from the drop-down list box.

* Email Interaction Ringtone Priority specifies the priority level of the email message ringtone within
the channels. Enable the option and then type the number for the priority level.

¢ Email Interaction Ringtone Duration specifies how long the ringtone rings. Use the following values:
* -1 specifies to repeat the ringtone until the email message is read.
* 0 specifies to play the ringtone only one time.

e 1 or more specifies to play the ringtone for the specified duration (in milliseconds) and then repeat
until the email message is read.

* Enable CC Addresses enables the ability to select CC addresses.

* Enable Instructions enables an instruction field in the email message being forwarded.

¢ Enable Multiple to Addresses enables the ability to select more than one address in the To line.
* From Addresses

 Email Max Attachments Size specifies the maximum size in megabytes allowed for files attached to
an external email interaction. Files larger than this maximum size will be refused by the system and an
error message will be displayed to the user.

* Can One Step Transfer enables one-step transfer for emails.

¢ Enable Interim Send enables agents to send an interim email before a final reply.

* Enable Click to Dial from Email enables agents to dial a phone number while handling an email.
e Allow Moving Email to Workbin enables agents to move an email to Workbin.

« Allow Email Format Toggle enables agents to toggle between HTML and text formats.

e Allow Email HTML Format enables agents to use HTML formatting.
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Outbound options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Outbound section under Desktop Options, configure the following options:
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Outbound

¥ Allow Reject Preview Record

[ Allow Cancel Record

[+ Allow Marking Record as Do Mot Call

0 Allow Reschedule Outbound Record

¥ Allow Reschedule Before Calling Contact
¥ Allow Reschedule on New Number

M Allow Setting Call Result

[1 Treatment Mode

[+ Allow Reguest Next Preview Record
¥ Allow Dialing an Alternative Chained Record
¥ Allow Push Preview

M Max Simultaneous Preview Record

M Timed Preview Auto Dial
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* Allow Reject Preview Record enables agents to reject a preview record. If an agent declines a
preview record, it can be processed by another agent in the campaign.

* Allow Cancel Record enables agents to cancel a preview record. If an agent cancels a preview record,
it is not processed again during the current campaign.

« Allow Marking Record as Do Not Call enables agents to mark a contact as Do Not Call.
¢ Allow Reschedule Outbound Record enables agents to reschedule an outbound record.

¢ Allow Reschedule Before Calling Contact enables agents to reschedule a call before calling the
contact on the record.

¢ Allow Reschedule on New Number enables agents to add a new record to the chain by rescheduling
with a new number.

* Allow Setting Call Result enables agents to set call results for outbound interactions.

* Treatment Mode specifies the type of treatment to be applied for the outbound record after it is
marked as processed. If not set or set to none, no treatment is applied.

¢ Allow Request Next Preview Record enables agents to request a new preview record while
processing of the previous preview record terminates.

¢ Allow Dialing an Alternative Chained Record enables agents to dial a number from the preview
record chain that is different than the number selected by the system.

¢ Allow Push Preview enables agents to use outbound push preview.

¢ Max Simultaneous Preview Record specifies the maximum number of simultaneous Outbound
Preview records an agent can view in the interaction window.

* Timed Preview Auto Dial specifies the method in which calls are dialed for agents in Preview, Push
Preview, or Reschedule campaigns.The options are as follows:

e The agent can manually dial a record.
* The record is auto-dialed as soon as the record is accepted.

* The record is auto-dialed after a specified number of seconds.
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Facebook options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Facebook section under Desktop Options, configure the following options:

Facebook

[ Facebook Auto Answer
[ Prompt for Done

Facebook Ringing Bell

[ Can Decline
¢ Can Mark Done
¥ Can One Step Transfer

B¢ Can Set Interaction Disposition

* Facebook Auto Answer automatically accepts a Facebook interaction when an Invite event if
received.

* Prompt for Done prompts a confirmation message when the agent clicks Done.
* Facebook Ringing Bell specifies the sound played when a Facebook interaction is ringing.

* Decline allows the agent to decline an incoming interaction. This option depends on the Channels
option for Facebook.

* Mark Done allows the agent to mark an interaction as Done with further processing. This option
depends on the Channels option for Facebook.

¢ One-step transfer allows the agent to use one-step transfer.

* Set Interaction Disposition allows the agent to set a disposition code before marking an interaction
as Done. This option depends on the Channels option for Facebook.
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Twitter options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Twitter section under Desktop Options, configure the following options:

Twitter

[ Twitter Auto Answer

C Prompt for Done
Twitter Ringing Bell

¥ Can Decline

¥ Can Mark Done

¥ Can One Step Transfer

[¥ Can Set Interaction Disposition

¢ Twitter Auto Answer automatically accepts a Twitter interaction when an Invite event if received.
* Prompt for Done prompts a confirmation message when the agent clicks Done.
* Twitter Ringing Bell specifies the sound played when a Twitter interaction is ringing.

¢ Decline allows the agent to decline an incoming interaction. This option depends on the Channels
option for Twitter.

* Mark Done allows the agent to mark an interaction as Done with further processing. This option
depends on the Channels option for Twitter.

* One-step transfer allows the agent to use one-step transfer.

* Set Interaction Disposition allows the agent to set a disposition code before marking an interaction
as Done. This option depends on the Channels option for Twitter.
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Workitem options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Workitem section under Desktop Options, configure the following options:

Workitem

[ Auto Answer
[ Prompt for done

¥ Workitem Ringtone Type Bell ~

¥ Workitem Ringtone Priarity 7

¥ Workitem Ringtone Duration -1

¢ Can Decline
[ Can Mark Done
¥ Can One Step Transfer

¥ Can Set Interaction Disposition

¢ Auto answer automatically accept an interaction when an invite event is received.

* Prompt for done presents a confirmation message to the user when they press the Done button. This
option is only available for Open Media interactions.

* Workitem ringtone type specifies the sound that is played when a Workitem interaction is ringing.

* Workitem ringtone priority specifies the priority of a Workitem ringtone. The higher the integer, the
higher the priority.

* Workitem ringtone duration specifies the duration of a Workitem ringtone (-1 plays and repeats the
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sound until an action is taken, 0 play the whole sound one time, and an integer > 0 sets a time in
milliseconds to play and repeat the sound).

* Decline enables the agent to decline incoming Workitem interactions.
* Mark Done enables the agents to mark done a Workitem interaction without further processing.
¢ One-step transfer enables the agent to use instant Workitem transfer.

* Interaction Disposition enables the agent to set the disposition codes for Workitem interactions.
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Recording options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Recording section, you can configure the following options:

Recording

[ Call Recording

[J Screen Recording

¥ Can Start Call Recording
¥ Can Pause Call Recording
¥ Can Resume Call Recording

[ Can Stop Call Recording

¢ Call Recording sets the agent's desktop to record all voice interactions.

¢ Screen Recording sets the agent's desktop to record all screen interactions.
¢ Can Start Call Recording allows the agent to start an active recording.

e Can Pause Call Recording allows the agent to pause an active recording.

e Can Resume Call Recording allows the agent to resume an active recording.

e Can Stop Call Recording allows the agent to stop an active recording.
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Contact options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Contact section of the Contact Center Settings tab, you can enable the following options:
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Contact

[ contact

UCE for Voice
E Aszsign Contact
E Save Contact
E Delete Contact

E Use Contact History

[# Contact History Display=d Columns Status, Subject. Start Date, End Date, Agent Mame -
E Zearch Contact History

[ contact History Search Attributes Subject, From Address -
[ vs= My History

[# Contact My History Displayed Columns Status, Subject. Start Date, End Date, Agent Mame -

[# Search My Histary

[ caq = tributes Subjec; ddress -

e Contact enables agents to access contact features.

* UCS for Voice enables the Universal Contact Server to generate voice interaction history in Agent
Desktop. This option is enabled when the Contact and Voice check boxes are selected.

* Assign Contact enables agents to assign contacts to an interaction. This option is enabled when the
Contact check box is selected.

e Save Contact enables agents to modify contacts.
* Delete Contact enables agents to delete contacts.

¢ Use Contact History enables agents to access contact history. This option is enabled when the
Contact check box is selected.

e Contact History Display Columns allows you to manage the interaction attributes you want to
display in the Contact History view in Agent Desktop. This option is enabled when the Contact and
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Use Contact History check boxes are selected.

* Search Contact History enables agents to search contact history. This option is enabled when the
Contact and Use Contact History check boxes are selected.

¢ Contact History Search Attributes allows you to manage the interaction attributes you want to
display in the Contact History Quick Search view in Agent Desktop. This option is enabled when the
Contact, Use Contact History, and Search Contact History check boxes are selected.

¢ Use My History enables agents to access their own contact history. This option is enabled when the
Contact check box is selected.

¢ Contact My History Displayed Columns allows you to manage the interaction attributes you want to
display in the My History view in Agent Desktop. This option is enabled when the Contact and Use
My History check boxes are selected.

* Search My History enables agents to search their own contact history. This option is enabled when the
Contact check box is selected.

e Contact My History Search Attributes allows you to manage the interaction attributes you want to
display in the My History Quick Search view in Agent Desktop. This option is enabled when the
Contact, Search My History, and Search My History check boxes are selected.

* Open from History allows agents to open in-progress emails from the interaction history. This option is
enabled when the Contact and Email check boxes are selected.

¢ Use Directory enables agents to view and search the contact directory. This option is enabled when
the Contact check box is selected.

* Contact Directory View specifies the format for the Contact History View. Options include List View
or Grid View. This option is enabled when the Contact check box is selected.

e Contact Notepad allows an agent to display and edit notes while handling an interaction. The notepad
is a feature that enables agents to enter comments about the current interaction or about a selected
interaction. Agents can view the note in most channels as well as contact history, My History, and My
Workbin.

¢ Use Contact History Notepad allows an agent to see notes about interactions in Contact History.
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Interaction History Advanced Search

options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Interaction History Advanced Search section, you can configure the following options:

[# Can Search all Interactions

[ Can Advanced Search all Interactions

[# Can Filter all Interactions

[ All Interactions Quick Search Attributes

[ History Search Attributes

[ Date Search Types

[ All Interactions Displayed Columns

Revert

Interaction History Advanced Search

Subject

Subject, Start Date, End Date, Status

0On, OnOrAfter, Before, Between

Subject, Start Date, End Date, Status

¢ Can Search all Interactions allows an agent to search among all interactions.

e Can Advanced Search all Interactions allows an agent to conduct an advanced search among all

interactions.

¢ Can Filter all Interactions allows an agent to filter all interactions.

All Interactions Quick Search Attributes specifies the interaction attributes used to search
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interactions in quick search mode of the Interaction Search view.

* History Search Attributes specifies the list of interaction attributes an agent can use in the Advanced

Search mode of the Contact History, My History and Interaction Search views.
Search attributes include Subject, Start/End Date, Status, Contact, From Address, Phone Number,

Released Date, Sent Date, Notes, and Interaction Type.

* Date Search Types specifies the search types available to search the contact database by date. Types
include On, On or After, Before, and Between.

« All Interactions Displayed Columns specifies the interaction attributes displayed in the result list of
the Interaction Search view.
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Standard Response Library options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Standard Response Library

[¥ Enable Standard Response Library
[ Standard Response Library - Can do Quick Search

Standard Responses Categories Filter SANIS

In the Standard Response Library section, you can enable or disable the Standard Response
Library and the ability to Quick Search within the library. You can also apply a filter to specify what
response categories are available to the agent in Agent Desktop.

Genesys Engage cloud Administrator's Guide 215



Agent Setup Desktop Options

Genesys Softphone options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Genesys Softphone section of the Contact Center Settings page, you can enable the
following options:

Genesys Softphone
[ Usage of Genesys Softphone
[ Can change microphone volume
[ Can change speaker volume
[J Can mute microphone
[ Can mute speaker
Voice Quality Alarm Threshold 0

Uri https://localhost:8000

[ Use Headset

Headset Name

¢ Usage of Genesys Softphone enables the use of Genesys Softphone.

e Can change microphone volume allows the agent to control the volume of their microphone.
e Can change speaker volume allows the agent to control the volume of their speaker.

¢ Can mute microphone allows the agent to mute and unmute their microphone.

¢ Can mute speaker allows the agent to mute and unmute their speaker.

* Voice Quality Alarm Threshold specifies the mean opinion score (MOS — a measure of reported
network quality ratings) threshold for generating Voice Quality Alarms. The value 0 disables the alarms.
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The recommended threshold value is 3.5.
¢ URI specifies the URI of the SIP endpoint.
* Use Headset enables the use of a headset for voice calls.
« Headset name specifies the name of the headset model if Use Headset is enabled.
¢ Can Use WebRTC - Enables WebRTC in Workspace. Depends on 'Voice - Can Use Voice Channel'.

* Can change speaker volume - Allows an agent to change speaker volume. Depends on 'Voice - Can
Use Voice Channel' and 'WebRTC - Can Use WebRTC'.

* Can mute microphone - Allows an agent to mute and unmute the microphone. Depends on 'Voice -
Can Use Voice Channel' and 'WebRTC - Can Use WebRTC'.

¢ Can mute speaker - Specifies if DTMF is available for WebRTC calls. Depends on 'Voice - Can Use Voice
Channel' and 'WebRTC - Can Use WebRTC'.

e Can send DTMF - Specifies if DTMF is available for WebRTC calls. Depends on 'Voice - Can Use Voice
Channel' and 'WebRTC - Can Use WebRTC'.

* Quality request interval - Specifies the voice channel ringing sound-configuration string. It consist of
three options:

* WebRTC Ringtone Type - Set WebRTC call ringing sound. Depends on 'Voice - Can Use Voice
Channel' and '"WebRTC - Can Use WebRTC".

* WebRTC Ringtone Priority - Set WebRTC call ringing priority between different channels. Depends
on 'Voice - Can Use Voice Channel' and 'WebRTC - Can Use WebRTC".

* WebRTC Ringtone Duration - Set WebRTC call ringing duration. Depends on 'Voice - Can Use
Voice Channel' and 'WebRTC - Can Use WebRTC'.
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Feedback options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the Feedback section, you can enable the following options:

Feedback

[ Feedback

[ Feedback After Disconnect

Feedback Max Length 10000

=]

* Feedback enables the Feedback icon to be displayed on the About dialog box.

* Feedback after disconnect enables the Feedback dialog box to be displayed when a user's browser
unexpectedly disconnects. The Feedback dialog box is displayed when the user logs back in.

 Feedback Max Length specifies how many characters are accepted in the Feedback dialog box.

When Agent Desktop or Gplus Adapter doesn't work as expected, Genesys recommends that agents
report the incident in the following ways:

* Use the Feedback options to capture logs and details about what the agent was doing in their most
recent Agent Desktop or Gplus Adapter session. These logs are sent directly to Genesys and are
available to Customer Care for later reference. To provide feedback reports to Genesys, depending on
what you enable in the Feedback section of the Desktop Options page, agents can use either the:

» Feedback option on the Help menu

* Feedback dialog box that is displayed after the web browser unexpectedly disconnects and
reconnects

e Afterwards, report the incident to their direct supervisor or administrator in person, following your
organization's reporting policies and procedures.
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When an agent reports an issue to a supervisor or administrator, that person should contact Genesys
Customer Care as soon as possible to provide the reporting user's name and DN at the time of the
incident, as well as the approximate time the incident occurred. At this point, the Customer Care
agent should be able to retrieve the relevant logs that were sent through the Feedback options to
determine what the issue might have been.
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My Channels options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In the My Channels section, you can enable the following options:

My Channels

[ My Channels

[1 My Channels Pending State

* My Channels allows an agent to access the My Channels tab.

* My Channels Pending State allows an agent to have a pending state in My Channels.
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Service Client options

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Before using the Service Client API to customize how your web application or website integrates with
Agent Desktop, first set the Service Client options in Agent Setup.

In the Service Client section of the Contact Center Settings page, configure the following
options:

Service Client

[ Block Mark Done Timeout 1000
List of User Data Read Allowed *
List of User Data Write Allowed *

B Auto Login

Block Mark Done Timeout specifies the duration of timeout in milliseconds. This timeout duration is
started by the function interaction.blockMarkdone().

List of User Data Read Allowed specifies the list of keys that can be read in the user data. This
applies to the UserData property of the interaction object returned by a function or an event.

List of User Data Write Allowed specifies the list of keys that can be written to when using functions
interaction.setUserData() and interaction.deleteUserData().

Auto Login returns an agent to their previous state if they are unexpectedly logged out of Agent
Desktop.
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Agent accounts

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

On the Users tab, you can manage agent accounts, including adding new accounts, importing agent
accounts from an external file, and exporting agents.

e To perform most tasks on user accounts, your account must have Administrator
privileges. If you are unable to perform certain actions using the Agent Setup interface,
check that your account privileges are correct.

* To add administrator accounts to your contact center, you can either import the
administrator accounts or use Platform Administration.

After you log in to the Agent Setup interface, the first screen that you will see is the Users tab. If
your contact center already has agents assigned to it, you see a list of configured agents. In a fresh
installation, you might see an empty list. Regardless, as part of your regular maintenance on your
contact center, you need to add agents.

How do | add a single agent?

Link to video

Click the Add User link. You can select a template from the Template drop-down list box if you have
configured one or more templates. A template automatically selects some of the options on the Add
User screen.

Complete all the required (*) fields on the screen. If you make an error, a message is displayed to tell
you the correct format for a field. Most fields are self-explanatory, such as the name and email fields.

This video demonstrates how to add a single agent.

Use the following table for advice on how to fill in the fields:
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Option
Folder

First Name
Last Name

Username

Login Code

Email

Reset Password

Password
Password confirm
Employee ID
External ID

Capacity Rule
State enabled

Multimedia Agent

Supervisor

Phone Number(s)

Place Name

Use

Description

From the drop-down list box, select the business
group to which you want to assign the user.

Type the first name of the user.
Type the last name of the user.
Type the username for the user.

Optional. Type a login code for the user. An
example of a login code is the user's employee ID.

The Login Code option is hidden by default,
therefore, it might not be displayed on your screen. If
you require the Login Code option, contact Genesys
Professional Services to request that they enable the
Agent Login Code option.

Optional. Type the user's email address.

When selected, this option specifies that when the
next time the user logs in, he or she will be
prompted to change the password. This option only
applies to agent user accounts.

Type a default password for the user.
Type the password again.

Optional. Type the user's employee ID.
Optional. Type the user's external ID.

Optional. Choose an existing Capacity Rule from
the drop down.

Enables or disables the user account.

Specifies that this agent is only enabled for
multimedia (non-voice).

Select this option if this agent has a supervisory
role.

In addition to the default phone number, you can
assign additional phone numbers to the agent. The
agent has the opportunity to select the number
when they log in to accept calls.

For example, if you type hjackson in the Username field, when
you type a phone number in the Number field of the first row,
the Place Name field displays hjackson. If you type a number
in the second row, the associated Place Name field displays
hjackson2 and the place name in the first row changes to
hjacksonl. If your contact center has a requirement to specify
unique place names for different business groups or regions,
you can overwrite the default place name.

The value that you type in the Username field
automatically populates the Place Name column.
If you don't want to use the username as a place
name, clear the Use check box.

The Use option specifies that the username is to
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Option

Wrap Up Time

Agent Voice Mail
Softphone

SIP Phone Type

Skills

Caller IDs

Agent Groups

Annex

Favorites

Switches

External URLs

Filter

Description

be used for the associated phone number. This
option is selected by default. When you clear the
Use check box, the phone number is used as a
place name.

You can configure wrap up time for an agent. Wrap
up time is the amount of time the agent is allotted
to complete after-call tasks, such as typing notes or
selecting a disposition. The wrap-up time is
measured in seconds. To disable wrap up time, type
0.

Type the voice mail box extension number for the
agent to use.

Select this check box if this user will use a
softphone.

When you enable Softphone, you must select a
softphone type.

Select the skills that you want to assign to the
agent, assign a skill level, and click Add. With
many skills to choose from, you can filter the list of
skills by using the search box.

Click Caller ID and add at least one identifier to be
displayed on a receiver's call display. If you add
more than one, the agent has the option to choose
which caller ID they want to display. You can also
enable the agent to use an anonymous caller ID.

Assign this agent to an agent group, which is a
logical grouping of agents that provide particular
sets of contact center services. For more
information about agent groups, see Managing
Agent Groups.

Assign this agent to an access group, which is a
logical grouping of agents that are provided
specific access permissions.

Personal Favorites is a list of Agents, Agent Groups
or external contacts that group members
frequently dial. This list provides a click-to-call list
of these numbers on Agent Desktop. Personal
favorites are configured the same way as Global
Favorites. See Global Favorites.

Select the switches where DNs and Agent Logins
should be provisioned.

Integrate internal and external websites into your
agent's main view. See External URLs.

For each agent group, you can control what
information that group can see from other agent
groups in the Team Communicator, Favorites, and
Statistics. After you select an agent group on the
Agent Groups window, select the Filter option on
the menu bar. In the list of agents groups, you can
choose to restrict or exclude agent groups by
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Option Description

selecting the appropriate check boxes. You can also
manage filters on the Desktop Options page. For
more information, see Desktop Options.

Assign channels and other options to the agent by
clicking Desktop Options and then selecting from
Desktop Options the listed options. You can select more than one
option. For a detailed look at what options you can
configure for an agent, see the Desktop Options.

CRM Adapter: Use the CRM Adapter tab to
configure the Gplus Adapter option settings for the
agent group. For information, see CRM Adapter
settings.

CRM Adapter

The recording hierarchy for an agent specifies the
access control applied to recordings of calls
handled by that agent. Select the Recording

Recording Hierarchy Hierarchy check box, and then type the hierarchy
string. See Access control for Recording users for
more information about Recording agent hierarchy,
access groups, and partitioning.
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Editing agents
single user account

Folder IPFS/
First Name = Usemame #
Mitchell mmarner
Last Name = Password # Reset Password
Marner A R B B R SRR R A R
Email Password confirm +

[# State Enabled
Multimedia Agent

w

multiple user accounts

Edit Users

Commaon annex options:
= Add Section

[+ State Enabled

o =n

You can edit a single agent or a group of agents. When you edit a single agent, you can edit any of
the agent's details. For a group edit, the two options available for you to edit are Annex and Skills.

When you edit one agent, click the agent's name in the Name column. In the Manage User window,
you can make your updates.

To edit multiple users at once, select the agents that you want to edit, click Edit Users, and then
make your changes in the Edit Users window. When you edit multiple users, consider the following:

* You can add Annex options or modify existing options. You can only delete Annex options that are
identical for all selected agents.

e Only values that are common for the selected users are shown for Skills and Annex. For example, if:

* Agent 1 has Russian skill level of 10 and English skill level of 5
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* Agent 2 has Russian skill level of 10 and English skill level of 7

You will see the Russian skill level of 10 and English skill level is blank on
the Edit Users screen under Skills.

Link to video

This video gives you a demonstration on how to update multiple agents.

Importing agent accounts

When you need to add a large number of agent accounts, you can use the Bulk Import tab in Agent
Setup. By importing a large number of agent accounts at one time, you won't need to add the
accounts one at a time and you can apply a template to configure options, such as DN, place, person,
and login options, to all accounts.

How do | import a file that contains agent accounts?

Link to video
Before you can import agent accounts , you must have a .CSV file that has all the required data.

The values from the imported file overwrite corresponding values that are specified in the template.
For example, the value for the Skill parameter in the imported file takes precedence over the value
for the Skill parameter that is specified in the template.

When you are ready to import the file, click Choose File, select the file from your local device, and
then click Import. If you want, you can validate the file to ensure that it is structured correctly.

About CSV files

The .CSV file must be a text file in a comma-separated format. In the source file each line represents
a single user or agent.

When you import a .CSV file, each parameter value is updated according to the following rules:

e If value is present, the new value replaces the previous value.
e If an empty value is encountered, no change is made.

e If the value includes /d , the attribute is unassigned and deleted. If the value includes /r , the attribute
is unassigned only.

e If no corresponding record is found, an error message is logged and the updated continues to process.
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[+] Show .CSV file parameters

Property

Username

First Name

Last Name

Email

Extension

Extension2

Extension3

Folder

Place Name

Place Name2

String

String

String

String

String

String

String

String

String

String

Type

Mandatory?

Yes

Yes

Yes

No

No

No

No

No

No

No

Action

ADD, UPDATE,
DELETE

ADD, * needed for
UPDATE if First
Name change

ADD, * needed for
UPDATE if Last
Name change

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

/d to unassign and
delete
/r to unassign only

Description

The unique
username of the
agent or user.

The first name of
the agent or user.

The last name of
the agent or user.

The agent or
user's email
address.

The extension #1
of the agent. A
place is also
created if the
extension is
specified.

The extension #2
of the agent. A
place is also
created if the
extension is
specified.

The extension #3
of the agent. A
place is also
created if the
extension is
specified.

The folder path to
root folder
(Persons) where
new agent or user
is created. For
example,
Company/
Department/Team.

The place name
#1 of the agent.
The place name
"Extension" is
used if not
specified.

The place name
#2 of the agent.
The place name
"Extension2" is
used if not
specified.
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Property Type Mandatory? Action Description

The place name
#3 of the agent.
The place name
"Extension3" is
used if not
specified.

/d to unassign and
Place Name3 String No delete
/r to unassign only

The name of the

Default Place String No Default Place.

The employee
Employee ID String Yes ADD identifier of the
agent.

Specifies that the
user will be

No prompted to
change the
password on their
next log in.

Change Password Boolean

Y specifies that the
agent account is
enabled.

N specifies that
the agent account
is disabled.

Enabled Boolean No

e Specifies that
this user is an
agent. If this
field is set to a
Y but the Is
Supervisor field
is not, only the
Agent Login,
DN, and Places
for the agent
are created. If

Is Agent Boolean Yes ADD thels ,
Supervisor field
issettoa,
additional
supervisor
features and
permissions
are enabled.

e If the useris an
administrator,
this field is not
required.

Any external ID
External ID String No used to identify
the user.

Login ID String No The user's login ID.
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Property Type Mandatory? Action Description

Y specifies that
this useris a
supervisor. If this
is the case, the Is
Agent field must
be set to Y. At that
point, all required
desktop logins and
features are
enabled, along
with the required
supervisor
features and
permissions.

Is Supervisor Boolean No

Y specifies that
this user is an
administrator. If
this is the case,
the Is Agent field
(and Is Supervisor
field) is not
required.

Is Admin Boolean Yes

The number of
seconds an agent
remains in ACW

Wrap Up Time Numeric No after call is
disconnected. This
field applies only
to voice calls.

If specified,
populate the
following option to
the Annex of all

associated Agent
VoiceMail.MailBox String No log ins:

AgentLoginAnnex:TServer/
gvm_mailbox. Valid
values: numerical

(12345)

If specified,
populate the
following option to
the Agent's
Annex: [recording]
agent_hierarchy.

The type of SIP
phone the agent is
using as a
softphone.

The number that
Skill:<skill_name>  Numeric No identifies the
agent's skill level

Recording

Hierarchy Sl No

SIP Phone Type String No
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Property Type Mandatory? Action Description

for the specified
skill.

Y means that a DN
and Agent Login
Switch:<switch_nameBoolean No are created for the
agent on the
specified switch.

Y means that the
agent is added to
the specified agent
group.
Any custom Annex
value. For
example, column
Annex String No name
Annex:htcc/roles
with a value of
Agent.

ADD adds a new
agent.

UPDATE updates
an existing agent.
DELETE removes
an existing agent.

AgentG:<agent_grouBoalee> No

Action String No

[+] Show an example

First Name,Last Name,Employee Id,Username,Is Agent,Is Supervisor,Is Admin,External
Id,Login ID,Extension,Skill:English,Switch: San Fran,Switch:
London,AgentG:Good,AccessG: Super,Annex,Action,Folder,Wrap Up Time,Enabled
Sarah,Lee, 223344 ,sarahl@acme.com,N,Y,Y,ADD,Acme/Branch/Team 1,60

John,Doyle, 223465, johnd@acme.com,Y,N,N,2233,1,Y,N,ADD,Acme/Branch/Team 2,0

Robert, Cook, 244456 ,bobc@acme.com,Y,Y,Y, johnd@acme.com,5,Y,Y,ADD,Acme/Branch/Team
3,60,Y

When performing a bulk import, the Password field is not included in the imported
file. A default password is associated to each user account in the imported file. The
format of the default password is: <username>@<company-
name>.com-<Month>-<year>, where <Month> is the three-digit abbreviation for the
month. For example, hjackson@demo.com-Feb-2017. The Reset Password option is
automatically enabled when adding or importing new users, therefore, all users are
prompted to reset their password the next time that they log in.
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How do | stop an import?

Bulk Import

Choose a csv file for import

Template Mo Template v m Validate

[+ Validate Before Import

Choose File | users 2017-._.1-17 PM.csv
D

Stop Import

Are you sure you wish to stop the import process?

Cancel

el

When you stop an import, a window is displayed in which you can confirm that you really want to

stop the import. After you click Stop, agents records that were imported before you clicked Q are
retained and the import process does not proceed.

Exporting agent accounts

There may be circumstances where you need to create a backup file of all your agent accounts or you
might want to export agent accounts to update them using another application and then import them
back in. When you export agent records, a spreadsheet document is downloaded to your local
computer.
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Agent Setup Contact Center Settings gent Groups ansactions

+ Add User
4 Username $ Roles Skills
PPP Admin Mo Skills Assigned
% Export All
— — — agent1_conf Agent Mo Skills Assigned
O agent1_conf_domain_cs agent1_conf_domain_cs Agent No Skills Assigned
O agent1_conf_domain_db agent1_conf_domain_db Agent No Skills Assigned
O agent2_conf agent2_conf Agent No Skills Assigned
O admin1_staging_aws_us-west-1_gws-upagr... admin1_staging_aws_us-we... Agent, Admin No Skills Assigned
agent1_staging_aws_us-west-1_gws-upqgr... agent1_staging_aws_us-we... Agent 2 Skills
agent2_staging_aws_us-west-1_gws-upqgr... agent2_staging_aws_us-we... Agent 2 Skills
s-west-1_gws-upgr... agent1_staging_aws_us-we 1 Skill

On the Users page, you can export all users or a subset of users.

e Export All: Click the down arrow on the User Actions menu and select Export All.

¢ Export Selected: To select a subset of users, select the users and then select Export Selected from
the User Actions menu. You can select the users by:

e Click the check boxes next to the users you want to export.

* Filter the list of users by using the search boxes at the top of the Users list and then click Select All
or individually select the users you want to export.

Genesys Engage cloud Administrator's Guide 233



Agent Setup

Agent accounts

How do | select the fields that | want to export?

Export Users

Please select fields to export, fields with * are required.

File Nﬂmﬂ:' users

Field

Access Group
] Agent Groups
Annex

Change Password

] Default Place

] Email
Employee Id
Enabled

" Farkmm i

Cancel

Import Action v

qp

On the Export Users window, you can give your exported file a custom name. This makes it easier
for you to locate on your local system after you export. You can either accept the default selections or
customize the list. If you want to export all fields, select the check box at the top of the list, next to

the Field label.
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Important

* If you are exporting your user accounts as a means to modify the records and then
import them back in, select the Import Action field. If you don't select this field, the
.CSV file will not import correctly.

e If you are including Skills in your export, the skill level must be zero or greater for it to
be listed in the export files.

Where did my export go?

Export Users

Please select fields fo export, fields with *are required.

File Name:” S

A B C D E F G H | J K
Finl MName Last Mame Email Extension Extension; Extension: Folder Place Narmr Mlace Nam Place N

W O =) Oh W e W Ry

When the progress bar at the top of the Export Users window reaches 100 per cent, the document
is completely downloaded to your local computer. How you access your downloaded files varies by
operating system. In general, you can open your Downloads folder, and look for the .csv file that
corresponds to the file name you specified.

You can then double-click the file to open it and view the exported data.
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If you use Microsoft Excel, the program automatically truncates all leading zeros from

numbers in CSV files when you open the file by double-clicking on its name. You need

to change at least the columns where the leading zeros occur to text format. For more
information on how to resolve this issue, see this FAQ.

Locating agent accounts

What you see in the Agent Setup interface is determined by your permission settings.

o
C’Q Agent Setup Users

Username

If you see a red check box next to an agent account, this means that the agent's
account is not valid due to some missing information. Hover your mouse over the
check box to see what information is missing. For example, if a voice agent does not
have a configured default Place Name field and your contact center is not configured
to prompt the agent to enter place when he or she logs in, the agent's account is
considered invalid until you update the agent account to supply the missing
information.

Note the following options that you can use to locate specific agents on the list:
* Search by Name/Username: Use this field to type an agent name or username, or part of an agent's
name, to filter the list to display only agents that match your search words.

¢ Agent Groups: Use this field to type the name of an agent group. All agents that are assigned the
specified agent group will be listed.

¢ Roles: Use this drop-down list box to filter the list to display only agents that are assigned a specific
role.

* Skills: Use this drop-down list box to filter the list to display only agents that are assigned a specific
skill.

e State: Use this drop-down list box to filter the list to display either All, Enabled, or Disabled.

* Page navigation: To scroll through the list pages, use the back and next arrow next to the page
number at the bottom of the page.
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Manage Email Addresses

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Email Address Management in the Digital Management sub-section of the Users section, allows
you to set up additional From email addresses for your agents to use in Agent Desktop.

Manage Email Address

&llow customer to configure their Agent’s potential From addresses displayed in WWE's drop-down list of cutbound emails.

E-mail Accounts w

+ &dd g Add Folder B Delete

Mame:Display Name
» | FMarner
eg|-22-30{@hmail stg.genesys-cloud.info: esj-22-30...

Mrtarner@email.com: Mitchell Marner

/—\///—\_/’

You can configure your agent's potential From addresses displayed in Agent Desktop drop-down list of
outbound emails.

When setting up additional addresses, you must first select or create the Business Attribute folder
that will contain the Attribute Values that are used as available addresses. These come from the
addresses of email interactions.

Once your intended Business Attributes folder is selected, you can begin adding new From email
addresses by entering the address Name and an associated Display name. Once you have updated
the users profile, the new From email addresses will be available for the agent to use when they start
a new session or restart their current session.
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Capacity rules

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Capacity rules allow you to define an agent’s ability to handle multiple interactions concurrently for
different channels. When the limits for a channel are reached, the agent stops receiving calls/

interactions for that channel.

When you create a capacity rule, you define rules for every enabled channel, except for workbins and
outbound channels. For each channel, you first need to set the maximum number of interactions an
agent can handle, and then you can optionally define rules that also set limits for that channel based
on the number of interactions being handled on other channels.

Example

You could define the following for an agent using a chat channel:

e Allow a maximum of 3 chat interactions.

You could define the following for an agent using a
chat channel:

¢ Allow a maximum of 3 chat interactions.

¢ Do not send new chat interactions when the
agent is busy with either:

e 1 email

e 1 voice

You could define the following for an agent using a
chat channel:

e Allow a maximum of 3 chat interactions.

* Do not send new chat interactions when the
agent is busy with either:

¢ 1 emailand 1 chat concurrently

e 1 voice

Result

This rule means that the system will not route new chat
interactions to an agent under the following conditions:

e If the agent is handling 3 or more chat
interactions.

This rule means that the system will not route new
chat interactions to an agent under the following
conditions:

e If the agent is handling 3 or more chat
interactions.

e If the agent is handling 1 or more email
interactions.

e |f the agent is handling 1 or more voice calls.
This rule means that the system will not route new

chat interactions to an agent under the following
conditions:

e |f the agent is handling 3 or more chat
interactions.

e If the agent is already handling at the same
time 1 or more email interactions and 1 or more
chat interactions.

e If the agent is handling 1 or more voice calls.
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Example Result

(Note: This is considered advanced functionality and is used in
rare circumstances)

Create a Capacity Rule

Contact Center Settings Agent Groups

Agent Desictop . Capacity Rules
Manage how the router assigns multiple media interactions to agents.
Desktop Options v Default Tenant Rule
Create Capacity Rule Script_1

Digital Management ™

Email Mailboxes Q
I Capacity Rules

To create a capacity rule:

1. Go to Contact Center Settings -> Digital Management -> Capacity Rules screen in Agent Setup.
2. Click Create Capacity Rule.
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Select media channels

Select Media Rule -

Voice @

Chat

Email

Voice o

Allow a maximum of 1 voice interaction.

Chat Z i

Allow a maximum of 1 chat interaction.

Email 7 0

Allow a maximum of 1 email interaction.

On the Create a Capacity Rule screen, enter a name for the capacity rule and specify the rule
folder.

Next, from the Select Media Rule menu, select all channels that apply to your contact center.

When you select a channel, a default media rule for that channel appears onscreen. To open and edit
the rule, click the pencil icon.

Now, you'll create the media rules by specifying the following:

¢ the maximum allowable interactions an agent can handle for a media channel.

* (optional) add limit conditions for that channel, based on interactions being handled on other channels.

Define maximum number of interactions
Voice '|'|'

Allow a maximum of 1 voice interaction.
\ Voice

Chat Z i Allow a maximum of =~ 1 voice interaction
Allow a maximum of 1 chat interaction,
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To define the maximum allowable number of interactions an agent can handle for a media channel,
click the pencil icon to open and edit the media rule for the respective channel.

Next, in the Allow a maximum of <channel> interactions section, simply enter an integer in the
text box to define the maximum allowable number of agent can handle for that media channel.

You can click Done or continue on to define additional rules that depend on other channels.

Specify limits that depend on other channels

Chat

Allow a maximum of 3 chat interactions

Also, don't send new chat interactions when agents are busy with, concurrently

 x] 1 Email v

o 1 Chat - &) Add Concurrent Interactions @
Also, don't send new chat interactions when agents are busy with

%] 1 Vaoice v € Add Concurrent Interactions @

© Add Rule On Other Channels @

Cancel Done

To specify rules that depend on the number of interactions of other channels being handled: Click
Add Rule on Other Channels. Next, enter the number of interactions and select the channel that
you want to depend on.

You can repeat and click Add Rule on Other Channels button to add more limit conditions on other
channels.

Advanced, rarely used: Sometimes, you may need to define a more complex rule, that sets a limit

based on interactions of several channels being handled at the same time by the agent. For that
case, click Add concurrent Interactions to build composite rules.

To illustrate how this works, let's look at the last example from above:
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Example Instructions

To enable:

1. Because the rule will contain chat, email, and
voice interactions, you must have already
selected all three channels from the Select
Media Rule menu. That means you should see
three separate sections on your screen - one for
each channel.

2. Click the pencil icon in the chat section to define
the chat media rules.

3. In the Allow a maximum of chat
interactions field, enter 3 in the text box.

* Allow a maximum of 3 chat interactions. 4. |In the next section, for the Also, don't send
+ Also, don't send new chat interactions when the new chat interactions when agents are
agent is busy with: busy with: option, specify an integer of 1 in
the text box and then select Email from the
¢ 1 email and 1 chat concurrently Select Channel menu.
¢ 1 voice 5. Click Add Concurrent interactions.

6. In the Also, don't send new chat
interactions when agents are busy with,
concurrently: section, specify an integer of 1
in the text box and then select Chat from the
Select Channel menu.

7. Click Add Rule on Other Channels.

8. In the next section, for the Also, don't send
new chat interactions when agents are
busy with: option, specify an integer of 1 in
the text box and then select Voice from the
Select Channel menu.

Edit a capacity rule

To edit a capacity rule that has already been created, go to Contact Center Settings -> Digital
Management -> Capacity Rules screen in Agent Setup. Locate the capacity rule from the menu
and click the corresponding pencil icon. The Edit Capacity Rule window opens. Edit any or all of its
properties.

Assign a default capacity rule

When you create a new capacity rule, it appears in the Default Tenant Rule menu on the main
Contact Center Settings -> Digital Management -> Capacity Rules screen. Select any Capacity
Rule from this menu to make it the default Capacity Rule for a tenant.
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Assign a capacity rule to an agent

You can assign a capacity rule to a user in Agent Setup, as follows:

1. From the Users tab, locate the user/agent or add a new one.

2. From the Capacity Rules menu, find the capacity rule you want to apply.

You can also assign a capacity rule to a user in a CSV for XLS file that will be imported via Bulk
Import:

e For CSV files - In the CapacityRule column, enter the capacity rule name.

e For XLS files - In the CapacityRule column, specify the capacity rule DBID.
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Sharing Business Attributes in Agent Setup

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

In Agent Setup, you can define a business attribute to be shared at an agent, agent group, and global
level. This means that you only need to create a business attribute once and it automatically
populates the Business Attribute lists on the Agent Group, Manage User, or Desktop Settings
pages.

You can consider a business attribute to be the container that holds a list of objects that have a
common theme. You can define shared business attributes for the following objects:

e Caller ID
¢ Dispositions
¢ Case Data

¢ Toast Data

Let's take a look at how Henry, a contact center administrator, uses sharable business attributes.
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Agent Setup Contact Center Settings Agent Groups

Agent Group Name $ Type Script
Users Agent Group Add Scrip
TIAA_Agents Agent Group Add Script
TestOutbound_AG_2230 Agent Group =
TestOutbound_AG Agent Group

testing-tests-agent-group Agent Group

Add Scrig

He wants to create a list of Caller IDs for a specific Agent Group that can be shared to other Agent
Groups at a later date.

Henry first needs to create a Caller ID business attribute. He needs to go to the right page in the
Agent Setup user interface, so he clicks Agent Groups, selects the agent group he wants to edit,
and then clicks Caller IDs.

Manage Caller IDs

A Caller ID 15 a registered phone number that the caller can see. You can select a caller ID for the contact center or for a team.

Folder: [DEVOPS/ Select Business Attribute ... v
Mone

Caller ID-Sales

Henry clicks the Folder drop-down list box to choose a folder into which the business attribute should
go. By default, the tenant home folder is automatically selected.

Then Henry clicks the Add Business Attribute drop-down list box and selects Add.
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The other options in the list are:

* None - This tells the system to not define any business attribute.

e Already configured Caller ID business attributes - These attributes were previously created on this page,
or at the agent group level. This is the benefit of shared business attributes. When a business attribute
is created once, it populates where needed in other locations.

Add Business Attribute

Display Name CallerlD-Sales

The Add Business Attribute window opens and Henry can now type the name of the business
attribute. To be able to easily detect the purpose of the attribute, he prefixes the name with
CallerlID, for example, CallerID-Sales.

After he clicks OK, the new Caller ID business attribute is displayed not only in the list on the Agent
Group page, but also in the Caller ID list on the Desktop Settings and Manage Agent pages.
However, at this point the business attribute is empty; it doesn't contain any actual caller IDs.

Manage Caller IDs

A Caller IDis a registered phone number that the caller can see. You can select a caller 1D for the contact center or for a team.

Folder: /DEVOPS/ CallerlD-5ales -

=+ Add I Add Folder i Delete

o & Sales

jame Display name

Now that the business attribute is defined, Henry can populate the business attribute with a list of
caller IDs. To do this, for each caller ID he wants to add, he clicks the Add icon to define the Name
and the Display Name. He can add more than one caller ID to the business attribute and he can
organize the caller IDs into folders.
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%8 AgentGroup?
Manage Caller IDs
Agent Group A Caller 1D 1s a registered phone number that the caller can see. You can select a caller ID for the contact center or for a team.
General Info
Folder: /DEVOFS/ Caller ID-Sales w
Agents
Dispositions
Custom Agent States + Add I® Add Folder O Delete
Group Favorites
Statistics
Cese Data ™ Sales: 1-555-555-5555
Toast Data
| caterins

Two weeks after he created the caller ID list for one agent group, Henry needs to configure another
agent group with the same list of caller IDs. All he needs to do is access the agent group (Agents
Groups > Agent Group2), and then select the sharable business attribute and caller ID. In this
scenario, he selects /DEVOPS/ > Caller ID-Sales > Sales: 1-555-555-5555.

The benefit of sharable business attributes is that Henry didn't need to create a new list of caller IDs
for another Agent Group.

Remember that this scenario demonstrates how to create a Caller ID business attribute, but the steps
also apply to Dispositions, Case Data, and Toast Data.
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Working with Global Favorites

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

As a contact center administrator, you can create and maintain Global Favorites, which are contacts
and internal targets that your agents can access quickly in the Team Communicator in Agent Desktop
or the Gplus Adapter.

You can create a list of favorites for each of the following levels:

e Desktop settings (everyone)

¢ Agent Groups (only members of the group)

e Users (personal)
Essentially, you add favorite contacts and targets to the global Favorites List. Then from that list, you
can select the favorites that you want to apply to agent groups, individual users, or the whole contact

center. Favorites can be re-used, meaning that if you create a favorite for a specific agent or agent
group, for example, you can also apply that favorite to another agent group or individual.

To help demonstrate how this all works, let’s observe how Henry, a contact center administrator,
adds a favorite to one agent group and then applies the same favorite to another agent group.

3 AgentGroupl

Global Favorites

Agent Group

General Info Global Favorites is a list of Agents, Agent Groups or external contacts that agents frequently dial This list provides a click-to-call list of these numbers
Agents on Agent Desktop.

Dispositions

Custom Agent States

I Group Favorites
Statistics Favorites List (2)
Case Data

Toast Data Q Il_ﬁ Delete
Caller IDs

Display Name Details Attached Data

Henry is configuring Agent Desktop settings for AgentGroupl and AgentGroup2. As part of the setup,
he needs to create a list of contacts to be displayed in the Team Communicator for each agent that
belongs to the groups. For the purposes of this demonstration, he’ll add only one favorite. In reality,

Genesys Engage cloud Administrator's Guide 249



Agent Setup Working with Global Favorites

he would set up as many favorites as required to meet the needs of his contact center. The goal is to

include a quick way for agents to transfer an interaction to an agent who can speak Dutch. These are
the steps he takes:

1. Access the Agent Group (Agent Groups> Agent Groupl)
2. Click Group Favorites.

Manage Favorites

Skill v Dutch w Dutch Attached Data

Quick r n

Q
Attached -
Name = Display Name = Type = Category = Details Data
Spanish Spanish Skill Quick
Russian Russian Skill Quick

/—\—///N—//

3. Add the Dutch skill as a new favorite in the global list:
a. Click Add Favorites.
b. On the Manage Favorites window, select Skill.

c. Select Dutch from the second drop-down list box.

Select a category. Categories organize how the favorites are displayed in Team Communicator. He
selects Quick.

e. Click Add.
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USSian [8

Spanish Spanish Skill Quick

S ——

.'-_
& Dutch [D Skill Quick -

The new favorite (Dutch) is now added to the global favorites list on the Manage Favorites window.
However, at this point, the new favorite is not assigned to AgentGroupl yet. It’s simply available in
the global list. He now needs to add the new favorite to AgentGroupl. Notice that Dutch is
automatically selected. If it wasn't, Henry would need to select the check box beside Dutch.

4. Click Save.

Result

When Henry clicks Save, the Manage Favorites window closes and the new favorite is added to the
Group Favorites list for AgentGroupl, as shown here.

Favorites List (1)
Q

Mame = Display Mame v Type s Category s

Dutch Dutch Skill Quick

glov_v it's time for Henry to add Dutch as a group favorite for AgentGroup2. To do this, all he needs to
o is:

1. Access Agent Groups (Agent Groups > AgentGroup?2).

2. Click Group Favorites to open the global list of favorites.

3. Click Add Favorites

4. Select Dutch from the Manage Favorites list.

5. Click Save.

All members of AgentGroupl and AgentGroup2 now have Dutch listed in the Quick contact list in the
Team Communicator.

Now that Dutch is listed in the global favorites list, Henry has the option in the future to easily add
Dutch as a personal favorite for other agent groups, individual users, or all users in the contact
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center.
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Audit

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

The Audit Trail, located in the Audit section, details the actions taken in your Agent Setup
application, including update, delete, import, login, and logout activities.

There are currently no limits placed on the number of audit logs or how long they are
kept in the Audit Trail.

Audit Trall

Audit Traif details changes made to your application, including change, delete, import, login, and logout activity.

Username Search: Action Search: Message Search: From Date Search: To Date Search:

ALL v 2020/05/25-13:57 2020/05/26-13:57 m
Download Audit Data

a

Username 3 Action Message v Date & Time 3
voice_2230_admin LOGIN User voice_2230_admin:100804:c05770f3-e4b3-422b-a93c-b1ecfa24cadf login Tue May 26 2020 13:50
GWA_admin_660 LOGOUT User GWA_admin_660:104162:c05770f3-e4b3-422b-a93c-b1ecfa24cadf logout Tue May 26 2020 13:49

The summary table on the Audit tab contains an entry for every action taken in the application. The
table lists the following details:

e Username - Of the user who made the change.

e Action - The type of action made. See a description of each action in the table below.

¢ Message - Specific details about the action. This could be the exact file name of an imported file or the
name of a skill that was updated or created.

¢ Date & Time - The date and time that the action took place.
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* Refresh - Updates/refreshes the audit search results.

¢ Download Audit Data - Exports the audit logs to .xlIsx files.

If you click on any entry within this summary table, a new Audit complete information window
appears. It lists the details outlined above and includes the Audit Record ID.

Each action type is documented in the table below. Note that an 'object' can mean an agent, an
agent group, a skill, or a transaction.

Action Description

A user (identified by a username) has logged in.
The Message field specifies the following
information about the user who logged in:

e Username

LOGIN *+ User ID

¢ Contact Center ID

e The action (login), including any applicable
reason or error.

A user (identified by a username) has logged out.
The Message field specifies the following
information about the user who logged out:

* Username

LOGOUT e User D

¢ Contact Center ID

¢ The action (login), including any applicable
reason or error.

CREATED An object was created (for example, a new agent).
DELETED An object was deleted (for example, an agent).

An object was updated. If, for example, an agent
was added to an agent group, this entry identifies

Sl the user who made the update and the name of the
user added to the group.
IMPORT A file was imported. The Message field specifies the

name of the file that was imported.
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Genesys Predictive Engagement
(Altocloud)

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Using Predictive Engagement in Genesys Engage cloud.

Genesys Predictive Engagement (previously called Altocloud), a real-time journey analytics platform,
can observe and analyze visitors on your digital properties, such as websites. Altocloud can predict
real-time probability for visitors to achieve a desirable business outcome, and then acts to offer the
most appropriate and effective channel to assist them in completing their journey. For an in-depth
look at Altocloud, see the full documenatation set here.

To set up Altocloud in your Genesys Engage cloud environment, complete these initial tasks.

Prepare your tenant

As a customer, evaluate your interest in Altocloud service for predictive
engagement. Reach out to your Genesys account team to discuss terms and
conditions prior to making a purchase decision.

With your Genesys account team, evaluate whether your environment has the necessary
prerequisites.

With your Genesys project team, enable Genesys Altocloud functionality on your tenant.

You receive:
¢ A reference to the region where Altocloud is accessible. For more information on using regions to
consume API information, see the Region Authentication table.

* An email containing instructions and credentials on how to connect to the Genesys Cloud Admin Ul to
define business logic, configure integrations, and query analytical dashboards.
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Configure permissions and routing logic

Work with your Genesys project team to:

1. Configure necessary Genesys Cloud permissions for administrators. For more information, see Altocloud
permissions overview.

2. Configure necessary Genesys Cloud permissions for agents to access the Altocloud journey dashboards
within Agent Desktop. Permissions can be set globally for the entire agent population, for an agent
group, or for individual agents. For more information see Altocloud permissions overview.

3. Define the appropriate routing logic for chats that Altocloud proactively triggers.

4. If this is the first time you have configured Web Chat with Genesys Widgets, request the corresponding
API key to use the Chat API (Advanced Chat v3). You will need this later for the initial provisioning of
Widgets on your website.

Important

After the initial service roll-out, if you need additional agent provisioning or routing
logic, you may need to raise a Service Request with Genesys Care.

Log in to Altocloud

\

In your Genesys Portal, click the Altocloud tile.
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Configure journey shaping settings
On the Admin tab, navigate to the Altocloud section.

In the Web Tracking section, enable domain whitelisting. This step authorizes your website domain
to be a valid originator of web journey events.

Configure your Segments. Segments categorize your website visitors into audiences that can be used
in real-time to trigger engagement logic.

Configure your Outcomes.

Outcomes represent business objectives and Altocloud uses them to predict
whether a visitor's behavior is leading them to achieve a desirable result on their
own, or whether an agent needs to intervene.

Configure your web pages

See Prepare widgets for Altocloud to deploy Genesys Widgets for Genesys Cloud.
Widgets v.2 is the Genesys Cloud name used for Genesys Widgets. For Genesys
Engage, see the Deployment guide for instructions.

Once you deploy Genesys Widgets, obtain the tracking snippet and add it to all web pages that
Altocloud should observe.

Configure your web pages with Genesys Widgets:
¢ If you are already running Genesys Widgets, ensure that you have the proper version.
¢ If needed, fetch the latest version from the public CDN (instructions in deployment guide).

Configure your widgets to enable Web Chat on every page. You must use Genesys Engage v3 API
transport. For more information, see Configure widgets and services.

Obtain the API key from your Genesys customer service representative (x-api-
key).

Genesys Engage cloud Administrator's Guide 257



Genesys Predictive Engagement (Altocloud) Audit

Use Live Now

To confirm that the Altocloud is properly provisioned and functional, navigate to
Live Now and observe web visits in real-time.

Create engagement logic

Configure action maps to engage with your website visitors.

Receive chats in Agent Desktop

Log in to Agent Desktop.
To receive a live chat interaction, set your status to Available.

Expand the Journey tab and view a customer's journey.

Additional integrations

Take notice of the following integrations.

Architect workflows

Administrators and contact center managers can now create workflows in Architect. This feature
allows customers to streamline business processes by using Predictive Engagement to build in-house
and third-party integrations.

For more information, see About Architect and Work with workflows.
Trigger architect flows

Predictive Engagement administrators can now use a new Architect flow action to configure action
maps that trigger Architect flows that integrate with in-house and third-party systems. For more
information, see About Architect flow actions.

Create leads in Salesforce

Predictive Engagement facilitates an integration with Salesforce by providing
predefined Genesys Cloud data actions and an example Architect workflow. An
administrator can build an action map that uses the Architect flow action along
with these data actions and workflow to create leads and assign campaign
attributions in Salesforce when qualified users arrive on your website. For more
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information, see Salesforce lead creation and campaign attribution.
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CX Contact

Important

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

CX Contact is a web-based application used to create and manage outbound campaigns. More
specifically, you can use the application to do the following:
e Campaigns - Set up and manage outbound campaigns, and monitor the status of running campaigns.

e Contact Lists - Import contact lists, apply upload rules to a list, create list automation jobs, and define
user field labels.

e Compliance - Restrict contact attempts to records within a contact list, and import or manage contact
suppression lists.

Introduction
Link to video

¢ Get to know campaign structure and terminology
e Learn about dialing modes and IVR modes
* Learn about pacing and optimization

¢ Learn about time zone assignment options

Campaigns
Link to video
¢ Create a dialing profile
¢ Create a campaign template

* Create a campaign group

¢ Learn about the metrics displayed on the campaign dashboard
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Contact Lists
Link to video

* Learn about list fields, file formats, and database tables
¢ Import or manage a contact list or contacts within a list
e Set weights for contact lists

* Define list rules

¢ Create data mapping schemas

* Create list automation tasks

« Define or edit user field labels

Compliance
Link to video

* Suppress contact attempts based on a set of prescribed rules

¢ Assign a time zone to phone numbers containing a specific country code or area code
e Suppress contact attempts based on the location of contacts

* Define allowable calling windows for each day of the week for a given region

¢ Suppress contact attempts by date

¢ Add or manage a suppression list
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CX Contact Solutions Overview

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

CX Contact is part of a fully customizable cloud solution that enables you to set up, run, and fine-tune
your outbound campaigns.

Through a series of Genesys Engage cloud products, you can define your routing application, import
contact lists, set up a campaign, apply compliance rules, and monitor and assess your campaign
through real-time and historical reports.

Here are the four stages you'll go through to make the most out of CX Contact in Genesys Engage
cloud:

Stage 1—Configuring outbound routing
Stage 2—Setting up a campaign

Stage 3—Dialing and call handling
Stage 4—Monitoring a campaign

Stage 1—Configuring outbound routing

Genesys handles the initial configuration of outbound routing.

Using Platform Administration, we configure the routing points, agent groups, and virtual queues. We
use Designer to configure voice scripting and call flow.

After that, you can log into these applications at any time to tweak the settings. Here are a few
instructions:

e How to set up Outbound Routing

* How to create and modify DNs

* How to set up agents

e How to add the Route Call Block in Designer
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Stage 2—Setting up a campaign
Link to video

Before you sign into the CX Contact application to set up your campaigns, you should visit the
Campaign Structure and Terminology page in the CX Contact Help manual to learn about the
following five components that make up a campaign:

¢ Dialing profile

e Session profile

* Campaign template

¢ Campaign group

e Contact list

After that, you can log into CX Contact to set up and manage your campaigns.

Many of the key features and tasks available to you in CX Contact are listed in the table below. Note:
Clicking any of the links in this table will take you to the CX Contact Help manual.

Category Key Tasks

e Create a dialing profile

* Create a campaign template
Campaigns * Create a campaign group
e Apply call treatments

e Learn about the metrics displayed on the
campaign dashboard

* Suppress contact attempts based on the results
of previous attempts

* Assign a time zone to phone numbers
containing a specific country code or area code

) e Suppress contact attempts based on the
Compliance location of contacts

¢ Define allowable calling windows for each day of
the week for a given region

* Suppress contact attempts by date

¢ Import or manage a suppression list

e Learn about contact list fields, formats, and

Contact Lists database tables
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Category Key Tasks
* Import or manage a contact list or contacts
within a list
* Set weights for contact lists
* Define list rules
e Create List Automation tasks
* Create data mapping schemas
* Define or edit user field labels

* Import specification files

¢ Define or edit General settings
Settings * Define or edit Security settings

¢ Define or edit Pacing settings

Stage 3—Dialing and bridging to an agent

Dialing

When you set up a campaign in CX Contact, you'll need to choose a dialing mode or IVR mode that
best suits your campaign. Your choice will depend on the type of campaign you're running, the
number of agents (if any) assigned to the campaign, and compliance regulations.

Depending on the dialing mode or IVR mode selected, you can also apply pacing and optimization
parameters to influence dialing behavior. Refer to the Dialing modes and IVR modes page for a
complete description of each dialing mode and IVR mode as well as the pacing options and
optimization parameters that apply to each.

Before starting a dialing event, the system refers to all selected pacing options, optimization
parameters, call treatments, and compliance rules in place. It places the call and then, for agent-
assisted campaigns, hands the call off to an agent once it detects a voice on the line.

Call handling

All interactions take place via the Agent Desktop application. The way in which an agent handles a
call depends on the dialing mode or IVR mode used in a campaign.

Link to video

For Predictive and Progressive dialing and IVR modes, the outbound calls are directed to the agents'
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workstation and dialed automatically. The video to the left shows you how agents handle these calls.

In a Preview dialing mode, agents preview the customer case information and then manually dial the
customer's phone number.

For a complete description of how agents use Agent Desktop to handle each type of outbound call,
refer to the Outbound campaigns page in the Agent Desktop Help manual.

Stage 4—Monitoring a campaign

Once you've set up your campaigns, you'll want to monitor the status of those that are still running
and look at the results of those that have ended. You can use a series of Genesys reporting tools to
accomplish these tasks.

Real-time reporting

To monitor the status of an ongoing campaign in real-time, you have two options: the CX Contact
campaigns dashboard and Genesys Pulse.

CX Contact campaigns dashboard
The CX Contact campaigns dashboard provides a statistical overview of call activity for each

campaign group that is currently running. If a campaign group contains multiple contact lists, the
data is broken down by contact list.

Lists Time Attempts Agents Hit Ratio Abandaned

Campaigns/Groups & ¥ v % ~ % - Remain  Done - PerMin | LoggedIn BusyFactor Success  Count %
v @@ Welcome Notifications
+ @ Welcome Notifications-bb76/bBS@TestOutbound_AG_2 [OXO)] 1460 172 % 1.78% 48 3.29% 1214 00:08:22 T4 1460 6 5 80.00%  30.00% 25 4.50%
(il canadad 1200 100 10 0.83% 30 250% 1060  00:02:22 40 1200 2 33.33% 8 3.00%
(i canada3 90 2 0 0.00% 10 1.11% 48 00:02:00 10 90 2 0.00% 10 100.00%
(il canada2 170 40 16 9.41% 8 4T1% 106 00:04:00 2 170 2 32.00% 7 3.00%

For a complete description of fields and metrics displayed on the campaigns dashboard, refer to the
Campaigns dashboard page in the CX Contact Help menu.

Genesys Pulse

Use Genesys Pulse to generate in-depth reports on agent activity and campaign activity.
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In the Genesys Pulse application, you can add a report widget to your report dashboard, choose a
template or define your own, select objects and statistics to include in your report, and specify
default settings - like the name, refresh rate, and type of widget. And then you can save and
download your report as a CSV file.

For a complete list of available agent statistics through Pulse, refer to the Agent Statistics page in the
Pulse Help manual. For a complete list of available campaign statistics through Pulse, refer to the
Campaign Statistics page in the Pulse Help manual.

Historical reports

Now you want to retrieve statistics of a campaign that has ended. OK, you have two options:

¢ CX Contact List Export
¢ Genesys CX Insights

CX Contact List Export

Using the List Automation feature in CX Contact, you can schedule an automatic list export for when
a campaign ends. This list export will contain call result fields. For more information about this
feature, refer to the List Automation page in CX Contact.

Genesys CX Insights

Genesys CX Insights uses data stored in our database and presents it in readable reports. For a list of
Outbound reports, refer to the Outbound Contact reports page and the Agent Outbound Campaign
Report in the Genesys CX Insights section of this manual.
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Callback

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Getting Started with Callback.

Businesses sometimes cannot offer on-demand, low-wait agent help because of resource limitations
or increased service usage. In these situations, the best option is to offer some form of deferred
service that can connect consumers and agents later, at a mutually-beneficial time.

Genesys Callback, which takes its name from the most typical form of deferred agent voice
connection, also provides support for a user-originated call-in feature, in addition to a range of
scenario and sourcing options. In short, Genesys Callback is much more than callback functionality.
Consider the name to be shorthand for the rich set of scenarios that are described in this Callback
documentation.

Genesys Callback is enabled by Genesys Engagement Services (GES) behind-the-
scenes and you might see references to GES or "Engagement Services" throughout
Callback pages or within resource names.

What is a Callback?

A Callback is a data record that contains data for calling a customer at some time in the future.
Callbacks generally consist of attached data and configuration data. Attached data is specific to the
end customer and might be used in screen pops, routing, reporting, and other applications.
Configuration data describes how a callback is fulfilled; this includes target expressions, timeout
values, and virtual queue names.

Using Callback, you can associate a callback service with a phone number, which enables a caller to

request a callback. Depending on which scenario you choose to implement, the callback is then
routed to an agent who processes the call.

Supported Scenarios

For information about the supported scenarios for Genesys Callback, see Callback Scenarios.

Genesys Engage cloud Administrator's Guide 267



Callback CX Contact Solutions Overview

Callback Reports

For information about real-time reporting for callbacks, see Real-Time Reporting with Pulse in the
Reporting in the cloud documentation. Callback activity is tracked as part of the Queue reports. You
can add a report widget that is based on the Callback Activity template to your Pulse dashboard.

For information about Callback historical reporting using Genesys Customer Experience Insights
(GCXI), see Callback Reports in the Reporting in the cloud documentation.

About the Callback Application

User, welcome to your Genesys Portal AllAgps  User  Adminisiration  Suppert
3.0
_
Agent Desktop Platform Administration Workforce Management IVR Administration Genesys Customer Care
Regional Access
E E
Training Recording Outbound Reporting Designer
@
Reporting Administration %

The Callback application is - as its name suggests - specific to callback functionality and
management. If you are a Callback Administrator, there are two additional applications that you
might use to configure and provision the Callback application. On the Genesys Portal, they are
Platform Administration and Designer. Platform Administration is used to manage contact center
resources and user access to Callback features. Designer is used to provision Callback-related
applications.
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Click the Callback icon on the Genesys Portal to open the application.

In the Callback application, tabs, dialogs, and panels display based on your role permissions. If you
cannot view a feature, use the Platform Administration application to check your access group.

Callback

+ Create Callback

(AGENT)

Desired Callback Time

18/2019 11:42:26 Al
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The Callback application has multiple tabs. You might see all available tabs or only some of the tabs
in your Callback Ul. Administrators will make sure that you have access to the tab or tabs that you
need to do your job. Access is based on the role(s) to which you have been assigned.

The following tabs are available in the Callback Ul:

Callback: Displays the list of callbacks. In some scenarios, you might need to create or monitor a
callback request, or even cancel a set of callbacks. Callback Monitor is the minimum role required to
access the Callback tab. To modify callback records, you require the Callback Administrator or Callback
Supervisor role.

¢ Developer: You must be a member of the Callback Administrator or Callback Developer role to access
the Developer tab. From the Developer tab, you can access developers' tools such as the list of
errors related to your Callback API queries as well as pages on which you can validate your API keys or
provision Push Notifications.

e Call-In: You must be a member of the Callback Administrator or Callback Developer role to access the
Call-In tab. If you have the Click-To-Call-In scenario provisioned, use the Call-In tab to view the Click-
To-Call-In records.

¢ Tools: You must be a member of the Callback Administrator, Callback Supervisor, or Callback Developer
role to access the Tools tab. The Tools tab offers additional views and tools to assist with callback
management, configuration, and troubleshooting. For example, you can search for a specific interaction
within the callback records or force a refresh of tenant configuration data.

Getting Started with Genesys Callback

The Callback application is supported in the following browsers:

e Firefox
¢ Google Chrome

¢ Microsoft EdgeHTML version 16.0 and up and on Chromium-based Edge

Before you start working with the Callback application, you need to configure your callback scenario.
You can review the supported callback scenarios on the Callback Scenarios page. In addition, you
must provision Designer applications for Callback and configure the callback service. This section
provides information about where to start.

1. To get started, go to the Provisioning Callback page. The page tells you what you need to configure in
Platform Administration and then guides you through the Designer application provisioning process,
including how to determine which type of Designer applications you require for your callback scenario.

2. Genesys provides predefined roles for the Callback application to ensure that your users only have
access that is appropriate for your business needs. If you are new to Genesys Callback, you might have
to assign resources (users) to appropriate access groups. In addition, you have the option to restrict
access to queues (and lists of callbacks) in the Callback application based on your lines of business. You
can create your own custom access groups and enable or disable Read permissions as required.

Read the following pages to understand which roles are required for access to each tab in the
Callback Ul:

* Managing Callbacks
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e Using the Developer Tab
* Using Callback Tools

For detailed information about Callback-specific roles and access groups, see Controlling User
Access.

3. After you have completed Callback provisioning and testing to ensure that calls are routed correctly,
and Callback users have been assigned to the correct roles and access groups, you can begin to use

the Callback Ul. The Callback tab displays the list of callback records. Users with sufficient permissions
use the Callback tab to manage the callback records, including creating, editing, or cancelling
callbacks.

4. Callback Administrators and Developers have access to a Developer tab in the Callback interface. Use
the Developer tab to manage callback activity and features at a more technical level. For example,

you can check for errors in Callback API queries or validate API keys. To learn more about the
Developer tab, see Using the Developer Tab.

5.

If you work with Genesys Engagement Services/Callback REST APIs, you can find links to tutorials and
additional information on the Genesys Engage REST APIs and Tutorials for Callback page in the Callback
documentation.
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Callback Scenarios

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Callback scenarios.

It does not matter how a callback originates, the voice interaction is always converted to a virtual call
and added to the queue where it is monitored so the system can provide information - such as the
Estimated Wait Time (EWT) for the queue - to future callers.

This page describes the callback scenarios that Genesys supports with Callback.

Immediate Callbacks

An Immediate callback is a callback that is set in motion when your customer (a "consumer") makes
a request to be called back as soon as an agent who can provide assisted service becomes available.
A consumer can request an Immediate callback in the following ways:

e While the consumer is in-queue on an IVR:

e A consumer's call arrives and the caller is offered Immediate callback. If the caller accepts, he or
she confirms the phone number for the callback.

e Through an API call; in other words, the consumer makes the request from a mobile app or website:

* A consumer is using your company's or organization's mobile app or website and encounters a
situation where he or she requires assisted service by voice. The consumer taps or clicks a button
to request a callback, confirms or provides the number at which he or she would like to receive the
call, and receives a confirmation message that the request was received.

No matter how the Immediate callback is requested, when an agent who satisfies the required skill
expression is ready, then the consumer is called and the call is routed to the agent.

Because user/context data might be attached to the API request for a callback, key components of
the consumer's app or web journey can be preserved for agent or reporting use.
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Scheduled Callbacks

A Scheduled callback is a callback that is set in motion when your customer (a "consumer") makes a
request to be called back in the future, at an approximate time that works for the consumer's
schedule. A consumer can request a Scheduled callback in the following ways:

e While in-queue on an IVR:

* A consumer's call arrives and the caller is offered the option to schedule a callback for some time in
the future. If the caller accepts, he or she confirms the phone number for the callback and is
prompted to input the time at which he or she would like to receive it. Using the caller's requested
time, the system searches for the closest-matching available time to connect with an agent.

e Through an API call (from a mobile app or website):

e A consumer is using your company's or organization's mobile app or website and encounters a
situation where he or she requires assisted service by voice. The consumer taps or clicks a button
to request a callback, confirms or provides the number at which he or she would like to receive the
call, interacts with a date/time picker to search for availability, and receives a confirmation message
that the request was received.

No matter how the Scheduled callback is requested, if an agent who has the required skill set is ready
at the specified time, then the consumer is called and the call is routed to the agent.

Because user/context data might be attached to the API request for a callback, key components of
the consumer's app or web journey can be preserved for agent or reporting use.

Click-To-Call-In (Immediate)

To implement this scenario, you need to use the corresponding Call-In API to initiate
the Click-To-Call-In request.

A Click-To-Call-In (Immediate) interaction is set in motion when your customer (a "consumer") taps a
button in a mobile app that is designed to trigger a Call-In APl request:

e A consumer is using your company's or organization's mobile app and encounters a situation where he
or she requires assisted service by voice. The consumer taps a button that you have provisioned in
your app to connect consumers to your contact center.

¢ The system responds with call-in details immediately. Using that information, the app triggers a call to
your contact center. The system attempts to match the caller to existing information. For more
information, see Provisioning the Click-To-Call-In (Immediate) Scenario.

¢ If the attempt to match the caller to a Call-In request is successful and your Designer application is
configured to route the call when a match is made, then the call is queued on hold like any other call to
the contact center. If the consumer is placed in a queue where the EWT is above the configured
threshold, then the consumer might be offered a callback option.
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Because user/context data might be attached to the API request, key components of the consumer's
app journey can be preserved for agent or reporting use.

Click-To-Call-In (Delayed)

To implement this scenario, you need to use the corresponding Call-In API to initiate
the Click-To-Call-In request.

A Click-To-Call-In (Delayed) interaction is set in motion when your customer (a "consumer") taps a
button in a mobile app that is designed to trigger a Callback API request. The following description of
what happens next is a brief summary. See How Click-To-Call-In (Delayed) Works for additional
information. To provision the Click-To-Call-In scenario, see Provisioning the Click-to-Call-In Scenario.

e A consumer is using your company's or organization's mobile app and encounters a situation where he
or she requires assisted service by voice. The consumer taps a button to contact your center.

The mobile app sends a callback request, which includes Push parameters that the system uses to
contact the consumer to provide information about the callback.

The call is queued in the Click-To-Call-In (Delayed) virtual queue.

¢ When the consumer reaches the top of the queue, the system sends a Push Notification to the mobile
app to notify the consumer that the callback is ready.

* When the consumer accepts the callback, the system immediately replies with a Push Notification that
provides a phone number to call and, if configured, a unique access code that the consumer will be
asked to enter before the call is initiated.

* When the consumer calls in and enters the access code, if required, the system attempts to match the
caller to an existing callback request. When a match is made, the caller is queued and routed to the
next available agent who satisfies the required skill expression.

Because user/context data might be attached to the API request, key components of the consumer's
app journey can be preserved for agent or reporting use.

How Click-To-Call-In (Delayed) works

Your mobile app sends a Callback request when the consumer taps the button or link that you have
provisioned for the Click-To-Call-In Delayed feature. The call is then queued in the Click-To-Call-In
(Delayed) virtual queue. The Callback request includes Push parameters. To use Push Notifications
with Callback, see Provisioning Push Notifications for information.

A Click-To-Call-In (Delayed) request is routed to an agent when the following criteria are met:

1. The Call-In request can be matched to an existing Callback request in the system.
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2. Your Click-to-Call-In Match Designer application is configured to route the call.

3. An agent (with the correct skills if skills are configured) is ready to accept the call.

There are, however, a number of things that can happen during an active Click-To-Call-In (Delayed)
session that might impact the session's flow. For example, the system might fail to match a Click-To-
Call-In (Delayed) request on the first attempt. As long as the Click-To-Call-In and Callback requests
remain valid and outstanding, though, the consumer can call and try again.

There are also Designer settings that can purge the callback from the system or remove the callback
from its queue:

1. The Callback Purge Time (minutes) for the virtual queue is reached before the consumer responds
to Push Notifications or before an agent is available to assist the caller. In this case, the callback is
purged from the system.

2. The end of the business day, based on the configured Business Hours, occurs before the Callback
Purge Time (minutes) is reached, before the consumer responds to Push Notifications, or before an
agent is available to assist the caller. In this case, the callback is purged from the system.

3. The Push Callback Expiry Time (minutes) setting in Designer causes the callback session to
terminate when that time interval expires. When this happens, the callback is removed from the queue,
but not purged from the system until one of the previous two events occurs.

A Call-In API request that is associated with a Callback request that was purged or terminated will fail
because no match can be made between the Call-In and Callback requests.
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Provisioning Callback in Designer

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Provisioning Callback in Designer.

Callback is provisioned through Designer. To create and configure Callback services, Designer
includes a set of blocks dedicated to Callback.

Provisioning Callback is slightly different than provisioning applications for route points and chat
endpoints. For information about the supported Callback scenarios, see Callback Scenarios. This page
provides information about how to provision your callback scenario in the Designer application.

Before You Start

Before you provision Callback in Designer, make sure that the following objects are created in
Platform Administration and ready for use:

¢ A Callback Administrator.

¢ Route Points to be used for Inbound strategies that offer Callback.

¢ Route Points to be used for Outbound strategies, if Callback calls to consumers will be handled by
separate Outbound strategies.

e Virtual queues to store Callbacks. Genesys recommends that you use three queues for callbacks. For
more information about the virtual queues, see Provision the Callback Virtual Queues.

¢ At least one agent who will process Callbacks.

Provision the Callback Virtual Queues

In addition to an Inbound virtual queue, Genesys recommends that you have two additional virtual
queues for Callback reporting purposes. That means that you will have the following three queues for
Callback:

e Inbound virtual queue

¢ Callback virtual queue

¢ Qutbound virtual queue
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Genesys recommends that you use the following naming conventions for the queues:

e Inbound virtual queue: <VQ_name>_VQ
For example, Sales VQ

* Callback virtual queue: <VQ_name>_VQ_CB
For example, Sales VQ CB

e Callback outbound virtual queue: <VQ_name>_VQ_CB_OUT
For example, Sales VQ CB 0UT

Having all three Callback-related virtual queues provides the following functionality:
e For each call type, the system can keep track of and compare Estimated Wait Time (EWT) and other
important queue statistics separately.

* You can configure both historical and real-time reporting. While the Inbound and Callback virtual queues
collect statistics such as EWT and which calls accept the callback offer and which calls reject it, the
Outbound virtual queue collects data for outbound interactions such as how long the customer had to
wait for an agent to connect during the callback attempt.

After you create the virtual queues that will be used in your callback scenario, you must provision
applications and Callback services in Designer. The virtual queues that you have created for callback
functionality will be required to complete the Designer application and services provisioning.

Provisioning your First Callback Scenario in Designer

The following Callback provisioning workflow assumes that you have already completed the
configuration described in the Before you Start section, above.

e Provision Callback for the inbound strategy. For information, see Create your Designer Applications and
Provision a Designer Application to Offer Callback Through the IVR.

e Provision Callback for the outbound strategy. For information, see Create your Designer Applications and
Provision the Designer Callback Application.

e Provision Business Hours for Callback.
¢ Provision the Callback services in Designer.

e Test your Callback scenario configuration.

Create your Designer Applications

The following table provides information about the types of Designer applications that you require for
each supported callback scenario. Create the Designer applications after you have created the
Inbound, Callback, and Outbound virtual queues and before you provision the Callback services.

Callback Scenario Designer Application Type
In-Queue Callback Default + Callback
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Callback Scenario Designer Application Type
Scheduled Callback Default + Callback
Web Callback Callback

The following procedures show you how to provision Designer applications for Callback. The Default-
type Designer application provides the Callback offer to a customer waiting in a queue; for example,
in a scenario where the customer is connected to an IVR. The Callback-type Designer application
provides the Callback attempt for scheduled and web callback scenarios.

Provision a Designer Application to Offer Callback Through the IVR

Creating new Application

MiyFirstGamackScenasid

Delsult

In Designer, add a new application. The application type must be Default. This application is used to
offer callback through the IVR.
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Application Settings

General Audio Reporting DTMF options Speech Recognition Global Retry Caching Misc

Application Reporting Title

MyFirstCallbackScenario
This is used as application label for Designer Analytics.
Application Version

0.1
Increase version when making significant changes to application.
Stage

Develop v

Cancel Please Review All Settings and Press Here to Continue

There are no mandatory settings changes for the Default application, however, if there are any
specific settings that you typically use for Designer applications, consider if those settings are
required for your Callback Default-type application and make any necessary updates.
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& Designer Applications
Application - MyFirstCallbackScenario *
Validation Status: @ % Settings (3 Save Flow
Palette Application Flow Views =  Actions + Properties - Callback V2
This block is used to offer callback and reconnect to the customer
c . 4
*J Initialize when an agent is ready. L

User Interaction _ k

L — )

i= Menu & call Routing & Offer Callback * Connect Customer
, Play i Routing Priority & Advanced A Result

© Select Virtual Queue
0 Record Callback V2
This virtual gueue is used as the key to fetch additional settings from the

\!{. User Input CALLBACK_SETT| data table.

Routing Sales_VQ 3

Business Controls

Advanced Options - Overrides ¥

Data @
External Services
Reporting
Callback

+

. BookAsaP

‘; Book

RS calback
LS callback v2

Callback vQ

In Designer, select your Default-type application.

Scroll the Palette list to reach the Callback items. Drag and drop a Callback V2 block into the
Assisted Service phase of your application.

In the properties panel, under Call Routing, select the Inbound virtual queue that you configured for
Callback.

For additional information about the Callback V2 block properties, see the Designer documentation.
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o
[e=]
[=]

Designer  Applications

1 Settings B Save Flow|

Validation Status: @

o
(=

o] Applications

Designer

Quick Filters £x  Sample  Survey

(© Last updated (© Last

Phone Number(s) /
Endpoint Status -

provisioned

Snapshot
= Type Stage Tags

Mame <

64023, 64024 & 02/15/2018 06/14/201

MyFirstCallbackScenario Default Live Sample
Designer sample application. t, Manage

O

Publish your application and remember to assign a phone number to it.

Provision the Designer Callback Application

You must create the Callback-type Designer application before you can edit the
CALLBACK_SETTINGS data table.
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Creating new Application

Mame

MyFirstCallbackScenano_OUT

Type

+ Default

qaF

Digital

In Designer, add a new application. The application type must be Callback. This application is used
to re-connect with customers who requested a callback.

Application Settings

General Audio Reporting DTMF options Speech Recognition Global Retry Caching Misc

Application Reporting Title

MyFirstCallbackScenario
This is used as application label for Designer Analytics.
Application Version

0.1
Increase version when making significant changes to application.
Stage

Develop v

Cancel Please Review All Settings and Press Here to Continue

Genesys Engage cloud Administrator's Guide 282



Callback Provisioning Callback in Designer

There are no mandatory settings changes for the Callback-type application, however, if there are any
specific settings that you typically use for Designer applications, consider if those settings are
required for your Callback application and make any necessary updates.

& Designer Applications Shared Modules Audio Resources Message Resources Speech Grammars Business Controls Admin Operations

Application - MyFirstCallbackScenario_OUT *
Validation Status: @ 2 Settings [ Save Flow
Palette Application Flow Views =  Actions + Properties - Callback V2
Py This block is used to offer callback and reconnect to the customer 7
Logic, Control ) Initialize ~ ‘. when an agent is ready. 4
— .
+— Assign L€ callback v2 ) S
onnect Lustomer : Routin rnori vance
L2 C t Cust Routing P t i Ad d
Q Change ] Result
1[ Section When an agent is ready, select which party should initiate the call.
. ® Business 1o Customer dials in
;:1. Segmentation
customer
@ Terminate
Business Controls Shared Modules ® Templates
External Services Select the shared module for the outbound call, to confirm that the recipient is the
correct customer:

i v
BEF0E Callback V2 - Calling Back 5
Callback €3

Version
’s; Book ASAP e Label Mote Created ¢
Q Book ° Latest Use latest unpublished 06/29/2017
save.

RS caliback
LS callback vz

Callback vQ

In Designer, select your Callback-type application.

Scroll the Palette list to reach the Callback items. Then drag and drop a Callback V2 item into the
Initialize section of your application. For information about the Callback V2 block properties, see the
Designer documentation.
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In the Callback V2 properties panel, under Connect Customer, only the Business to
customer option is currently supported.

o

=L

Validation Status: @

Application - MyFirstCallbackScenario OUT ¢ e

Click Publish to make your application available. For information about publishing a Designer
application, see Saving and Publishing Your Application.

Provision Business Hours for Callback

In Designer, you must configure the Business Hours object, including the timezone, before you
configure the CALLBACK SETTINGS data table. The time zone that you configure is used for
scheduled callbacks. You cannot save the CALLBACK SETTINGS data table before the business hours
are configured.

For information about configuring your business hours in Designer, see Business Hours in the
Designer documentation.

Provision the Callback Services

The configuration parameters for Callback services are stored in the Designer CALLBACK _SETTINGS
data table. For detailed information about the CALLBACK SETTINGS table, see Callback Settings Data
Table in the Designer documentation.

You must make sure that the following prerequisites are completed before you add your queue to the
CALLBACK SETTINGS table:

¢ You must create the Callback-type Designer application before you can edit the CALLBACK SETTINGS
data table.

¢ You must configure the business hours, including the time zone, before making the following updates to
the CALLBACK SETTINGS data table. You cannot save the data table before the business hours are
configured.

e The virtual queues that you will use for callback functionality must be created and saved in Platform
Administration.
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Adding a Callback Virtual Queue to the CALLBACK SETTINGS Data Table

< Designer Applications Share aS0UrCes : s Grammars Business Controls

Data Tables

=+ Add Data Table

Quick Filters £

Name = Tags (@ Last Modified » (@ Last Published 3 Actions
[ CALLBACK_SETTINGS readonly 01/15/2019 & 07/04/2018 o +
B NUMBER_VALIDATION_CONFIGURA- o6/22/20064 00000 — =~ &
TIONS

In Designer, navigate to Business Controls > Data Tables. Click CALLBACK_SETTINGS and add
an entry for your Callback Inbound queue as described here.

< Designer ns Sha / I 5 Gra rs Business Controls Admin
g @
Data Tables - CALLBACK_SETTINGS
() Cancel A save Table :]
Show Medified Rows Only validation Status: 0
> 2 Va ~ | Immediate E..~ | Scheduled E..~ Hold Enabled ~ Logged InCh..>» Immediate Bl.» Callback Pur..~ Call Display ...~ Call Display . =

default true true true false 60 120
_CB_VQ  true true true false 60 10
_CB_V..  true true true false 60 3
_CB_V.. false false false true 60 120
&  Sales_vQ true true true false 60 120 Sales

The default VQ row in the CALLBACK SETTINGS table must include a valid Designer Callback-type
application, a valid Business Hours object, and a semantically-correct skill expression.

In the row in which you are configuring the Inbound virtual queue, select your Designer Callback-type
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application in the Callback Application column of the table. In the figure, this is the Sales VQ row
of the table.

If you defined Callback Skills for Callback agents, you can use this as a condition for the Inbound
virtual queue.

For Callback-type applications, you must specify the routing point in the Routing Point column. The
routing point for Callback-type applications is required for Callback to be fully functional. Outbound
calls can sometimes fail if this is not configured.

Testing Your Callback Scenario

Now you can test the in-queue Callback scenario. Call the phone number that is assigned to the
Designer Default-type application and accept an in-queue callback for an external phone number on
which you can receive calls. If an agent with a matching skill is already logged in to the voice channel
in Agent Desktop, you will receive a phone call on the external phone number. Once you have
accepted the callback on the external phone, the call will be connected to the logged-in agent.

To test scheduled callback, call the phone number that is assigned to the Default-type application and
choose Scheduled Callback. Listen carefully to the prompt. If it is using default settings, then it will
ask you to specify a day and time for the callback based on the Pacific time zone. Also pay close
attention to the actual date and time that you booked before accepting, especially if you have
entered a time intended to be on the current day; the system might have offered you a time slot that
is a week later. The outbound call experience is identical to the in-queue callback scenario.

To test web callback, see Managing Callbacks for information about creating a callback in the
Callback application, or Genesys Engage REST APIs and Tutorials for Callback for information about
creating a callback using the REST API.
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Controlling User Access

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Controlling user access.

You can limit user access and activities in the Callback application to what is appropriate for each
user's role in your enterprise. For example, to perform their duties, it is sufficient for some users to
only view the list of callback records in the Callback application, without the ability to modify a
callback in any way. Other users might require additional permissions; for example, some users might
require access permissions that allow them to view errors associated with callbacks so they can
troubleshoot problems.

You configure the restrictions on user access and activities for Callback in the Platform Administration
application. If you do not configure access and activity restrictions for a user, then that user has full
access to everything in the Callback application.

Genesys provides predefined Roles for the Callback application to ensure that your users have access
that is appropriate for your business needs - such as the ability to view and modify Callbacks, use the
Developer tab, and view Callbacks based on lines of business. For detailed information about Roles,
see the Roles section in the Platform Administration documentation.

Migration of Roles

If you have not yet moved to the Roles and Access Group settings described on this page, the original
method for configuring Callback access still applies to your setup. In the original configuration,
Callback access was granted when the ges or gms section in the Person object's annex included a
role option (for example, Administrator).

To move to the new configuration method for granting access, add your user to the correct Callback

or custom Access Group and remove the ges or gms section. If you don't remove the ges or gms
section, the old configuration applies and the Access Group is not taken into consideration.

Callback Roles

Genesys provides the following default Callback Roles:

¢ Callback Administrator—Callback Administrators have full access to the Callback application, which
includes the ability to create, cancel, and reschedule callbacks, and to export reports. Users with this
Role can also access all of the Developer tab features.
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« Callback Supervisor—Supervisor users have full access to the Callback panel, which includes the
ability to create, cancel, and reschedule callbacks, and export reports. They cannot access the
Developer tab in the Callback application.

« Callback Monitor—Monitor users can only view callbacks.

* Callback Developer—Developer users can view callbacks on the Callback tab and have full access to
the Developer tab, which includes the ability to view recent errors, test API keys, and to provision
Callback.

If a user is a member of more than one Role, the Role that allows the most access to Callback
features takes precedence.

Predefined Access Groups Supporting Callback

By default, Genesys defines a list of Access Groups and adds Callback Roles to some of these groups,
as described below. Users who are already in these Access Groups are given Callback permissions by
default. For example, any user in your Administrators Access Group is automatically granted the
Callback Administrator role.

The Access Group name is prefaced with your company's business name if the Access
Group is not Callback-specific. For example, if your business name is ACME, then the
Access Group for Administrators is called "ACME Administrators".

Callback .
A Callback Callback Monitor Callback
(AR (L) Admg;sérator Supervisor Role Role Developer Role
Administrators v
Supervisors v
Managers v
Callback ,

Developers

Line of Business Segmentation

By default, all users who are part of standard Access Groups and can access the Callback application
will have Read permission for all the Virtual Queues. To restrict access to queues based on your lines
of business, you can create custom Access Groups and enable or disable Read permissions as
required.
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Configuration  Routing Parameters
Home > Scripts = Scripts > Customer > Callback
[ select © New : More @, Hide Quick Filter Direct... Callback (Script Folder) v
Q sales X
. Name =] Script Type
. 8 ges Sales vQ Data Collection

Any time you provision a Virtual Queue in Designer's CALLBACK SETTINGS data table, the Callback
service automatically creates a Script object in Platform Administration > Scripts > Callback.
The created Script object has the same name as the Virtual Queue and is prefixed with the ges
label. For example, if you create a Virtual Queue called Sales VQ, there will be a Script object called
ges_Sales VQ in the Callback directory.

To control access to queues based on your lines of business, you must create Access Groups for your
various lines of business and then enable or disable access to the script objects that represent the
virtual queues for each group. For a user to access a specific queue, the Access Group to which the
user belongs must have the Read permission for the script object that represents that queue. The
Read permission is assigned by default to all Access Groups, which means that all Access Groups can
access all Virtual Queues until you change the permissions. To deny access to a Virtual Queue,
navigate to the Script object associated with the queue and remove the Read permission from Access
Groups that do not require access to that queue.
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= GAX Pulse Configuration Routing Parameters
Home > Scripts > Scripts > Customer: > Callback > ges_Sales_VQ Properties L& Clone 1 Delete B Move To
General
Permissions Add Access Group Add Person

Options

. Mame ] Tenant ] Create Read Update Delete E
Permissions e e - bt bt i
Dependencies o ® Provisioning Environment

[ 2 Read Only Environment

a 2 Sales Environment

o 2 service Environment

o P Super Administrators Environment

. & SYSTEM Environment O O O

o ®P Test Accounts Environment

o & Users Environment O] O] O]

. 2 default Environment

m 2 onPremise Environment

Cancel

For example, if your Tenant has two lines of business called Sales and Service, you could create two
Access Groups for Callback: Sales and Service. Then, navigate to the script object representing the
VQ and add that Access Group with read permission:

* In the ges_Sales_VQ Script object, retain the Read access for the Sales team and disable the Read
permission for the Service team.

* In the ges_Service_VQ Script object, retain the Read access for the Service team and remove the
Read permission from the Sales team.
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Configuration

Home = Seripts = Seripts = Customer > Callback = Sales LOB Properties
General
Permissions Add Access Group A

Options

Name ¥ Tenant El Create Read Update Delete Exec... RP cP Prapagate
Permissions

P Administrators Environment L4 L4 ) Ld Ld Ld L L

2 callback Sales Environment - /\ ‘

..P Callback Service Environment L

& Customer2039 Administrators Environment i il o} ] #| td it td

To set permissions on groups of Virtual Queues (instead of one at a time), create subfolders under the
Scripts > Callback folder and apply appropriate permissions to the subfolder. Then, move the Script
objects representing the various Virtual Queues into the corresponding subfolder. Any Script object
that is in a subfolder will inherit the permissions of that subfolder. Check the Propagate box to apply
the permissions to any object that is in the folder. The permissions apply to any Virtual Queue that is
in the subfolder now and will apply to any new Virtual Queue that you add to the subfolder in the
future.
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Managing Callbacks

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Managing callbacks.

You might see Service or Service Name mentioned in the Callback Ul. A service, in this context, is a
virtual queue. The service name, therefore, refers to the name of the virtual queue. On the Callback
page in the Ul, the Service Name column identifies, by name, the virtual queue associated with
each callback.

Callback Monitor is the minimum role required to access the Callback tab.

The Callback page in the Callback application displays the list of callback records. Callbacks are
displayed in pages of 250 items. On this tab, you can create, edit, or cancel callbacks if you have
sufficient user privileges. Your ability to access tabs and dialogs on the Callback page is based on
your Role permissions.

A callback record will continue to display on the Callback page for a fixed number of days after the
Desired Callback Time has passed; you might need to select a different time filter in order to see it.

Callback records are stored for 14 days. The 14-day TTL setting starts at the Desired
Callback Time. The Callback TTL (seconds) setting in the CALLBACK SETTINGS
data table has no effect on callback record storage duration; 14 days is a fixed value
for all callback records.
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Callback states

Callback

o X hd Last 14 Days v Q ~ o3
State Desired Callback Time Phone Number Service Name
COMPLETED (AGENT) 07/08/2019 11:42:26 AM
COMPLETED (AGENT) 07/08/2019 12:48:12 PM t
COMPLETED ~ (AGENT) 07/08/2019 03:28:10 PM 3
COMPLETED ~ (AGENT) 07/08/2019 04:06:23 PM t
COMPLETED (AGENT) 07/08/2019 04:43:13 PM t
COMPLETED ~ (AGENT) 07/08/2019 04:47:40 PM
07/08/2019 04:58:47 PM

Callback records can have the following states:

¢ SCHEDULED—Callback Management is handling the request (there are no sessions started in the
system). While in this state, the request is available in the Callback tab when the specified Desired
Callback Time is upcoming.

* QUEUED—Callbacks actively waiting for an agent in ORS/URS; the agent is not assigned yet.
* ROUTING—Agent is reserved but the call is not yet routed to the agent.

¢ PROCESSING—Callback being handled by assigned agents. You cannot cancel a callback when it is in
the PROCESSING state.

e COMPLETED—Callback was completed with a result; for example, timed-out, cancelled, and so on. See
the Result tab of your Callback block in Designer. The completed reason appears beside COMPLETED
in the state column of the table.

When a callback in the SCHEDULED state remains in that state past the Desired Callback Time, a
warning icon displays to alert you. Hovering your cursor over the icon displays the warning message.
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% Craste Callbach o * ]
Callbsack 1D II'I/
COMPLETED [B]
COMPLETED [E] I|'
COMPLETED &
e — -
| — — —— )
— - —— I

A calendar icon displays beside callbacks that originated as scheduled callbacks. If there is no icon
associated with a callback's state, then the callback was initiated as an immediate callback.

Callback Administration Overview

Callback Develope: Call-In adm

Last 14 Days v

Desired Callback Time Phone Number Service Name

=+ Create Callback

COMPLETED ~ (AGENT) Refresh the 07/08/2019 11:42:26 AM

: elect the date range
callback list Sell 4
COMPLETED v (AGENT) 07/08/2019 12:48:12 PM for which you want to

view callbacks

COMPLETED ~ (AGENT) 07/08/2019 03:28:10 PM
COMPLETED  (AGENT) 07/08/2019 04:06:23 PM
COMPLETED ~ (AGENT) 07/08/2019 04:43:13 PM
COMPLETED (AGENT) 07/08/2019 04:47:40 PM

07/08/2019 04:58:47 PM

The Callback tab includes the following features:

¢ Refresh—You can force the interface to refresh the list of callbacks.

¢ Date range selector—The date range drop-down menu lets you filter the list of callback records based
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on a specific (pre-defined) period of time. In the Advanced Options window, you can add your own
custom date range to the drop-down menu.

Select the filtering option from the .
drop-down
State -
State Desired Callback Time Phone Number Service Name:
Completed Reason
- Desired Time
COMPLETED ~ (AGENT) 07/08/2019 11:42:26 AM =]
Phone Number H
COMPLETED ~ (AGENT) 07/08/2019 12:48:12 PM Service Name 3
COMPLETED ~ (AGENT) 07/08/2019 03:28:10 PM 3
Enter the property that you are
COMPLETED + Create Callback o X ¥ . Next 2 Weeks v Q, 15065555555 x v el
= searching for
COMPLETED
State Desired Callback Time Phone Number Service Name
COMPLETED ~ (CANCELLED_BY ADMIN) 07/16/2019 04:30:00 PM 15065555555 t
COMPLETED ~ (CANCELLED_BY_ADMIN) 07/25/2019 01:45:00 PM 15065555555 t

e Search box—You can select a column field in the drop-down at the right of the Search box. The interface
then filters the results dynamically as you type.

Callback

+ Create Callback o X ¥ Check your time filter Last 14 Days v Q v
State Desired Callback Time Phone Number Service Name

COMPLETED

(AGENT) 07/08/2019 11:42:26 AM

07/08/2019 03:28:10 PM

If you do not see your callback after you successfully create it, make sure that your time filters are
correct. For example, if you scheduled a callback to occur in two days, it does not show up if the Last
30 Days label is selected; switch to Next 7 Days for example.
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Metrics

Callback  Develope

+ Create Callback o x

State Desired Callback Time Phone Number Service Name

&

Lest 14 Days v - ol

COMPLETED  (REDIAL_LIMIT_REACHED) 07/09/2019 09:41:29 PM

COMPLETED ~ (REDIAL_LIMIT_REACHED) 07/09/2019 09:46:10 PM

Estimated wait time: 10 Seconds
Callback

Positionin queue: 1

Create Callback s x hd Last 14 Days ~ ~
State Desired Callback Time Phone Number Service Name

COMPLETED  (REQ(L_LIMIT_REACHED) 07/09/2019 09:41:29 PM

JAL_LIMIT_REACHED) 09:46:10 PM

The small arrow toggles the COMPLETED @

default metrics list
Agents logged in: 0

Agents logged in at first outbound call: 0

Use the Advanced Callback
Metrics toggle to view a more b

Call direction: CUSTOMER_TERMINATED
Callback origination channel: WEB complete list of metrics for the
Callback type: WAIT_FOR_AGENT callback

Dial attempts: 3

Dial result; CONNECTED

Estimated wait time: 10 Seconds

Estimated wait time at callback offer: 10

Estimated wait time at first outbound call: 0

s snoozed: false

ORS URI - bt/

On the Callback tab, you have access to diagnostic data or metrics for each callback record. The
metrics that are available for a callback depend on the callback's state. As the state of the callback
progresses, more data becomes available, which means that additional metrics become available as
well.

To view the metrics for a callback, click the arrow beside the record. Callback provides some basic
information below the callback record (Position in Queue and Estimated Wait Time).

To view all metrics for the callback, click the Advanced Callback Metrics toggle. For example, you

might want to know who cancelled a particular callback. That information is available in the list of
advanced metrics.

The username of the person who created, cancelled, rescheduled, or recreated a
callback is captured only when the action is performed in the Callback Ul.

Advanced options
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Callback

Advanced Options
$---‘_‘_‘—‘—-_

Configure Columns Visible Callback Services

[#Show Time in 24 Hour
Show Times in UTC
Include Callback ID

[#Include Service Name

[#Include Time Updated

Configure Custom Date Range

©Add Custom Date Range

Offset From Today (-14 to +14 days)
Range name Start End

Visible Callback States

(#ALL]
[WSCHEDULED
[¥/QUEUED
[WROUTING

Close

Advanced Options—Opens a new window where you can customize how the Callback tab displays
data:
¢ Configure Columns—Select display properties for columns.
* Show Time in 24 Hour—Show all times in 24-hour time rather than AM/PM format.
* Show Times in UTC—Show all times in the table in UTC time rather than local time.
¢ Configure Custom Date Range—Add a time range filter.

e Filter the display of callbacks by States and Services—To filter the list of callbacks that display on the
Callback tab, you can select specific callback states and virtual queues (services). To view callbacks in
any state, select ALL in the Visible Callback States list. Similarly, to view callbacks from every virtual
queue, select ALL in the Visible Callback Services list.

Create or Schedule a Callback

This feature requires the Callback Administrator or Callback Supervisor role.
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Add New Callback

Callback Type

Scheduled

Service Type

Callback Parameters

15065555555
Customer Number:

Desired Date: 07/25/2019 £y

Available Time Slot: 07/25/2019 01:45:00 PM  ~

Cancel Create Callback

You can submit or schedule a callback request by clicking Create Callback. A new dialog opens.
Select the Callback Type (Immediate or Scheduled), then a Service Type (the name of the virtual
queue provided in Designer), and enter the number to call in the Customer Number field. For
scheduled callbacks, select a date and time for the call.

If you provision a virtual queue for callbacks in Designer while you are logged in to the
Callback Ul, be aware that the new queue will not be available for use in the Callback
Ul until you log out and log in again because Callback fetches virtual queue
permissions data only at login. In other words, Callback determines which virtual
queues you have access to when you are logging in, and only then.
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Edit a Callback

This feature requires the Callback Administrator or Callback Supervisor role.

Edit Callback

Current Callback Information
Callback Time 07/16/2019 04:30:00 PM

Callback Number 15065555555

Change Desired Time

Desired Date: e m

Available Time Slot: Please Selecta Time Slot v

Cancel Callback

If a callback can be edited, a blue pencil displays in the last column of the table. Click the pencil icon
to display the edit options for that callback:

* You can choose to reschedule the callback (only for SCHEDULED callbacks).

¢ You can choose to cancel the callback.

Recreate a Callback

This feature requires the Callback Administrator or Callback Supervisor role.
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Recreate Callback

Current Callback Information

Last Callback Time 07/08/2019 12:48:12 PM

Callback Number

Desired Callback Time

Desired Date: 07/08/2019 1

Available Time Slot: Please Selecta Time Slot v

i

For completed callbacks that can be recreated, the icon displays in the last column of the table.
Click the icon to open the Recreate Callback dialog for that callback.

Name recordings will be preserved if a callback is rescheduled within four days of the completion of the
original callback.

Bulk Cancel and Export of Callback Records

This feature requires the Callback Administrator or Callback Supervisor role.
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@ Cancel Callbacks Confirmation

Cancel All Callbacks in Current Time Range: ( 1 Callback(s) )
Callbacks to Cancel in Current Page: 1

0c427d56-334c-4382-b614-10e2f0f2a480 SCHEDULED  2019-07-25T16:45:00.000Z 15065555555

Confirm and Cancel Callbacks

Make sure to select an appropriate time range to filter callbacks, then make a callback selection to
activate the Cancel Callbacks button. When you click this button, the Cancel Callbacks
Confirmation dialog opens, displaying the selected callback cancellations.

You can either:

¢ Continue with the selections you have made and click Confirm to cancel them.

e Check Cancel All Callbacks In Current Time Range to override your previous callback selections
and delete all callbacks in the current time range. In that case, the list of displayed callbacks
disappears from the dialog. Callbacks that are in the PROCESSING state cannot be cancelled. If there
are any callbacks in this state within the selected time range, they are excluded in the Cancel
Callbacks Confirmation dialog box and are not cancelled.

Click Confirm to cancel the records.
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Callback

+ Create Callback s] x hd Next 2 Weeks v |Q v 0
State Desired Callback Time Phone Number Service Name

COMPLETED (CANCELLED_BY_ADMIN) 15065555555 (=}

You can export cancelled reports
or recreate cancelled callbacks

The resulting display shows all the callbacks that you have cancelled and that are now in the
COMPLETED (CANCELLED BY ADMIN) state.

Download Reports

Callback

Export Cancelled Reports

Report Type

Cancellation Summary Report

The Export Cancelled Reports dialog provides the Cancellation Summary Report file only if you
recently cancelled some callbacks. This report shows the cancellation status of the recently-cancelled
callbacks.
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Provisioning the Click-to-Call-In Scenario

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Provisioning the Click-to-Call-In scenario.

A EONSUMER (S USIng your mobile app and
has a question, so the consumer clicks the
Call Us button.

Click-To-Call -1

Click-To-Call-in (Delayed)
(lwunediate) connects .
starts by sending a
the consumer to the

callback request to your
contact center system

contact center systent

immediately.
v \d

You can use Callback's Click-To-Call-In feature to let consumers initiate a call to your contact center
directly from your mobile app. Click-To-Call-In is advantageous because it can provide the context of
the call to the agent. In addition, the data can be used for routing and reporting purposes.

You can implement the Click-To-Call-In functionality so consumers are immediately connected to the

contact center; tapping the Call Us button in your app initiates the call. Depending on the Estimated
Wait Time (EWT) on the queue, the consumer might be given the option to take a callback after they
are connected to your contact center. The other option is to configure the feature to delay the call
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until the system is sure that there is an agent available who has the correct skills to assist the
consumer. In both scenarios - immediate or delayed connection to your contact center - you must
configure Click-to-Call-In groups in the Callback Ul. If you configure the delayed scenario, then you
must also provision Push Notifications.

Click-To-Call-In (Delayed) Scenario Push Notifications
Push Notifications are not used with the Click-To-Call-In (Immediate) scenario.

If you use the Click-To-Call-In (Delayed) scenario with your mobile app, then you must provision Push
Notifications. Your mobile app sends a callback request when the consumer taps the button or link
that you have provisioned for the Click-To-Call-In (Delayed) feature. The callback request includes the
Push parameters. For information about the Push Notifications supported with Callback, see Callback
Push Notifications. For a description of the Click-To-Call-In (Delayed) scenario, see How Click-To-Call-In
(Delayed) works.

Provisioning the Click-To-Call-In (Immediate) Scenario

To provision the Click-to-Call-In (Immediate) scenario, you will work in both Callback and in Designer.
You can do the work in the Callback Ul before you do the work in Designer or after. Either way, the
configuration in both must be completed before you can test your Click-To-Call-In (Immediate)
scenario.

The Click-To-Call-In (Immediate) scenario uses the Genesys Engagement Services (GES) Call-In API.

For information about the callback-related APIs, see Genesys Engage REST APIs and Tutorials for
Callback.

Overview of the Provisioning Steps

You do not require a dedicated virtual queue for the Click-To-Call-In (Immediate) scenario. The
consumer is simply calling into your contact center.

You must provision the following for the Click-To-Call-In (Immediate) scenario:

¢ In the Callback Ul, provision the following:

* Click-to-Call-In groups: Required by the system to determine which telephone number is appropriate
for a Click-To-Call-In request. The system also uses the group configuration to determine whether or
not an access code is required when the consumer dials in.

e In the Designer Ul, provision the following:

* A Click-to-Call-In Match application: This application must include the Click-to-Call-In Match Block.
This Designer application must be of type default. During this part of the process, the system
attempts to match a caller to a Call-In request based on data received with the request and data
that the system provides in the response, such as the number that the caller dialed (the DNIS
number), the access code (if required), and the caller's telephone number. If the attempt to match a
caller to a Call-In request is successful and your Designer application is configured to route the call
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when a match is made, then the call is queued on hold like any other call to the contact center.

Provisioning the Click-To-Call-In (Delayed) Scenario

To provision the Click-to-Call-In (Delayed) scenario, you will work in both Callback and in Designer.
You can do the work in the Callback Ul before you do the work in Designer or after. Either way, the
configuration in both must be completed before you can test your Click-To-Call-In (Delayed) scenario.

The Click-To-Call-In (Delayed) scenario uses the following Genesys Engagement Services (GES) APIs:

e Callback
e Call-In

For information about callback-related APIs, see Genesys Engage REST APIs and Tutorials for Callback.

Before You Start

Before you start provisioning Designer applications for Click-To-Call-In (Delayed), create a virtual
queue in Platform Administration for this purpose. You need to add the queue to the

CALLBACK SETTINGS data table and then configure it, so be sure to give it a name that helps to
identify it; for example, ClickToCallinDelayed_VQ.

Overview of the Provisioning Steps

You must provision the following for the Click-To-Call-In (Delayed) scenario:

* In the Callback Ul, provision the following:

e Push Notifications: Required for communicating information about the call-in to the consumer such
as when the callback is ready, what number to call and - if required - what access code to enter.

* Click-to-Call-In groups: Required by the system to determine which telephone number is appropriate
for a Click-To-Call-In request. The system also uses the group configuration to determine whether or
not an access code is required when the consumer dials in.

e In the Designer Ul, provision the following:

* A Callback application specifically for Click-To-Call-In (Delayed): Used to start the callback process.
This Designer application must be of type Callback. During this part of the process, the call is
queued in the Click-To-Call-In Delayed virtual queue.

* The Click-To-Call-In Delayed virtual queue in the CALLBACK_SETTINGS data table.

e A Click-to-Call-In Match application: Used when the customer calls the phone number that the
system provided in a Push Notification. This Designer application must be of type default. During
this part of the process, the system attempts to match the caller to an existing callback record and,
if successful, routes the call to an available agent. For more information about the Click-to-Call-In
Match block, see Click-to-Call-In Match Block.

Every environment is different and requires its own specific routing logic, error handling, and so on.
That means that, in addition to the configuration described in this section, you must consider what
customized configuration you require in the Designer applications and in the virtual queue used with
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the Click-To-Call-In (Delayed) scenario. This section describes only the basic configuration that is
required in all environments to provision the Click-To-Call-In (Delayed) scenario in Designer.

Provision the Click-To-Call-In Delayed Callback Application

1. In Designer, create a new application. Select Callback for the type.

2. Add a Callback V2 block to the Initialize phase.

3. In the properties of the Callback V2 block, select Customer dials in, rather than Business to

customer under the Connect Customer tab.

Properties - Callback V2

‘2 This block is used to offer callback and reconnect to the customer when an agent is ready.

2 Connect Customer : Routing Priority 2x Advanced 1 Result

When an agent is ready, select which party should initiate/the call.

Business to customer (8) Customer dials in

4. In all other regards, configure the application as required for your contact center.

5. Save and publish your Click-To-Call-In (Delayed) Callback application.

Configure Settings for the Click-To-Call-In Delayed Virtual Queue in the Data Table

1. In Designer, navigate to Business Controls > Data Tables and open the CALLBACK_SETTINGS data
table.

2. If you have not yet done so, add the Click-To-Call-In Delayed virtual queue to the table; otherwise, find
the queue in the table.

3.

Make sure that you configure all of the following settings in the data table for this queue, in addition to
any other parameters that you choose to customize for your environment:

* Pushed Callback Expiry Time (minutes). This setting specifies how long the callback session
stays alive after the system sends the initial Push Notification to the consumer. If the callback
expires, any subsequent Call-In request related to that callback session will fail.

* Push Notification Threshold (minutes). This setting specifies when to send the
CALLBACK_UPCOMING Push Notification to the consumer. For example, if you specify a value of 1,
then when the Estimated Wait Time (EWT) on the queue drops below 1 minute, the system sends a
CALLBACK UPCOMING Push Notification to the consumer if conditions are favorable for the callback
to proceed. For detailed information about the CALLBACK_UPCOMING Push Notification, including

information about cases in which the system does not send this notice, see Callback Push
Notifications.

¢ Call Direction. This must be set to USERORIGINATED.
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* Callback Application. Select the Callback-type application that you created for the Click-To-Call-In
(Delayed) scenario.

The Callback Purge Time and the Business Hours that you specify in the CALLBACK_SETTINGS
data table for the Click-To-Call-In Delayed virtual queue are applied to this queue just as they are
applied to any other queue. Those two settings are relevant when the system must determine if
the callback can be purged or not. In addition, Genesys recommends that you configure the Skill
Expression for the virtual queue to ensure that the calls are routed to the agents who can best
serve the consumers who are calling in.

Tip
The callback will be purged at the end of the day based on the specified business hours, regardless of
the Callback Purge Time status.

4. Save and then publish your updated data table.

Provision the Click-to-Call-In Match Application in Designer

In addition to the Callback-type Designer application, you also require a Click-To-Call-In Match
application for the Click-To-Call-In (Delayed) scenario. When a Push Notification sends the number
and optional access code to the consumer, then the consumer calls in. The Match application
matches the caller to the original callback request. Based on the results of the matching attempt, the
application either routes the call to an agent (successful match) or the call moves to the next block
(no match). The routing is performed by a Route Call block.

The Match application must be a Default-type application. It can be used with multiple Click-to-Call-
In Delayed virtual queues and multiple Click-to-Call-In Groups.

Sample Configuration

For the purposes of the following procedure, let's assume that consumers who are using the Click-To-
Call-In feature are prompted to enter an access code. We'll have the application perform the match
only on the access code.

1. In Designer, create an application of type Default.

2. Click the Initialize phase and add the variables that you will use to store block outputs.

3. We will add the following blocks to the Assisted Service phase to handle the call flow:

e User Input: This is required when you are using access codes with the Click-To-Call-In (Delayed)
scenario. You configure this block to prompt the user to enter the access code.

e Click to Call In Match: In the Click To Call In Match block, on the Match criteria tab, select the
option to use the access code that the consumer enters as the matching criterion.
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Application Flow

RS Click to Call in Mateh
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B Play Message
O Terminate Call
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Make sure that you configure the parameters on the Routing Parameters tab. As with any
application, consider the logic that needs to be configured to handle all outcomes

appropriately for your contact center.
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If a match is made between the caller and an existing callback record, then the call needs to

move to the Route Call block.
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* Play Message: When the system can find no successful match for the caller or the caller is dropped
from the Match block for any reason, then the Play Message block informs the caller that the system
could not find their record.
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e Terminate Call: When no match can be found between a caller and existing callback records, and the
message in the Play Message block has finished playing, then the call drops to the Terminate Call
block and the call ends.

* Route Call: When a caller matches a callback request that exists in the system, then the system
routes the call based on the information in this block. The routing priorities, virtual queue, skill
expressions, and so on are included in the Routing Parameters tab of the Click To Call In Match
block. You must assign the variables used in the Routing Parameters tab to the corresponding
fields in the Route Call block in order for the call to retain its priority from the original callback
request.
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Viewing Click-To-Call-In records

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Viewing Click-to-Call-In records.

Callback supports the Click-To-Call-In scenario. Use the Call-In tab in the Callback Ul to view the
Click-To-Call-In records.

To view the Call-In tab, you must be a member of the Callback Administrator or
Callback Developer role.

For information about provisioning the Click-To-Call-In groups that are required for Callback Click-To-
Call-In functionality, see Configuring Click-To-Call-In Groups.

You can find information about using the Genesys Engagement Service (GES) APIs, including the
Click-To-Call-In API, on the Genesys Engage REST APIs and Tutorials for Callback page in this Guide.
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Using the Call-In tab

2 Al v Qo v

D State Time Created ANI Expiry Time Group Name 5
E4Sb:E:ﬂZ?:;gsj::bd2hr Expired 09/05/2019 04:56:15 PM 09/05/2019 04:56:45 PM nonUniqueGroupl
590“::;03:‘0‘;?:3%5 Completed 09/05/2019 04:55:42 PM 09/05/2019 04:56:13 PM nonUniqueGroupl

:gﬂg;;’ii;‘i‘; Expired 09/05/2019 04:55:41 PM 09/05/2019 04:56:12 PM nonUniqueGroupl |
%”":215793“;‘1:::6553% Expired 09/05/2019 04:55:40 PM 09/05/2019 D4:56:11 PM nonUniqueGroupl
2 of:g::z:;:;:gm et Completed 09/05/2019 DA:55:26 PM 09/05/2019 04:55:57 PM nonUniqueGroupl

hf”ﬂ:ﬁfﬁz;i::ﬂsc‘j' Expired 00/05/2019 04:55:25 PM 09/05/2019 04:55:56 PM nonUniqueGroupl ]
;g;ziﬁh;’:f;::ig Expired 09/05/2019 04:55:24 PM 09/05/2019 04:55:55 PM nonUniqueGroupl
6e37di53773:;:::::2;9bb2' Expired 09/05/2019 04:54:26 PM 09/05/2019 04:54:56 PM nonUniqueGroupl
“:;ﬂ;‘;::;t:éﬁg' Expired 09/05/2019 04:54:25 PM 09/05/2019 04:54:56 PM nonUniqueGroupl
gfdg‘gzj;;gics“;;:weu' Expired 09/05/2019 04:54:24 PM 09/05/2019 04:54:55 PM nenUniqueGroupl

16 Call In(s) Found

The Call-In tab lists up to 5000 Click-To-Call-In records. Once you have more than 5000 Click-To-Call-
In records, the oldest records are dropped from the list in the Ul.

One page on the Call-In tab displays up to 500 records. Once you have more than 500 records, you
can use the pagination tools at the bottom of the page to navigate through the records.
Filtering and sorting the records list

To help you find specific records more easily, the Call-In tab offers the following filtering tools:

 Filter the list using the predefined time-range filters available at the top of the page.

e Click a column heading to sort the records in ascending or descending order.
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Time Created

0 v
5046 be-Decd 4420305 Comp D5/D05/ 2019 04-55:42 PM
fa63909 14a2

S90fbSd-bAch-434d-8181

elcbldded3ed

Completed 050520 1% D4 5526 P

e Sboebic-ddS9-4614-bdb- o
ba@f6efS4abs Expired D9/05/2019 04:56:15 P

ﬂ_'—‘_h\_\‘_‘_‘_’_’/_,/_—’_'—‘_
e Search based on a specific record attribute. In this example, we want to find all of the records that are
in the Completed state. We select State from the drop-down menu and enter Completed in the Search

field. Only records that are in the Completed state display.

Q
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Using the Developer Tab

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Troubleshooting and validating functionality.

The Developer tab requires the Callback Administrator or Callback Developer
role.

Displaying Errors

Developer

+ Create Callb ¥
API Key Validation

Credential Management
State Allowed CORS Domains Desired Callback Time,

Developer

Most Recent Errors
s Q v
Select an Error to View Details
Correlation ID URL Method Time Stamp Status Code
0b3f9540-a8c9-11e9-881c-4d BGET 2019-07-17719:28:24 3627 50001
5741f520-28b8-11e9-acbd-e7... GET 2019-07-17T17:28:50.539Z 50001
17d95120-a832-1129-97d3-87. GET 2019-07-17T01:27:51 5052 50001
ba130650-a7bc-11€9-8228-f7... GET 2019-07-16T11:27:43.067Z 50001
36601d20-a758-119-b079-2f GET 2019-07-15T23:28:12.6712 50001
65e9f9a0-a747-11e9-8¢c38-b5.. 2019-07-15T21:27:50.741Z 5701

The Developer > Errors page displays the list of errors related to your Callback API queries. If you
select one of the listed errors, the tab displays more information in the right-hand panel. When an API
call returns an error, the response includes a correlation ID. Use this correlation ID as input into the
Search bar to find more information about a specific API call.

This should help you to solve API issues when developing an application using the REST APIs.
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Viewing CORS Domains

Developer

Errors

APl Key Validation

Credential Management

Allowed CORS Domains

Developer

To use GES APls in your web applicatiorf you need to register the host of the web application as a CORS origin.
Please contact your @enesys representative in order to add additional tenants.

CORS Origins

https://

https://

To access Genesys Engagement Services (GES) APIs in a Web application, your Web application's host
must be registered as a "safe" domain or origin. The Developer tab includes an Allowed CORS
Domains page, which you can access from the Developer tab menu. On the Allowed CORS
Domains page, you can view the list of domains or origins that have been provisioned for your use.
Cross-origin resource sharing (CORS) requests to the origins in the list are allowed.

The list of origins on the Allowed CORS Domains page is read-only. To add cross-origin resources to
the list, you must contact your Genesys representative.

If you do not currently have the Allowed CORS Domains page in your Callback Ul,
contact Genesys Customer Care to request it.
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Validating your APl Key

Developer

Errors

+ Create Callk b4
AP| Key Validation
Credential Management
Allowed CORS Domains Desired Callback T

If your permissions allow it, the Developer tab menu includes API Key Validation.

Developer

Validate APl Key

Validate APl Key

Copy/paste your API Key into the textbox and click the Validate API Key button.

e If your API Key is incorrect, the Ul displays Invalid APl Key.
e If your API Key is valid, the Ul displays Valid API Key.

Using Credential Management

The Developer tab menu includes Credential Management if you have sufficient permissions to
view this part of the interface. Use Credential Management to register, manage, and test
credentials for features within your Callback environment and features such as push notifications that
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work within other supported delivery networks.

Developer

Credential Management

Push Motification Upda‘[e GWS Credentials

CAPTCHA

GWS Credentials

Username

Password

Callback Administrators and Developers have access to GWS statistics information through Callback's
Statistics API, but you must register your credentials on the Credential Management > GWS
Credentials tab before you can retrieve the statistics.

For additional information about the Callback APIs, see Genesys Engage REST APIs and Tutorials for
Callback.

On the Credential Management page, Callback Administrators and Developers also manage
credentials for the following features:

¢ Push notification

« CAPTCHA
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Provisioning Push Notifications

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Provisioning Push Notifications.

Push Notifications are messages that are proactively sent from an app to a known, permitted client
(either a mobile device or a web browser). Modern smartphone users will be well acquainted with
push notification behavior within their favorite apps.

The Push Notification page in Callback helps you to integrate Push Notification support into your
apps. In the Callback Ul, you implement Push Notifications on the Developer > Credential
Management > Push Notification tab. Only users who are members of the Callback Developer
and/or Administrator Roles can access this tab. See Controlling User Access for more information
about controlling user access to Callback tabs and features. As long as you have sufficient
permissions to view the Push Notification page, then you have full access to use all of its features.

In terms of Callback features, you might want to include a Click To Call feature in your mobile app so
customers can easily connect with you when they need an agent's assistance. As part of that
feature's implementation, the system can communicate with the customer through Push
Notifications; for example, in cases where the system needs to let the customer know that an agent
is available to take their call or to offer follow-up actions such as the ability to confirm or cancel the
call. For information about provisioning the Click-To-Call-In feature in Callback, see Provisioning the
Click-to-Call-In Scenario.

Callback Push Notifications

If Push parameters are provided with a Callback Create API request on a standard callback virtual
queue, the system can send Push Notifications for the following events:

e CALLBACK UPCOMING—When the callback's Estimated Wait Time (EWT) is below the configured
threshold for the queue (configured under the Push Notification Threshold (minutes) setting in the
CALLBACK_SETTINGS data table), the CALLBACK_UPCOMING event sends a Push Notification to let the
consumer know that they can expect a phone call soon. This event is sent only once. In other words, if
the EWT increases above the threshold after the notification is sent and then drops below the threshold
again, the CALLBACK_UPCOMING Push Notification is not sent again.

The system might not send a Push Notification for the CALLBACK _UPCOMING event in the following
situations:

* When the EWT is already low (below the configured threshold) when the Callback Create API request
arrives.

* When the system determines that there is not enough time to complete the callback because the
callback will be purged or the end of the business will occur before the callback is at the top of the
queue.
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e CALLBACK READY—Used only with the Click-To-Call-In (Delayed) scenario. When a consumer's callback
request reaches the front of the queue, the CALLBACK READY event sends a Push Notification to alert
the consumer. If the consumer accepts the callback, the mobile app sends a Call-In Create API request.
The system immediately sends another Push Notification with the information that the user needs to
call in to the contact center.

Note that the callback "acceptance" is a function of your mobile app's configuration. For example,
your mobile app developer might configure your mobile app to automatically make the call-in
request as soon as it receives the CALLBACK_READY notification or the app could require the
consumer to manually make the call-in request by clicking a button to acknowledge receipt of the
notification.

e CALLBACK PURGED—This Push Notification is sent if the callback has been purged from the system and
the callback was not rescheduled.

* CALLBACK_ATTEMPT_FAILED—This event occurs when the system makes the outbound call for a
callback, but the call fails to connect to the consumer for some reason. Another outbound call can be
attempted later. In the CALLBACK SETTINGS data table, you can configure the number of times that the
system will make outbound calls for each Callback request before declaring failure. This Push
Notification is not used with the Click-To-Call-In (Delayed) scenario because there are no outbound calls
associated with that scenario.

e CALLBACK_FINAL_ATTEMPT_FAILED—This event occurs when the system makes the final outbound call
associated with a Callback request and the call fails to connect to the consumer. In the
CALLBACK SETTINGS data table, you can configure the number of times that the system will make
outbound calls for each Callback request before declaring failure.This Push Notification is not used with
the Click-To-Call-In (Delayed) scenario because there are no outbound calls associated with that
scenario.

Firebase Cloud Messaging Push Notifications

Genesys Callback currently supports Google Firebase Cloud Messaging (FCM) Push Notifications.
Using the Callback Ul, you can integrate Firebase Cloud Messaging into your web or mobile
applications. For detailed information about FCM, see the Google Firebase Cloud Messaging
documentation. You use the Push Notification page in the Developer tab to register your Firebase
credentials with Callback and to test that the credentials are valid.

Before You Start

Before you start working with the Push Notification page on the Callback Developer tab, ensure
that you have a Google Firebase account. You require the following Firebase objects to register with
Callback and to implement and test the Push Notification functionality:

* The Firebase project name that is associated with the app that you are registering with Callback.

e The client email address that is associated with the project. See Client Email for more information.

¢ The private key.

* The sender ID that is associated with the project.
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Using the Push Notification Page

You can perform the following activities on the Push Notification page:

e Provision and update your Firebase credentials in Callback.
¢ Determine if your Firebase credentials for an app are already configured in Callback.

¢ Perform a test to verify that the Firebase credentials that you entered are correct and configured in
Callback and, by extension, that the Push Notifications are working as intended.

To configure the Firebase credentials in Callback, you enter and update those credentials on the
Update Firebase Credentials pane of the Push Notification page. You use the Test Firebase
Credentials pane to verify that web Push Notifications are working in your environment. If the
Firebase credentials that you provisioned on the Update Firebase Credentials pane are correct
and valid, then - when you run a test using your Firebase Sender ID - the Push Notification page
returns a message that your Firebase credentials were successfully configured.
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Register your Firebase Credentials with Callback

Credential Management

Update Firebase Credentials

Project Name

Client Email

Private Key

Test Firebase Credentials

Sender ID Test

Enable this app to deliver push notifications to your browser

To implement the Firebase Cloud Messaging functionality, you must provide the following information
in the Update Firebase Credentials pane of the Push Notification page:

* Project name
¢ Client email address
* Private key

After you click the Update button, a message appears in the bottom right-hand corner of the page to
let you know that your credentials were successfully updated or that there was an issue.

Genesys recommends that you also test your Firebase credentials to make sure that the credentials
have been successfully configured in Callback. To run the test, you require the Firebase Sender ID
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associated with the project that is identified on the Update Firebase Credentials pane.

Project Name

This is a user-friendly name that you configure for the Firebase project. For example, fcm-
client-11959. Once configured, the Firebase project name (or Project ID) can be found in the
Project settings > General tab on the Firebase console. On the Push Notification page, you must
enter the Firebase project name exactly as it is configured in Firebase.

Client Email

This is an email address that is associated with the Firebase project. On the Firebase console, this is
the service account, however, in the file that contains the private key, the account is called the client
email address. For example, a client email address might be firebase-adminsdk-rkbys@fcm-
client-11959.1iam.gserviceaccount.com. Once configured, you can find the service or client email
account on the Project settings > Service accounts tab on the Firebase console or within the file
that contains your private key.

Private Key

The private key is used by an application to access the Firebase API. You generate a file that contains
the private key for your app on the Project settings > Service accounts tab of the Firebase
console. Generating the file downloads it to your local machine. The private key is a very long
character string and is only available in the downloaded file.

If, for any reason, you need to generate a new private key for an application that was previously
configured in Callback, then you can do so on the Firebase console, but then you must update the
credentials in Callback using the Update Firebase Credentials pane on the Push Notification
page. Remember to test the new credentials as well.

Test Your Credentials Configuration

If you are registering new Firebase credentials with Callback or updating credentials, then test the
credentials to verify that Firebase and Callback can validate the configuration. You require your
Firebase Sender ID to test your credentials. You can find the Firebase Sender ID in the Project
settings > Cloud Messaging tab on the Firebase console. You must check the Enable this app to
deliver push notifications to your browser box to run the test. The Push Notification page
returns either a "successful configuration" message or a "failure" message.

If you receive a failure message, use the following process to recover and try again:

1. Check that the Sender ID that you have entered on the Update Firebase Credentials pane matches
the Sender ID on the Firebase console for the app that you are registering with Callback. Run the test
again.

2. If the Sender ID matches and you do not receive a Push Notification, then refresh the browser and run
the test again.

3. If you don't receive a Push Notification, then navigate to your browser's Settings and ensure that the
browser allows notifications from your Genesys Engagement Service (GES)/Callback host. If you need
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help to find the setting, check the documentation for your browser. If your browser is blocking
notifications, then alter the setting to enable notifications. Run the test again.

4. If you don't receive a Push Notification, then refresh your browser again, check all of your FCM
credentials to ensure that they are entered correctly, and run the test again.

Displaying the Firebase Credentials on the Push Notification Page

After you have successfully configured the Firebase credentials in the Callback Ul, and you refresh the
Push Notification page or leave the page and return to it later, you will see only a few characters
for each entry (project name, client email address, and the private key). This is for security purposes.
Once configured, it is impossible to see the complete entries again on the Push Notification page.
The Project name, Client email address, and Private key sections on this page explain where you can
find the full credentials again, if required.
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Provisioning CAPTCHA

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Provisioning CAPTCHA.

A CAPTCHA is used as a security measure. Its purpose is to determine if an interaction on a website is
made by a human or a bot. If you have a website that includes a callback feature, then you can
provision and use a CAPTCHA widget to verify that a human is requesting a callback. This protects
against being flooded with callback requests from a fraudulent source.

Currently, Callback supports integration with only one CAPTCHA widget: Google reCAPTCHA. This
page describes how to enable the use of reCAPTCHA with Callback.

Important Information About Enabling reCAPTCHA on Callback
Requests

Integrating reCAPTCHA into your Callback API operations means that reCAPTCHA validation will be
required with all of the Callback API operations. For example, if you have both a website and a mobile
app, you cannot implement reCAPTCHA on callback requests for only your website - it must be built
into your mobile app as well. Also, this implementation of reCAPTCHA is not integrated with the
Genesys Widget for Callback. If you are using the Genesys Widget for Callback, then Genesys
recommends that you avoid enabling this reCAPTCHA capability.

Provisioning Google reCAPTCHA for Callback

Callback currently supports Google reCAPTCHA. To provision reCAPTCHA for Callback, you must have
a Google account. If you have not yet done so, go to the reCAPTCHA Admin console to register your
site and to specify the reCAPTCHA version that you want to use. Callback supports reCAPTCHA v3,
reCAPTCHA v2 Checkbox (Visible), and reCAPTCHA v2 (Invisible). Review the Google reCAPTCHA
documentation; it describes the three versions of reCAPTCHA and contains information to help you to
register your site on the Admin console.

On the Google reCAPTCHA Admin console, it is important that you add the domain of your Callback
instance and the domain of the site that is hosting the reCAPTCHA widget to the list of allowable
domains.
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Credential Management
Push Notification .
Provision reCAPTCHA Credentials Select Existing Key Set ¥ | © Test reCAPTCHA
CAPTCHA
CAPTCHA Type V2-VISIBLE v
Key Set Name V2 Visible
Site Key
Secret Key
Ensure that the domain of this GES instance and the domain of the site that is hosting the
reCAPTCHA widget have been added to the list of allowable domains on the Google
reCAPTCHA Admin console.
Generate New Test Page Delete

After you have registered your site on the Google reCAPTCHA Admin console, you must register your
reCAPTCHA credentials with Callback on the Developer > Credential Management > CAPTCHA
tab. The CAPTCHA type, site key, and secret key that you specify must match the settings for the
reCAPTCHA widget that you provisioned in the Google Admin console.

Specify a name (the Key Set Name) to identify the reCAPTCHA widget and its
associated credentials. It is helpful to use a descriptive name. For example, you
might enter a name that reflects the type of reCAPTCHA widget that you're using
(V2 Visible). The Key Set Name is used only in Callback; it is not specified or
used in the Google reCAPTCHA Admin console.
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Developer

Credential Management

Push Notification

Provision reCAPTCHA Gredentials V2Invisible ~ o Test reCAPTCHA

CAPTCHA Type V2INVISIBLE v Submit
Success!

Key Set Name V2 Invisible

Site Key
Developer
Secret Key i
Credential Management

Ensure that the

reCAPTCHA w|

reCAPTCHAAL  Push Notifiation
Provision reCAPTCHA Credentials V2 Visible ~ e Test reCAPTCHA

Generate| -

CAPTCHAType V2VISIBLE v

Select all images with

V2 Visible traffic lights

Key Set Name

Site Key

Secret Key

Developer

seneratend  Credential Management

Push Notification

Provision reCAPTCHA Credentials v3 v o Test reCAPTCHA
CAPTCHA Type V3 v P@
Success!

Key Set Name va
Site Key

Secret Key

Threshold o

50%

domain of this of the site that is hosting the
1eCAPTCHA widget have been added to the lst of allowable domains on the Google
reCAPTCHA Admin console.

Generate New Test Page: Delete

After you save your reCAPTCHA credentials on the CAPTCHA page in Callback, be sure to test them.
When you click Generate New Test Page, a testing widget opens on the page. The widget will vary
slightly depending on the type of reCAPTCHA that you're provisioning. You might have to check a box
or otherwise interact with the widget, but you will be presented with a Submit or Test button at
some point. If your credentials were correctly configured and you pass the reCAPTCHA validation,
then the widget returns a Success! message. If it fails, check your credentials or - if you are using
the V3-type reCAPTCHA - try adjusting the threshold, and then try again.
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Using Callback Tools

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Monitor callback queues.

The Callback application includes a Tools tab, which offers additional views and tools to assist with
callback management, configuration, and troubleshooting. You must be a member of the
Administrator, Supervisor, or Developer Role to access the Tools tab.

The Tools tab includes the following menu options:

* You can look up when your tenant's configuration data was last refreshed. You can also force a data
refresh.

¢ You can view the complete list of configured queues. The list includes detailed information about each
queue.

e You can search for a specific interaction within the callback records.

¢ You can configure rules that will be assigned to queues. For example, you might want to limit the
countries to which you allow callbacks or limit the number of scheduled callbacks that you allow within
a certain time interval.

This page gives you an overview of the Tools tab menu options. Some of the work that you can
perform on pages that are accessible from the Tools tab requires more explanation than an overview
can provide. In those cases, links to pages that contain detailed information are included in the
descriptions.
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Refreshing your Tenant Configuration data

Refetch Tenant Configuration (last fetched 2 minutes ago)
+ Create Callback -

Queues
Callback Search

Callback ID Permitted & Blocked Numbers
Capacity

Mo Callbacks/f
Click-To-Call In Config

By default, the system refreshes the Tenant configuration every 30 minutes. The Tools > Refetch

Tenant Configuration menu option shows you how long it has been since the data was last
updated.

When you click Refetch Tenant Configuration, the system refreshes tenant configuration data
throughout the Callback application. For example, you might want to force a refresh of data to
immediately reflect configuration changes in features that are affected by such settings.

Genesys Engage cloud Administrator's Guide 327



Callback Using Callback Tools

Viewing the list of configured queues

Refetch Tenant Configuratiomgt fetched a minute ago)
+ Create Callback [s]
uuuuu
Callback Search
Callback ID Permitted & Blocked Numbers
Capacity

26dooS1d-27Me-402.8250-cSbAdATE o1y 1ol Gonfig

454d109-5439-46bd-

L gz Callback Queues
Q Filter (s] v
~
Queue Expected Wait Time Calls A“"i:l""'"'g Queued Callbacks Scheduled Callbacks ~ Open/Close Time """'be;lxl"' idation Capacity Rule
&1 1000 Unknown Unknown 0 0 (e 2Ll o o (s}
service.
b 3| -1.000 Unknown Unknown 0 0 Cpn=s 24 hour o .|
ssssss
&, -1.000 Unknown Unknown 0 0 (e 2en - - (s}
service.
Open now. Closing
8B -1.000 Unknown Unknown [ 0 at9/25/2019, v .| e
7:00:00 PM
Callback_vQ & B -1.000 Unknown Unknown 0 0 e eil=r - - (s}
eeeeee
Open now. Closing
Unknown

The Tools > Queues menu option opens a page that shows you the list of configured queues. The
page includes information for each queue such as Estimated Wait Time and the number of callbacks

in queue. Icons beside each queue's name indicate whether the queue accepts Immediate (f,) or
Scheduled (E) callbacks or both.

Queues are displayed in pages of 50 items. If Unknown values are displayed for a queue, it means that
the queue cannot return data for some reason; for example, the queue might be inactive.

Tip

If you provision a virtual queue for callbacks in Designer while you are logged in to the
Callback Ul, be aware that the new queue might not display on the Callback Queues
page until you log out and log in again because Callback fetches virtual queue

permissions data only at login. In other words, Callback determines which virtual
queues you have access to when you are logging in, and only then.

The Callback Queues page pulls data when you first open the page, but does
not continually check for new data. To update the data for a specific queue, click
Refresh for that queue. When you click Refresh at the top of the page, it
refreshes the data for every queue.
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Number Validation
Rule

Open/Close Time Capacity Rule

Open now. 24 hour

SErvice.

Open now. 24 hour
service.

Open now. 24 hour
service.

Open now. Closing
at 9/25/2019, w w
7:00:00 PM

Open now. 24 hour

The Callback Queues page provides information about Open and Close times for each queue. The
time displayed is based on the time zone configured for the device that you are using to access the
Callback application.

Callback Queues /_\X
@ Filter o v

Number Validation
Rule

Queue Expected Wait Time Calls Average Quitting Time Queued Callback heduled Callback Op: lose Time

Sales vQ &, -1.000 Unknown Unknown 0 0 Open now. 24 hour

On the Callback Queues page, it is sometimes helpful to reduce the list to only one queue or a few
queues for which you want to find information.
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To filter the list, enter a queue name or part of a queue name in the field at the
top of the page and click Filter. Using this method, you can filter the list of
queues using only one criterion at a time. For example, let's say that you enter
Sales in the field and click Filter. Any queue that includes Sales in its name will
display. If you clear Sales from the field and filter on the word Service, then all
queues that have Service in their name display, replacing the list of
Sales-related queues.

Alternatively, when the specific queues that you want to view on the Callback Queues page have
dissimilar names, use the Filter Displayed Queues dialog. From the list of virtual queues in the
dialog, select those that you want to display. If you have a lot of queues, use the filter at the top of
the dialog to help you find the ones that you are looking for.

In addition to filtering, you can also click the Queue column heading to sort data based on that
column.
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Callback Queues

m&mm Wait Tirne Calls Average Quitting T
“"--——-""

Timezone_ V0 [E 1,000 Lindoncrwm Linknown
Sades VU 5 E 1.600 Lirsioncrams Linknown
defautt % B -1.000 Unimcram Uinkniown

Searching for a specific interaction

Refetch Tenant Configuration (last fetched 3 minutes ago)
+ Create Callback s

Queues
Callback Search

Callback ID Permitted & Blocked Numbers
Capacity

Yo Callbacks Found.
Click-To-Call In Config

Callback Search @

“From" Number State Route Point Last Updated Time Queue “To" Number Callback ID Scheduled Time Diagnostic Data

2019-08-
12719:32:42.5292

f0ba509d-dac3-482c-
b344-fc9565f51282

2019-08-
12T23:30:00.000Z

COMPLETED

The Tools > Callback Search menu option lets you search for a specific callback interaction. To
search for an interaction, enter either the callback ID or the customer's phone number and click
Search.

Configuring rules for queues

The Tools tab includes menu options to configure the following types of rules, which you can then
assign to queues:

e Patterns: Country and number validation rules. These rules specify the countries to which you allow
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callbacks and can include a list of "blacklist" numbers (blocked number patterns) within those
countries.

e Capacity: Callback capacity rules. These rules specify the maximum number of scheduled callbacks that
are allowed within each time slot for a week.
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Configuring Country and Number Validation
Rules

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Configuring Country and Number Validation rules.

To create, edit, or delete country and number validation rules, you must be a member
of the Callback Administrator, Callback Developer, or Callback Supervisor role.

To avoid initiating callbacks to certain countries or to numbers that you know to be fraudulent, you
can now configure country and number validation rules on the Tools > Permitted & Blocked
Numbers page, and then assign those rules to queues on the Callback Queues page. You can
create a rule to specify the list of countries to which you permit callbacks for specific queues. You can
also optionally enhance a rule by defining simple or complex (regular expression) numeric patterns
that will block callback attempts to matching numbers.

16 rminutes aga)

Refetch Tenant Configuration [last fetchy
+ Create Callback o
Quewes

Callback Search

Callback ID Permitted & Blocked Numbers

Capacity

c2428dea-51 09433006 57247586 Click-To-Call In Config

o COMPLETED
67504 aa-a7 56-46f2-bb2e-bTha¥9a11c37 ANCELLE

Once a rule is configured, you can assign it to as many queues as necessary. It is important to note,
though, that you can assign only one rule to each queue. Before creating a rule, consider to which
queue or queues you will assign it and make sure that the rule incorporates the countries to which
you permit callbacks for that queue as well as any numeric patterns in any of those countries that
you want to block. Rules are checked before the system initiates a callback.
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Configuring Country and Number Validation Rules

Permitted & Blocked Numbers — Please selecta Ruleset

Blocked Callback Number Patterns Allow Callbacks To: Q Currently Selected Countries:

n

Patterns Action

Select All Countries Canada (CA) United States (US)

No Patterns to display

Afghanistan (AF) Albania (AL) Algeria (DZ)

Angola (AD)

Create New Rule

US_exceptions

The first step in creating a new country and number validation rule is to give the rule a name. Later,
you will need to pick the rule from a list when you assign it to a queue, so make sure the name is
descriptive enough for you to understand what it allows and denies.
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Tools

Permitted & Blocked Numbers  us_esceptions ~  No Associated Queues [i} m
Blocked Callback Number Patterns Allow Callbacks To: Q, Filter Country Name | Currently Selected Countries:
- s = United States (US)
=0 ton ["|Select All Countries Canada (CA) [# United States (US)
18005555555 7 0 [ Afghanistan (AF) Albania (AL) Algeria (DZ)
[“American Samoa (AS) Andorra (AD) Angola (AQ)
[“JAnguilla (Al) Antarctica (AQ) Antigua and Barbuds (AG)
[JArgentina (AR} Armenia (AM) Aruba (AW)
., [Jhustralia (AU) Austria (AT) Azerbaijan (AZ)
["Bahamas (BS) Bahrain (BH) Bangladesh (BD)
Add Pattern
[|Barbados (BB) Belarus (BY) Belgium (BE)
18005555555 [+]
\'*"—'/ [Belize (82) Benin (8J) Bermuda (BM)
Test Phone Number
L . BES Islands (BQ) Bhutan (BT) Bolivia (BO)
@ Unsaved Changes! Bosnia and Herzegovina (BA) Botswana (BW) Bouvet Island (BV)
Brazil (BR) British Indian Ocean Territory (10) British Virgin Islands (VG)
Revert m Brunei Darussalam (BN) Bulgaria (BG) Burkina Faso (BF) -

When creating a rule, you must select at least one country on the Permitted & Blocked Numbers
page. You can enter blocked number patterns only after you make country selections. Adding a
country to the rule means that you allow callbacks to that country. For countries that are not added to
a rule, no callback attempt will be initiated on the queue or queues to which the rule is applied.

After you have selected the countries to which you allow callbacks, enter any patterns that you want
to block. Patterns must be entered as regular expressions. For example, if you have a list of
suspicious phone numbers for the selected countries and you do not want the system to make
callback attempts to those numbers, then add those to the rule. The figures on this page show the
addition of specific numbers, but you could enter ~1234[0-9]+, which would match any phone
number that starts with 1234. While a rule must contain at least one country, the addition of blocked
number patterns is optional.

To add a blocked number pattern, simply enter it in the field and click "plus" (0). You must enter
patterns individually; that is, enter a pattern and add it to the rule before entering another pattern.
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Assigning Rules to Queues

Callback Queues

Queue
4]
=
4]
Callback_vQ & [
=
o
&E
&5
defout 18

e

29 Service(s) Found

Expected Wait Time

-1.000

-1.000

-1.000

-1.000

-1.000

-1.000

-1.000

-1.000

-1.000

-1.000

-1.000

Calls

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Average Quitting Time

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Queued Callbacks

0

Scheduled Callbacks

0

Q
2

Open/Close Time

Open now. 24 hour
service

Open now. 24 hour
service.

Open now. 24 hour
service.

Office closed. Opening
© 219/28/2019, 7:00:00
AM

Open now. 24 hour

US_exceptions
senvice

Open now. Closing at
9/27/2019, 6:00:00
PM

Open now. 24 hour
service.

Open now. 24 hour
senvice

Open now. 24 hour
senvice

Open now. 24 hour
senvice

Open now. Closing at
9/27/2019, 6:00:00
PM

Number Validation Rule

Filter

Page

Capacity Rule

1

Q

-

After you have configured at least one rule, you can assign the rules to your queues. You can assign a
rule to multiple queues, but you can assign only one rule to each queue.

To assign a rule to a queue, navigate to the Tools > Queues page in your Callback Ul. Locate a
queue to which you want to assign a rule. You might need to filter the list of queues to locate what
you're looking for. Once you find the queue, open the drop-down menu in the Number Validation
Rule column. Select the rule that you want to assign to the queue. The rule is applied to the queue
immediately and that change to the queue is saved automatically.

Editing and Deleting Rules
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Permitted & Blocked Numbers | us_exceptions ~ | 1 Associated Queue(s)

Blocked Callback Number Patterns Allow Callbacks To
Patterns Action Select All Countries Canada (CA)
18005555555 7 0

Afghanistan (AF) Albania (AL)

Queues Using US_exceptions:

Callback_VQ

For your reference, each rule displays the list of queues to which the rule is assigned (or indicates
that the rule is not yet assigned) so you will know which queues, if any, you are impacting when you
edit a rule.

Changes that you make to a rule's definition are applied to any queue to which the rule is assigned as
soon as you click Save Changes. If, while editing a rule, you decide that you want to discard your
changes - perhaps you have made some mistakes or you discover that you are editing the wrong rule
- click Revert to return the rule to its last-saved configuration.
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Bahamas (BS)
Add Pattern
Harbsdaa (BE)
18005555555 o
Belze (BI)

Test Phone Mumber
BES lalanda (B0)
“ Unsaved Chaﬂg&gl Bosnia and Herzegosina (BA)

Brazil {BR)

Brunes Danussalam (BN)

To help you manage impacts to queue activity, the Callback Ul does not allow you to delete a rule
that is assigned to a queue. Use the list of queues associated with the rule to help you determine if
the rule can be safely removed from each assignment.

Navigate to the Callback Queues page in the Callback Ul to remove a rule from a queue. Once the
rule is removed from all queue assignments, you can delete it.

Callback Queues Click the blank space at the top of the drop-down menu
to remove a pumber validation rule from the queue o ¥
Cueue Expescied Weit Tiene Cails Arveruge sy Tive: Gueued Cailsacks Scheduied Calibacks =
4m 1,000 Urirarem Unincrvn -
i 1000 Lniararam Lnirren -
e 1.000 Uirikngwm [T -
=] 1000 i Linircwn -
Callback_VQ ‘E 1000 ritsngren [rre -
e 1,000 [T [y @ @ TN, G000 U_pwcegiions w
LYl
a8 1.000 Lirierarem Linierown @ @ ::“‘?" b - .
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Testing a Number Pattern

Permitted & Blocked Numbers  us_exceptions ¥ No Associated Queues i m
Blocked Callback Number Patterns Allow Callbacks To: Q, Viet Nam (VN) x Currently Selected Countries:
§ United States (US)

Patterns Action Viet Nam (VN)

18005555555 s 0
Add Pattern

L

8445555555
D Test Failed! The country of the phone number
is not in the allowable list: Viet Nam (VN)

= | |

After you have created and saved a rule, you can use the rule to validate any number quickly using
the testing feature on the Permitted & Blocked Numbers page. For example, you might be
troubleshooting an error and you want to see if a rule might be interfering with the callback.

Enter a number in the Test Phone Number field. The number fails the rule's validation test if the

number belongs to a country that is not added to that rule or if the number matches any one of the
defined blocked number patterns.

If the number fails the check against allowable countries, then the system returns this reason for

failure and does not validate the number against the blocked number patterns, even though the
number might also fail that test.

Genesys Engage cloud Administrator's Guide 339



Callback

Using Callback Tools

Blocked Callback Number Patterns
Patterns Action

18005555555

Add Pattern

18005555555

@ Test Failed! Phone Number matches Pattern:
18005555555

o | |

Permitted & Blocked Numbers

Allow Callbacks To:

Select All Countries

Afghanistan (AF)

American Samoa (AS)

Anguilla (Al)

Argentina (AR)

Australia (AU)

Bahamas (BS)

Barbados (BB)

Belize (B2)

BES Islands (8Q)

Bosnia and Herzegovina (BA)

Brazil (BR)

Brunei Darussalam (BN)

US_exceptions ~ No Assaciated Queues

Canada (CA)

Albania (AL)

Andorra (AD)

Antarctica (AQ)

Armenia (AM)

Austria (AT)

Bahrain (BH)

Belarus (BY)

Benin (BJ)

Bhutan (BT)

Botswana (BW)

British Indian Ocean Territory (10)

Bulgaria (BG)

[#United States (US)

Algeria (DZ)

Angola (AD)

Antigua and Barbuda (AG)

Aruba (AW)

Azerbaijan (AZ)

Bangladesh (BD)

Belgium (BE)

Bermuda (BM)

Bolivia (BO)

Bouvet Island (BV)

British Virgin Islands (VG)

Burkina Faso (BF)

Currently Selected Countries:

= United States (US)

If a number passes the country validation test, then it is checked against the blocked number

patterns.
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Permitted & Blocked Numbers  us.esceptions “ No Associated Queues i IS
Blocked Callback Number Patterns Allow Callbacks To: ]  Currently Selected Countries:
o e = United States (US)
e on Select All Countries Canada (CA) [ United States (US)
18005555555 Afghanistan (AF) Albania (AL) Algeria (D2)
American Samoa (AS) Andorra D) Angola (A0)
Anguilla (Al) Apfarctica (AQ) Antigua and Barbuda (AG)
Argentina (AR) Armenia (AM) Aruba (AW)
. Australia (AU) Austria (AT) Azerbaijan (AZ)
Bahamas (BS) Bahrain (BH) Bangladesh (BD)
Add Pattern
Barbados Belarus (BY) Belgium (BE)
elize (B2) Benin (BJ) Bermuda (BM)
Test Phone Number
T BES Islands (BQ) Bhutan (BT) Bolivia (B0)
Phone number passed exceptions! Phone Bosnia and Herzegovina (BA) Botswana (BW) Bouvet Island (BY)
umber is from country: United States (US).
Brazil (BR) British Indian Ocean Territory (10) British Virgin Islands (V6)
Revert | | Brunei Darussalam (BN) Bulgaria (BG) Burkina Faso (BF) -

If the number belongs to a country to which callbacks are allowed for that rule and the number is not
listed within the blocked number patterns, then the system validates that the number is acceptable
for callback attempts.
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Configuring capacity rules

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Configuring Capacity rules.

To create or edit capacity rules, you must be a member of the Callback
Administrator role. The Callback Developer, Callback Supervisor, and Callback
Monitor roles have read-only access. Access to queues is subject to line-of-business
filtering where role-based access control is enabled.

_ ~ Refetch Tenant Configuration (last fetched 2 minutes sga)
<= Create Callback [

Crueisea
Calinack Search
State
P & Blecked Numbers

Click-To-Call bn Conifig

=Y .
Scheduled Capacity Rules | sect Bxstng capacty  ~

) Add New Capacity © Dalele Capacity

Timeslot Sunday Manday Tuesday ‘Wednesday Thursday

000
1:00
200

Callback capacity refers to the maximum number of scheduled callbacks that are allowed in a given
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time interval. On the Tools > Capacity tab, you create capacity rules. A capacity rule contains a
day-by-day weekly calendar on which you specify callback capacity for each time slot. A time slot is
either a one-hour slot or a half-hour slot; you select the time slot duration from a drop-down menu.
Once you have configured a capacity rule, you can assign it to queues. A capacity rule can be
assigned to multiple queues, but you can assign only one capacity rule to each queue.

Time zone associations

There is no time zone associated with a capacity rule. During the evaluation process to determine if a
scheduled callback can be booked or not, the time zone associated with the business hours service is
used. Be sure you have the business hours, including the time zone, configured (in Designer) for the

queue before you apply any capacity rules. For more information about configuring business hours,
see Business Hours and Business Hours Block in the Designer documentation.

How capacity rules affect capacity settings configured in
Designer

A capacity rule that you configure in the Callback Ul and assign to a queue has an effect on the Slot
Capacity and Slot Duration settings in Designer's CALLBACK SETTINGS data table.

Designer Business Controls

Data Tables - CALLBACK_SETTINGS

» ' Durat.>» | Push Retry Ti.>» | Max Push Att. > Call Direction Slot Capacity ~ | Slot Duration (minutes) v

e ‘\q‘ = 1 _‘A\f\ *i‘\ L..h‘_ o

30 3 USERTERMIN...

30 3 USERTERMIN... 5 15
30 3 USERTERMIN... 5 15
30 3 USERTERMIN... 5 15
30 3 USERTERMIN... 5 15

A value that you specify for a time slot on the Capacity page in Callback is the maximum number of
scheduled callbacks that you can support for each Slot Duration (configured in Designer) within that
time interval. For example, if you configure a capacity rule for 9:00 to 10:00 a.m. on Monday morning
with a value of 5 and you assign that rule to a queue for which the Slot Duration in Designer is 15
minutes, then what the rule allows is a maximum of 5 scheduled callbacks every 15 minutes between
9:00 and 10:00 a.m. on Monday morning.
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A capacity rule assigned to a queue overrides the Slot Capacity setting in the Designer

CALLBACK SETTINGS data table for that queue. For example, if you configure a rule for 3:00 to 4:00
p.m. on Wednesday afternoon with a value of 5 and you assign that rule to a queue for which the
Slot Capacity in Designer is set to 3, then the rule allows a maximum of 5 scheduled callbacks for
each Slot Duration during that hour on Wednesday afternoon, overriding the value of 3 that was set
in the CALLBACK_SETTINGS table.

Before you start

Before you create capacity rules and assign them to queues, make sure that you have provisioned
Callback in Designer. In particular, make sure that the following configuration is complete:

e In Designer, you have provisioned your business hours, including the time zone. See also Business
Hours and Business Hours Block in the Designer documentation.

e In Designer, you have provisioned the callback services, which includes specifying a value for the Slot
Capacity and Slot Duration (minutes) columns for your callback application. See also Callback
Settings Data Table in the Designer documentation.

Using a rule to adjust capacity

Let's assume that we have a special campaign running in the month of March because we are
launching a new product feature. We anticipate higher than normal call volumes, so we plan to
increase the number of skilled agents to support customer inquiries. We also anticipate more callback
requests, so we plan to adjust the capacity for scheduled callbacks during the entire month of the
launch.
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Slot Capacity ~ | Slot Duration (minutes)

b 15

In the CALLBACK_SETTINGS data table in Designer, let's say that we have set the capacity for
scheduled callbacks to 5 and specified a slot duration of 15 minutes for the callback application. In
other words, on a normal day we can handle 5 scheduled callbacks every 15 minutes during open
office hours. In Designer, we set this "flat rate" for capacity, but - for the month of March - we want
to make some adjustments to that. We make the adjustments using a capacity rule that we'll
configure and assign to queues in Callback.

Let's say that our business hours are 8:00 a.m. to 6:00 p.m., Monday to Friday. For the month of
March, we plan to have 40 agents from 8:00 a.m. to noon, 50 agents from noon to 2:00 p.m., and
back to 40 agents from 2:00 to 6:00 p.m. Slot duration in the CALLBACK_SETTINGS table is, as
previously mentioned, set to 15 minutes.
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Configuring the "March" capacity rule

Scheduled Capacity Rules | sekect Bxisting Capacty ~ ~

@ Add New Capacity © Delete Capacity

Timeslot Sunday Monday Tuesday

0:00
1:00
2:00
3:00
4:00

5;00

Create Scheduled Capacity Rule

Capacity Name | March|

To create a capacity rule, you must first give it a name. You cannot edit the name of a rule after you
click Create Rule, so be sure that you have entered the name exactly as you intended. We'll call this
new rule March because we are making adjustments to the capacity for that month. The rule can be
applied to all relevant queues for the month of March to override the setting in Designer.
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Scheduled Capacity Rules  maren v

E
-
i
@ Add New Capacity @ Delete Capacity { Timeslot Length Hour Lo
1

Timeslot Sunday Monday Tuesday o Saturday Set All i
4 //
0:00 / /

6:00 o

Select the Timeslot Length. This value sets the time slot duration on the capacity calendar, it does
not change the Slot Duration that you set in Designer. This setting governs all time slots on the
calendar; you cannot have some half hour-long slots and some hour-long slots.

For this example, we will set the timeslot length to Hour.

An hourly time slot begins at the top of every hour (:00). Half-hourly time slots begin at the top of
every hour (:00) and at the bottom of every hour (:30). If you plan to use capacity rules with queues,
Genesys recommends that you always set the Slot Duration (minutes) in Designer to a value that
is evenly divisible into 60. Otherwise, you might experience unpredictable results when a capacity
rule is applied.

Once your capacity calendar is set up, then you can start adding the capacity values. Remember that
the capacity values that you specify on the Capacity page indicate the maximum number of
scheduled callbacks that you have the capacity to handle in each Slot Duration that occurs within
the hour or half-hour that you're configuring. To find the Slot Duration that is configured for a
particular queue, you must check the CALLBACK SETTINGS data table in Designer.

If your contact center is open 24/7 and you want to set the same value for the same time slot on
every day of the week, enter the value in the Set All cell for that time slot. To set the same value for
every time slot on a particular day, enter the value in the Set Day cell for that day.
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Timeslot Sunday Monday Tuesday Wednesday Thursday Friday Saturday Set All
0:00
1:00
2:00
3:00
400
500
6:00
7:00
8:00 10 10 10 10 10 10 10 10|
9:00
10:00
1100 Timeslot Sunday Monday Tuesday Wednesday Thursday Friday Saturday Set All
:222 0:00 10
1:00 10
200 10
3.00 10
400 10
5:00 10

L T D N g I Ly v FUDSIRY W

20:00 10
21:00 10
22:00 10
Set Day 10/

When creating a capacity rule, if you do not enter a value for a particular time slot, then the system
reads that time slot as having 0 or no capacity when determining if a scheduled callback can be
booked.

Currently, Callback does not support the definition of exceptions for specific dates; for example,
statutory holidays.
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Scheduled Capacity Rules  waren ~  Associated with 0 VQ(s).
& Add New Capacity @ Delete Capacity Timeslot Length Hour b4
Timeslot Sunday Monday Tuesday Wednesday Thursday Friday Saturday Set All i
100 -

2:00

3.00

200 You have additional agents at your busiest time of

= the day so you can accommedate more scheduled

6:00 callbacks.

7:00

8:00 10 10 10 10 10

9:00 10 10 10 10 10

10:00 10 10 10 10 10

11:00 10 10 10 10 10

12:00 15 15 15 15 15 L
13:00 15 15 15 15 15 1
14:00 10 10 10 10 10

15:00 10 10 10 10 10

16:00 10 10 10 10 10

17:00 10 10 10 10 10

18:00

19:00

T Ne values are set for €00 pam. (18:00). The value set
2100 for 5:00 p.m. (17:00) (s in effect up to &:00.
22:00 Capacity is © starting at &:00 p.m. because the office
2300 has closed.

Set Day =

Returning to our sample capacity rule (March), we will set values for the days and hours that we're
open (8:00 a.m. to 6:00 p.m., Monday to Friday) based on the additional agents that we have during
the month of March. Slot duration in the CALLBACK _SETTINGS table is, as previously mentioned, set
to 15 minutes. This means that we will be overriding the 5 scheduled callbacks that we normally have
capacity to handle every 15 minutes with the following capacity values:

e up to 10 scheduled callbacks every 15 minutes from 8:00 a.m. to 12:00 p.m.

e up to 15 scheduled callbacks every 15 minutes from 12:00 p.m. to 2:00 p.m. (there are extra agents on
phones during peak hours)

e up to 10 scheduled callbacks every 15 minutes from 2:00 p.m to 6:00 p.m.

Once this capacity rule is assigned to the callback virtual queue, the capacity specified in the rule
takes effect.

After you have set some or all of the values, remember to save the rule. You can edit the values at
any time. Saved changes to rules will be applied immediately to any queue to which the rule is
assigned.

If you edit values in the calendar after it has been saved and you discover that you have made some
mistakes - perhaps you are editing the wrong rule - click Revert to return to the last-saved values.
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select Revert.
Timeslot Length m

o

Saturday Set All T

Assigning a capacity rule to a queue

A rule is created based on one week (Sunday to Saturday), but the capacity specified in the rule for
each time slot of every day remains in effect on a queue for as long as the rule is assigned to that
queue. After you have configured at least one rule, you can assign the rule or rules to your queues.
You can assign a rule to multiple queues, but you can assign only one rule to each queue.

To assign a rule to a queue, navigate to the Tools > Queues page in your Callback Ul. Locate a
queue to which you want to assign a rule. You might need to filter the list of queues to locate what
you're looking for. Once you find the queue, open the drop-down menu in the Capacity Rule column.
Select the rule that you want to assign to the queue. Continuing our example, we will assign the
March capacity rule to the callback virtual queue. The rule takes effect immediately on that queue.
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€ Add New Capacity @ Delete Capacity
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2:00
3:00
4:00
5:00
6:00
7-00
8:00

TIP: You can select a rule on the Scheduled Capacity Rules page to see how many queues the rule
is assigned to. This is important if you want to delete a rule. As long as it is assigned to at least one
queue, you won't be able to delete it.

Once March is over and we want to return to our normal level of scheduled callbacks, we simply
remove the assignment of the March rule from the queue.
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Callback Queues Click the blank space at the top of the drop-down
menu to remove a capacity rule from the quewe.
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Using JSON-format capacity statements to configure a capacity
rule

You can create a capacity rule and manually enter your capacity for various hours and days or you
can define your capacity in JSON format and then copy and paste the JSON capacity statement
directly into an open and focused capacity rule using your usual pasting shortcut; for example,
Command/Ctrl+V or the contextual menu. Make sure that no cells are selected in the capacity
calendar. If a cell is selected, then the capacity data will be pasted into only the selected cell.

When you paste a JSON-format capacity statement into a rule that already has data, the pasted
capacity data completely overwrites the existing data. For example, let's say that we have a capacity
rule already defined and it includes a capacity of 5 on Tuesday from 9:00 a.m. to 10:00 a.m. We paste
a JSON-format capacity statement into the rule, but the pasted capacity data does not include a value
for the Tuesday, 9:00 a.m. to 10:00 a.m. time slot. After we paste in the JSON-format capacity
statement, we notice that the capacity for that time slot has changed to 0. This happened because
the pasted-in capacity statement did not merge with the existing data, it wrote over it. If nothing is
defined for the 9:00 to 10:00 time slot on Tuesday morning, then the Ul interprets that as a capacity
of 0. If you want to maintain existing data, remember to include that data in your JSON-format
capacity statement.

The following sample shows the correct format to use for JSON capacity statements:

{"days":{"sun":{"02:00":2},"mon":{"05:00":2},"tue":{"07:00":3,"06:00":4},"wed":{"08:00":5},"thu":{"11:00":6},"f

How capacity is evaluated for a "short" time interval

The callback system, when queried for availability, first checks the business hours that are configured
in Designer. For more information about configuring Business Hours, see Business Hours and Business
Hours Block.
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As mentioned earlier on this page, the Callback capacity rules affect the Slot Duration and Slot
Capacity settings that are configured in Designer. Because the capacity rules are based on callback
capacity for time slots that begin at either the top of the hour or the bottom of the hour, there are
situations in which a time slot might be ignored (no callbacks will be scheduled in that slot). For
example, if your office hours begin at 7:50 a.m., Slot Duration (minutes) is set to 15 minutes in
Designer, and a capacity rule assigned to the callback queue specifies a capacity of 10 scheduled
callbacks between 7:30 and 8:30 a.m., then the system will begin scheduling callbacks for 8:00 a.m.
There can be up to 10 scheduled callbacks between 8:00 and 8:15, and another 10 between 8:15 and
8:30. The system will not schedule callbacks between 7:30 and 7:45 because the business is not
open during that slot, and the slot 7:45 to 8:00 is also considered to be unavailable because the
business is still closed at 7:45. In other words, Callback checks the conditions only at the start of a
Slot Duration period.

Switching the timeslot length in a saved capacity rule

If a capacity rule was initially configured with half-hourly time slots in Callback, and you later decide
that you want to change it to hourly time slots, then you can certainly do so. The capacity values that
were originally configured for the bottom of each hour are "dropped" and the capacity values that
were set at the top of each hour are used instead.

Original half-hourly capacity rule settings
Time: 9:00 9:30 10:00 10:30
Capacity Value: 8 10 8 10
Half-hourly converted to hourly

Time: 9:00 (9:30) 10:00 (10:30)
Capacity Value: 8 (8) 8 (8)

When you convert a half-hourly capacity rule to hourly, then the value that was set at the top of the
hour is duplicated at the half hour.

Original hourly capacity rule settings
Time: 9:00 10:00
Capacity Value: 8 8
Hourly converted to half-hourly

Time: 9:00 9:30 10:00 10:30
Capacity: 8 8 8 8
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When you convert an hourly capacity rule to half-hourly, then the value that was set at the top of the
hour is duplicated at the half hour.
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Configuring Click-To-Call-In Groups

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Configuring Click-To-Call-In Groups.

Callback supports the Click-To-Call-In scenario. To implement the scenario for use with Callback, you
must configure at least one Click-To-Call-In group. A Click-To-Call-In group definition consists of a
Dialed Number Identification Service (DNIS) pool and access code settings, including the choice to
use or not use an access code with Click-To-Call-In requests. The system uses the DNIS pool
associated with a group to find the number that it will provide to the customer who is making the
Click-To-Call-In request. The system also uses the group configuration to determine whether or not an
access code is required when the customer dials in.

You can find information about using the Genesys Engagement Service (GES) APIs, including the
Click-To-Call-In API, on the Genesys Engage REST APIs and Tutorials for Callback page in this Guide.
The page includes links to APl documentation.

In Callback, you provision the Click-To-Call-In groups on the Tools > Click-To-Call-In Config tab.

Biebetoh Tennat Ciomdagoratetn 151 feviiend b romties s3] |1
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Callth Search

—
——* Click-To-Call-In Configuration

- /,_.,’—_

DHES Pool Settings
£ Diptiznal Descripton Aecens Code Loagih & [Gmerate Actens
Mo DREE 10 Diipday Expery [neconda) ]

Dot e DAES for concemmt requents
Add DNIS
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There are two ways in which you can enter the DNIS pool of numbers for a Click-To-Call-In group:

e Enter each DNIS number individually using the fields on the Click-To-Call-In Config page.
e Bulk import the DNIS numbers for a group.
The information on this page describes both methods. For general information, including how to enter

a DNIS pool manually, see Provisioning Click-To-Call-In Groups. For information about the bulk import
of a DNIS pool, see Performing a bulk import of DNIS pool numbers below.

For information about the Callback Call-In tab, on which you can view the Click-To-Call-In records, see
Viewing Click-To-Call-In records.

A Note about Migration

If you are migrating to Callback, make sure that you enter any existing Click-To-Call-In group
information on the Click-To-Call-In Config page in the Callback Ul. Previously, the Click-To-Call-In
group information was configured in Platform Administration.

Provisioning Click-To-Call-In Groups

To create or modify Click-To-Call-In groups, you must be a member of the Callback
Administrator role. The Callback Developer, Callback Supervisor, and Callback
Monitor roles have read-only access.

Genesys Engage cloud Administrator's Guide 356



Callback Using Callback Tools

Click-To-Call-In Configuration

Select Group v Delete Group

DNIS Pool Settings
DNIS Optional Description Access Code Length 6 ’, [¥/Generate Access Codd
No DNIS to Display Expil
Add DNIS
Create New Group
New DNIS
Description [+
auto_insurance ‘
Bulk Impaort From File i

To create a new Click-To-Call-In group, navigate to the Tools > Click-To-Call-In Config page and
click Create New Group. The Ul accepts alphanumeric characters and symbols in the group name.
You cannot edit the name of a group in the Callback Ul after you click Save Group, so be sure that
you have entered the name exactly as you intended before saving.
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Click-To-Call-In Configuration

auto_insurance v Create New Group m

This is the DNIS Pool for the

AUED_{InSUFANEE group.

DNIS Pool Settings

DNIS Optional Description Access Code Length 6 ,, [#{Generate Access Code

iry (seconds 30 i
/7 0O Expiry ( ) .
+18005555554 Claims
[_| Do not reuse DNIS for concurrent requests

To add a DNIS number to the pool, enter
Add DNIS the number here. You can add a description
as well, but that is optional.

New DNIS +18005555555
Click Add DNIS to add the number to the DNIS

[+] \/Poo{ for the selected group.

Deseription Renewal5|

Bulk Import From File |

In the pane on the left side of the Click-To-Call-In Configuration page, you enter your DNIS pool of
numbers. The group must contain at least one valid DNIS number (that is, it must conform to the
E.164 format for telephone numbers). You can enter a maximum of 10,000 DNIS numbers for each
group. A DNIS number cannot exceed 16 characters, and can include the "plus" sign (+) prefix.

You can include a description for a DNIS number, but that is optional. The Ul accepts alphanumeric
characters and symbols in the description. The description cannot exceed 32 characters.

If you have a large DNIS pool for a group, you can bulk import the numbers instead of entering each
one individually. For more information about the bulk import method, see Performing a bulk import of
DNIS pool numbers below.
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Click-To-Call-In Configuration
These are global settings for the group, In other
e — . m words, these settings apply to every entry in
your DNIS Pool for the selected group.
You can edit or
DNIS Pool delete entries. Settings
DNIS Optional Description Access Code Length 6 ’, [/ Generate Access Code
/ \\ Expiry (seconds) 30
+18005555554 Claims Y
|| Do not reuse DNIS for concurrent requests
+18005555555 Renewals /7 O
Add DNIS
New DNIS
Description [+]
Bulk Import From File " |

In the pane on the right side of the page, you enable or disable the use of an access code. In other
words, the access code is optional. If you enable the use of the access code, then you can specify
settings for the code. If enabled, the system generates an access code for each Click-To-Call-In
request and provides it to the caller at the same time that it provides the phone number that the
caller must use to dial in. The caller must enter the access code correctly for the call to be directed to
an agent.

Additional information about the Settings

Setting Description
Generate
Access Enable or disable the use of access codes with Click-To-Call-In requests.
Code
Length The length of an access code. Valid values are 4 to 12, inclusive. The default value is 6.
Expiry The lifetime, in seconds, of the Click-To-Call-In request. Valid values are 10 to 1800,
(seconds) inclusive. The default value is 30.

Specifies if a DNIS number is unique or not. "Unique" means that it cannot be reused
while it is in use. Select the check box if the DNIS is unique. Otherwise, leave the check
box clear. The default value is false, or "not unique" (the check box is not selected).

Unique
DNIS

Performing a bulk import of DNIS pool humbers

If you have a large DNIS pool associated with a Click-To-Call-In group, you can import the DNIS pool
as a bulk upload. After you create the group on the Tools > Click-To-Call-In Config page, then use
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the Bulk Import From File button to import the DNIS pool from a .csv file.

Ciick-To-Call-in Configuration

e

DS Pooi Sertrgn
R e e e Lt B B it B i
N SR gy By -

Mew DNIS

Dhmnec

If you use the bulk import method, you will require a separate .csv file for each group. You can upload
the DNIS pool for a single group from a file; you cannot upload the DNIS pool for many groups from
one file.

ﬁ auto-insurance_dnis.csv - Notepad E@g

File Edit Format View Help

+18005555554 ,Claims, -
+18005555555,Renewals, :
118005555558, DNIS number with
+18005555557 ,Referrals, o description.

+18005555558 ,Complaints,

+18005555559,Inquiries %
C DNIS number and des

cription

The bulk import method supports only .csv files (values must be separated by a comma). You can
include a description, but it is optional. In the sample file shown here, there is no description for one
entry, although you still require the commas.

The DNIS numbers must be entered in the .csv file using the E.164 format for telephone numbers.
The system will check the values for compliance and prompt you to fix any errors. All rules that apply
when entering the DNIS numbers individually also apply when bulk uploading the pool of numbers.
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Configuring Region Affinity rules

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Configuring Region Affinity rules.

Warning

Region Affinity rules configuration is an advanced feature that requires an
understanding of region configuration and processes that are typically managed

internally by Genesys personnel. Do not use this feature unless you have consulted
with your Genesys representative.

Use the Tools > Region Affinity page to create Region Affinity rules. To create Region Affinity rules,
you must be a member of the Callback Administrator role.
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Genesys has regional names for the locations at which there are nodes (servers with relevant
applications) that manage the interactions for callback virtual queues. You use a Region Affinity rule
to specify the regional nodes that you prefer to use and to control the order in which Callback
attempts to connect to the available nodes. When there is activity on a queue to which a Region
Affinity rule is assigned, Callback tries to connect to a node in the region designated as "preferred"
first. Depending on the health status of nodes in the preferred region, Callback might fall back to
other regions in the order of configuration until it finds a viable node. For information about how to
configure regions in the order in which you want to attempt connection, see Specifying the order in
which to connect to regional nodes.
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Creating a Region Affinity rule

Region Affinity Rules

Revert

Preferred Regions

SanFrancisco

Create Region Affinity Rule

A Preferred region required

Cancel

Fallback Regions Ignared Regions

M. California

S. California

Region Affinity Rules

Revert

SanFrancisco

A\ Preferred region required

Preferred Regions

Fallback Regions Ignored Regions

N. California

N. California,
[% S. California

Click and drag

Qregon

When you create a new Region Affinity rule, all of the regions that are available for your use are
initially listed under the Ignored Regions column of the rule. To configure the rule, drag region
names from the Ignored Regions column to the Preferred Regions and Fallback Regions
columns. It is not mandatory to have a region in the Fallback Regions column and you can leave
some regions in the Ignored Regions column. To save a rule, though, there must be at least one
region in the Preferred Regions column. If there is a region that you want to use, but it does not
show up on the Region Affinity Rules page in the Ul, contact your Genesys Representative.
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Specifying the order in which to connect to regional nodes

When handling queue interactions, Callback always tries to connect to a node in the region listed first
in the Preferred Regions column. On occasion, there might be some reason why Callback cannot
connect to that node. When this happens, Callback attempts to connect to a node in another region
in the following order:

 If there are additional nodes specified in the Preferred Regions column, then Callback tries to connect
to a node in the second region listed in the Preferred Regions column, and so on until it has
attempted connection to every region - in descending order - in the Preferred Regions column.

e |If Callback cannot connect to any node in the preferred regions, then it tries to connect to a node in the
region listed first in the Fallback Regions column. If that fails, then Callback tries to connect to a node
in the second region listed in the Fallback Regions column, and so on until it has attempted
connection to every region - in descending order - in the Fallback Regions column.

With this in mind, you can configure your Region Affinity rule to specify the precise order in which you
want Callback to attempt connection to the other available regions. For example, if the following
Region Affinity rule is applied to a callback queue, then Callback will always try to connect to the N.
California region first, then the S. California region, and if both of those connections fail, then it tries
to connect to the Oregon region.

Region Affinity Rules  sefmncisea  ~ ]

Revert

Preferred Regions Fallback Regions Ignored Regions
@ N. California @ Oregon
@ 5. California

Assigning a Region Affinity rule to a callback queue

Tip
Access to queues is subject to line-of-business filtering where role-based access
control is enabled.

To use a Region Affinity rule to specify the regional node at which to manage interactions on a given
queue, you must assign the rule to the queue on the Callback Queues tab in the Ul. The rule is in
effect for that queue as soon as you assign it. You can assign a Region Affinity rule to multiple
queues, but you cannot assign more than one rule to a queue.
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Callback Queues
Filter s ¥
~
Expected Average .
. - Queued Scheduled . N . Number Validation -
Queue .Walt Calls Quln\ng Callbacks Callbacks Open/Close Time Region Affinity Rule Rule Capacity Rule
Time (s) Time (s)

. -1.000 Unknown  Unknown 0O 0 Open now. 24 hour % % %

service,
To assign a Region Affinity

Open now. 24 hour

. -1.000 Unknown Unknown 0 0 N ~
E=ice rule to a callback queue,
Open now. Closing select the rule from the

L -1.000 Unknown Unknown 0 0 at 3/30/2020, ~
7:00:00 PM drop—douw\ menu-
Open now. 24 hour

& [ Callback_VQ -1.000 Unknown  Unknown 0 0 " SanFrancisco @ - v
service.
Open now. Closing

. -1.000 Unknown Unknown 0 0 at 3/30/2020, w ~ v
6:00:00 PM

If you want to delete a Region Affinity rule from the system, you'll first need to remove the rule from
all queues to which it is assigned.

Callback Queues
Filter 's) v
~
Expected Average .
. L Queued Scheduled . . . Number Validation .
Queue I\ant Calls Qlulmng Callbacks Callbacks Open/Close Time Region Affinity Rule Rule Capacity Rule
Time (s) Time (s)

. -1.000 Unknown  Unknown 0 0 SO T " " .
service.

. -1.000 Unknown  Unknown 0 0 S 2 " o .
service.
Open now. Closing

. -1.000 Unknown Unknown 0 0 at 3/30/2020, ~ v o
7-00:00 PM
. e To remove a Region

& E5] Callback VO -1.000 Unknown Unknown 0 0 F’E',“ e our SanFrancisco ~ .
T ; Affinity rule from a
Open now. Closing callback queue, select the

. -1.000 Unknown  Unknown 0 0 at 3/30/2020, SanFrancisco
:00:00 PM blank space at the top of

the drop-down menu.

. -1.000 Unknown  Unknown 0 0 Cp=nnoRiZEhouy " " .

service.
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Genesys Engage REST APIs and Tutorials
for Callback

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage REST APIs and tutorials for Callback.

Depending on your Role, you might work with the APIs that are available for Genesys Engagement
Services (GES)/Callback. The documentation for REST APIs is available through the Genesys Engage
cloud Developer Center.

The GES/Callback APIs are:

» Callbacks - Create, retrieve, and cancel callbacks.

e Estimated Wait Time - Retrieve Estimated Wait Time.

e Availability - Retrieve time slots for a Callback, matching Office Hours.

e Call In - Request the phone number to call in.

¢ Queue Status - Retrieve information about a queue's readiness to accept callbacks.

e Statistics - Provides a proxy to the GWS Statistics API. To use the Callback Statistics API, you must first
register your GWS credentials in the Callback Ul (Developer > Credential Management > GWS
Credentials tab).

You can test queries in the Developer Center. However, if you receive error messages while testing
your application, use the Developer tab to get more information.

This portal also includes Callback Tutorials; select Engagement in the tutorial list.

Accessing Callback APIs

To access Callback APIs from Web or Mobile applications, the following items are mandatory:

1. Request an API key from your Genesys Customer Care Representative. You need to send this as the
value for x-api-key in the header of every request.

2. In your request to Customer Care, specify the list of domains from which you expect your API requests
will originate. Genesys uses this list to configure cross-origin resource sharing (CORS) domains for you
(this is not currently available as self-service configuration).

3. The base URL for your APl endpoints is:
https://gapi-<region>.genesyscloud.com/engagement/v3
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You will receive the <region> information from Genesys at the same time that you receive your API
key.

Consult the Genesys Engage cloud Developer Center for complete endpoint paths.
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Cloud intelligent Workload Distribution

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to IWD.

Cloud intelligent Workload Distribution (iWD) allows you to dynamically prioritize the distribution of
workitems from external source systems to the employee best suited to handle them.

What does Cloud IWD do?

iWD takes workitems from existing enterprise software applications (such as ERP, BPM, DCM,
Salesforce) as well as homegrown legacy systems, analyzes the business context of the
workitem—for example, the associated business process, product requested, or value of the
customer making the request—and creates a single global task list, sorted on business value, that
ensures that the most critical or highest-value workitem are distribued to the right resource at the
right time, regardless of media type, system or location.

You'll use the Cloud iWD API to create, update or delete work items which are then categorized,
prioritized and routed to employees according to configured rules and assigned routing application
logic. A Genesys Designer application handles handles routing/distribution of the workitems, which
are then handled by employees using Agent Desktop.

Monitoring of real-time activity is available in iWD Manager and also in Pulse, and historical reporting
is also available through Genesys CX Insights.

With iWD, enterprises can effectively manage all customer service resources and business processes
across the enterprise, going beyond the walls of the formal contact center and into other areas of the
business like branch offices and experts in the back office.

Cloud IWD features and functions

* Business Context Configuration—Cloud iWD allows the source system to either:

* Pre-classify workitems down to the Department and Process level and pass this information on to
iWD to match with the appropriate Departments and business Processes in Genesys, against which
tasks are then managed and reported on: or;

e Use Cloud IWD Rules to apply rules that classify the workitems down to the Department and Process
level. When using iWD Rules, adding new departments or business processes is a simple matter of
configuration by a business user.
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¢ Service Level Agreement-based Prioritization Rules—The Cloud iWD service level rules ensure
workitems are completed according to the service level agreements (SLA) defined by business users.
SLA rules quickly order the workitems from most important to least important, based on business
value. Because information related to a workitem can change, iWD automatically re-assesses
workitems throughout their lifecycle, ensuring the most important are at the top of the global task list.

* Workitem Management—Operations Managers and Team Leads with appropriate security permissions
can:

* View captured workitems

Hold, resume, and cancel workitems
e Modify workitem attributes

* Manage prioritization schemas

The same workitem management capabilities (except managing prioritization schemas) are also
exposed to source systems via the iWD API.

* Business Insights—Cloud iWD offers a set of workitem-based statistics providing insight into business

performance and comparisons against key performance indicators configured in iWD by business users.
Business insights are available for the current day, and intraday historically.
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Set up IWD

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to IWD Setup.

iWD takes workitems from existing enterprise software applications and creates a single global task
list, sorted on business value, that ensures that the most critical or highest-value workitems are
distributed to the right resource at the right time, regardless of media type, system or location.

You'll use the Cloud iWD API to create, update or delete workitems which are then classified,
prioritized and routed to employees according to configured rules and assigned routing application
logic.

A Genesys Designer application handles routing/distribution of the workitems, which are then
handled by employees using Agent Desktop.

Reporting is also available through Genesys CX Insights.

You should be able to complete most of the steps on your own, but sometimes you'll
need help from Genesys. We'll let you know when a step requires extra help from a
Genesys representative.

High-level process

At a high level, you'll need to complete the following steps to implement Cloud iWD:

1. Define agents and agent groups.

2. Configure agent desktop options for your contact center.

3. Configure Role-Based Access Control (RBAC) for all users of iwD Manager.

4. Define a routing application in Designer to handle incoming workitems to iWD.
5. Use iWD Manager to:

1. Create Endpoints that correspond to the target endpoints created in your Designer routing
application.
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2. Create Categories that correspond to specific departments or business processes and their
hierarchies (business context), associate each with an Endpoint and create a set of Service Level
Agreement-based rules for how workitems in each Category are to be handled.

3. Create Prioritization schemas that control the logic and speed with which workitems are (re-
)prioritized both before and after their Service Level Agreement, and associate the schemas to
Categories.

4. Ask your Genesys team to configure other global iWD settings, including setting up notifications
back to the source system by configuring a webhook integration. Click here for more detail on
webhooks.

6. Integrate your source systems to use the Cloud iWD API to submit workitems to Genesys (see
Integrating source systems below).

7. Monitor the activity of your contact center as iWD manages the global queue of workitems.
8. Manage individual workitems or groups of them while they are being queued and distributed by iWD.

9. Report on historical contact center activity using Genesys CX Insights. Report on realtime activity
through the iWD Manager Monitoring features on the Summary tab and through Pulse.

Integrating source systems

Create an application to submit workitems to Cloud IWD

A third-party application such as Salesforce or Netsuite can interact with Genesys Engage cloud IWD
through the Cloud IWD API.

You'll need to develop an adapter for your third-party application that can create and stop workitems
by using the Cloud IWD API. It should also update information about a workitem, if needed, and be

capable of retrieving it, or receiving messages about it if webhooks are configured to communicate
back to source systems. (Webhooks must be configured by Genesys.)

Add a webhook URL for each source system in IWD Manager

You'll need one webhook URL per source system to be configured so that your source system can
receive messages about workitems back from Cloud IWD. You'll need to work with your Genesys
representative to configure this.

Starting/updating/stopping a workitem/interaction

The typical workflow is as follows:

1. The application creates a workitem through the IWD API.
2. The application updates the workitem through the IWD API (if needed).
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3. The application stops the workitem.

There are two ways for the application to stop an interaction:

e Implicit (recommended) — stop by invoking Mark Done. For this method, complete the following steps:
1. Set up Agent Desktop to use the Service Client API.

2. Disable the Mark Done button in Agent Desktop (as mentioned earlier in Configuring Agent Desktop)

and instead invoke Mark Done.

3. Set the Disposition Code

e Explicit — stop by using the IWD API. This requires additional configuration from your Genesys
representative.

A sample application that demonstrates using the IWD API is also available through your Genesys
representative.
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Roles and privileges for IWD Manager users

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to IWD Roles and Privileges.

Roles and privileges will be configured initially by Genesys Professional Services. The table below
show the roles and privileges they will create for iWD users.

Privilege name Roles
e L s iWD Supervisor iwD User Notes
User
Workitems (Workitems tab in iWD Manager)

Requires

iWD.Workitems.canView X X X iWD.Workitems.Search.canExecut
privilege.

iWD.Workitems.canRead X X X

iWD.Workitems.canDelete X X

iWD.Workitems.canUpdate X X

iWD.Workitems.canCreate X

iWD.Workitems.BulkActions.caXExecute

iWD.Workitems.Search.canExedute X X

iWD.Workitems.Search.canExe&ute X X

iWD.Workitems.Export.canExeeUte X

iWD.Workitems.Hold.canExecube X

iWD.Workitems.Cancel.canExeeute X

iWD.Workitems.Resume.canEx&cute X

iWD.Workitems.Restart.canExeXute X

Dashboard (Summary tab)

Requires

iWD.Dashboard.canView X X X iWD.Workitems.Search.canExecut
privilege.

Settings (Settings tab)
iWD.Settings.canView X X X
Settings/Categories

Requires

iWD.Categories.canView X X X iWD.Categories.canRead
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Privilege name Roles
iWwD.Categories.canRead X X
iWD.Categories.canUpdate X

Settings/Prioritization
iWD.Prioritization.canView X X
iWD.Prioritization.canRead X X
iWD.Prioritization.canUpdate X
Settings/Endpoints

iWD.Endpoints.canView X X
iWD.Endpoints.canRead X X
iWD.Endpoints.canUpdate X

privilege.

Requires
iWD.Prioritization.canRead
privilege.

Requires
iWD.Endpoints.canRead
privilege.
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Test IWD provisioning

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Test IWD Provisioning.
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You can test your iWD provisioning setup by using this procedure in conjunction with the supplied CIWD Designer sample application.

1. Create an interaction with this cURL command that will set the workitem's activation time to three minutes in the future.

curl --location --request POST 'https://<iwd-host>/iwd/v3/items' \

--header 'Content-Type: application/json' \

--header 'x-api-key: <iwd x-api-key>' \

--data-raw '{

"external id":"e21c3332-eecd-4f3b-8a7f-c90",

"FirstName":"Leonardol23",

"LastName":"Doe",

"EmailAddress":"Leonardol23@Doe.com",

"PhoneNumber": "(925)555-1236499",

"activate":"2020-02-18T11:35:03.0772" //Sample timestamp. Can be set to 3 minutes ahead of current time

}

2. Check that the interaction appears in real time reporting by creating iWD Queue Activity and iWD Agent Activity widgets based on the Genesys-supplied
Pulse widget templates.

3. Check that the interaction appears as expected in iWD Manager.
1. In the iWD Manager Workitems tab, check Search, filter and modify workitems.
2. In the iWD Manager Summary tab, check Category-based graphs and statistics.
3. In the iWD Manager Settings tab, check the configuration of Category tree, Priority and Endpoints.
4. Check workitem routing to an agent.
5. Login workspace employee #1 with the following skill profile:
* GSYS skill 1 > 5
* GSYS skill 2 > 2
* GSYS skill 3 > 2
6. Make employee #1 ready.
7. Three minutes after receipt, the workitem should be routed to employee #1.

8. Open the workitem.

Genesys Engage cloud Administrator's Guide 376


https://docs.genesys.com/Documentation/PSAAS/Public/RPRT/RTRTemplates
https://docs.genesys.com/Documentation/PSAAS/Public/RPRT/RTRTemplates

Cloud intelligent Workload Distribution Test IWD provisioning

9. Disposition the workitem.
10. View the transfer in real time reporting by using the iWD Queue Activity and iWD Agent Activity templates described above.
11. Wait for 15 minutes.
12. Check the Genesys CX Insights for iWD reports.
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Integrate with Genesys Workforce
Management (WFM)

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Overview

You can integrate iWD with Genesys Workforce Management (WFM) to enable WFM capabilities to
improve management of your contact center workforce. To enable this functionality, three metrics are
provided to WFM for each activity every 15 minutes:

e Interaction Volume (also known as "new")—The total number of workitems that have been placed in
Cloud iWD categories corresponding to the activity in the last 15-minute time interval.

* Average Handle Time (AHT)—Calculated as the total time agents spent working on workitems
divided by the total number of workitems processed.

¢ Actual Queue (also known as "backlog")—The number of pending interactions (not completed yet) at
the end of the last 15-minute time interval in all Cloud iWD categories corresponding to the activity

Interaction Volume and Actual Queue are provided by iWD Data Mart. Average Handle Time is
read by WFM from Stat Server.

* Do not specify Stat Server metrics for Interaction Volume and Actual Queue during
iWD Activities configuration in WFM. This will cause values from Stat Server to override
metrics obtained from iWD Data Mart and WFM will show incorrect numbers.

» |f Data Mart fails to send data to WFM, it will try to send metrics for all missed intervals
during the next run.
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Limitations

=

. Only 1:1 mapping between iWD categories and WFM activities is supported.

iWD categories and WFM activities must have identical names.

. Activities must have unique names—duplicate names are not supported. No data is provided to WFM in

this case.

. Tenant provisioning and configuration are done manually using Configuration Manager.

. Exactly two levels of category tree are matched to WFM activity.

To match a one-level category activity, you must use [Unknown as the second level. For example, to
match category Default activity Default|Unknown must be created.

Third level and lower cannot be used in activity-to-category mapping.

. If a category has second-level entries, the first-level entry cannot be matched to an activity. For

example, if WFM|WFM_subcategoryl and WFM|WFM_subcategory2 are configured,
WFM|Unknown activity cannot be used.

If a workitem is reclassified after it was reported to WFM for the first time, it will not be reported as
PERF_ITEM_ACT_IV but will be reported in PERF_ITEM_ACT_QUEUE on subsequent interval.

Take into account the fact that iwD Data Mart is run every 15 minutes, which does not
necessarily match WFM intervals' boundaries. So there could be delays in data
becoming visible in WFM,

Configuration in WFM

1.

Configure Filters for the selected iWD Categories to make it possible to calculate AHT for the
corresponding Activities:

1. Connect to the tenant Configuration Server.
2. Go to Applications > region > WFM > SS_WFM > Application Options.

3. Add new option under the Filters section:
<option name>=PairExists("category path","<iWD Category>|<iWD Subcategory>")

For example, WFMTestSubcatl Filter=PairExists("category path",
"WFMTestCategory |WFMTestSubcategoryl").

4. Save the changes.
5. Open Applications > region > WFM > SS_WFM_B > Application Options.
6. Repeat steps 3 to 5.
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2. Create Activities as normal WFM activities taking into account the following guidelines:

1. Create exactly one Activity of type Deferred per category with the following naming pattern:

iWD_Category/iWD_Subcategory

and with exactly the same name as in iWD.

2. Create a special Activity named Default/Unclassified to handle unclassified workitems. You also
need to create a separate Filter for it as described in step 1.

3. Configure the Average Handle Time (AHT) statistic for each Activity:

1.

2
3.
4

Open WFM > Configuration > Activities.

. Open the Activity > Statistics tab.
Click Add.

. Configure:
1. Type = Handle Time.
2. Either Group of Agents or Group of Places depending on your needs.
3. Total Handle Time = WFM Workitem Interactions Processing Time.
4. Interactions Handled = WFM Workitem Interactions Processed.
5. Filters = <select the filter for the corresponding iWD Category/Subcategory>.
Click Apply.
Save the Activity.
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Use IWD Manager

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to IWD Manager.

Use iWD Manager to:

e Search, display, manage and update workitems (Workitems tab)

¢ Monitor workitems (Summary tab)

e Configure iWD global settings—Genesys use only—(Settings tab)

IWD Manager Workitems
CATEGORIES «
Gold X W Uses lucene query syntax Last 30 days
~  Service Department o Q 5 ' Q@ y c O
w Service Request - SFOC
- P Activate Il Hold P Resume @ cancel O Restan # Bulk Update Views ~
0|
Silver 0 State 4 @) Priority FirstName LastName Email + €) Phone Customer Segment Category  Subject Created Due Date
(i) (state) (priority)  (FirstMame)  (LastName)  (EmailAddress) PhoneNumber) (Cisstomes Segmant) (category_path)  (Subject) (exeated) {dueDate)
FILTER & VIEW «
7488 B <O 480 Bil Smith +1-555-  Gold Gold 27/01/2020,
Completed 11192 13:40:52
Search Filter & View
7486 p <@ 460 Anna Sanchez +1-555-  Gold Gold 27/01 /2020,
v Completed 11190 13:40:52
7481 B <D 400 Anna Harris +1-655-  Gold Gold 27/01/2020,  29/01/2020,
Expired 111-85 13:40:52 14:40:52
e 7475 B <0 400 Anna Sanchez +1-555- Gold Gold 27/01/2020, 29/01/2020,
Expired 111-79 13:40:52 14:40:52
1 day to due date
v 474 pa@ 400 John May +1-555.  Gold Gold 27/01/2020,
“ompleted Xt 5
T Completed 1178 13:40:53
7472 N AW 200 Steve Jobs +1.555.  Gold Gold 27/01/2020,  29/01/2020,
Assigned 10 agents Expired 11-76 13:40:53 14:40:53
Close 1o due date T4T1 W <10 200 Bill Caollins +1-555 Gold Gold 27/01/2020,  29/01/2020,
Expired 11175 13:40:53 14:40:53
Completed but igned
ompl e masin T468 B 0 Steve Harris +1-555  Gold Gold 27/01/2020,  29/D1/2020,
curently in routin x 1172 13:40:53 14:40:53
d ‘ Deleted

Default

You can only view and/or use features and functions in iWD Manager if you have the
appropriate roles and privileges assigned to you. On-screen features that are grayed
out are not available. Contact your administrator to update your privileges.
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You can:

¢ Drag and drop columns across the screen.

e Sort multiple columns at once using the up and down sort arrows, which display on mouseover. Columns
with sorting applied are indicated with a sequence number.

e Scroll continuously to the bottom of the display list without paging.
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Search, display, manage and update
workitems

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Search, display, manage and update workitems.

Search for workitems

iWD Manager Workitems

CATEGORIES «

Gold dueDate:[* TO now C—/ Uses lucene query syntax
~ Service Department D O\ [ 1 X B query syl

~ Service Request - SFDC K
B Activate I Hold » Hesume M cancel LY +

Rectar

create new category

e Search for a specific workitem by entering its ID in the Search field at the top of the Workitems tab
and clicking return.

e Search for any list of workitems by entering a text string in the Search field and clicking return.

e Search the workitems database directly by using the Lucene query syntax described here (vendor
document).

¢ Clear the current search citeria by clicking X in the Search field.

» Create a new Category from the current search criteria by clicking the Category button in the Search
field.
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Filter by Category

IWD Manager Workitems Summary
CATEGORIES €
Gold
= Service Department old € O‘
= Service Request - SFDC
P Activate Il Hold P Re:
Gold 4—\
Silver ID State Priority F
(id) (state) {priority) (F
FILTER & VIEW «
7488 » <O 480 E
Completed
Search Filter & View
7486 » <@ 460 A
Completed

Favorites

Select a Category on the collapsible Categories tab to quickly filter by workitems that match the
selected Category or sub-Category only.
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Using the Filter & View tab

IWD Manager Workitems
CATEGORIES «
Id
= Service Department cod @ Q
~ Service Request - SFDC
P Activate Il =
Gold
Silver ID State
(id) (state)
FILTER & VIEW «
7488 » <@
Completed
Search Filter & View
7486 »<@
Favorites Completed
7481 »<©
flems yet Expired
Filter & View 7475 N <@
Expired
1 day to due date
T474 »nL@®
10 days to due date \ Completed
7472 » T
Assigned to agents Expired
Close to due date 471 »<T
Expired
Completed but never assigned
P g 7468 » <
Currently in routi <
urrently in routin
Y ¢ Deleted
——
Default
30

Use a saved or favorited filter/view on the collapsible Filter & View tab to quickly apply filtering and
view settings to workitems list. If you have previously selected a Category, any Category defined
inside the filter/view overrides the earlier Category selection. If All Categories is selected inside the
filter/view, any previous selection of Category is cleared.
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Search by time interval

iWD Manager Workitems imim 2 - @
CATEGORIES
Uses| 1
+ Service Department God @ Q X B Useslucene qu,ery,syn__af___ @© Last30 days | C &
v SemiceRequest-SFDC e T M
” P> Activate 11 Hold P Resume ©Q cancel - O-Rensit ™" /' BulkUpdate Viewslh
Go | (% ORI TR TOT [T RO e emmeas N
L S —— D ---stae™™ Priority  FirstName Last Name Email Phone Customer Segment Category Subject Created = Due Date
AEREvIEw e i (state) (oriorit)  (FistName)  (LastName) " PAR | (Qubine (eronted Caate)
@ Time interval @ Time nterval
Search Filter & View QUICK  ABSOLUTE QUICK  ABSOLUTE
Favorites
Noiterms ye Today Last 15 min Last 7 days From To:
This Week Last 30 min Last 30 days | 019 2019
Filter & View This Month Last 1 hour Last 60 days - —
This Quarter Last 4 hours Last 90 days Th u, Oct 3] Fr|' NOV 8
1 day o due date Last 12 hours Last 6 month
Last 24 hours
< October 2018 > < November 2019 >
10 days to due date
nssigned to agent s M T ow T F s s M T ow T s
ssigned to agents
< o CANCEL SAVE &
12 3 4 s 12
Close to due date Expired
6 7 8 & 10 M 12 3 4 5 6 7 9
7468 »< 0 Steve Harris
Completed but never assic P 1314 15 6 17 18 19 oMoz 13 14 15 16
Currently in routing Detated 20 222 23 24 25 % 17 18 19 20 2 2 2B
27 o bs 26 2 2 2 2
Rows per page 30 0 6 5 3 O
. L
Y STAI RART  SPECIFY TIME | DAYEND
0
@© o06:30 n 1 0
0 28 233
22 14
9 21 153
CANCEL SAVE
20 16
8 4
19 18 17
7 oan s
o

Use the time interval button (which shows the currently selected time interval) to display either:

¢ Quick search using predefined time ranges

¢ Absolute date/time ranges for customized time intervals
You can click DAY START and DAY END selectors to select the day start and end times configured
for your contact center or you can use the SPECIFY TIME selector to open a clock-style drag-and-
drop selector in which you can click the displayed time, then change the From and To hour values.

Drag the selector to select a new hour and minute value, then, on the second selector displayed, a
new minute value.

Tip

You must select a minute value, even if it is 00, to register the selection.

If you have a Category selected, only workitems in that Category are displayed.
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Save filters and views

/" Bulk Update Views -

State column view
Colored
v Extended
Simple

Filter & View

Save Filter & View

Filter & View Name

pvf— Save current state

Filter details

Category

All categonies

Query
state: Routng

View details

Table columns

10, State, Priority, First Mame, Last |

Due Date

Order by

Created (desc), Prionty (desc
Cancel

&l Save view

Email, Category, Subject, Created,

Reset filtering
Restore default table view

Filter & View list

Restore preconfigured

Use the Views button to do the following:
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e Select a view for the State column.
e Save/reset filters (Category + query) and views (columns + sorting):

* Save the current filter and/or view for future use (Supervisors, Business users and Administrators
only).

* Reset the filter to clear the filtering details from the page.

e Reset the table view to the default.

* Restore the list of preconfigured filter and view states.

Extended States

The table below describes the meanings of the extended state symbols.

Extended Description
New

» Not yet distributed
i Held
» =, In routing state, not yet assigned
» 2 Being processed by an agent
»<9 Completed but not assigned to an agent
»<0 Expired but not assigned to an agent
»29 Completed and has been processed by an agent
»LO Expired and has been processed by an agent
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Display and update workitem attributes

iWD Manager Workitems Summary etting g (2]
CATEGORIES «
1
~ Service Department Gold @ Q X B Useslucenequerysyntax (D Lestdodays C €
~ Service Request - SFDC
» P Activate 11 Hold P Resume € cancel O Restant /' Bulk Update Views ~
Gol
silver D state Priority  First Name Last Name__Emaib==""""""" Phone . .
@ (stat) (riorit)___(Fusamny="([5iName)  (Emsladdress)  phone  WOTitem Details - X
FILTER & VIEW « | L emsmee &Xpﬂlﬁd field
o__m-?'<?l , 480 Bill Smith +155  Category Gold
A omplete 11146 .
Search Filter & View \ Pronization Leed Management add attribute to
A6 <@ 60 Anna Sanchez +1-58 ndpoint Defau
Favortes s, Completed ML poeries search
7481 WO 400 Anna Harris +1-55 Subject @ «* [ Lorem ipsum dolor sit amet,ut
Expited - qui graeco indoctum, ad guber
Filter & View 7475 RLO N, 400 Anna Sanchez +1-55 Segment Q Gold ]
Expired % 117 me i
1day to-due date , LastName ma Smith [
7474 »<@ 00 John May +1-55
10 days to due date Completed . ma Contactld Q 0014SaEMPSPWO00K L
*, FirstName oa L]
7472 RO 200 N, Steve Jobs: toggle 155 -
Assigned to agents Expired . 3 categorylD a Sales Gold i
\\ PhoneNumber Da 1(555) 789-3334 L ]
Close to due date 74 »L@ 200 gilty,  Colins +1-58 TR — Da 5
Expired \ 117 _
cometed bt ) i N departmentin Q Credit Card Sales i
ompleted but never assigne .,
P 9 7468 » < 0 Steve Harris +1-55 CustomerSegment ma Gold 5
N ]
Currently in routing ;I | \\ m- CustomerSegmentiD Q Gold L]
clete LY dueDste oa 2019-08- -
Default = 18T19:28:45.7652 s
hS =
Rows per page 30 “ sla Q 180000 [ ]
, Add attribute
s, C—_— . .
o add attribute to display
M, System properties
\,
),
LY id ma 35590 i
\,
N | extemal_id a 701654399 i

A =
LN Update
%,

For individual workitems
Select a workitem and/or click one of its attributes to display all its attributes.
Toggle the display of specific fields in the summary display by clicking the symbols indicated.

Expand a field with more than 200 characters by clicking the dynamic expand symbol next to the
field label.

To update the attribute values of a workitem, click the value you want to change, add the new value,
then click the Update button. System properties of the workitem are protected, so you can't update
them.

You can add an attribute to the display by clicking Add attribute... at the bottom of the first panel of
attributes.

You can also search for other workitems corresponding to a specific attribute value by clicking the
search symbol next to the attribute.

For multiple workitems

To make an identical value change to one or more attributes of multiple workitems, select the
workitems by checking their checkboxes or by filtering workitems using a search query, click the
value you want to change, add the new value(s), then click the Bulk Update button.

System properties of the workitem are protected, so you can't update them.
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Manage workitems

iWD Manager Workitems

CATEGORIES
Gold @ Q X W Useslucene query syntax  (O) Last 30 days cC O

~ Service Department

- Service Request - SFDC

P Activate Il Hold P Resume € cancel O Restart

/Z Bulk Update Views ~

Gold

Silver Phone Customer Segment Category Subject Created Due Date

(id) (state) (priority) ( (LastName) G ( (category_path)  (Subject) (created) (dueDate)

FILTER & VIEW «
7488 N <@ 480 Bill Smith +1-555- Gold Gold 27/01/2020,
Completed 111-92 13:40:52

Use the control buttons at the top of the Workitems window to do the following to either individual
or multiple workitems:

e Activate workitem(s)—Select a workitem(s) that has been assigned an activation date in the future, and
click Activate to activate it immediately.

* Hold workitem(s)—Select a workitem(s) and click Hold. Held workitems can't be reprioritized or
distributed, but you can cancel, restart or resume them.

¢ Resume workitem(s)—Select a held workitem(s) and click Resume to resume processing. You can only
resume held workitems.

e Cancel workitem(s)—Select a workitem(s) and click Cancel to permanently cancel it. You can't cancel a
workitem if it's been completed, canceled, or rejected. But you can cancel a workitem that has already
been assigned to an agent. Canceled workitems remain in iWD for an amount of time that's configured
in the Keep completed workitems for field (by Genesys only) before being deleted. Workitems can
only be completed through the source system or the API, so Genesys recommends canceling any of the
workitems that you no longer want matched with an employee.

¢ Restart workitem(s)—Select a workitem(s) to send it back to the beginning of the process, where it will
be treated as if it was new.

Any action can be applied to one or many individually selected items (checked in the table) or to all
the items that satisfy the current query, including time frame and any applied Category filter.

Workitems that are in the Default category have not been segmented by any of the existing
Categories. Genesys recommend that administrators monitor these workitems to decide whether a
category should be established to segment them.
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Monitor workitems

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Monitor workitems.

The Summary tab in iWD Manager gives you several options for displaying dashboards for
monitoring the state of workitems controlled by iWD:

e By backlog

* By volume

¢ By Service Level Agreement

* By categories

* By timing

¢ By path

e All the displays reflect the currently selected time frame and the selected Category and
query.

* Where very large numbers of workitems are displayed, scientific notation is used on the
axes of display graphs.

Using saved and favorite search filters

Where filters have been created and saved by a Supervisor, Business User or Administrator you can
apply them to the display of the summary dashboards, and favorite them. Expand the Filter & View
panel to see available search filters.
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By backlog

iWD Manager Norkite Summary

i Q_ query Uses Lucene querysyntax @ Lastaodays G €
= ™,
W
o E backlog
o
o] Overall Backlog
o I
=
g Date: 2019/07/26 13.00
Pad == Count: 974
1000, :
< » / k
500,
= |
o 08 Jul 104ul 120l 1430l 16.Jul 18.Jul 20.ul 22 ul 24.Jul 26 Jul 28 Jul 30 Jul 01 Aug 03 Aug 05 Aug
2
&
5 Backlog By Category ® By12h
w
» 1000,
800
600,
400
200
08 Jul 10Jul 120l 143ul 16.Jul 18 Jul 20.ul 22 Jul 24 Jul 26 Jul 28 Jul 30 Jul 01 Aug 03 Aug 05 Aug
Arrival and Completion Volumes
D N — Arrived — Completed

300

08 Jul 10.Jul 1200l 14 3ul 16 Jul 18 Jul 20 Jul 22 Jul 24 0ul 26 Jul 28.Jul 304ul 01 Aug 03 Aug 05 Aug

Provides an intraday high-level summary of the backlog for the period chosen. This is the starting
point for analysis, enabling you to quickly spot trends in KPl and potential bottlenecks in workitems.
For example, it can enable you to quickly recognize that the backlog is growing or shrinking. It
displays dynamically the overall backlog, the backlog by category, and arrival and completion
volumes.

You can:

¢ Dynamically change the time interval and category for display.
e Dynamically select a saved search filter from the Filter & View tab for display.
e Hover over populated areas of the graph to display a detail panel for the date and time selected.

e Use your cursor to drag a box to select a range of columns and drill down to a lower level of detail.
Metric descriptions

¢ Overall backlog—The overall amount of workitems.
¢ Backlog by Category—The amount of workitems in distribution by category.

e Arrival and Completion Volumes—The amount of arrived and completed workitems in a time range.
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By volume

Summary

Q search...(e.g. FirstName: Adam OR state: Queued) Uses lucene query syntax (O Last 6 month cC O
[
] e —
<] Grouped by 12h volume Date: 2019/07/26 01:00
» Q@ —New: 10
=3 400 -~ Classified: 0
. 5} Queued: 283
e — Routing: 0
200 W —assigned: 1
=< B 2 — Completed: 0
S — Expired: 79
3 — Deleted: 0
" 200 —Hold: 27
i} —Error. 0
: . [ I 0 ll 0
P
B | B
o 0 - | - - ||
ey 08 Jul 10 Jul 12 Jul 14 Jul 16 Jul 18 Jul 20 Jul 22 Jul 24 Jul 26 Jul 28 Jul 30 Jul 01 Aug 03 Aug 05 Aug
» . .
Total @  AvgDuration @  AvgQueued @ AvgRouting i ]
N A A n
Distribution by State (i ] Distribution by Priority Ranges : ;)
New: 56 150 Count
Classified: 0 LiB =
2%% Queued: 1206 1400
LCX Routing: 51 1200
&% Assigned: 1 1000
Completed: 0 800
Expired: 261 600
75% Deleted: 0 400
Hold: 27 200
Error: 0 0 21 0 o 0 0 0 o
’ *=100.0 100.0-200.0 200.0-300.0 300.0-400.0 400.0-500.0 500.0-1000.0 1000.0-5000.0 5000.0-*

Displays dynamic histogram and summary totals (total, average duration, average time in queue,
average time in routing) for the selected time interval and category, and distributions by state (pie
chart) and priority ranges (bar chart). You can:

¢ Dynamically change the time interval and category for display.

e Dynamically select a saved search filter from the Filter & View tab for display.

e Hover over points in any graph to display a detail panel for the selected data point.

e Use your cursor to drag a box to select a range of columns and drill down to a lower level of detail.

Metric descriptions

¢ Volume graph—The total number of new workitems that were submitted to iWD in a time range.
e Total—The total number of new workitems that were submitted to iWD during the reporting interval.

e Average duration—The average amount of time that elapsed before agents completed workitems. This
metric includes the time that workitems were backlogged, as well as work time.

e Average Queued—The average amount of time a workitem was waiting in the queue.
e Average Routing—The average amount of time a workitem was waiting to be routed.

¢ Distribution by state—The distribution of workitems by their state, in percent and quantity.

Genesys Engage cloud Administrator's Guide 393



Cloud intelligent Workload Distribution Use iWD Manager

e Distribution by priority ranges—The number of workitems that have different priorities.

By SLA

iWD Manager Summary

Gold €3 Q Search...(e.g. FirstName: Adam OR state: Queued) Uses lucene query syntax @ Last 7 days &} O
1) .
o M service level agreement
[=]
» E Pre SLA i) Breached SLA (i ]
E Will reach SLA in less then 1d Breached SLA for less then 12h
-~ e
ot [ [
»
=
1]
>
o3
o
w
=
w
»
0 0.1 0.2 0.3 0.4 05 0.6 0.7 0.8 09 1 0 01 0.2 0.3 0.4 0.5 06 0.7 0.8 0.9 1
Count Count
S @ sla sta ——@
10d 9d 8d 7d bd 5d 4d 3d 2d 1d 12h Th Th 12h 1d 2d 3d 4d 5d 6d 7d &d 9d  10dvore

Displays dynamically workitem counts for selected pre-SLA intervals, and for workitems that have
breached their SLA by selected intervals. You can:

¢ Dynamically change the time interval and category for display.
e Dynamically select a saved search filter from the Filter & View tab for display.
¢ Hover over populated areas of the graph to display a detail panel for the date and time selected.

e Use the sliders at the foot of the panels to change the time ranges.

Metric descriptions

¢ Pre SLA item counts—The amount of workitems that should be serviced in a selected time range.
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¢ Breached SLA item—The amount of workitems that should have been serviced but were not, in a
selected time range.

By categories

Summary

Q, Search...(e.g. FirstName: Adam OR state: Queued) Uses lucene query syntax (@ LastMenth C &

= %]
.
© g
» B Distribution by Categories Tree [ ]

=
~ __————~._ __— category

»

=

o

>

o

&

= @

5 2

o %

»

Gold
2
K2

Displays dynamically the distribution of workitems across the available categories for the date and
time selected. You can select current or historical time intervals for a rapid visual comparison.

You can also dynamically select a saved search filter from the Filter & View tab for display.

Hover over a Category chart to display information about that Category. Metric description

» Distribution by categories—Distribution of workitems by categories.
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By timing

iWD Manager s Summary

Q, search...(e.q. FirstName: Adam OR state: Queued) Uses lucene query_syntax (© Last30 days CcC O
= %3
~ B
Ol = vy
S Volume timing
<) Grouped by 12h - i ]
» BT -
= —
= —
~ P 400 m
< 300
o > =
5
S 200
E 100 - - -
s
o3 0 - | - - - -
E 10 Jul 12 Jul 14 Jul 16 Jul 18 Jul 20 Jul 22.ul 24 Jul 26 Jul 28 Jul 30 Jul 01 Aug 03 Aug 05 Aug 07 Aug
5
w .
Average Duration o
» Grouped by 12h
25000
20000
15000
10000
5000
0 - p
10 Jul 12 Jul 14 Jul 16 Jul 18 Jul 20 Jul 22l 24 Jul 26 Jul 28 Jul 30 Jul 01 Aug 03 Aug 05 Aug 07 Aug

Average Routing Duration
Grouped by 12h i

120000
Date: 2019/08/05 13:00
— Avg Routing Duration:

100000 114609.96

80000
60000
40000

20000

0

10.Jul 12.Jul 14.Jul 16.Jul 18 Jul 20 Jul 22.ul 24 Jul 26 Jul 28 Jul 30 Jul 01 Aug 03 Aug 05 Aug 07 Aug

Displays dynamically the volume of transactions, plus average duration times and average routing
duration times. You can:

¢ Dynamically change the time interval and category for display.

e Dynamically select a saved search filter from the Filter & View tab for display.

e Hover over populated areas of the graph to display a detail panel for the date and time selected.
Metric description

e Volume—Total number of received workitems in a time frame.
e Average Duration—Average workitem lifetime and time before workitem becomes queued.

¢ Average Routing Duration—Average time that workitems spent in routing before being routed to the
agent.
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By path

iWD Manager Norkitems Summary

Q_ search...(e.g. FirstName: Adam OR state: Queued) Uses lucene query syntax @ Last30 days C O

Path path ()

CATEGORIES

v

Default
Queved

. 63016626-2272-4529-bca3-83652937ada8 default

FILTER & VIEW

Hold

99702947-4524-4624-921c-4884c33ce024
Expired

e ee L0 #20cb910-99da-11e9-8951-c167221b70_lve

I 27096260.9358-1100-2602-41953c583de7 _live 1 Routing

The Path dashboard enables users to see where the workitem has been segmented, queued in
Designer and matched with an employee, through to completion. This dashboard is also useful for
identifying workitems that have not been segmented and have been matched through the default
path.
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Configure IWD

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to IWD Settings.

The Settings tab of iWD Manager lets administrators do the following:

¢ View Summary details of all categories, prioritization schemas and endpoints. You can also search the
displayed items and export displayed items to .CSV format.

¢ View, edit and create the Categories displayed in the collapsible Categories panel. Categories
correspond to business units, lines of business, departments or business processes whose workitems

iWD will control.

* View, edit and create different Prioritization schemas that will be assigned to Categories for handling
the Prioritization and escalation of the workitems in those Categories.

¢ View, edit and create Endpoints that can be associated with different Designer applications and
assigned to the Categories.

Ask your Genesys team to configure other iWD settings on the Options toolbar,
including notifications back to the source system.
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View Summary

This content may not be the latest Genesys Engage cloud content. To find the latest

content, go to View Summary.

The Summary tab in iWD Settings shows a display of all categories, prioritization schemas, endpoints

and service level agreements.

iWD Manager s Settings

»
1 Category Prioritization
Gold Gold 400 to 1000 50 hours
@ SilverBronze Bronze 20 to 550 50 hours
Q New Enrollment Gold 400 to 1000 50 hours
New Enroliment \ Calgary Gold 400 to 1000 50 hours
New Enroliment \ Saskatoon Gold 400 to 1000 50 hours
New Enroliment Bronze 20 to 550 50 hours
New Enroliment \ Calqary Gold 400 to 1000 50 hours
>

Search

400

400

400

atsLA
550
550
800
800
800
550
800

SLA

0 Hours

50 Hours
50 Hours
50 Hours
50 Hours
50 Hours
50 Hours

Designer Endpaint
Gold
openmedia.Bronze
Gold

Gold

Cloud iwD

Cloud iWD

Gold

Rows per page:

25

Limit
1

15
15
15
1

1

15

-

Segment by User data
category
category
category
125045 > 2l
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View, edit and create Categories and Rules

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to IWD Categories.

Each node in the Category tree corresponds to a business unit, department or process that handles a
specific set of workitems for a specific purpose. Each node is associated with a Prioritization schema
that controls how workitems are prioritized. Each node also specifies a Designer Endpoint at which its
workitems are targeted, and enables you to define rules for how workitems are assigned to it.

View and edit a Category

iWD Manager Workitems mmary Settings
=l CATEGORIES « -
L categories
LAl scarch Cateqories Name
n ) Gold Sales
1 ~  Service Department
® . Description
Customer Segment Gold
] Silver

Prioritization schema

Default Gold 400 to 1000 50 hours -

Add roat category ...
Route to endpoint

Gold -

Assignment criteria ENE RULES BUILDER

Every attribute should match ~

level 2 Attribute Expression t match
Segment Gold X

{ e vgf 1 None of attributes should match - o

Attribute Expression to match %
Gustomer NotPremium

ADDRULE  ADD GROUP

ADDRULE  ADD GROUP

o Lucene query will be used for categorization. See Lucene Query Syntax

o]

1. Select the Settings tab.

2. From the collapsible Categories panel, select the Category you want to view or edit.
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Remember that changes can have large impacts on contact center operation.

The Prioritization schema and the Designer Endpoint associated with this Category are displayed. You
can change them if you have the appropriate privileges. Designer applications are loaded on the
Designer Endpoint in order to match the segmented workitems with employees.

Category levels and reporting

The first level of Category (Service Department in the screenshot above) translates to the
Department in historical reporting (for example, here).

The second level of Category (Gold Sales, Silver in the screenshot above) translates to the Process
in historical reporting (for example, here).

The third level, and any lower levels, do not translate to historical reporting. These levels add power
to the capabilities, but you should establish a clear business reason why more than two levels need
to be configured.

The first level filters all workitems that match the Category's criteria. Any sub-levels further filter
workitems that match the first-level criteria as well as the sub-level's criteria. In this way you can

create a hierarchy that funnels workitems through to lower levels of specificity to enable them to be
handled in more specific ways.

Add/delete controls

CATEGORIES «

-

Bronze Sales ﬂdd Sﬂb _Category

b Silver Sales

*  Gold Sales ®O0—___— delete Cﬂtﬂg ory

Add root category ...

~ add root category

e To add a new root category, at the bottom of the collapsible Categories panel, click Add root
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category...

e To add a sub-category to an existing category, click the + button to the right of the parent Category's
name.

* To delete a Category click the X button to the right of the Category's name.

Warning

You cannot undo deletion of a Category.

Create a new Category

1. Select the Settings tab.
2. Open the collapsible Categories panel.

3. Click either Add root category... or, to create a new sub-Category, the + symbol next to an existing
Category .

4. Give the new Category a name. For a sub-Category, you should enter a name that follows the naming
convention for the root or parent Category, for example:
[source system] [department][process] high-level criterion

5. Give the Category a business-friendly description, to include the rule intention if possible (see the
examples below).

6. From the drop-down list, select a Prioritization schema for this Category.
7. From the Route to Endpoint drop-down list, select a Designer Endpoint for this Category.

8. In the Assignment criteria section, create a rule or group of rules, or a Lucene query, that will
determine which workitems are assigned to this Category. The examples below illustrate some
relatively simple rules and rule groups.

Tip

You can use Elasticsearch query syntax in describing Categories and creating rules and rule groups.

9. Click Save when you're done.

Rules

The Assignment criteria panel shows which rules and rule groups have been set up for this
Category (with the RULES BUILDER button selected). Rules determine which workitems are
assigned to this Category. Rule groups are bundles of more than one rule. Rule groups can be coupled
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with standalone rules. (You can only nest rule groups down to the third level.) Every Category must
have at least one rule configured. See the sample rules below.

Lucene queries

You can configure a Category by selecting the Lucene query option and entering Lucene query syntax
in the field that displays:

Assignment criteria LUCEME QUERY

Elasticasarch (Lucens) guery

o Lucene query will be used for categorization. See ene Query Syntax

cance' “

Workitems retrieved by the Lucene search will be assigned to this Category.

Rules examples

Mame

Customer Segment New Enrollment A

Description

Customer Segment = New Enrollment AND (value between 300 and 900) OR (productType = Residential)

Prioritization schema
Lead Management A

Route to endpoint

Default -
Assignment criteria LUCENE QUERY ~ RULES BUILDER
Every attribute should match -
Attribute Expression to match
customerSegment New Enrollment x
Any one attribute should match v [x]
Attribute Expression to match
businessValue [300 to 900] X
Attribute Expression to match
productType Residential X
ADDRULE  ADD GROUP
ADDRULE  ADD GROUP

o Lucene query will be used for categorization. See Lucene Query Syntax

Cance'
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Example 1
This rule assigns workitems to this Category if they meet the following conditions:

The value of their customerSegment attribute is New Enrollment
AND

EITHER

the value of their businessValue attribute is between 300 and 900
OR

the value of their productType attribute is Residential.

Name
Customer Segment New Enrollment B

Description
Customer Segment = New Enrollment and (productType <> Residential AND| productType <> Business)

Prioritization schema
Lead Management -

Route to endpoint

Default v
Assignment criteria LUCENE QUERY ~ RULES BUILDER
Every attribute should match -
Attribute Expression to match
customerSegment New Enrollment X
None of attributes should match - o
Attribute Expression to match X
productType Residential
Attribute Expression to match X
productType Business
ADD RULE  ADD GROUP
ADD RULE  ADD GROUP

o Lucene query will be used for categorization. See Lucene Query Syntax

Cance'

Example 2
This rule assigns workitems to this Category if they meet the following conditions:

The value of their customerSegment attribute is New Enrollment
AND

NEITHER

the value of their productType attribute is Residential

NOR

the value of their productType attribute is Business
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Mame
Customer Segment New Enrollment C

Description

Customer Segment = New Enroliment and business value between 100 and 700 and product type = Residential

Prioritization schema

Lead Management hd

Route to endpoint

Default -
Assignment criteria LUCENE QUERY ~ RULES BUILDER
Every attribute should match -
Attribute Expression to match
customerSegment New Enrollment x
Attribute Expression to match
businessValue [100 to 700] X
Attribute Expression to match
productType Residential X
ADDRULE  ADD GROUP

o Lucene query will be used for categorization. See Lucene Query Syntax

Cance'

Example 3
This rule assigns workitems to this Category if they meet the following conditions:

The value of their customerSegment attribute is New Enrollment
AND

the value of their businessValue attribute is between 100 and 700
AND

the value of their productType attribute is Residential.
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View, edit and create Prioritization
schemas

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to IWD Prioritization.

A Prioritization schema defines an initial priority for new workitems in a Category, plus the timestamp
(workitem age) at which subsequent reprioritizations take place and what the new priority value at
each reprioritization will be. It also defines the Service Level Agreement (SLA) for the Category, and
how workitems are prioritized post-SLA. A schema can be used by multiple Categories.

Genesys recommends that you start with simple linear prioritization for their
environments. As you become more accustomed to how prioritization works in your
environment, you can evolve to a more complex prioritization graph. Genesys also
recommends that you reduce the interval as the SLA approaches to increase the
probability of workitems being assigned to an employee, as the priority is used to
reflect the business value of the work. You can refine the graph by dragging and
dropping the curve to represent the business value of the work item over the
expected lifecycle. So if there are tiered penalties for work items that breach their due
date and time, the graph after SLA can be arranged to reflect these tiers.
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View and edit Prioritization schema

iWD Manager N E ! Settings

P PRIORITIZATION « L. s

- prioritization

» Search Priorities
Name Urgency

t Gold 400 to 1000 50 hours Hours - Rustions (R

4 Bronze 20 to 550 50 hours -

® Silver 100 to 600 50 hours .00 400
SLA Service Level Agreement With priority management over 6.63 416

e Gold 400 to 1000 50 hours [x] 50 Hours 120 Hours 12.40 434

7.4 454
Add prioritization ...

- . . 2177 476

priority O o . -
00 800 1000 = 25.55 500
delete schema B 2885 523
Steps Before SLA R After SLA R Reduce interval as SLA approaches . 37 547

30 15

- - - 34.20 570
.o _ —e
pr:orrty reset 3636 592
38.24 614
39.88 634
Hide table
2130 653
4254 671
Priority Over Time
o P, 4361 687
o 4455 701
4536 74
900
6.06 726
\ 46.68 77
800 A oo 0o o o o
4121 746
. 4767 55
700 &
o 48.08 762
e 48.43 769
600 af
o 48.73 775
o 49.00 780
500 > 4923 784
o ) 49.43 788
e 49.60 792
0 20 w0 60 8 100 120 i
4975 795
Hours
49.89 798
50.00 800

1. Select the Settings tab.

2. Select the Prioritization tool from the left toolbar.

The Prioritization schema details are displayed and can be changed if you have the appropriate
privileges. Remember that such changes can have large impacts on contact center operation.

You can edit the schema by:

e Changing the values in any of the fields in the top part of the panel.
e Changing the priority values directly in the hideable table on the right of the panel.

¢ Dragging the individual data points up or down on the Priority over time graph.
Use the Cancel button to abandon all changes entered on the page.

Use the Reset button to reset changes made in the graph and priority tables.
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Field names

Changes in the static fields and in the table are reflected dynamically in the Priority
over time graph.

e Name—The schema name.
* Urgency—The units in which the intervals for calculation are denominated: Days, Hours or Minutes.
e SLA—The interval (Days, Hours or Minutes) by the end of which workitems must be completed.

* With priority management over—The post-SLA interval (Days, Hours or Minutes) during which the
workitems are to be monitored and managed.

e Priority—Minimum, SLA and Maximum priorities for the workitems.

* Speed of increase as SLA approaches—Use the slider bar to accelerate or decelerate the change in
priority when workitems under this schema are reprioritized before their SLA. As you move the slider
bar, the curvature of the Priority over time graph changes dynamically to reflect the changes. A
straighter line indicates a more single-speed regime. A more curved line indicates acceleration as the
SLA approaches.

¢ Steps—The number of times the workitems under this schema are reprioritized, both before and after
their SLA.

¢ Reduce interval as SLA approaches—Use the slider bar to alter the interval between reprioritization
steps as the SLA approaches.
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Add a new Prioritization schema

iWD Manager Workitems Summary Settings
PRIORITIZATION «
L3 Search Priorities Urgency
Name Days hd
i1 Bronze 20 to 550 50 hours
® silver 100 to 600 50 hours N )
SLA Service Level Agreement With pricrity management over
e Gold 400 to 1000 50 hours 50 Days 80 Days
New prieritization Priority V‘ﬂr‘mwmum gtosgA g;:)mum Speed of increase as SLA approaches .
Add prioritization @ v
Steps ::;’mesLA grtersLA Reduce interval as SLA approaches .
— o -
View in table »
o el . Priority Over Time
add prioritization 00 o
schema s00
y
400 :
p
300 o
y
-
200
100
0e -
0 10 20 30 40 50 60 70 80

1. Select the Settings tab.
2. Select the Prioritization tool from the left toolbar.

3. Click Add prioritization... to create a new Prioritization schema.

Use the field definitions above to set up your new schema. Some fields have default values, listed
here:

* Urgency—Days

*« SLA—-50
¢ With priority management over—380
e Priority
* Minimum—o0
* At SLA—-500
* Maximum—600
* Steps

e Before SLA—10
e After SLA—5
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View, edit and create Endpoints

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to IWD Endpoints.

A Designer Endpoint corresponds with the Designer application to which workitems will be
distributed. The Designer application:

¢ Determines how this workitem is matched with the employee.

e Can add any information that needs to be attached if further information needs to be retrieved prior to

sending the work to the employee. (Genesys recommends that the majority of the information for the
employee is attached by the Designer application.)

e Determines how to distribute the workitem.

Configuration of tenants to which Endpoints belong, and of all routing to Endpoints
takes place in Designer.
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View, edit and create Endpoints

Settings
ENDPOINTS

Bronze

Silver Gold

Gold
Limit s B
egment By -
Add endpoint ... 500

gyLdpofnt User Data
Key Value
EndPt Gold []
Add key-value pair ...
Configuration

add 6Hd}90l' nt stream.dev 2799h260-9358-11e9-a602-41953c563de7_dev.0
stream.live 2799b260-9358-11e9-a602-41953c583de7_live.IQ
stream.qa 2799b260-9358-11e9-a602-41953¢583de7_ga.lQ
stream.uat 2799b260-9358-11e9-2602-41953c583de7_uat.IQ
endpointName digital.2799b260-9358-11e9-a602-41953c583de7
endpoint digital.2799b260-9358-11e9-a602-41953c583de7

Select the Endpoint tool from the left toolbar, then select a Category to display or edit its Endpoint
details.

To add a new Endpoint click Add endpoint...

The Limit field is the limit for the number of unassigned/incomplete interactions that iWD creates for
routing. iWD tracks the number of such interactions by subscribing and monitoring the Interaction
Server events for each Interaction Queue associated with the Endpoint. If the limit is reached, iWD
will not create any more interactions until some interaction is assigned to an employee, stopped or
placed into the final queue (defined by the Final queue option in the iWD Options page, which is for
use by Genesys Professional Services/Customer Care only).

The Segment By field displays an attribute by which workitems reaching this Endpoint can be
segmented. To make changes to this value, either select from the displayed list or manually enter a
different attribute.

The User Data field displays key/value pairs that will be attached to the user data of workitems
when they are classified and targeted at this Endpoint. You can delete existing key/value pairs and
add additional ones here.

The Configuration panel displays read-only details of the specific Designer application streams
associated with this Designer Endpoint. You can read more about Designer Application streams here.
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Designer

Important

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Getting Started with Designer.

Important

These help topics are intended for the latest release of Designer (version 9).

e If you are running an older version of Designer (i.e. 8.x), some of the features and
functionality described here might not apply. In that case, you should refer to this
version of the Designer Help. (You can check your version in the top-right corner of the
Designer interface.)

e If you are new to Designer 9 after running an 8.x version, refer to this section for
important details about working in Designer 9.

e Contact your Genesys representative if you have any questions about the features that
are available in your version of the software.

Designer is a web-based tool for developing self-service (IVR) and assisted service (routing)
applications that run on the Genesys Engage cloud platform and enable you to manage voice and
chat interactions.

This video shows a quick overview of Designer and demonstrates a few of its latest features:

Link to video
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Supported browsers

Designer supports the latest versions of the following web browsers:

e Mozilla Firefox

Google Chrome
e Microsoft Edge
e Apple Safari

The minimum display resolution supported by Designer is 1920 x 1080.

What's new

Here are some of the features and capabilities you'll find in the latest version of Designer:

Microservices platform

Chatbots

Streams-based workflow

Omnichannel capability

Predictive Routing

Rich media

Designer is now built as a microservice, which
means you get faster access to new features and
zero downtime during upgrades.

You can use the Bot block in the Self Service phase
of your application to add a chatbot to your
application. Chatbots are software applications that
apply automatic speech recognition and natural
language understanding to listen and respond to
customers in a way that resembles a conversation
with a live agent. You can define and manage your
bot resources in the new Bot Registry.

Designer now features a streams-based workflow,
where you can generate multiple builds of an
application and assign them to different streams.
For example, you can have one build of an
application assigned to QA, and another build of
the same application assigned to your Live
operations. You can manage these builds from the
application properties. In addition, you can now
designate certain resources for use in testing, so
that non-production builds do not reference
resources that are being used in your live
operations.

"Build once, deploy anywhere." A single call flow
now handles both voice calls and chat interactions.

If your site is enabled for Genesys Predictive
Routing, you can use the new Predictive Routing
block to add this powerful routing capability to your
applications.

For chats, customers can now click a "quick reply"
button instead of manually typing a response. The
quick replies offered are based on the DTMF Key

options set up in the Menu block. In addition, the
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Social media channels

Personas

Play Message block has a new option that lets
you specify an image to display within the chat
window.

Designer is now capable of handling messages
coming from Facebook, WhatsApp, Twitter, and
SMS. If a customer contacts you from one of these
social media platforms or services, Designer
detects which channel the message is coming from
and launches the appropriate application for
managing and routing that type of interaction. If
applicable, Designer can also send or post
messages back to the incoming channel.

Designer now includes a variety of personas that
you can use to control Text-to-Speech (TTS)
services in your applications.

Check out the Designer page in the Genesys Engage cloud Release Notes for more information about
these and other features and improvements to Designer. If you've been using a version of Designer
older than 9, you should also review some of the changes in how Designer 9 works.

What do you want to do?

Use these topics as a starting point to find the information you need.

Getting started

Learn the basics.

Getting started with Designer
Using the Designer user-interface

Understanding the application workflow

Managing resources

View and manage your application
resources.

Business Controls (Business Hours,
Special Days, Emergency Flags, Data
Tables)

Media files and collections

pesigner roles and permissions

Managing variables

Digital messaging resources

Speech grammars and Bots
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Building applications

Using the various blocks to build
applications in Designer.

Application phases
Working with blocks

Reporting and Analytics

Designer has an integrated set of
dashboards that provide detailed
information about your operations.

Designer Analytics

Managing the dashboards

For Designer Administrators

Manage users and their access to
resources (Designer Administrators only).

Partition-based Access Control (PBAC)

applications.

For users of previous versions of
Designer (8.x)

If you are new to Designer 9 after working in a
previous version, there are some things you
should be aware of when working in Designer 9:

Designer now uses a new application workflow based
on builds and streams. You can learn more about this
new type of workflow on the Application Workflow
page. To gain familiarity, you can clone an existing
application and experiment with making changes,
generating builds, and assigning the builds to
streams. When you are comfortable with the
workflow, you can start to adopt it with your original

e If you make any changes to a Business Control, Audio Resource, or Speech Grammar resource, those
changes now take effect immediately if the resource is being referenced by the LIVE production build.
However, if you make a change to a data table, you must publish the data table for the changes to take

effect in any builds that are referencing it.

e In previous versions of Designer, any changes made to an application took effect immediately after the
application was published. In Designer 9, you must generate a new build and assign it to the LIVE

stream for the changes to take effect.

¢ Some permissions have changed. Refer to Permissions and Access for a list of Designer roles and their

associated permissions.
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Getting Started

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Designer provides easy-to-use, highly functional blocks that enable common tasks in a simple and
straightforward manner. For example, there are blocks for building menus, playing messages, setting
up decision points, routing interactions to agents, and offering surveys.

To build an application, you simply drag blocks from the Palette and drop them into the Application
Flow, which is divided into phases and represents the application structure.

For example, you might use the following blocks in the Assisted Service phase, in which an agent
helps a customer. The first block controls the announcement to the caller that they are being
transferred, and the second block controls the routing function to an agent:

’ Announce Transfer

Q Route Call

But before you start building applications, you should learn about some of the key concepts. The
following topics provide an overview of things you should know when working with Designer:

¢ Using the Designer user-interface

* Designer roles and permissions

* Managing variables

¢ Understanding the application workflow
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User Interface

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Supported browsers
Designer supports the latest versions of the following web browsers:

e Mozilla Firefox
¢ Google Chrome
e Microsoft Edge
e Apple Safari

The minimum display resolution supported by Designer is 1920 x 1080.

Internet Explorer is deprecated. Genesys recommends that IE users select one of
the supported browsers when using Designer. Using non-supported browsers with
Designer can produce unexpected results.

User interface overview

Watch this video to see an overview of the Designer user interface:

Link to video

The various elements within the interface are described below.
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Navigation bar

L-]
S Designer  Applications

Provides one-click access to Applications, Shared Modules, Media Resources, Digital Resources,
Speech Grammars, and Business Controls objects.

Workspace toolbar

Provides buttons for common actions. Click your user name to log off. Click the settings icon to view
or modify the global Caching settings for certain resources and to toggle certain Features. Click the
Help icon to access the Designer Help.

Application toolbar

Validation Status: @ 1 Settings B Save Flow o Build

Provides buttons for common actions. Click Settings to set global settings for your application. Click
Save Flow to save and validate your application, or click Publish to save and validate your
application and prepare it for use by routing engines. Click Build to create and manage the builds
associated with the application.

Palette

Provides all available blocks that you can use in your application, sorted by functional grouping:
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Palette
Logic, Control e
User Interaction e
Routing R4
Operational Ma... el

@ Business Hours

E Data Table

i Emergency

@ Special Day
Data R
External Services B
Reporting R4
Callback b

Application flow

Provides the main area to build your application by adding blocks vertically. (See Build Logic for more
information.)
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Application Flow Actions ~

) Initialize b

+— Assign - Initialization

Emergency check

|

Special Days - Check holidays

ﬁ Check Business Hours
N

Milestone - Application Started

’ Play Message
¢= Menu - Main

D Main - Sales

Help pane
Displays help information for the selected block:
Properties - Menu - Main

{1mmm  TNis block can be used to speak a list of choices to callers and get their selection. Based on this
2===  selection, commonly used actions can be defined in Menu option blocks. To start, select the
3™  DTMF keys you would like to use.

Block properties

Displays all properties exposed by a block and provides assistance to set them:
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3) Menu Promptis fii DTMF Options o) Retry Prompt [ Results

M Milestone

Specify prompts to play to offer menu selection

+ Add Prompt
Type Variable? Value Play as Actions
TS v (] Press 1 for sales. ] text v LAl
TTS v O 2 for service. text v R |
TTS v O 3 to check if there are any sup: text v + 4 i@
Timeout - wait for 5 s before assuming that no input was received.
Search bar

Most Designer pages have a search bar located near the top-right corner:

You can use this search bar to find items on that particular page. As you start typing, the items on the
page are filtered to only show those items that match the terms you've entered.

There are additional levels of search available when you are working directly within an application
flow. See Searching the application flow.

Tip
If you are searching on the Applications page, you can search for a specific phone

number that is assigned to an application. The applications list is then filtered to only
show the application(s) with that number assigned.
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Actions toolbar

Many of the resource pages in Designer have an Actions toolbar:
o B @ ® o

The action items on the toolbar will vary based on the resource page you are viewing. Depending on
the functions available for that particular resource, you can use this toolbar to do the following:

View History

Use the View History button ( g ) to open the history view (or audit log) for a resource.

The history view shows you a list of each time the resource was viewed, edited, or published, the
user who made the change, and the new and previous value of any properties that were changed.

You can use the buttons on the page to view the results for a specific time period (for example, last
1W to see the results for previous week), or use the date fields to specify a custom date range.
Results can be sorted or searched and you can use the Export button to export the results as a CSV
file.

You can drill-down further into each results item by double-clicking it. This opens an audit window
opens that displays additional details for that particular event.

List Media/Message Collection Consumers

Use the List Media/Message Collection Consumers button ( @ ) to see information about which
applications and modules are using that particular media or message collection.

Clone

Use the Clone button ( = ) to clone the resource. You'll have to give the cloned resource a unique
name.

A cloned resource does not inherit the history and published versions of the original
resource.
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List Module Versions

Use the List Module Version button ( = ) to view the version history for a shared module. You can
then choose to make a version public, or view a version (in read-only mode) as it appeared at a
particular time.

Export

Use the Export button ( © ) to export a resource. This exports the selected resource for use in
another Designer workspace. When you export a resource, all versions of that resource are exported,
including the unpublished version.

Tip
If you are using a Safari browser when performing the export, the exported file is

downloaded as unknown. The file is valid and can be imported successfully, but you
might want to rename it to something more meaningful.

Import

Lt
This Actions item is only available on the Data Tables page. Use the Import button ( ) to import
the contents of a CSV file into the selected data table.

Delete

Click Delete ( B ) to delete all versions of the resource. However, published applications that were
using the resource (in other words, applications that had previously generated their code) are not
affected.

Quick filters

This toolbar enables you to filter a list of resource items by selecting one or more filters that are
associated with tags. The list then refreshes to show only those items that match the selected filters.

In this example, the SMART and Debug filters are selected so that only data tables with those tags
are shown:
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Selected filters

Data Tables

Sﬁttfﬂgs DuckFites fx  Uve  Uveiewi (D) Restrg

selfTestAppMsg
i dez?

AT
L

0 VA Menus

i

Vi1 Routing

=

B M1 HDOPS Services

B M1 Profiles

[

Tags

debig, abed

Mldpp

WlApp

MlApp

MApp

©) Lasait ol

DSNEANT &

0N ENT &

MEFT &

DANETNT &

MANRNT &

Note that the filters will display any item in the list that has the associated tag, even if there are
other tags associated with that item. If you navigate to a new resource page (such as going from
Data Tables to Business Hours), any selected filters are automatically applied to the new page.

To add, modify, or delete quick filters, click the Settings icon to open the Manage Quick Filters
window. To associate a filter with a specific tag, select it, and add the tag(s) under the Parameters

section.

In the above example, the SMART filter was associated with the "M1App" tag, as follows:

Manage Quick Filters

+ Mew CQuick Filber

i
Live Retal
Rourting
Debug

Close Delete Fiter

SMART

Descripbion

Farameters

11 App

O Add Tag

The Quick Filters toolbar appears on the following resource pages: Special Days, Business Hours,
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Data Tables, Applications, Shared Modules, Emergency Flags, Media Resources, and Digital

Resources. The same filters appear on each page, and any filters that you create are visible to other
Designer users.

Tip
Tags are a useful tool for keeping resources organized. For consistency, Genesys

recommends that you define and use a similar set of tags across your various
resource types.
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Application Phases

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

An application flow consists of several sections of common blocks, known as application phases.

) Initialize

I'C.’ Assisted Service

" Finalize

Each Designer application contains the following four phases:

e |nitialize
¢ Self Service
e Assisted Service

e Finalize

Each phase is described in more detail below.

Initialize

This phase initializes application-level user variables and parameters to use when the application
executes. The application initializes during this phase.

By default, the following actions take place:

e Initialize and set up user variables.

* Load application run-time parameters from external sources.
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e Process interaction properties (for example, ANI and DNIS) and application run-time parameters. System
variables or properties may be initialized internally.

e If configured, additional processing that was set up by the user.

Self Service

The Self Service phase is the IVR (Interactive Voice Response) portion of the interaction. This phase
hosts blocks that provide automated interaction with the customer via speech, chat, and/or DTMF. It
attempts to provide automated service and contain the interaction within an IVR, so there is no need
to route the interaction to an agent.

If routing is necessary, this phase collects necessary data from the user through various questions
and menus, and then determines how to route the interaction in the next phase, Assisted Service.

Tip
To enable voice call recording for the Self Service phase, set the
EnableSSRecording variable to true in the System Variables section.

The following are typical actions that take place during the Self Service phase:
e Play Messages. These may be pre-recorded audio files or dynamic text spoken using TTS (see Media
Resources).

e Check business hours and customize logic based on the outcome (for example, take this action if we are
closed).

e Collect user input.

e Present choices to customers using menus.

* Navigate customers appropriately, based on their responses (i.e. segmentation and branches).
* Call external RESTful APIs and fetch data into user variables.

» Call Bots to interact with customers.

e Update user variables and write ECMAScript expressions (see Variables).

e Set up and process global commands and hot words.

The Self Service phase updates user variables with collected or calculated data. This data is later
used by other blocks in the Self Service or Assisted Service phase.

Interaction processing might complete during the Self Service phase. In this scenario, the
application control skips the Assisted Service phase and proceeds to the Finalize phase. For
example, if the business hours check determines that the contact center is closed, the corresponding
announcement is played to the customer and the interaction is terminated.
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Assisted Service

This phase hosts blocks that route the interaction to a live agent, if necessary.

During the Assisted Service phase, the application attempts to route interactions to agents.
Routing is performed based on data collected in previous phases. For example, target skills are taken
from user variables.

The following are typical actions for this phase:

e Attempt to route the interaction while playing music or prompts.
¢ Call external RESTful APIs.

e Update user variables.

There may be multiple Route Call blocks in sequence. Each Route Call block might try to route the
interaction to different targets with different timeouts. For example, it might expand a target by
geographical location.

Each Route Call block has a timeout, after which the next Route Call block in sequence is executed.
If any of the blocks successfully routes a call, the Assisted Service phase is complete and
processing continues to the Finalize phase.

Finalize

This phase provides post-processing and interaction termination after the customer has been
serviced.

When interaction processing is finished, the application goes to the Finalize phase to perform post-
processing for various scenarios that are based on how the interaction was completed.

The following are examples of typical scenarios:
* Interaction was abandoned by the customer (while in either the Self Service or Assisted Service
phase).
¢ Interaction was completed in Self Service phase.
* Interaction was routed to an agent in the Assisted Service phase.
¢ Interaction was delivered to voicemail in the Assisted Service phase.

e User opted to leave a queue and schedule a callback.

You can also use the Finalize phase to submit application data to an external system for reporting
metrics, or to select a disposition code for post-processing.
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Disposition codes

When you click on the Finalize block in the application flow, each of the tabs (General, Error, Self
Service, Assisted Service, and Callback) has a list of disposition codes that you can enable.

When you select a disposition, a block for it is created below the main Finalize block. You can then
drag other valid blocks (such as an HTTP REST block) below the disposition block to further customize
the handling for that disposition.

Here's an example:

Tip
Setting up handlers for the Finalize phase is optional. There may be no need to do
anything special for these cases.

This list contains additional information about some of the common disposition codes that can be
enabled in the Finalize phase:

All

When an application enters the Finalize phase, it has only one disposition code, so only one
disposition block is executed. However, the All disposition code is unique in that it is always
executed, in addition to (and after) any disposition block related to the actual disposition code of the
application. This is the only case where more than one disposition block is executed.

Typically, you would select the All disposition code when you want to execute some post-processing
logic, no matter what the actual application disposition code is. This is more efficient than duplicating
the same logic in every possible disposition block.
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default

This code is used when no other disposition code is applicable. For example, it could indicate that a
call was not routed, not terminated (by any party), and was likely still active when the session and/or
application completed.

System Error

There was an unexpected error in the application (such as a script validation error).
Application Timeout

The application got stuck in a loop and reached the timeout limit.

Terminated (Terminate Call)

The application reached a Terminate Call block.

Terminated (Business Hours)

The call came in outside of regular business hours, as specified in the Business Hours block.
Terminated (Special Days)

The call came in on a special day, as specified in the Special Day block.

Terminated (Emergency)

The emergency flag was set, as specified in the Emergency block.

Terminated (Menu Option)

The caller chose a menu option to exit or end the call.

Abandoned in Self Service

The caller hung up before completing the Self Service phase of the application.
Abandoned in Queue

The caller completed the Self Service phase, but hung up while waiting to speak with an agent.
Completed in Self Service

The caller successfully completed their call in the Self Service phase — the application did not need
to go to Assisted Service and went directly to Finalize. If the call ended in Self Service due to
some other condition or event (such as the call being received outside of business hours or the
customer hanging up), then the appropriate disposition code for that condition or event is used
(Abandoned in Self Service, Terminated, and so on).
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Routed to Agent
The interaction was successfully delivered to an agent.
Routed to DN

The call was successfully delivered to a direct number.
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Permissions and Access

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

Genesys Designer provides layered access roles to ensure that your users only have access that is
appropriate for your business needs—such as the ability to make changes to prompts, business
hours, or set an emergency routing flag—without exposing control to the overall application logic.

Designer only permits one user at a time to open an application, shared module, or data table for
editing. If you try to open one of these resources and it is already in use, Designher shows you which
user has the resource locked. You can then choose to open it as read-only or go back to the previous
screen.

If a user has opened an application or module for editing and then goes inactive, their browser

eventually displays a timeout warning. If they do not respond, the resource is closed and the lock
released.

Designer roles

Designer supports the following user roles:

Designer Developer

Designer Developers have the ability to view and modify all resource types within Designer, with the
exception of features that are restricted to Designer Administrators (such as managing partitions and
user accounts). Developers are also able to view the flows of application builds and previous versions
of shared modules in read-only mode.

Designer Business User

Designer Business Users have limited access to Applications, Speech Grammars, and Shared
Modules. They can view these resources, but cannot make any changes to them.

They have full access to Media Resources, Analytics, and most Business Controls resources (i.e.
Business Hours, Special Days, and Emergency Flags). They can view and modify Data Tables, but
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they cannot create or delete them.

Business Users can also assign phone numbers to applications.

Designer Administrator

Designer Administrators have full access to the Admin settings for Designer, which includes the
ability to manage partitions and control which users have access to them. They can view most of the
other resource types in Designer, but cannot make any changes to them.

For full access to all resource types in Designer, a user would need to be assigned to
both the Designer Administrator and Developer roles.

Designer Analytics

All Designer roles have access to Analytics. Users assigned only to the Designer Analytics role can
view and modify the Analytics dashboards, but do not have access to any other Designer resources.

Designer permissions

The following tables provide a high-level overview of what each role can do with various Designer
resources:

Media Resources

Task Designer D'esigner De.si.gner Design.er
Developer Business User Administrator Analytics
View v v v
Modify v v
Create v v
Delete v
Message Resources
Task Designer D_esigner De_si_gner Design_er
Developer Business User Administrator Analytics
View v v v
Modify v
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Task Designer Designer Designer Designer
Developer Business User Administrator Analytics
Create v
Delete 4
Applications
Task Designer Designer Designer Designer
Developer Business User Administrator Analytics
View v v v
Modify v
Create v
Delete v
Switch to last v y
snapshot
Assign phone s, / /
numbers
Change block y
properties
Shared Modules
Task Designer Designer Designer Designer
Developer Business User Administrator Analytics
View v v v
Modify v
Create v
Delete v
Speech Grammars
Task Designer Designer Designer Designer
Developer Business User Administrator Analytics
View v v v
Modify v
Create v
Delete v
Business Controls
(Business Hours, Emergency Flags, Special Days, Data Tables)
Task Designer Designer Designer Designer
Developer Business User Administrator Analytics
View v v v
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Designer
Task Designer Designer Designer Designer
Developer Business User Administrator Analytics
Modify v v
v
Create v (all except Data
Tables)
v
Delete v (all except Data
Tables)
Blocks
Task Designer Designer Designer Designer
Developer Business User Administrator Analytics
View v v v
Modify v v
Create v v
Delete v v

Restricted mode during upgrades

During upgrades, Designer continues to provide full service, but goes into a restricted mode that only
allows selective modifications to be made. While Designer is in this mode, certain objects (such as
applications, shared modules, and workspace settings) are locked for editing until the upgrade is
complete. You can, however, continue to make changes to objects such as business controls, audio

resources, and grammars.
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Application Workflow

This content may not be the latest Genesys Engage cloud content. To find the latest
content, go to Genesys Engage cloud for Administrators.

This page describes the builds and streams workflow that Designer uses for developing applications.
In this type of model, an application consists of multiple work streams, each of which represents a
different stage in the life cycle of the application (such as the development or quality assurance
stage).

At various times, you can "freeze" the current state of the application code as a build, which you can
then assign to the appropriate stream. The builds are promoted through the various streams until a
build is approved for use in the live production environment.

One of the primary benefits to this type of workflow is that each stream runs a build of the
application that is completely independent of the others. For example, the development team can be
working on a build without impacting the build being tested by the quality assurance team or the
build that is actively running in production.

This video shows an example of a workflow in action:

Link to video

Application streams

You can view and manage the streams of an application from the application properties:
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g+ Joules Coulomb Direct Sales »

Designer sample application.

Sample demo
Status Stream
«© o=
| o
o
&€
&) e

Builds

Latest Published

BUILD : 3 - Recorded File Des

BUILD : 2 - Added MNew Sales

BUILD : 1 - First IVR

BUILD : 2 - Added New Sales

Phone Numbers

65267
65268
. Manage

65380
t. Manage

65269
t. Manage

65277
t. Manage

65345
. Manage

Type: Default

Chat EndPoints

je_1_dev

jc_1_ga

je_1_uat

Jje_1_live

je_1_live_b

All streams are enabled by default. You can use the Status sliders to enable or disable them, as

needed.

DEV (Development)

Use this stream to test the latest changes to your applications. You can then generate a build that
can be promoted to QA, UAT (as applicable), and then to a LIVE stream. The DEV stream is the only
one that can run the latest published version of the application code. As such, it is also the only
stream impacted by Designer upgrades.

Warning

The DEV stream is intended for development testing purposes only and does not
support live production traffic. Live production traffic must always be assigned to the
LIVE or LIVE B streams.

QA (Quality Assurance)

This stream is for builds that require Quality Assurance testing.
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UAT (User Acceptance Testing)

This stream is for builds that require beta-testing or some other variation of user-based trials.

LIVE

This stream is for builds that are actively running in the production environment.

LIVE B

This is an optional stream that can run a second application build in the live production environment.
For more information, see LIVE B streams.

Application builds

When you want to "freeze" a version of your application code, you can create a build. A build is

basically a self-contained package of the application code. It has all of the resources it needs to run,
SO you can assign a build to a stream without worrying about impacts to the original resources or to

the other builds.

You can create a build by clicking Build when the application is open in editing mode. Designer

automatically increases the version number of the build, but you can add your own label and note:

é-‘ Joules Coulomb Direct Sales

slisation Status @ % Setings | #4 SavaFlow m 2 il

Palatte Application Flow e Properties - Initialize
“This black or phase is typically u=2d to setun verisales for the sppication and mitielize them. Assign biocks can be used to calcuiate
A UserVariables & System Variables
W chat Custom Message ———
@ Emergency check . .
£ ‘Specily User Variables. String values must be surraunded by single quates.
Wi Get Chat Transcript o E
; Special Days Gheck holidays + A Variable
= ™
[
° £ check Business Hours I Name pefaukt value Description Sexre  Trace  Delete
B rlaytiersone M wilesione Agplication Started B T c— 5
@ Recors , "
W Flay Message varcompanyFeundzdain 03 ]
%2 Record Utterance = =
IS Menu Main varCateizipCode (]
W% send chat Transeript
O Mainsales varServiceType &
& vserinput
o
RS Record Ulterance varDefaultTransferhum 1234567000 [}
Routing - a
A i e varLockupURL Tt smERmEre atwil eime thenearas L sUpSTenanger i
@ oueryvas .
= serice Menu optians =
B P jromasray i
& Route agent
O service Battery
varsurveyResponse. [}
® nowecall
O service Eectronic _
varincrementintzeys &
1) stan Treatment
O service All other
owtt ]
Qo Vaice Mail =
O service Previous Menu
Business Controls = ent [}
[0 main nearest supercharger station
[ business Hours s (]
B activity lookup started
£ ot Table it &
& user input collect zip code
& Emergency s ¥
. HTTP REST lookup nearest station
B special Day ol i
@ Pley back station leation
Data e
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You can manage the builds for an application by clicking Manage Builds from the application
properties.

* Once generated, a build cannot be changed. If you want to make changes, you
must generate a new build. You can also choose to perform a rollback by selecting a
previous build.

¢ There is a limit of 20 builds for each application. Therefore, it's recommended that
you generate a build only when required. If you exceed 20 builds, the Build button
becomes disabled. You can re-enable the button by deleting builds that are no longer
needed.

Parallel Test Environment (PTE)

The Parallel Test Environment enables you to use test resources instead of production ones when
running an application build in a non-production stream. You can enable this option on the Misc tab
in the application settings. When enabled, you can create copies of certain resources and add a
special test prefix to the resource name.

For example, if you create a business object resource to use in the LIVE Production stream (example:
Hours), you would also create a similar business resource object with the test prefix for use in the
non-Production streams (example: test_Hours).

Then, you can reference the resource in your application as you would normally, using the original
name (using the above example, you would just reference the Hours resource). Streams that are
running non-production builds (DEV, QA, and UAT) will automatically reference the PTE versions of the
resources (test <resource name>) instead of the ones being used in production. The LIVE build
continues to reference the original production resources.

When making changes directly to the test_<data table>, you do not need to add the
test_ prefix to the resource names, as Designer adds this prefix automatically when
PTE is enabled.

PTE is supported for Business Controls resources (Business Hours, Emergency Flags, Special
Days, and Data Tables) and certain configuration resources (Virtual Queues, Agents, Agent
Groups, and Skills).
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LIVE B streams

You can run an optional LIVE B stream in addition to the existing LIVE stream. This allows you to run a
second application in LIVE production mode, which gives you greater flexibility in how you can
introduce new application builds into your production environment.

For example, each LIVE stream can have different contact points assigned to it, so one way you could
use the LIVE and LIVE B streams is to allocate interactions coming from a certain region to a
particular stream, or use the streams to balance (or gradually introduce) the number of interactions
being handled by a new production build. In this way, you can implement a form of A/B testing.

Let's say you wanted to split or balance the number of interactions being handled between the LIVE
and LIVE B builds. Typically, you would gradually introduce more interactions from LIVE to LIVE B,
which could be done as follows:

e Assign Build X to the LIVE stream.

e Use the Manage button to assign phone numbers to the LIVE stream. At this point, 100% of the
interaction load will be handled by Build X on the LIVE stream.

* Now, assign Build X+1 to the LIVE B stream.

¢ Assign some of the phone numbers to the LIVE B stream so that 70% of the interaction load is handled
by LIVE and 30% by LIVE B.

Tip
The Transfer from Others button is a great way to easily and quickly move several numbers from one
stream to another.

* Check Designer Analytics to see if there are any issues.

e |If there are no issues, we can then move more of the phone numbers from LIVE to LIVE B, so that 30%
of the interaction load is being handled by LIVE and 70% load by LIVE B.

e Again, we continue to monitor Designer Analytics to see if there are any issues.

* |f everything still looks ok, we can move the remaining phone numbers from LIVE to LIVE B, so that
100% of the interaction load is being handled by LIVE B.

e Assign Build X+2 to the LIVE stream. This is a new build that we want to test in conjunction with Build
X+1 on LIVE B.

e Assign some phone numbers to the LIVE stream so that 30% of the interaction load is being handled by
our new application build running on LIVE and 70% by LIVE B.

¢ Continue to check Designer Analytics for any issues, and adjust and balance the interaction load
between the two builds as desired.
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Variables

You can use two types of variables in Designer:

e User Variables - These are variables that you create. You can use these variables throughout the
application and in all phases.

e System Variables - These variables are created with the application and cannot be deleted.

Tips
Variable names must be alphanumeric, but not start with a numeric character. For example:

¢ Valid variable names = abcdef123 or c123badef

¢ Invalid variable names = 123abcdef or 3abcdef21l
Variable values may be:

¢ ECMAScript objects, such as Date().
* Valid ECMAScript expressions. Do not add an ending semi-colon (;) as typically required by ECMAScript.
¢ Simple values, such as numeric or string.

e If the value is a string, it must be surrounded by single quotes (for example, 'value'). If the value
also uses a single quote, you can use a backslash to escape the quote character (for example
'Joe\'s Pizza').

The block properties page will indicate if single quotes are required.

User Variables

You can add user variables in the Initialize phase. You can assign initial values to these variables in
the Initialize phase, or by setting values in an Assign block in the Initialize phase.

You can also assign a system variable as the default value of a user variable. For example, you might
assign the system variable DNIS to a user variable you have created. (If the system variable does
not have a value at the time of the call, the default values are used.) This is also supported for Self
Service Shared Modules.
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User variables may not be initialized correctly if their value is set to one or more
system variables in the Initialize phase itself. This phase should be used to declare
variables, but their values should be assigned later using an Assign block if the value
or the value expression involves a system variable.

Warning

You can delete a variable even if it is required by the application. Designer validates
the application when you click Publish, at which time it checks for deleted variables.

Securing Variables

Warning

Variable values can be captured in a variety of data sources when Designer
applications run on the Genesys platform. To prevent the values of variables from
being exposed as plain text in Designer and the Genesys platform, they
must be marked as Secure.

You can enable the Secure check box to indicate that a variable is secure and must not be logged or
recorded. The application must be published for any changes to these settings to take effect.

Secure variables function as follows:

e Secure variable values are not logged in application logs.

¢ When you use secure variables to store the results of a user input, the user input is masked in MCP
(Media Control Platform) logs.

¢ When you use secure variables to play back prompts, the prompt message is masked in MCP logs.

¢ Users cannot select secure variables for blocks that record reporting information, such as Call Data,
Activity, and Milestone blocks.

e Secure variables are not reported in Analytics.
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Properties - Initialize

This block or phase is t\,r{:icall\,r used to setup variables for the application and initialize them. Assign blocks can be used to calculate
’j expressions and assign their results to variables in this phase.

2 User Variables System Variables

Specify User Variables. String values must be surrounded by single quotes.

+ Add Variable

Name Default Value Description Secure Delgte
varMyCompanyMame "Joules Coulomb’ o
varCompanyFoundedin 2013 O o
varincrementinterval ] i

varCreditCard 4]

=13

ewt2

System Variables

The Initialize phase has a second tab that lists system variables - these variables are created with
the application and cannot be deleted.

Most system variables are initialized when the application starts and can be used throughout the
application, such as the Last Milestone variable. When your application starts, the initial value of
Last Milestone is an empty string. While your application runs, the Last Milestone value is set to
the last milestone that your application reaches.

The following system variables are available:

Variable Name Description

DNIS Specifies the dialed number.

ANI The number associated with the calling party.

MaxTime MIaX|mum time (in minutes) to keep this session
alive.
The timezone used for this application, unless this
value is overridden in other blocks.

Timezone If you override this value—for example, by using

Advanced Scripting in the Assign Variables block or
setting up a timezone data type when defining
columns for a data table—you must assign it a valid
value (e.g. "America/Los_Angeles"). Otherwise,
Designer might experience issues when performing
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Variable Name

Language
AppLanguageName

AppCountryName

RoutingSkills

RoutingVirtualQueue

EstimatedWaitTime
IVRProfileName

GVPTenantID

SelectedTarget

SelectedVirtualQueue

SelectedComponent

Description

certain functions, such as executing Business Hours
logic. The Timezone drop down contains a list of valid
values you can reference.

The default language for this application that is
used for announcements.

The name of the default language for this
application that is used for announcements.

The name of the country for this interaction (can
also be specified by the application).

A set of skills that might be specified in some
blocks, such as Menu Option child blocks, that
determine how the call is routed. For example, if
you select a Skill in the Call Handling tab of a
Menu Option block, this selection is stored in the
RoutingSkills variable. Then, in a subsequent
Route Call block, you can enable the Use system
variables RoutingSkills and
RoutingVirtualQueue set already in Menu
Options check box to use the value of the
RoutingSkills variable.

A virtual queue that might be specified in some
blocks, such as Menu Option child blocks, that is
used for routing unless a different queue is
specified in Routing blocks. For example, if you
select a Virtual Queue in the Call Handling tab of
a Menu Option block, this selection is stored in
the RoutingVirtualQueue variable. Then, in a
subsequent Route Call block, you can enable the
Use system variables RoutingSkills and
RoutingVirtualQueue set already in Menu
Options check box to use the value of the
RoutingVirtualQueue variable.

The estimated wait time for the call to be routed to
an agent.

This application's calls will be associated with the
given IVRProfile for VAR reporting.

This application's calls will be associated with the
given tenant for VAR reporting.

This is the DN and the switch name of the target to
which the interaction was routed or should be
routed to definitively. The target format is
Name@SwitchName.Type.

The virtual queue that was selected.

The agent-level target to which the interaction was
routed or should be routed to definitively. If the
target selected for routing is of type Agent, Place,
Queue, or Routing Point, this variable contains
the target. If the desired target type is Agent
Group, Place Group, or Queue Group, the
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Variable Name

SelectedTargetObject

SelectedAgent

Access

CustomerSegment

Customerld
EnableSSRecording

CallbackReporting
PositioninQueue
AppCountry
AppRegion
AppCallType
AppUserDisposition

AppUserDispositionCategory

AppDeflectionMessage

Description

function returns the agent, place, or queue from
the corresponding group to which the interaction
was sent. The target format is
Name@StatServerName. Type.

This is the high-level target to which the interaction
was routed or should be routed to definitively. If a
skill expression is used, the function returns:
?7:SkillExpression@statserver.GA or
?GroupName:SkillExpression@statserver.GA.
The target format is Name@StatServerName. Type.

This is the Employee ID of the agent to which the
interaction was routed.

(Optional) When present, this is an ECMAScript
object that represents a switch access code. The
table below show its properties and the
corresponding switch access code fields:

Switch access code

Access property field
prefix Code
rtype Route Type
destination Destination Source
location Location Source
dnis DNIS Source

The segment to which the customer belongs, based
on information that the customer has provided.

A unique identifier for the customer, based on
information that the customer has provided.

Enable call recording in the Self Service phase.

An object containing key-value pairs for callback
reporting.

The call's position in queue while waiting to be
routed to an agent.

The country code for this call (can be specified by
the application).

The region for this call (can be specified by the
application).

The type of call (can be specified by the
application).

A custom disposition that the application can use
to specify a user-specific outcome.

A custom disposition category that the application
can use to categorize user-specific outcomes.

The application can use this variable to track
deflections by specifying the message played when
a caller disconnected their call.
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Variable Name
AppLastMilestone

AppStrikeoutMilestone
AppBailoutMilestone

AppDeflectionMilestone

ScriptID
AppSelfHelpedMilestone

SdrTracelLevel

AppSessionType

EnableRouteCallRecording

GmsCallbackServiceName

GmsCallbackServicelD
survey sOffer
survey_iAgentScore
survey_iCompanyScore
survey_iCallScore

survey_iProductScore

survey _iRecommendScore

ApplicationRevisionSeriallD

ApplicationPath

Description
The last milestone that the application achieved.

The last milestone that the application achieved
before strikeout.

The last milestone that the application achieved
before the caller bailed out to an agent.

The last milestone that the application achieved
before the caller was deflected.

The ScriptID as reported by the routing engine.
Used to contain a self help milestone.

Enables users to set the recording level. This
variable accepts the following values:

e 100 — Debug level and up. Currently, there are
no Debug messages.

e 200 — Standard level and up. This setting shows
the existing blocks array in the SDR.

e 300 — Important level and up. This setting
filters out all blocks except those containing
data that can change from call to call (such as
the User Input block).

The type of the session. The default value is
inbound for inbound calls. Survey applications
must use the value survey.

Set to true or false to enable or disable call
recording for routed calls in the Assisted Service
phase. Leave blank to use platform defaults.

The GMS Callback Service name.

The unique identifier that GMS assigns to a
scheduled callback.

Set by the Setup Survey block to specify if a survey
was offered, setup, or rejected.

Holds the user satisfaction score for the agent, if
this question is asked by the survey.

Holds the user satisfaction score for the company,
if this question is asked by the survey.

Holds the user satisfaction score for the overall
call, if this question is asked by the survey.

Holds the user satisfaction score for the product, if
this question is asked by the survey.

Holds the user's rating score (on a scale of 0-10) of
the company, product, or service. Used to calculate
Net Promoter Score (NPS).

A read-only variable that increments by 1 each
time an application is revised.

The absolute path to the application.
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Variable Name Description
Details about the interaction
Interaction (Interaction.Subject, Interaction.Type, and
So on).
Details about the customer contact
Contact (Contact.EmailAddress, Contact.LastName, and

DefaultPartition

Flow Entry Count

TreatmentlterationCount

AgentsTotalSize

AgentsLoginSize

ChatEntryPoint

InteractionSource

ReferrerUrl

UserAgent

UserAgentOS

AutoStoplnteraction

ChatOffervQ

ExpirationTime

So on).

The default partition used to provide access control
in GIR. This variable can be overridden by settings
in the Record block.

Number of times (including this run) a Designer
application has been executed to handle this
interaction.

Keeps track of how many times a treatment has
been executed.

The total number of agents that could possibly be
available. For example, the total number of agents
in a specified Agent Group.

The number of agents that are actually logged in.

(Digital only) Holds the point of entry for a chat
interaction. Can be used in application logic at
runtime to provide alternative processing or to
facilitate the use of parallel testing environments.

Source of the interaction. Expected values are web
(i.e. desktop and mobile browsers) or mobile (i.e.

apps).

URL of the previous page (document.referrer) to
detect where the customer came from (might be
shortened).

Type of browser the customer is using (e.g.
Chrome, Mozilla, Opera).

Type of operating system the customer is using.

(Digital only) Specifies whether or not the
interaction is to be automatically terminated when
the session ends. The default value is auto (to
automatically terminate a chat interaction if it
exceeds 20 application runs or exceeds the
specified expiration time); other valid settings are
true or false.

Name of the Virtual Queue that was queried for the
Estimated Wait Time, to determine if chat will be
offered.

Maximum time (in minutes) from the time this
interaction was first processed by an application to
keep this interaction alive. When an application
terminates and the AutoStoplnteraction variable
value is auto, the application terminates the
interaction if that interaction has been processed
for longer than the specified ExpirationTime.
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Variable Name Description
Persona The persona to be used for this application.

(Digital only) Holds the number of times a digital

EREEUmRtliTm 2 dnG, interaction has been parked.

VAR Metrics

VAR action IDs are stripped of spaces and pipe characters (|). This includes implicit
actions that are generated when a caller enters a shared module.

Use the IVRProfileName variable (User Data Key: gsw-ivr-profile-name) to associate the
application VAR metrics with an IVR Profile. Use a value of auto to auto-detect the IVR Profile.

Use the GVPTenantlID variable (User Data Key: gvp-tenant-id) to associate the application VAR
metrics with a tenant. Designer attaches the value to user data. Use a value of auto to auto-detect
the tenant.

These variables are listed in the properties of blocks once they are defined.

Assigning Values to Variables

Designer lets you assign values to variables in different ways. These examples show a few of the
methods you can use to assign different types of values to a variable, including a JSON value.

Example 1: Simple Assignment

The easiest (and recommended) way is to assign a value to a variable using the Assignments tab on
the Assign Variables block.

Click Add Assignment to add an assignment slot to the block, then choose a variable from the
Variable column. For the Expression, you can use the name of another variable whose value should
be copied in to the Variable column, a literal value (for example, "Sales Channel"), or an expression
whose value should be calculated first and the results assigned to the Variable.
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Properties - Prepare Welcome Prompt

This block can assian values of expressions to variables. Define a variable in the Initialize phase or block and
— select it in this block to asmlg_n it values or results of ECMAScnpt expressions. You can also call ECMAScnipt
-— utility functions, such as sorting an array, and provide an input to be run through the function.

G Assignments 1] Sort Function = Advanced Scripting

String values must be surrounded by single quotes.

+ Add Assignment

Variable Expression Delete
varCompany ¥ ‘Genesys' [i]
varCurrentDate ¥ new Date() i
varCustomerData v ( { customerid' : 'CUSTO001", 'customername’ : "Joge’ }) [i]
varSkillLevel v 7 [i]
varZipCode v ‘94014 [i]
varCustomerPrompt ¥ ‘Hello " + varCustomerData.customername + " Welcome to " + varCompany [i]
varDidScriptHaveErrors v false [i]

You must use single quotes (' ') when specifying string values, but you can assign numeric values
without quotes. Note that the varZipCode above is a string data type (the single quotes tell JavaScript
to treat it as a string), but it contains only numbers. It's important to remember that JavaScript treats
string and numeric data types differently. For example, 1 + 2 = 3, but ‘1" + 2 = ‘12",

JSON data (for example, varCustomerData) is typically retrieved from an external data source, but
you can also form a JSON string in the application. JSON strings must be enclosed in brackets ( ) and
should follow the rules and syntax for JSON strings as defined by JavaScript. Note also that variables
can easily be used to form part of the JSON string (as represented by varCustIDFromCRM, in the
example shown below).

The varCustomerPrompt above shows a simple string expression, with the different string segments
linked together by a +. If used in a Play Message block, it will play “Hello Joe! Welcome to Genesys."

It accesses a property of the varCustomerData object using the “.” notation and combines it with the
welcome message.
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Although the terms ECMAScript and JavaScript are used interchangeably throughout
this Help, Designer technically supports ECMAScript and does not support JavaScript
functions that are typically used for web-browser based applications, such as pop-up
windows, alerts, and so on.

Here is another example of how you could build a JSON expression. It contains mostly hard-coded
strings, but also uses a variable to form part of the JSON string:

Properties - Prepare JSON

This block can assign values of expressions to variables. Define a variable in the Initialize phase or block and select it in this block to
— assign it values or results of ECMAScript expressions. You can also call ECMAScript utility functions, such as sorting an array, and
— provide an input to be run through the function.

@ Assignments 13 Sort Function = Advanced Scripting

String values must be surrounded by single quotes.
+ Add Assignment

Variable Expression Delete

varlyJSONData v ({ customerid' : varCustIDFromCRM, ‘customersegment’ : ‘Unknown’, ‘pendingOrders’: 3 }) m

Example 2: Advanced Scripting

If your application requires you to go beyond simple assignments and use JavaScript constructs like
loops or multiple nested conditions, you can use the Advanced Scripting tab, which allows you to
compose valid ECMAScript or JavaScript.

Advanced Scripting is an optional feature and might not be enabled on your system.
To enable this functionality, contact Genesys.

To use this feature, you need a basic level of familiarity and understanding of ECMAScript syntax and
rules. Any errors in the script can cause erratic behavior, so test your changes to make sure that your
script works correctly.

Warning

Use caution! Designer can check your script for syntax errors, but cannot validate it
nor check for runtime errors that might occur when the script runs during a call.

In this example, the script sets the variable varOrdersPrompt to "3 Laptop bags, 2 Phone chargers, 1
Super rare fish". Here's how it works:

Genesys E